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1
Welcome to Bryce

Welcome to Bryce® 5, the leading 3D program for 
desktop artists, animators, Web designers, and 
multimedia producers. Bryce is ideal for creating 
3D graphics for magazines, ads, or virtually any 
illustration that would benefit from the powerful 
3D impact of realistic perspective and shading.

Bryce animation features let you create great 
animations for video and multimedia easily. Bryce 
key-event and timeline-based animation lets you 
create incredibly realistic, fully animated, 3D 
worlds where rivers rush through gorges, the sun 
sets over the ocean, or mist evaporates to reveal 
flocks of birds soaring between mountain peaks.

Bryce is also an invaluable tool for interactive 
multimedia. 
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Corel support and services
Corel is committed to providing quality customer 
service and support that is easy to access and 
convenient to use, while fostering one-to-one 
customer relationships.

If you have a question about the features and 
functions of Corel applications or operating 
systems, see the user manual or online Help for the 
product you are using. Updates and technical 
information are also available in the Release Notes.

Registering Corel products
Registering Corel products is important. 
Registration provides you with timely access to the 
latest product updates, valuable information about 
product releases and access to free downloads, 
articles, tips and tricks, and special offers.

For more information about registering a Corel 
product see the online Help for the product or see 
http://www.corel.com/support/register on the 
Internet.

Technical support
The Web address for Corel is http://www.corel.com 
on the Internet. A list of localized Corel Web sites is 
available at http://www.corel.com/international/
country.htm on the Internet. Corel LINUX® 
information is available at http://linux.corel.com on 
the Internet.

Self-serve technical support options

Several self-serve tools are available to address 
technical questions 24 hours a day, seven days a 
week.

Support newsgroups:

http://www.corel.com/support/newsgroup.htm

Corel® Knowledge Base

http://kb.corel.com

FAQs

http://www.corel.com/support/faq

AnswerPerfect™

http://www.corel.com/support/answerperfect.htm

File Transfer Protocol (FTP)

ftp://ftp.corel.com

FTP information

http://www.corel.com/support/ftpsite/ftpindex.htm

Online Help

Type keyword Technical Support

Automated Fax on Demand*

1-877-42-COREL

*Fax on Demand is available only in North America.

Telephone technical support options

Corel users can use complimentary and fee-based 
telephone technical support options. Three levels 
of support are available.

Classic Service
Classic Service is a complimentary, 30-day service 
designed to address installation, configuration, and 
new feature issues. This service begins on the day 
of your first technical support call.

Classic Service is a paid for service for OEM, “White 
box,” Jewel Case (CD only), trial, or Academic 
versions of Corel products.

Priority Service
Priority Service is a fee-based service for users who 
require the help of second-level technicians. 
Priority Service may be purchased by the minute, by 
the incident, or on a term basis. Options range 
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from core-business-hour access for individual users 
to around-the-clock access for multiuser 
environments.

Premium Service
Premium Service is Corel’s highest level of support. 
This service is designed for organizations that want 
to establish a direct relationship with Corel and for 
organizations that employ dedicated support 
professionals or have centralized technical 
management.

Customer Service
Corel Customer Service can provide you with 
prompt and accurate information about Corel 
product features, specifications, pricing, 
availability, and services. Corel Customer Service 
does not provide technical support. You can access 
Customer Service support through the following 
avenues.

World Wide Web
You can access general customer service and 
product information at http://www.corel.com/
support on the Internet.

Mail, fax, email
You can send specific customer-service questions to 
Corel Customer Service representatives by mail, 
fax, and email.

Corel Corporation
Corel Customer Service
1600 Carling Avenue
Ottawa, Ontario
Canada K1Z 8R7

Fax: 1-613-761-9176

Email: custserv2@corel.ca

Telephone
You can telephone Corel Customer Service centers 
with your questions.

In North America, you can reach Corel Customer 
Service by calling the 1-800-772-6735 toll-free line. 
The hours of operation are 9:00 a.m. to 9:00 p.m., 
eastern time (ET), Monday through Friday, and 
10:00 a.m. to 7:00 p.m. on Saturdays.

Corel customers outside North America can call a 
local authorized Corel Customer Service Partner.

Installing Bryce
Your Bryce package includes:

• the Bryce CD-ROM

• the Bryce Content CD-ROM
• the Bryce User Manual

• your Bryce serial number

• a software registration card

If you are missing any of these items, please 
contact your Bryce dealer/distributor or Corel 
Customer Service.

To install Bryce for Windows®

1 Close all applications.

2 Insert the Bryce CD-ROM into the CD-ROM 
drive. The Corel setup wizard should start 
automatically.

If the Corel setup wizard does not start 
automatically, click Start on the Windows 
taskbar, and click Run. Type X:\setup, where X 
is the letter that corresponds to the CD-ROM 
drive.

3 Follow the instructions in the Corel setup 
wizard.

To uninstall Bryce for Windows
1 Click Start on the Windows taskbar, and click 

Programs>Bryce>Uninstall Bryce.
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2 Follow the instructions on your screen.

To install Bryce for Macintosh®
1 Close all applications.

2 Insert the Bryce CD-ROM into the CD-ROM 
drive. 

3 Double-click the Bryce installer to start the 
installation. 

4 Follow the instructions on your screen.

To uninstall Bryce for Macintosh

If you created presets that you want to use again, 
make sure you save your presets to another location 
before following this procedure.

• Drag the Bryce folder to the Trash.

Registering Corel products
Registering Corel products is important. 
Registration provides you with timely access to the 
latest product updates, valuable information about 
product releases, and access to free downloads, 
articles, tips and tricks, and special offers.

For more information about registering a Corel 
product, see the online Help for the product, or see 
http://www.corel.com/support/register/ on the 
Internet.

What is Bryce?
Bryce is a stand-alone application that allows you 
to create and animate three-dimensional virtual 
environments. 

With Bryce you can create any type of environment 
you can envision, from the ivory beaches of Tahiti 
to the silvery rings of Saturn. Bryce user interface 
contains all the tools you’ll need to create your 
environments. 

For example, Bryce includes controls for managing 
infinite skies that let you set everything from time 
of day to the color and frequency of clouds. Using 
the sky controls, you can also set light direction, 
sun/moonlight, atmospheric depth haze (with 
intensity and color), height fog (with height, 
intensity, and color), and multiple sky color 
components. 

You can also use Bryce controls to create a wide 
variety of objects you can use to populate your 
environment. You can use the Terrain editor to 
create an infinite number of custom terrains, which 
you, in turn, use to create landscapes.

The realism of a Bryce environment largely depends 
on the materials applied to the objects in the scene. 
Materials are complex combinations of textures 
and values. The Materials Lab lets you combine 
textures and channel values that simulate any 
material found in the real world (and a few that 
aren’t!).

When you have set up your environment just the 
way you want it, you can add a fourth dimension—
time. You can use Bryce’s animation tools to set up 
landscapes that move and materials that change 
over time.

What’s New in Bryce
Bryce5 has new tools, features, and improvements 
over Bryce 4. This overview provides a head start on 
locating, learning about, and taking advantage of 
new features in Bryce. They include:

Network Rendering
The new Network Rendering feature in Bryce lets 
you spread a rendering job over multiple 
computers. This reduces the amount of time 
required to render a complex scene or animation. 

With Network Rendering, Bryce can use the 
computing power of any computer running Bryce 
or Bryce® Lightning and connected by a TCP/IP 
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network to render a scene or animation in a 
fraction of the time. Refer to “Network Rendering” 
on page312 for more information.

New Light Lab
The Light Lab provides new and improved tools for 
editing lights. The redesigned Light Lab makes it 
easier to adjust lights as all the controls are now 
conveniently placed in a single location. 

The new gradient feature lets you add a color 
gradient to lights. When a light has a gradient 
applied, the color and intensity of the light is 
determined by the distance the light travels and the 
gradient that has been applied. You can create your 
own gradients and save them for future use, or 
import gradients from Corel PHOTO-PAINT® or 
Adobe® Photoshop®. 

Other new lighting options include Shadow 
Ambience, Soft Shadows, and premium rendering 
effects like Blurry Reflections, Blurry Transmissions, 
and True Ambience. Refer to “Lights” on page274 
for more information on the Light Lab.

Tree Lab
The new Tree Lab lets you create tree objects in a 
scene. You can control the size and texture of the 
tree trunk, the thickness and number of branches, 
the type of foliage and its frequency, randomness, 
and color. You can import images to be used for 
the trunk or foliage texture. You can also control 
how gravity affects the tree, making branches bend 
and leaves droop to varying degrees. Refer to 
“Editing Trees” on page119 for more on the new 
Tree Lab.

Metaballs
Also new to Bryce are Metaballs, a new object type 
found on the Create palette. Metaballs are spheres 
that blend into each other based on proximity. 
With Metaballs, you can create a wide variety of 

organic and realistic-looking shapes. Refer to 
“Creating Metaballs” on page81 for more on the 
new Metaballs feature.

Enhanced User Interface
To enhance ease of use, the user interface in Bryce 
has been enhanced in a number of ways. For 
example, the Terrain editor has been redesigned to 
give you more control when painting effects, to let 
you create more detailed terrains, and to provide 
larger previews and animated previews of the 
resulting terrains. The animation playback controls 
have been streamlined to make them easier to use. 
The Create palette has also been simplified to make 
it easier to find the object you want. In addition, 
two new object types have been added to the 
Create Palette: Metaballs and Trees.

...And Much More
Bryce also includes the following new features:
• partial shadows for objects with volume 

materials

• shadow ambience for lights
• new 3D Grid spatial optimizer

• new terrain grid resolutions: Gigantic (2048), 
and Planetary (4096)

• support for distributed rendering effects for 
lights, including soft shadows, blurred 
reflections, blurred transmissions, depth of 
field, and true ambience

• support for Total Internal Reflection (TIR)

• enhanced Render dialog
• volume shading mode

• volume materials shading mode

• uniform density shading
• five new mapping modes: Sinusoidal, World 

Front, World Side, World Cubic, and Object 
Cubic

• new Sky Integration feature

• distance squared texture noise & phase type
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• earth-based starfields and comets

• new import and export filters and plug-ins

Using Bryce Help
Bryce has several tools that help you work with the 
application:

• User manual — lets you access Bryce concepts 
and procedures in a paper format, and 
includes a tutorial to help you get started 
quickly

• Online documentation — lets you access Help 
directly from the user interface and find topics 
using the contents, index, and word/phrase 
search tool

• CorelTUTOR™ — lets you follow step-by-step 
tutorials that teach you how to perform 
common tasks in Bryce

To use online Help
1 Choose Help menu> Help topics.

2 Click one of the following tabs:

• Contents — lets you choose a topic from a 
section of the online Help

• Index — lets you use the index to find a 
topic

• Search — lets you find a topic by searching 
for a particular word or phrase in the 
online Help

You can also print a Help topic by opening a Help 
topic and clicking Print.

To use CorelTUTOR™:
1 Choose Help menu> CorelTUTOR™.

2 Choose a tutorial from the list and follow the 
directions on your screen.

About Your User Manual
The user manual provides all the information you 
need to get the most out of Bryce. It will help you 
learn the application as well as serve as a reference 
as you attempt more sophisticated procedures and 
effects.

We assume you are already familiar with basic 
Macintosh and Windows concepts such as menus, 
dialogs, and mouse operations. If you need more 
information on these subjects, or on the Macintosh 
Finder or the Windows Desktop, refer to the 
Macintosh User’s Manual or the Microsoft Windows 
User’s Guide, respectively.

The best way to learn Bryce is by reading 
“Exploring the work area” on page8 and “Getting 
Started” on page17, and then completing the 
“Tutorial” on page31. The tutorial leads you 
through the process of creating illustrations in 
Bryce and explains some of the important concepts 
you’ll need to know.

Conventions
The Bryce User Manual and online Help are written 
for both Macintosh and Windows. By convention, 
Macintosh commands precede Windows 
commands in the text. For example, Command/
Ctrl+I, is equivalent to the Macintosh Command-
I and the Windows Ctrl+I. For simplicity, the term 
folder refers to directories as well as folders. 
Screenshots may alternate between the Macintosh 
and Windows versions. The Bryce interface for both 
platforms is identical, unless otherwise specified.

There are also several conventions used to identify 
paths to certain tools and controls. The convention 
used to tell you to access a command in a menu is 
menu name> menu item. The convention used to 
tell you to access an item on a palette is palette 
name: subpalette name  or palette item. The 
convention used to tell you to access a palette 
menu item is palette name: palette menu> 
menuitem. 
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Modifier Keys
When a modifier key differs between the Macintosh 
and Windows platforms, the Macintosh modifier is 
listed first followed by a slash and the Windows 
modifier key. Option/Alt means Macintosh users 
press the Option key and Windows users press Alt.

Bryce Terms
Computer graphics and three-dimensional 
modeling use special terms that are usually 
explained where they are introduced. The 
“Glossary” on page371 provides concise definitions 
of a number of terms.

Before you get started in Bryce, you should be 
familiar with the following terms.

Scene — a) The complete content of your Bryce 
world; b) the two-dimensional screen projection of 
your 3D scene; c) the file that Bryce saves, 
containing all information regarding your 
landscape. 

Object — An independent element that you can 
modify. Objects include shapes, terrains, planes, 
symmetrical lattices, and pictures.

Wireframe — A mesh representation of a 3D 
object.

Render — The complex process of building a two-
dimensional bitmapped image from all the 
information contained in your three-dimensional 
wireframe scene.

Palette — A collection of related tools.
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Exploring the work area

The Bryce Window
Bryce’s default environment consists of the 
Working window, the Control palette, and the Tool 
palettes. 

By default, the Bryce environment replaces your 
screen whenever you launch the application. 
However, your operating system’s standard menus 
and windows are still available from within Bryce. 

The Working Window

The Working window displays all the objects in 
your Bryce scene. It’s the work area where you’ll 
arrange the objects and lights to create your 
environment.

The view of your scene shown in the Working 
window is taken from a “camera” that you can 
move around for different views of your scene. The 
Working window also has several display modes 
that let you view a scene as a wireframe, a rendered 
object, or a combination of both. Refer to “Display 
Modes” on page26 for more information.

Nano-Preview

Memory 
Dots

Camera 
Controls

View 
Control

Working 
Window

Text 
Display 
Area

Tool Palettes

Advanced 
Display 
Palette

Animation Controls

Time/
Selection
Palette 
Toggle

Render 
Controls
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The Working window displays all the objects that make up your 
scene.

Nano-Preview

The Nano-Preview displays a rendered preview of 
your scene. As you update your scene, Nano-
Preview shows your changes. You can immediately 
see how your adjustments to object position or 
other properties affect the final look of the scene.

The Nano-Preview shows a small rendered version 
of your scene. As you change the scene, the display 
updates to show your changes.

You can use the preset viewing positions to see 
your scene from different angles, or you can use the 
Memory Dots to store and retrieve your favorite 
camera positions. Refer to “Using the Nano-
Preview” on page19 for more on working with the 
Nano-Preview.

View Control

View Control lets you adjust the view of your scene 
without moving the camera. Using this control you 
can see your scene from the top, bottom, left, right, 
front, or back. You can also set your scene to 
continuously rotate so you can see it from any 
angle. Refer to “Using the View Control” on page20 
for more on using the View Control
.

The View Control lets you control how you see your scene.

Camera Controls

Camera Controls change the position of the camera 
specifically along the X, Y, and Z axes. The Camera 
Trackball lets you move the camera in any 
direction, and along any axis. 

Refer to “Using the Camera” on page287 for more 
on moving the camera.

The Camera controls let you adjust the position of the camera.
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Render Controls

Render Controls let you render your scene to see all 
the materials and lighting effects you added. The 
center button starts the rendering process and the 
other buttons control rendering options. Refer to 
“Rendering” on page301 for more on rendering.

The Render controls let you render your scene as a 2D image.

Text Display Area

The area just below the Render Controls is reserved 
for momentary display of text information. When 
you pass your pointer over interface elements, this 
area displays the name of the interface element, 
and in some cases, it also displays the element’s 
current settings. The Text Display Area also 
displays information about the total number of 
polygons in an object or a scene, and information 
about current control settings.

To display information about the interface:
• Pass the pointer over any interface element.

The name of the element is displayed. In some 
cases, the element’s current settings are also 
displayed.

To display statistics about the objects in your 
scene:

1 Switch to Wireframe display using the Display 
Mode tool.

2 Pass the pointer over the Working window.

•  If no objects are selected, the Text Display 
area displays a count of all of the objects in 
your scene, as well as a total polygon 
count. 

• If an object is selected, the Text Display 
area displays object and polygon counts 
for the selected object.

To display information about rendered images:
1 Switch to Bitmap display using the Display 

Mode tool. 

If you have not rendered your image, the 
Working window is blank.

2 Pass the pointer over the Working window. 

The Text Display area shows the file size.

The Palettes
Bryce uses a series of palettes to manage tools and 
controls—the Create palette, Edit palette, Sky & 
Fog palette, Advanced Display palette, Selection 
palette, and Animation controls. These palettes let 
you create objects, edit objects, create skies and 
fog, control the display of your scene, select 
objects, and animate objects. 

Beside the title of each of the three tool palettes 
(the Create palette, Edit palette, and Sky & Fog 
palette) is a small triangle that opens the different 
Preset Libraries available in Bryce. Refer to “The 
Bryce Preset Libraries” on page15 for more on 
Preset Libraries.

The Create Palette

The Create palette contains tools for creating 
infinite planes, terrains, stones, primitive shapes, 
derivative primitives, 2D picture objects, and lights. 
Refer to “The Create Palette” on page64 for more 
on the Create palette.

The Create palette contains tools for creating all the types of 
objects you can use in a Bryce scene.
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The Edit Palette

The Edit palette contains tools for editing object 
materials and resizing, rotating, repositioning, 
aligning, and randomizing objects. Refer to 
“Transforming Objects” on page206 for more on 
the Edit palette.

The Edit palette contains tools for transforming objects and 
accessing the Editors.

The Sky & Fog Palette

The controls available on the Sky & Fog palette let 
you add shadows, fog, and haze, and let you set the 
altitude, frequency, and amplitude of clouds. The 
Sky & Fog palette also lets you control the color of 
clouds in your sky and the position of the sun and 
moon. Refer to “The Sky&Fog Palette” on 
page242 for more on the Sky & Fog palette.

The Sky & Fog palette contains tools for creating the 
atmosphere of your Bryce scene.

Advanced Display Palette

The Advanced Display palette contains tools for 
controlling the display of the interface and 
enabling/disabling the Nano-Preview and Plop 
Render features. The Advanced Display appears on 
the right side of the Working window. Refer to 
“Setting Up the Bryce Window” on page25 for 
more on using the Advanced Display palette tools.

The Advanced Display palette contains tools for changing the 
Working window display. 

Selection Palette

The Selection palette contains tools for selecting 
specific types of objects in your scene. You do not 
see this palette in the default Working window. To 
view it, you must use the Time/Selection Palette 
toggle at the far bottom right of your Working 
window to replace the Animation controls with the 
Selection palette. Refer to “The Selection Palette” 
on page66 for more on selecting objects.

The Selection palette contains tools that let you select objects in 
your scene

The Animation Controls

The Animation controls let you set up key frames 
and edit the timeline of your animation. These 
controls also let you preview your animation, add 
and delete key frames, and access the Advanced 
Motion Lab. Refer to “Setting Up an Animation” on 
page321 for more on using the Animation 
controls.
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The Animation controls display the timeline of your animation.

Displaying/Hiding Palettes

To keep the interface uncluttered, many of Bryce 
palettes and toolbars are hidden when you first 
launch the application. Some palettes are hidden 
behind other palettes.

To display palettes:
• Either click on a text button above the 

Working window, or press the key 
combination for the desired palette:

• Control/Ctrl+1=Create palette

• Control/Ctrl+2=Edit palette

• Control/Ctrl+3=Sky & Fog palette

• Control/Ctrl+4=Control palette

• Control/Ctrl+6=Advanced Display palette

To display or hide all palettes:

• Press Control/Ctrl+Tab.

Displaying Submenus and Pop-up Dialogs
Wherever you see an inverted or sideways triangle 
icon in the interface, it indicates that there is a 
menu or other item available that contains options 
pertinent to the item closest to it. For example, in 
the Create palette, there are triangle icons next to 
each tool in the palette. These triangles access the 
additional options for the tools.

The triangle icon next to a tool or text button indicates that 
there are more options available for the element.

To display a submenu:
• Click the triangle icon.

The Menu Bar
The Bryce menu bar contains five menus: the File 
menu, the Edit menu, the Objects menu, the Links 
menu, and the Help menu. These menus provide 
access to several Bryce functions and editors.

The display of the menu bar depends on the state 
of the application. When the application interface 
snaps to the edges of your Working window, the 
menu bar is hidden until you pass the pointer over 
the menu bararea at the top of the Bryce window.

The Editors
Bryce has several editors that let you do everything 
from creating terrains to editing the speed of 
animation. Each editor is like a separate room in 
Bryce. When active, the editor takes over the 
interface, completely replacing the Working 
window.

The Terrain Editor

The Terrain Editor is where you’ll create all the 
terrain objects in your scene. The editor contains 
tools for painting and refining terrain objects. The 
Terrain Editor also has a real-time preview so you 
can see the effects of your changes instantly. Refer 
to “Creating Terrains” on page92 for more on the 
Terrain Editor.
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The Terrain Editor lets you create any type of landscape using 
the preset tools and paint brush.

The Materials Lab

The Materials Lab is where you’ll create the 
materials to apply to your objects. By combining up 
to four texture components on the materials grid, 
you can create incredibly complex surfaces that can 
bring your scene to life. 

There are two types of materials you can create: 
Surface materials, which define the surface 
properties of an object, and Volume materials, 
which define the properties of an object’s volume 
as well as its surface. When you’re creating volume 
materials, the settings in the Materials Lab change. 
Some of the surface material settings are replaced 
by volume effects settings. Refer to “The Materials 
Lab” on page160 for more on the Materials Lab, 
and “Understanding Volume Material Channels” on 
page130 for more on Volume materials.

The Materials Lab lets you create different types of materials by 
combining texture components on the materials grid.

The Advanced Motion Lab

The Advanced Motion Lab lets you fine-tune your 
animations. After you’ve created your key frames 
using the Animation controls, you can use the tools 
available in this lab to control the speed at which 
objects move along a motion path, adjust the 
position of key frames, and preview your changes. 
Refer to “The Advanced Motion Lab” on page334 
for more on animating scenes and using the 
Advanced Motion Lab.
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The Advanced Motion Lab lets you refine the action in your 
animations. Use the Velocity Curve editor to create different 
velocity effects and the Hierarchy area to control when object 
transformations occur.

Adjusting editor settings

The editors have unique interfaces that let you 
adjust individual settings by using a variety of 
tools, including controls, fields, knobs, and 
component indicators. To get the most out of each 
editor, it is important to know how these elements 
work.

Using controls
Controls let you set a value for an element within 
an editor. For example, in the Sky Lab, the Cloud 
Cover control lets you set the amount of clouds in 
your scene.
 

Controls are comprised of a slider and a field. Controls are used 
to set values.

To adjust the value of a control using the 
slider:
• Slide the highlighted portion of the control to 

the left or right. 

Using fields
Fields can be found in dialogs and in controls. A 
field lets you enter a precise numerical value.

To adjust the value of a field:

• Click in the field and type a value.

A field located in a control.

To adjust the value of a control using a field:

1 Click the numerical value to the right of the 
control’s slider. The field will appear. 

2 Click in the field and type a value.

Using knobs
Some of the editors in Bryce contain knobs. Knobs 
can perform many different functions, such as 
randomizing or saving elements. To activate the 
knob’s function, click the knob.

Knobs can perform many different functions. To activate a 
knob’s function, click the knob.

Using component indicators
Some of the editors contain component indicators. 
When you are combining several components to 
create a composite element, such as a texture, the 
component indicator lets you know which 
component you are currently manipulating.

Component indicators let you know which component you are 
currently editing. In the image above, the first component is 
active.
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When working with materials, you can blend 
material components by turning on multiple 
component indicators simultaneously. Refer to 
“Combining Components” on page154 for more on 
using the component indicators to blend material 
components.

To turn a component indicator on or off:
• Click the component indicator.

The Bryce Preset Libraries
Bryce has several libraries of presets that can make 
creating scenes easier. There are three main preset 
Libraries available in Bryce: the Preset Objects 
Library, the Preset Materials Library, and the Preset 
Skies Library. 

You can use the Preset Objects Library to add 
ready-made objects to your scene. Refer to “Using 
the Presets Object Library” on page75 for more on 
the Preset Objects Library. 

The Preset Materials Library lets you add a wide 
variety of materials to your objects. Refer to “Using 
the Materials Presets Library” on page164 for more 
on the Preset Materials Library.

The Sky & Fog Preset library contains pre-made 
skies that you can add to your scene to quickly 
create an environment. Refer to “Using the Preset 
Skies Library” on page270 for more on the Preset 
Skies Library.





2
Getting Started

Scenes are the three-dimensional images that you 
create and animate in Bryce. In this section, you’ll 
learn about
• starting and opening scenes

• using the basic features of Bryce

• viewing scenes
• positioning the camera

• undoing and redoing operations

• saving scenes
• closing scenes and quitting Bryce

• setting application preferences

• customizing the Bryce interface
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Working with documents
Before you can create a Bryce environment you 
need a document. A document can be either a 
blank scene or an existing file that you’re going to 
edit. 

Creating an Empty Scene
When you create a blank scene, Bryce opens the 
Document Setup dialog which lets you specify the 
aspect ratio and dimensions of the new scene.

To create a new document:

1 Choose File menu> New. The Document 
Setup dialog appears.

2 Enter values in the Document Resolution 
fields.

This is the absolute size of your working space 
expressed in pixels. You can enter any values 
you like here, though it’s recommended that 
you do not exceed your available screen space 
if you can avoid it. You can work small and 
render large if you need to. The values in the 
Aspect Ratio fields will update automatically as 
needed.

3 Enter values in the Document Aspect Ratio 
fields.

These fields represent the Document 
Resolution as a ratio. Depending on the type of 
work you are doing, it may be more 
convenient to enter values here rather than in 
the resolution fields above. For instance, many 
video formats, as well as the standard 13” 
screen, are 3:4 aspect ratios. 

The values in the Document Resolution fields 
will update automatically if you change the 
aspect ratio.

4 Enable the Constrain Proportions button if you 
want to preserve the current aspect ratio as 
you adjust the resolution.

5 Select a Render Resolution from the list. 

This resolution sets the absolute size of your 
rendered image, expressed in pixels as a 
multiple of your document size. 

You can work in one size as you build your 
scene and render that scene in a different size. 
For example, you could be working at Bryce’s 
default size but need to render four times 
larger for print or four times smaller for a Web 
page. Rather than resetting your document 
resolution every time you render (thereby 
impacting your wireframe workspace), you can 
simply set a separate size for rendering. Think 
of Document Resolution as input, and Render 
Resolution as output.

The default resolution is 540 x 405, and the default 
aspect ratio is 4:3.

To set up a new document using presets:

1 Choose File menu> New Document. The 
Document Setup dialog appears.

2 Click one of the preset aspect ratios displayed 
along the right side of the dialog.

These presets are aspect ratios for many useful 
document types. The pixel values that are 
placed in the Document Resolution fields are 
either absolute (as in Legal or Letter paper 
sizes) or based on your available screen 
resolution (as in Maximum Recommended or 
Square).

Opening an Existing File
Bryce can open any file created in any previous 
version of Bryce (Mac® or PC).

To open an existing file:
1 Choose File menu> Open. 

2 Use the dialog controls to locate and open 
your file.



Bryce5 19

Merging scenes
You can merge two Bryce scenes using the Merge 
command. When you use this command, the scene 
you are opening is merged with the currently open 
scene. Objects from the scene you’re opening are 
placed in your current scene at the same absolute 
coordinates that they previously occupied. Some 
information from the scene you’re opening will be 
discarded, such as family names.

To merge two scenes:

1 Choose File menu> Merge. A dialog appears 
prompting you to save the current scene.

2 Click Save. The Open dialog appears.

3 Use the dialog controls to locate the file you 
want to merge and click Open.

The file you selected is merged with the 
current scene.

Holding down the Option/Alt key while performing 
this function will merge only the sky from the incom-
ing scene.

Using the basic features of 
Bryce
Bryce has a large number of tools and capabilities 
to help you create and animate scenes. The 
following table lists the basic features of Bryce to 
help you get started.

Working in a Scene
When working in Bryce, you position objects in 
three-dimensional space while looking at a two-
dimensional display. You may find that your scenes 
become rather large, and you might not be able to 
see the entire landscape in the Working Window. 

Displaying Your Scene
Bryce has several tools that can help you position 
elements and see every inch of your new world 
from all angles. You can also control how individual 
objects are displayed in the Working Window, and 
how your scene is displayed in the Nano-Preview.

Using the Nano-Preview

The Nano-Preview is where your object is displayed 
before you render it. Nano-preview can display your 
scene from a number of different angles without 
affecting the position of the camera.

For information on See

Creating objects “Creating Objects” on 
page63

Arranging objects “Arranging Objects” on 
page201

Editing objects “Editing Objects” on 
page229

Editing terrains “Editing Terrains” on 
page91

Creating skies “Creating Skies” on 
page241

Working with 
materials

“Applying Materials” on 
page127

Working with textures “Creating and Editing 
Textures” on page169

Working with the 
camera

“Using the Camera” on 
page287

Working with the 
lights

“Creating and Editing 
Lights” on page273

Rendering scenes “Rendering” on 
page301

Animating scenes “Animating” on 
page319
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The Nano-Preview displays a rendered preview of your scene.

To display your scene from different angles in 
the Nano-Preview:
• Click the triangle icon below the Nano-Preview 

and choose a preset display angle.
The view of your scene does not change in the 
Working window. 

To set Nano-Preview options:
• Click the triangle icon below the Nano-Preview 

and choose a display option:

• Sky Only previews only your sky settings.

• Full Scene previews your actual scene. This 
is the default setting for the Nano-Preview.

• Wireframe Only previews your wireframes 
only, as opposed to a rendered preview. 

• Auto Update will automatically update the 
preview render with every single change 
you make during your session. In most 
cases, this gives you almost immediate 
feedback after any action. On slower 
machines, or when working with highly 
complex scenes, you can deselect this 
option.

With this option deselected, you’ll need to 
click in the Nano-Preview window to 
update the render.

• Select either Fast Preview or Full 
Rendering to adjust the quality of the 
rendered preview. With Full Render 
selected, every pixel is raytraced and anti-
aliased. Fast preview mode skips pixels to 

achieve faster updates. This can cause 
small objects to be partially or completely 
missing.

Using the View Control

Bryce lets you view your scene from several preset 
positions: Main, Top, Front, Side, Bottom, Right, 
Left, and Back. All these views, with the exception 
of the Main View, are special Orthogonal 
projections which allow perspective-free views 
well-suited for alignment operations. Refer to 
“Orthogonality and Views” on page21 for an 
explanation of how and why Bryce uses Orthogonal 
projections.

The View control is an interactive way of cycling 
through the various preset views. The current 
position of the View control indicates the view 
you’re seeing in the Working window.

To switch views using the View control:

• Click or drag the Views control until you reach 
the view you are looking for. 

Every time you click the control Bryce displays 
a different preset view.

To switch views using the View control menu:
• Click the triangle icon next to the View control 

and select a view option:

• Director’s View: select this option to view 
your scene from the perspective of a 
director sitting outside the scene.
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• Camera View: select this option to view 
your scene as the Camera sees it, based on 
the Camera’s current location and 
orientation.

• From Top: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from above (based on 
absolute world coordinates).

• From Right: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from the right (based 
on absolute world coordinates).

• From Front: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from the front (based 
on absolute world coordinates).

• From Left: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from the left (based on 
absolute world coordinates).

• From Back: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from behind (based on 
absolute world coordinates).

• From Bottom: select this option to view a 
perspective-free orthogonal projection of 
your scene as seen from below (based on 
absolute world coordinates).

To switch views using the keyboard:
• Select a preset view shortcut:

• Director’s View=~

• Camera View=1 

• Top View=2

• Right View=3

• Front View=4

• Saved views=5 through 9

To reset the view of your scene:
• Click the triangle icon next to the View control 

and choose Reset Views, or

• Press the Option/Alt key and click on the Views 
icon.

This option resets your View to the default 
setting.

Orthogonality and Views

When you view a scene from the side, front, top, or 
bottom using the Camera, you’ll see certain 
amounts of perspective distortions. These 
distortions can make precise visual alignments 
difficult. 

For instance, if you have a dozen cubes in different 
locations and you place the camera so that it looks 
down on the scene from above, you will find it very 
difficult to place the cubes on top of one another. 
Cubes further from the camera would be slightly 
smaller than cubes close to the camera, resulting in 
a confusing array of lines. The more complex the 
scene, the more confusing and difficult this kind of 
alignment becomes.

If you viewed objects from above through a real-world camera, 
the perspective distortions would make alignment or placement 
difficult.

To solve this problem, Bryce uses a perspective-
free, drafting board kind of view in which like-sized 
objects far away appear exactly the same as those 
up close.
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Bryce uses an “orthogonal projection” of your objects to 
eliminate perspective distortion.

This perspective-free view is called an orthogonal 
projection. In Bryce, all views other than your Main 
View (that is, Top, Bottom, Right, Left, Front, and 
Back) are orthogonal projections. They are not 
generated by the camera, and so do not contain the 
perspective distortion that would necessarily come 
with a camera view. 

As a result, Camera controls do not work in these 
views. You can navigate within the orthogonal 
views using the Zoom and Pan tools.

If you press the Render button while in an orthogonal 
view, Bryce will quickly set up the camera position 
you need and render your image. There may be slight 
differences between what you see in the wireframe 
projection and what you see in the rendered image, 
as a result of the added perspective distortion in the 
rendered image. 

Zooming In and Out

In Bryce, there is a difference between moving the 
camera and using the zoom tools.

When you move the Camera, you’re moving in 3D 
space. When you use the pan and zoom controls, 
you’re transforming a 2D projection of your 3D 
scene—your camera position does not change.

When you use the Zoom tool, you are essentially 
making the 2D projection larger or smaller. Your 
camera position in 3D space does not change.

To zoom in:
• Click on the Zoom In tool.

Bryce scales the 2D projection of your scene 
larger, creating the illusion of zooming into 
your 3D scene; your camera position remains 
unchanged.

Keyboard Shortcut: plus (+)

To zoom out:

• Click the Zoom Out tool.

Bryce scales the 2D projection of your scene 
smaller, creating the illusion of zooming out of 
your 3D scene. Your camera position remains 
unchanged.

Keyboard Shortcut: minus (-)

To zoom into a specific area:
• Hold down Command-Spacebar/Ctrl+Spacebar 

and drag a marquee around an area of your 
scene.

Your cursor changes to a Zoom tool, and Bryce 
centers and scales up the area in the marquee 
to fit your window. 

To zoom using the mouse:

• Hold down Command-Option-Spacebar/
Ctrl+Alt+Spacebar and drag the mouse left or 
right in your scene. Dragging left zooms in and 
dragging right zooms out.

To zoom numerically:

1 Double-click the Trackball in the Control 
palette. The Camera & 2D Projection dialog 
appears.

2 Enter a value in the Scale field.

The default value is 100%.
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You can only zoom numerically when you are work-
ing in either Director View or Camera View. 

To reset the zoom value:

• Press the Option/Alt key and click the Zoom 
tool.

The view of your scene resets to 100%.

Panning

Panning works the same way as zooming. When 
you use the Panning tool, you are moving a 2D 
projection of your scene right and left, up and 
down, in front of the camera. Your camera position 
in 3D space does not change. 

To pan your scene using the Pan tool:
• Drag over the Pan tool in the direction you 

want your scene to move. 

To pan your scene using the Spacebar:

• Hold down the Spacebar and drag your scene 
in the direction you want your scene to move.

To pan numerically:

1 Double-click the Trackball in the Control 
palette. The Camera & 2D Projection dialog 
appears.

2 Enter a value in the Horizontal field.

The default value is 0.

3 Enter a value in the Vertical field.

The default value is 0.

You can only pan numerically when you are working 
in either Director View or Camera View. 

Changing Object Display

You can change how your objects are displayed 
using the Object menu commands. Changing the 
object preview can greatly reduce redraw time in a 
complex scene. The Object’s preview does not 
affect how the object renders.

To display objects as boxes:
1 Choose Object menu> Show Object as Box.

This command displays any selected object, 
objects, or group as box(es). This is useful 
when you just want to work with the object’s 
position but don’t need more details. 

Keyboard Shortcut: Command/Ctrl+B.

To display objects as wireframes:
• Choose Object menu> Show Object as Lattice.

Use this command to change objects shown as 
boxes back to wireframes. 

Keyboard Shortcut: Command/Ctrl+L.

Using Fly-around View

You may have noticed a tiny circular icon above and 
to the right of the Views icon. If you click here, you 
will change from your current View to a special 
motion view, or Fly-around View.This view gives you 
a sense of context in your Bryce world. If you’re 
working close to the ground, or stuck in the midst 
of a clump of trees, or you’ve lost a cube you know 
you created a half an hour ago, you can use the Fly-
around view to see your entire scene all at once.

In Fly-around view, Bryce positions the Camera on 
an imaginary monorail track above and away from 
your scene so that you can see the whole scene 
from all sides as the camera moves around it.

To switch to Fly-around view:
• Click the Fly-around view icon next to the View 

control. The View control changes to the Fly-
around control.

To switch back to Camera view:
• Click on the View control icon next to the Fly-

around control.
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To change the angle of your scene in Fly-
around view:
• Drag your mouse in your scene. The scene 

rotates in the direction you drag.

To zoom in and out in Fly-around view:
• Hold down the Command/Ctrl key and drag up 

or down. Dragging up zooms in and dragging 
down zooms out.

To slow the Fly-around:
• Hold down the Shift key.

To pause the Fly-around:
• Press the Spacebar. Press the Spacebar again 

to resume the Fly-around.

To end the Fly-around and save the Fly-around 
position:
• Press Return/Enter. The view switches back to 

Camera view and the last Fly-around position 
becomes the new Camera View.

Keyboard Shortcut: Command-Y/Ctrl+Y.

Positioning the Camera
The Camera View is produced by the Camera which 
exists in 3D space, meaning that you can view your 
scene from anywhere within your Bryce 
environment — even underneath it. The Camera 
View can be positioned using the positioning tools 
or by repositioning the Camera in the scene. Refer 
to “Positioning the View of Your Scene” on 
page291 for more on positioning the camera.

Using the Movie Preview
In addition to viewing still images in the nano-
preview window, you can use the same window to 
see a small version of your animation, without 
leaving Bryce.

Refer to “Previewing Animations” on page327 for 
more on using the movie preview.

Undoing Operations
The Undo and Revert to Saved commands let you 
erase the effects of changes you made to your 
scene.

To undo the last operation:
• Choose Edit menu> Undo or press Command/

Ctrl+Z.

To redo the last operation:

• Choose Edit menu> Redo or press Command/
Ctrl+Z after performing an undo.

To revert to the last saved version of your 
scene:

• Choose File menu> Revert to Saved.

All unsaved changes are discarded.

The Marker Pen
The Marker Pen adds the functionality of a white 
board to your scene. When you’re using the Marker 
Pen, you can draw anywhere in the Bryce 
environment without affecting your scene. One key 
click erases all the marker pen lines.

To draw with the marker tool:

1 Click the Marker Pen tool or press the M key.

2 Drag it anywhere on your screen.

To erase marker pen lines:
• Click the Marker Pen tool again or press the M 

key again.

Saving and Closing
The Save command lets you save your work in a 
convenient location for later use. Since your scene 
files can quickly become large and complex, you 
should save your work often.
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Saving Files

To save a file:
1 Choose File menu> Save. The Save dialog 

appears.

2 Use the dialog controls to choose a location 
for your work and click Save.

To save a file under a different name:
1 Chose File menu> Save As. The Save dialog 

appears.

2 Enter a new name and/or location in the fields 
provided and click Save.

3 A copy of your work is saved, leaving the 
original intact. 

If the Image With Scene Open/Save preference is 
selected, Bryce saves both the scene data and the ren-
dered image when it saves the file.

Closing
When you close the application, a dialog appears 
asking you to save your work. 

To close Bryce:

• Choose File menu> Quit or press Command/
Ctrl+Q.

Setting Application 
Preferences
By setting application Preferences, you can 
customize Bryce to suit the way you work. You do 
not have to restart Bryce to make these changes 
take effect. 

Application Preferences are set in the Preferences 
dialog.

To set the application’s launch state:
1 Choose Edit menu> Preferences. The 

Preferences dialog appears.

2 Enable either Launch to Previous State or 
Launch to Default State.

Launch to Previous State launches Bryce using 
the settings from your last session.

Launch to Default State launches Bryce using 
the default settings.

To save Images used in a scene with a file:
1 Choose Edit menu> Preferences. The 

Preferences dialog appears.

2 Enable Image with Scene Open/Save.

With this option enabled, Bryce will 
automatically open or save a PICT or BMP file 
(PICT/BMP files are automatically appended 
with the extension), along with your scene file, 
every time you open or save. In most cases, 
this option should always be selected.

To control new object placement:
1 Choose Edit menu> Preferences. The 

Preferences dialog appears.

2 Enable either Create Objects Within View or 
Create Objects at World Center.

Create Objects Within View places newly 
created objects within the camera view, rather 
than at world center.

Create Objects at World Center places newly 
created objects at world center, regardless of 
whether they will be visible in your current 
camera view. 

Setting Up the Bryce Window
When you first launch Bryce, the interface snaps to 
the edges of your Working window. The menu bar 
is hidden until you pass your cursor over it, and 
other applications are hidden behind Bryce. This 
setup lets you work with an uncluttered desktop.
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To maximize the Bryce window:
1 Pass the cursor over the right side of the 

Working window. The Advanced Display 
palette appears.

2 Click the Interface Max/Min tool.
 

3 Click the tool again to switch to a standard 
window.

Setting Up the Working Window 
Before you start working in Bryce, you can change 
the display mode to determine how objects are 
displayed in the Working window. These display 
modes can help you when you’re arranging objects 
and can also speed up your redraw time.

Display Modes

The Display Mode tool, at the bottom-right corner 
of your Working window, toggles through the three 
possible display modes. 

To switch between display modes:

1 Click on the Display Mode tool in the corner of 
the Working window.

This button is only visible when you pass your 
pointer over it.

2 Click the button until you’re in the desired 
mode.

There are three modes available:

• Wireframe Display shows all objects as 
wireframes.

In Wireframe Display all objects are shown as wireframes.

• Bitmap Display shows a rendered scene. 
The display automatically switches to this 
mode whenever you click the Render 
button.

In Bitmap Display all objects are displayed as rendered objects.

• Wireframe/Bitmap Display lets you edit 
wireframes while simultaneously viewing 
the most recently rendered version of your 
scene behind them.
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In Wireframe/Bitmap display, all objects are displayed as 
wireframes, but with the rendered image in the background.

This mode is most useful when you have a 
partially-rendered image and want to improve 
the results. If you switch to this mode, you can 
move your wireframe objects relative to the 
rendered image behind them in order to 
accurately judge the results of your change.

To toggle between modes:

• Press the Esc key. 

The Esc key will toggle between the last 
Wireframe mode you selected (Wireframe or 
Wireframe/Bitmap) and Bitmap mode. 

Flat Shaded Preview Mode

This preview mode is only available if your system 
contains hardware that supports OpenGL®, 
Sree3D, or Direct 3D®.

 

In Flat Shaded Preview display, all objects are displayed as flat 
shaded solids.

When this mode is active your objects appear as 
flat shaded solids, without materials, instead of 
wireframes, and you can see the effects of light 
sources on object surfaces.

To display objects in Flat Shaded Preview:
• Hold down the mouse button over the Display 

Mode button and choose SGI OpenGL, Sree3D, 
or Direct3D from the menu.

Wireframe attributes

When you’re in Wireframe mode, there are several 
options you can set to make the display more 
helpful. Disabling some of these options may speed 
up drawing time.

To set Wireframe attributes:

1 Make sure you’re in Wireframe mode. Click the 
Display Mode tool until the display switches to 
Wireframe.

2 Drag the Depth Cue control up or down. Drag 
up to increase the intensity of the depth 
cueing effect and drag down to decrease it.

When depth cueing is active, the wireframe 
appears lighter the farther it is from the 
camera.
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When depth cueing is active, objects appear lighter the farther 
they are from the camera.

If you hold down the Control key/Ctrl+Alt keys and 
click on the Depth Cue icon, Bryce will turn both 
anti-aliased wireframes and depth cueing on or off 
simultaneously.

3 Click the Wireframe Shadows button to turn 
shadows on or off.

Shadows are designed to help you determine 
object placement in your scene. For this 
reason, shadows appear even when there is no 
ground plane or when the object is below the 
ground plane.

 

You can use wireframe shadows to help you determine the 
placement of objects in the scene.

This feature may slow down your system when work-
ing with a complex scene on slower machines.

4 Click the Underground On/Off button to hide 
or show underground lines.

When underground lines are hidden, any 
portion of a terrain or object that is positioned 
below ground level will not be visible in your 

wireframe scene. This is useful for easy 
visualization and composition. However, you 
might overlook an object that is hidden 
underground.

When underground is enabled, objects that are positioned below 
the ground plane are not visible in the scene.

5 Click the Resolution tool and choose Static, 
Selected, or Motion. Then choose a resolution 
for the wireframe mode.

Static lets you define the resolution of the 
wireframe when the object is not moving and 
not selected. 

Selected lets you define the resolution of the 
wireframe when the object is selected.

Motion lets you define the resolution of the 
wireframe when the object is being moved.

Window Backgrounds

The background texture of the working window 
can add a great deal to the overall look of the 
interface. It makes it easier to see wireframes and 
selected objects.

To select a background texture:
• Click the Background Paper button and choose 

a background from the menu.
 

Adding a background texture may slow down some 
machines. If you need more speed for any reason, 
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select No Texture, and you will get a simple, clean 
background with no texture.

To select a background color:

1 Click the Background Paper button and choose 
Select Color from the menu.

2 Use the color picker to select a color.

Customizing Bryce
The Bryce interface can be customized to better 
suit your personal workflow. If you want to, you 
can tear apart the interface and reposition any 
palette, or you can choose to hide the entire 
interface and leave only the working window 
visible.

To move a palette:
• Hold down the Spacebar and drag the desired 

palette to a new location.

When you break the interface apart, you can see all the palettes 
at the same time. You can move these palettes anywhere in the 
Bryce window.

To reset a palette to its original position:
• Hold down the Option/Alt key and the 

Spacebar, then either click on a palette or 

choose Edit menu> Reset Palettes to reset all 
palettes to their default positions.

To hide the Bryce interface:

1 Press Command/Ctrl+Alt. All the palettes 
disappear and your image appears at the 
center of your work space.

2 Press Command/Ctrl+Alt again to display all 
the palettes.
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Tutorial

Welcome to the Bryce tutorial. This tutorial 
introduces you to the major features and 
functions of Bryce. The main goal is to teach you 
the basic techniques you’ll need to create 
landscapes and environments.

There are two separate tutorials. The basic 
tutorial shows you how to create a terrain, 
customize the sky, and create a body of water. 
“Creating a vaulted roof” on page40 teaches you 
how to create a more complex environment and 
how to create an animation. 

Each section of the tutorials is self-contained, so 
you can start from any point. All the files 
necessary for completing the lessons are provided 
for you on the Bryce CD-ROM in the folder 
“Manual Tutorial.”
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Getting Started
Lesson 1: Creating a Document
When you set up a new document, you define the 
size of your working space in pixels. The higher the 
resolution, the larger your working space. The 
resolution you choose depends on what type of 
scene you want to create. 

To help you choose a resolution, Bryce provides 
several preset aspect ratios for the most commonly 
used types of documents. Refer to “Setting Up the 
Working Window” on page26 for a complete 
discussion of resolutions and aspect ratios.

To set up a new document:

1 Choose File menu > New Document. 

The Document Setup dialog appears. 

2 Click the button beside the Default preset in 
the list of presets on the right side of the 
dialog. 

The Resolution and Aspect Ratio fields update 
automatically. 

3 Click the OK icon at the bottom of the dialog 
to accept your changes and exit the dialog.

Now that you have a document, you can set up the 
camera view and start creating a scene. 

Lesson 2: Positioning the Camera
In this lesson you’ll use the Director’s View to view 
objects. In this view, you can see all the objects in 
the scene including the camera. 

There are four controls you can use to position the 
camera: the Camera axes controls, the Trackball, 
the Preset Views and the Camera and 2D Project 
dialog. Most of these tools are located on the 
Control Palette.

Refer to “Positioning the View of Your Scene” on 
page291 for more on these tools.

When you reposition the camera, you’re changing 
the view of the scene, not the position of the 
objects.

To open the camera lesson file:
1 Choose File menu > Open.

2 On the CD-ROM, locate the file Manual 
Tutorial: Camerascene, and click Open.

To reposition the camera using the Camera 
axes controls:

1 On the XZ control, drag the Z arrow up to 
move the scene away from you. 

When you move over the tip of an arrow in the Camera control, 
the cursor changes to an axis indicator.

2 On the XY control, drag the tip of the Y arrow 
up to move the scene up.

Your scene should look like this when you’ve finished using the 
Camera controls.

The sphere and the torus objects should now be 
easier to see, but you can adjust the camera again 
to get a better view of the hidden cylindrical 
objects. 
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To reposition the camera using the Trackball:
1 Click the center of the Trackball and drag to 

the right. The scene appears to rotate to the 
left.

Use the Trackball to rotate the camera around the scene.

The camera is now in an almost perfect position to 
view the scene. You can place the camera in a 
precise position by moving it numerically.

To reposition the camera numerically:
1 Double-click the Trackball. The Camera & 2D 

Projection dialog appears. 

2 Enter Position X=104, Position Y=32, Position 
Z=-100, Rotate X=0, Rotate Y=-46, Rotate 
Z=0

3 Leave the remaining values at their defaults.

4 Click the OK icon to apply the changes to the 
camera.

When you apply the values you entered in the Camera & 2D 
Projection dialog, the view of your scene should look like this. 

5 Close the file. You don’t need to save the file 
unless you want to.

Arranging Objects in the 
Scene
A 3D illustration depends heavily on the 
arrangement of the objects in the scene to create a 
specific look or feel. 

In 3D space, an object can be viewed from any 
angle. You should take all of these angles into 
account when you’re arranging objects.

The lessons in this section will help you learn how 
to add, position and transform objects to create a 
3D illustration.

Lesson 3: Adding and adjusting the 
Terrain 

To create a terrain:
1 Click Create to display the Create Palette.

2 Click the Terrain Object. 

The terrain appears in your scene. 

Terrain 1

To reposition the terrain:
You can use the Reposition tool to move the 
terrain to the rear left of your scene. 
As you move the mouse pointer over the arms 
of the Reposition tool a small tag appears and 
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displays the name of the axis over which you 
are positioned. 

1 With the terrain selected (outlined in red), 
click Edit to display the Edit Palette. 

2 Click the upper X (left) arm of the Reposition 
tool, and drag to the left. The terrain will 
move along the X axis towards the rear of your 
scene. 

3 Click the upper Z (right) arm of the tool, and 
drag to the right. The terrain will move along 
the Z axis towards the middle of your scene. 

4 Repeat this process as needed until the terrain 
is in the position shown below. 

Repositioning a terrain

To resize the terrain:

1 With the terrain still selected, click the center 
of the Resize tool, then drag to the right to 
increase the size of the terrain. 

Notice that as you resize the terrain it appears 
to disappear below the ground plane. The 
ground plane is the grid in the foreground 
which appears by default whenever you start a 
new project. It is an infinite plane because it 
extends to infinity along the X and Z axes. The 
terrain appears to disappear because it is 
resized evenly about its center. 

2 Click the Land Objects button (the arrow 
button located at the bottom of the vertical 
row of buttons to the right of the terrain). 

The terrain repositions on the ground plane 
and the arrow button disappears. 

3 Resize the terrain until it looks something like 
the image below. 

The terrain so far

To add and reposition a second terrain:
1 Click Create, then click the Terrain Object to 

add a second terrain. 

2 Click Edit, to display the Edit palette. 

3 Use the Reposition tool to move the terrain to 
the far right of the scene. 

4 Increase the size of the terrain, using the 
Resize tool. 

Note that this terrain (Terrain 2) is further 
back than the first one.

5 Click the Land Objects button to align the 
second terrain along the ground plane. 
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A second terrain

6 Click the Render button to view your image. 

To switch back to Wireframe display mode:
• Click the Display Modes button once to return 

to Wireframe display mode, or hit the Escape 
key to toggle between the modes.

To change the terrain’s appearance:

1 Select Terrain 2. The wireframe turns red.

2 Click the Editor button (the E button located 
in the vertical list of buttons associated with 
the selected terrain object). Your screen is 
overlaid by the Terrain Editor.

3 In the Editing Tools palette, click the Eroded 
button twice.

4 Exit the Terrain Editor by clicking the OK icon. 

5 Select Terrain 1. 

6 Click the Editor button to display the Terrain 
Editor.

7 In the Editing tools palette, click the 
Smoothing button once. 

8 Exit the Terrain Editor by clicking the OK icon. 

Lesson 4: Applying Textures
Now you will apply a material to the terrains and 
the ground plane. 

To apply a texture:
1 Click the Display Modes button to return to 

Wireframe display mode. 

2 Select Terrain 1. 

3 Hold down the Shift key on your keyboard and 
click Terrain 2; still holding the Shift key 
down, click the ground plane (Plane 1). 

All three wireframes are selected and outlined 
in red. 

4 Click the triangle icon next to Edit, to display 
the Material Presets selection panel. 

5 In the Material Presets selection panel, click 
Planes and Terrains. Another selection of 
preset materials appears. 

6 Click Desert Rock. (sixth from the left and the 
third from the top)

A red border appears around your selected 
material. 

7 Click the OK icon to return to your scene.

If you look at the Nano Preview window (top 
left), you'll see that the Desert Rock material 
has been applied. 

8 Click the Render button. 

The terrains after texture has been applied. 
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Creating the Sky
To complete these lessons, you’ll need a terrain. If 
you’ve been following this tutorial from the 
beginning, you can use your scene. Otherwise, you 
can use the sample file provided for you. The 
sample file is called Finished Terrain and is located 
on the CD-ROM in the Manual Tutorials folder.

Lesson 5: Adding a Sky Preset
You can add a sky preset to the scene.

To add a sky preset:

1 Click the triangle next to Sky & Fog. 

A selection of sky presets appears. 

2 Click Jet Stream. 

3 Click the OK icon to add the sky preset.

Lesson 6: Adjusting the Sky
Once you have added a sky preset you can adjust 
the appearance of the sky. You can determine what 
type of clouds are included in the scene. You can 
also add perspective to the scene by adjusting the 
amount of Haze in the scene.

To modify the clouds:

1 On the Sky & Fog palette, click the triangle 
beneath the Sky Memory Dots. This displays 
the Sky & Fog options menu. 

2 From the menu that appears, click Cumulus 
Clouds to deselect it.

To adjust the sky:

1 Move the pointer over the thumbnails on the 
Sky & Fog palette to locate the Haze 
thumbnail. 

Note that the names of the palettes appear in 
the bottom left of the Bryce window. 

2 Click the Haze thumbnail.

The number 1 appears at the bottom left 
corner of the Bryce window; this is the Haze 
value. 

3 Click the Haze thumbnail, drag to the right to 
increase the Haze value to 17. 

4 Render your scene again.

Note that the increased haze value has 
separated the two mountains, appearing to 
push the second terrain farther back in the 
distance. 

Creating a Body of Water
To complete these lessons you’ll need a terrain. If 
you’ve been following the tutorial from the 
beginning, you can use the files you have created. 
Otherwise, you can load the sample file, Finished 
Sky provided for you on the CD-ROM.

Lesson 7: Preparing the Landscape
Next you will create a body of water by digging a 
hole and adding some water. 

In this tutorial, we'll use a Negative Boolean 
operation to cut a hole out of the ground plane. A 
Negative Boolean operation requires a Positive 
object (or a Positive group of objects) and a 
Negative object. When these are grouped together 
the shape of the Negative object is cut out of the 
Positive object. Objects can be given Negative, 
Positive, Neutral or Intersect attributes in the 
Object Attributes box.

To set the landscape as a Positive Boolean 
object:

1 Click the Display modes button to switch to 
Wireframe mode. 

2 Select one of the terrains. 

3 Holding down Shift, select the second terrain 
and the ground plane. 

All three wireframes should now be 
highlighted in red. 
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4 Click the Object Attributes button (the A 
button), then enable the Positive option. This 
makes each one of the selected objects 
positive. 

5 Click the OK icon. 

To group the terrains:
1 Click the Group button (the G button in the 

vertical list associated with the selected 
objects).

This will group the three objects (Terrain 1, 
Terrain 2, and Plane 1) together in a Group 
called Group 1. 

2 With Group 1 still selected, click the Objects 
Attributes button. 

3 Enable the Positive option. 

4 Click the OK icon. 

Lesson 8: Creating the Interior of the 
Lake
Next you will create a third terrain object—Terrain 
3 -and apply the same Desert Rock material as you 
used before. Then you will rotate the terrain object 
to create an inverted terrain that will eventually 
form the interior of the lake. Next you will make 
the inverted terrain a Negative Boolean object. 
Grouped with the positive terrains created in the 
last lesson, this negative terrain will ‘cut’ a hole out 
of the ground plane. 

To create a new terrain object:

1 Click Create.

2 From the Create palette, click the terrain 
object to add a third terrain.

3 Click Edit.

4 Click the triangle icon next to Edit to display 
the Material presets selection panel.

5 Click Planes & Terrains.

6 Click Desert Rock.

7 Click the OK icon.

This terrain needs to be rotated through 180 
degrees about the X or Z axis to create the interior 
of the lake. 

To rotate an object:
1 Click Edit.

2 Locate the Rotation tool. Move the pointer 
over the X or Z axis rotation ring. 

3 Hold down the Shift key (this causes the 
rotation to be carried out in 45-degree 
increments), then click and drag horizontally 
on the rotation ring. 

You’ll see the angle of rotation displayed at 
the bottom left of your screen. 

4 Drag until you see either 180 or -180. The 
terrain will now be upside down and your 
screen should look like this:

An inverted terrain. 

To create a Negative Boolean object:
1 With Terrain 3 still selected, click on the 

Object Attributes button to display the Object 
Attributes box, then click Negative. 

It is now a negative Boolean object. This 
means that Bryce will ‘cut’ this shape from the 
ground plane.

2 Exit by clicking the OK icon. 
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You'll notice that the Terrain 3 wireframe is 
dotted, since it is now Negative. 

To create the lake:

1 Ensure that the Wireframe underground 
button, found on the Advanced Display 
Palette, is off.

2 Click and drag Terrain 3 until the square base 
(which is now on top) is just above the ground 
plane. 

Watch the Nano Preview window to track your 
progress.

Your scene in wireframe mode should look 
like this:

Positioning the inverted terrain

To group the terrains:

1 With Terrain 3 still selected, hold down the 
Shift key and click one of the other terrains to 
select Group 1 together with Terrain 3. 

2 Click the Group button. 

3 Click the Render button to see the hole in the 
ground plane.

A hole in the ground plane

To make the interior of the lake bigger:
1 Click the Display modes button to return to 

Wireframe mode.

2 Click the Time/Selection toggle, located in the 
bottom right corner of the Bryce window, to 
display the selection palette.

3 Click and hold the Terrain icon on the 
Selection Palette at the bottom of the screen. 

4 From the list, select Terrain 3. 

Terrain 3 should now be the only selected 
object. Although it is part of a group this 
terrain can still be repositioned, resized and 
rotated on its own. 

5 With Terrain 3 selected, use the Resize tool to 
make it bigger and the Reposition tool to fine- 
tune the positioning. 

Watch the Nano Preview window to check the 
effect you're creating. When you lower the 
terrain, keep the terrain’s square bottom 
above the ground plane; otherwise, the hole 
will disappear. 
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An enlarged hole in the ground plane. 

Lesson 9: Filling the Lake
Now we'll fill the hole with water. 

To fill the lake:

1 Click Create to display the Create Palette. 

2 Click the Water Plane icon. 

A water plane appears with a random material 
applied. It covers the whole of your image up 
to the bases of the mountains.

3 Click the triangle icon next to the word Edit to 
display the Materials Presets selection panel. 

4 Click Waters & Liquids from the list of 
categories.

5  Select Waves of Reflection (third row down, 
third from left). 

6 Click the OK icon to exit the Materials 
selection panel.

7 From the View Options menu choose From 
Front.

8 Click the Wireframe underground button to 
display underground lines.

9 Click the water plane icon on the Selection 
Palette at the bottom of the screen.

10 Click Edit.

11 Using the Reposition tool, move the water 
plane along the Y axis until it is just below the 
ground plane.

Your scene in wireframe mode should look 
like this:

The waterplane below the ground plane

12 Choose Director’s view from the View Options 
menu. 

13 Check the Nano Preview window to ensure 
that the water plane has filled the inverted 
terrain.

14 Click the Render button to view the final 
image. 

A filled lake. 

This concludes the beginner’s tutorial. 
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This tutorial has only touched on a very small 
fraction of the controls and procedures available in 
Bryce. You could go further with this image by 
adding some rocks and vegetation to the 
foreground. 

Try different water materials for the lake and 
different terrain and plane textures and a different 
sky—in Bryce the variations are literally endless. 

Creating a vaulted roof
In this tutorial, you will create an animation of an 
interior scene of a building with a vaulted ceiling. 
You’ll work with an imported image, adjust the 
lighting of the scene and finally animate the camera 
to fly through the scene. 

Lesson 10: Creating a pyramid
While creating the building’s roof, you will become 
familiar with the create and edit controls of Bryce, 
as well as Boolean operations. 

To create the pyramid:
1 Click Create to display the Create Palette.

2 Click the Create Pyramid icon. 

A pyramid appears in your scene. 

A pyramid displays 

Next, make the pyramid flatter by reducing its 
height.

To resize and reposition the pyramid:

1 Click Edit to display the Edit Palette.

2 Click the upper Y axis of the Resize tool.

3 Holding down the Shift key, slowly drag to the 
left.

Pressing the Shift key constrains the change to 
regular increments.

The pyramid after the height change 

Next, you’ll proportionately enlarge the 
pyramid. This time, work directly with the 
object’s handles in the scene window.

4 Place the cursor over the upper right corner of 
the object’s bounding box, next to the Object 
Attributes button (the A button).

The cursor changes to a proportional resize 
icon.

5 Holding down the Shift key, drag the corner of 
the bounding box to the right.

The pyramid snaps to a larger size. 

6 Drag for three more snaps. 

The pyramid is enlarged, and should extend 
off the right edge of the scene window. 
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The enlarged pyramid 

Next, you’ll use the arrow keys to nudge the 
pyramid to a more central position in the 
scene.

7 Press the left arrow key four times.

The pyramid moves so that the entire object 
can be seen in the scene window.

Lesson 11: Converting the Pyramid
The next task is to duplicate the pyramid and 
convert it to a sphere. Eventually the sphere will be 
“cut out” from the pyramid using a Boolean 
operation. 

To duplicate the pyramid:

1 Click Edit menu.

2 Choose Duplicate.

A second pyramid appears in the exact place 
where the first one is.

3 Click the double arrows at the top right of the 
Edit Palette. 

A set of Bryce primitives appears.

4 Drag to the left until the sphere primitive is 
highlighted. 

5 Release the mouse button.

The pyramid has changed to a sphere.

The converted pyramid 

Lesson 12: Resize the Sphere
To cut the sphere out of the pyramid, the sphere 
needs to be resized and slightly repositioned. This 
time you will resize the object using Bryce the 3D 
Transformation dialog box.

To resize the sphere:
1 On the Edit Palette, click the triangle beneath 

the Resize tool.

2 Select 3D Transformations from the list.

A dialog box appears.

The bottom row of options are for changing an 
object’s size. Size is expressed as a percentage 
of the current size. To enlarge the sphere 
horizontally without affecting the height, you 
will enter new values for the X (width) and Z 
(depth) axes and leave the height (Y) axis 
unchanged.

3 In the numerical boxes for the size of the X 
and Z axes, enter 125 (for 125%).

4 Click the OK icon to exit the dialog box. 

The sphere expands slightly on the horizontal 
axis while the height remains unchanged.
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To adjust the position of the sphere:

1 From the View Controls menu, select From 
Front.

The scene changes so that you are viewing the 
objects from a straight horizontal view.

2 Click the upper Y axis of the Reposition tool.

3 Holding down the Shift key, drag to the left. 

The sphere drops so that it is half hidden 
under ground. 

4 Release the mouse button.

Next you will lower the sphere a bit more until 
the next “rung” of the wireframe is aligned 
with the ground level.

Lowering the sphere 

5 Again, click and hold the upper Y axis of the 
Reposition tool.

6 Holding down the Shift key, drag to the left 
slightly until the wireframe is aligned with the 
ground.

You may have to repeat this step several times 
to get the alignment exact.

The repositioned sphere 

Lesson 13: Use the Sphere to Carve Out 
the Roof
Next you will carve out the under side of the roof 
with the sphere using a Boolean operation.

To carve out the roof:

1 Change back to Director’s View, by choosing 
Director’s View from the View Options menu 
on the Control Palette.

Now, you will assign Boolean properties to 
your objects. The sphere is selected, so we’ll 
start with that.

2 Click the Object Attributes button next to the 
sphere’s bounding box.

The Object Attributes dialog box appears. 

Under the title, Sphere 1, the button for 
Neutral is selected. That is the default for all 
Bryce objects. 

3 Enable the Negative option. 

4 Click the OK icon to exit the Object Attributes 
dialog box. 

The sphere’s wireframe changes to dotted 
lines.

Next, make the pyramid positive.

5 Select the Pyramid by clicking it. Its wireframe 
turns red. 
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You could use the Object Attributes dialog box 
to make the pyramid positive. However, Bryce 
has an easier way. 

6 Type P (for positive).

The wireframe doesn’t change; its line is still 
solid. 

Lesson 14: Creating a Group
To make the Boolean effect work, you must group 
the objects together. 

To group objects:

1 Ensure that the Selection Palette is displayed, 
type S.

2 On the Selection Palette, click the Select 
Pyramid icon. 

3 Holding down the Shift key, click the Select 
Sphere icon from the Selection Palette.

4 Click the Group button to group the selected 
objects.

The bounding box changes slightly, with 
diagonal insets at each corner. This indicates 
that the object is a Boolean group. In addition, 
the G button disappears, and a U button takes 
its place. (The U stands for Ungroup)

Grouping objects 

5 Click the Render button to check your work.

Your scene should look like the following 
figure.

The results so far 

To create a family group:

1 Press the Esc key to switch back to wireframe 
mode. 

The wireframe of your scene appears.

2 Click the gray Family button underneath the 
Object Attributes button. 

The Family dialog box appears. The gray color 
is selected and the Default Family name 
displays at the bottom of the dialog box.

Tip
To make an object negative, type N. 
To make it intersect, type I. To make 
it neutral, type the letter O. 
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3 Click the bottom left color (maroon). 

The text display now reads Family 21.

4 Type the words Boolean Roof.

5 Click the OK icon to exit the Family dialog box.

The dialog box disappears, and the Family 
button has changed to the maroon color. 

6 Deselect the object by clicking the background 
of the image. 

The wireframe has now changed to maroon.

7 Save your scene file and give it the name 
Rendered Boolean.

Building the Walls
In this next section, you will create walls for your 
roof using the cube primitive. Before doing so, 
however, you will need to raise the roof so that the 
walls can fit underneath.

Lesson 15: Moving the Roof

To raise the roof:
1 If needed, select the Group by clicking it in the 

scene window. 

The wireframe turns red.

2 Press the Page Up key 6 times. 

The bottom of the pyramid is aligned to the 
horizon.

Moving the roof

Lesson 16: Creating the Walls
You are now ready to create walls to go underneath 
your roof with the arched cutouts. The Cube 
primitive will be the basis of your walls.

To create the walls:

1 On the Create Palette, click the Create Cube 
icon. 

A cube appears in your scene.

2 Click the family color button to access the 
Family dialog box. 

3 Change its color to an unused color and type 
the word Wall in the text entry field. 

The family color is changed.

Note
You can also change the position of 
the roof by clicking the Object 
Attributes button. Change the Y axis 
position to 35.60.
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Creating the walls

4 Look at your scene from Top View by choosing 
the Control Palette, View Options menu > 
From Top . 

The scene changes to top view.

You can zoom in for a closer view. 

5 Click the Zoom In tool on the Advanced 
Display palette (the Zoom In tool is the 
magnifying glass with a +). 

The objects appear larger, with the selected 
cube in the center of your scene. 

View from the top 

Lesson 17: Adjusting the Wall Size
Notice that the cube’s lower edge is aligned with 
the pyramid’s edge. However, it needs to be made 
wider to match the pyramid’s width, but less deep 
so that it does not occupy so much of the pyramid’s 
interior.

To adjust the wall size:
1 Place the cursor over the top center point of 

the cube’s bounding box. 

The cursor changes to a Z, indicating that 
Bryce is ready to work with the object along 
the Z axis. 

2 Click, and holding down the Shift key, slowly 
drag to the left. 

The cube snaps to half its depth. 

3 Release the mouse button. 

4 Repeat the procedure to shrink the cube to 
half its depth again. 

Tip
Another way to change to top view 
is to use a keyboard shortcut. Press 
the number 2 key. (or ~ for 
Director’s View, 1 for Camera View, 
2 for Top View, 3 for From Right, 
and 4 for From Front). 
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Adjusting the wall size 

5 Place the cursor over the right center point of 
the bounding box. 

The cursor changes to an X.

6 Press the Option or Alt key (this will resize the 
object from the center). 

7 Click, then slowly drag to the right.

8 If needed, drag its points so that it aligns 
correctly. 

Widening the wall. 

Lesson 18: Duplicate the Walls
You now have one wall. Duplicate this wall to 
create the one opposite.

To duplicate the walls:

1 From the Edit menu, choose Duplicate.

An identical cube appears in the same place.

2 Press the up arrow key to align the wall with 
the opposite side of the pyramid. 

3 Click the Select Families icon on the Selection 
palette, and select Wall from the list. Both 
walls are selected.

4 Duplicate these walls by choosing Edit menu 
> Duplicate or by pressing Command/
Ctrl+D. A second set of walls is created in 
your scene.

For the next action you will temporarily group 
the newly created second set of walls.

5 Click the Group button to group the walls. 

The G button changes to a U, indicating that 
the objects are grouped. The Family button 
color is gray for Default family. (as a new 
entity, it takes on the Default family color and 
label)

Now you can rotate this group around its 
center, which happens to be the same as the 
center of the pyramid.

6 Click Edit button to display the Edit Palette.

7 Place your cursor over the horizontal band of 
the Rotate tool.

The cursor changes to a Y.

8 Press the Shift key to constrain rotation to 45 
degree increments. 

9 Click and slowly drag in either direction.

The group snaps first to 45 degrees, and, as 
you continue dragging, to 90 degrees. 

10 Release the mouse button.

11 Click the Ungroup button. 

The U changes to a G, and the Family color 
changes to the Wall color.
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Lesson 19: Make the Walls Taller
Before starting this lesson, press ~ to switch back 
to Director’s View. This view will show more depth 
perspective.

To make the walls taller:
1 Make sure the walls are selected, then place 

the cursor over the top axis of the Resize tool.

The cursor changes to a Y.

2 Pressing the Shift key, click and drag to the 
right until the walls pop up to meet the 
bottom of the pyramid. 

Raising the walls 

Lesson 20: Adding a Doorway
You will make a doorway by duplicating and 
resizing one of the cubes so that it cuts a Boolean 
hole through the wall. 

To add a door:
1 Switch to Top View.

2 Select the wall objects. 

3 On the Selection palette, click the Solo Mode 
button. 

All unselected objects (the ground plane and 
the boolean group) disappear, leaving only 
your selected objects and the camera.

4 Deselect the wall objects by clicking elsewhere 
in your scene window. 

5 Click the bottom wall object to select it. 

6 Duplicate the object by choosing Edit menu 
> Duplicate, or Command/Ctrl+D. 

This new object will become the doorway 
object.

The doorway object must be a little thicker 
than the wall. While you’re still in Top View, 
you will increase its depth slightly. 

7 Click the Z axis on the Resize tool. 

8 Hold down the Option (Macintosh) or Alt 
(Windows) key to change the size 
symmetrically. 

9 Drag slightly to the right to make the doorway 
object thicker. 

The other resize adjustment must be made 
looking at the object from Front View.

10 Switch to Front View.

11 Click the X axis on the Resize tool. 

12 Hold down the Option/Alt key and drag to the 
left until the object is about the width in the 
following figure. 

Creating the door.

13 Click and drag the top Y axis on the Resize tool 
to the left. 

This will shorten the doorway. Continue until 
it is about the height in the previous figure.
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Lesson 21: Assigning Boolean Properties
After the doorway object is created and sized 
correctly, assign Boolean properties to it. The 
doorway must be cut out of the wall, so you’ll need 
to make the doorway object negative.

To add Boolean properties:

1 Press the N key to make the doorway object 
negative. 

The wireframe changes to a dotted line.

2 Switch to Top View.

3 Select the front wall by clicking it.

The wireframe turns red.

4 Press the P key, to change this object’s 
properties to positive.

5 Select both the front wall and the doorway by 
drawing a selection marquee around their 
centerpoints. 

Creating a Boolean object 

6 Click the Group button to group them. 

The G changes to a U and the family color 
changes to Default Gray.

Since this group is part of the Wall family of 
objects, it’s a good idea to assign the group to 
the Wall family. 

7 Click the Family button on the Selection 
palette to access the Family dialog box. 

8 Select the Wall family.

9 Click the OK icon to exit the dialog box.

The Family button changes to the Wall 
wireframe color.

10 Click the Solo Mode button to exit solo mode.

The rest of your scene appears.

11 Change to Director’s View. 

12 Click the Render button.

You may need to adjust the walls if there is a 
gap between the walls and the roof.

13 Save your scene.

Group and Grow the Entire 
Building
Since you’ll be placing objects inside this building 
and eventually flying through it with the camera, 
the building needs to be bigger. When you enlarge 
the entire object as a group, the individual objects 
retain their relative size and position.

Lesson 22: Grouping the Building

To group the building:

1 Choose Edit menu > Select All  (or 
command/Ctrl+A). 

All of your objects, including the ground, are 
selected. 

2 Hold down the Shift key and click the ground 
to deselect it. 

The selection bounding box encloses only the 
pyramid group and the wall objects. The Group 
button is showing.

3 Click the Group button to group these objects.
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Grouping the building 

4 Press the * key twice (Shift+8). 

Each time, your group’s size doubles. 

5 Click the upward pointing arrow button 
(located with the group of buttons associated 
with the bounding box of the selected object).

The group jumps up so that it is now resting at 
ground level. 

Positioning the building 

Lesson 23: Change Your Viewpoint of the 
Scene
You need to adjust your viewpoint of the scene so 
that you can see the entire building.

To change viewpoint:
1 Place the cursor over the Trackball control on 

the Controls palette. 

The cursor changes to double crossed arrows. 

2 Click and drag the Trackball to the right. 

The scenes rotates counter clockwise in the 
scene window. 

3 Continue dragging until the blue camera 
wireframe is on the left side of the window 
and the center wireframe lines of the front and 
back walls line up in the center of the window, 
looking like the following figure.

Changing the viewpoint 

You are now looking through the doorway of 
the building, 

4 Place the cursor on the bottom Z arrow of the 
XZ Camera control.

5 Drag up on the XZ Camera control until you 
can see the entire front wall of the building. 

The scene should look like this.
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Changing your viewpoint. 

6 Save your scene and call it Grouped Building.

Sphere on a Pedestal
The next section of this tutorial will incorporate an 
existing scene file. This image will be merged into 
the scene you are creating.

Lesson 24: Merging an Existing Scene

To merge another scene:

1 Select File menu > Merge.  

2 In the Open dialog, navigate to the Manual 
Tutorial folder on the Bryce 5 CD-ROM.

3 Select the scene file called Pedestal Merger.

4 Click the Open button. 

The Wireframe for the merged scene appears 
in your scene, and is selected.

The merged scene 

5 Render the scene. 

There is now a pedestal with a mirrored 
sphere on it. There are lights in the scene as 
well. 

The rendered scene 

Lesson 25: Adjusting Lights
In this next lesson, you will make slight 
modifications to the lights and use Bryce’s tracking 
controls to make the lights always point at certain 
objects. To make it easier, you’ll need to 
temporarily rid your scene of some extra objects. 

To adjust lights:
1 Click the Solo Mode button on the Selection 

palette to change to Solo mode.
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The ground, walls and building objects 
disappear, leaving only the two lights and the 
pedestal and sphere. 

The scene in Solo mode 

2 Click away from the objects to deselect them

3 Select the lower light.

The fourth button down (in the group of 
buttons associated with the selected object) is 
the Tracking icon. 

4 Click the Tracking icon (the fourth button 
down in the group of buttons associated with 
the selected object) and drag from it to the 
sphere object. 

While your mouse button is still pressed, 
whatever object is underneath the cursor turns 
blue. 

5 Release the mouse button when the sphere 
turns blue. 

The light is now set to track the sphere.

6 Drag the light so that it is located above and 
to the left of the sphere. 

The light remains pointing at the sphere.

7 Click the Land Object button (the Down arrow 
button located in the group of buttons 
associated with the selected object). 

The light snaps to the ground, pointing 
toward the sphere from this position.

8 Select the light that is located above and to 
the right of the pedestal. 

9 Drag from this light’s Tracking icon to the tall 
cylinder. 

10 Release the mouse button when the tall 
cylinder turns blue.

11 Drag the light down slightly to the right.

Repositioning a light 

12 Click the Solo Mode button to exit Solo Mode.

13 Render and save your scene.

Pre-Production
In this section of the tutorial, you will plan the 
creation of an animation.

You’ll work on some pre-production tasks. Then 
you will animate the camera, tweak the animation, 
and conduct test renders.

You can use either the the scene you created in this 
tutorial, or the file entitled Animation-start on the 
Bryce 5 CD.

Lesson 26: Pre Visualizing and Timing the 
Sequence
The pre-production phase is where you plan the 
sequence of events.
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Up until now, you’ve been working with your scene 
in Director’s View and in the different orthogonal 
views. For animating you will use Camera View. 

To plan and time the sequence:

1 On the Controls Palette, choose Camera 
Options menu > Camera to Director. 

The camera wireframe disappears from the 
scene. The camera object has moved to the 
same location as the Director’s View, so it is 
now located at your point of view.

2 Switch to Top View .

Your scene changes to top view. The camera is 
now located at the bottom of the scene 
window.

The top view 

In this animation, the camera will go through 
the doorway, circle around the pedestal, then 
go out through the archway just above the left 
wall. 

3 On the Display palette, (to the right of the 
Working Window) click the Demo marker tool.

4 Beginning at the camera’s location, drag the 
mouse to draw a path from the camera, 
through the door, around the pedestal, and 
out the left side. Your scene should look 
something like this.

Drawing the path

For this example, let’s assume that this path 
will take 9 seconds for the camera to travel.

5 Press the space bar to remove the marked 
path.

Lesson 27: Setting up the Timeline for the 
Sequence
Now that you have decided that the animation will 
take 9 seconds, it is time to set it up and begin 
animating the camera.

To set up the Timeline:

1 Choose File Menu menu > Animation 
Setup . 

2 In the dialog, enter 9 seconds in the Duration 
section, and change the frames per second 
(FPS field) to 10. 

When you exit the dialog box, the Time 
Scrubber and Current Time Indicator on the 
Animation palette fill with a blue timeline.

The blue extends beyond what is visible in the 
Time Working area. You will use the Scale tool 
above the right end of the timeline to scale the 
timeline so that you can see it.

3 On the Scale tool, drag the cursor to the right.
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The Scale tool 

The tick marks move closer together and more 
of them appear from the right. 

4 Continue dragging until you can see the entire 
blue portion of the timeline. 

5 If the Selection palette is showing, toggle to 
the Animation palette by clicking the Selection 
Animation toggle in the lower right corner of 
the Bryce interface.

6 Click the triangle on the right side of the 
Animation palette, ensure Auto-key is 
selected.

7 Click the triangle again and select Ticker 
Marks > Every 5 Frames. 

When your frame rate is 10 frames per second, a 
ticker mark every 5 frames is equivalent to a ticker 
mark every half a second.

Animate the Camera 
Lesson 28: Setting the Camera Trajectory

To adjust the camera’s trajectory:

1 Click the Add Keyframe (+) button to add a 
keyframe to the beginning of the timeline. 

2 Drag the Scrubber three ticks to the right.

The time reading is 00:00:01.05.

3 Place the cursor over the camera. Ensure that 
the cursor is a single arrow and not a cross 
arrow.

Do not drag the camera by the blue handle in 
the center of the camera; you will be dragging 
and adjusting the actual key position rather 
than the camera itself. 

4 Drag the camera to the interior of the room, as 
shown.

Positioning the camera. 

A blue point appears where the camera was 
just located, and a blue trajectory line links the 
first point with the new camera location.

The trajectory is the line along which the 
camera will move.

5 Drag the Scrubber another three ticks to the 
right. 

The time reading is 00:00:03.00.

6 Drag the camera so that it is on the left side of 
the mirrored sphere wireframe.

Drag to the next position.

7 Drag the Scrubber another three ticks to the 
right.

The time reading is 00:00:04.05.
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8 Drag the camera so that it is on the far side 
(top) of the sphere wireframe, as shown.

Another camera location. 

9 Drag the Scrubber another three ticks to the 
right.

The time reading is 00:00:06.00.

10 Drag the camera so that it is on the right side 
of the sphere wireframe.

Yet another camera location

11 Drag the Scrubber another three ticks to the 
right.

The time reading is 00:00:07.05.

12 Drag the camera so that it crosses to the left of 
the path as shown.

Continuing the trajectory

13 Drag the scrubber the final three ticks to the 
right to the end of the timeline.

The time reading is 00:00:09.00.

14 Drag the camera well beyond the wireframe to 
the left of the building, as shown.

Finishing the path

Congratulations! You have just created a 
camera trajectory to animate this camera.

You’ll no longer need the Bryce’s Auto-key 
function. To ensure that you do not 
inadvertently create a new keyframe during 
the next steps of this tutorial, you can 
deactivate this function.
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15 Click the triangle to the right of the Animation 
palette.

16 Deselect Auto-key from the list.

Lesson 29: Pointing the Camera
Check to see how the camera moves by playing the 
sequence.

To play the sequence:

• Click the Play button on the Animation 
palette. 

The camera moves along the blue trajectory 
while the Time scrubber moves from left to 
right. Notice that throughout the animation, 
the camera faces in one direction.

To point the camera:

1 Toggle back to the Selection Palette by 
clicking the Selection Animation toggle in the 
lower right hand corner of the Bryce window.

2 Click and hold the Select Sphere tool. 

3 Choose the last sphere on the list that appears.

This should select the pedestal sphere in the 
merged scene. Make a note of the sphere’s 
name; you will find it in a different pop-up 
menu in the next couple of steps.

4 Click the camera to select it. 

The camera’s wireframe turns red and the blue 
trajectory line appears.

5 Click the Object Attributes button. 

6 Click the Linking tab. 

A new panel appears with options for Object 
Parent Name and Track Object Name. 

7 Click the box titled ‘None’, under Track Object 
Name.

8 Select the name of the pedestal sphere.

9 Click the OK icon to leave the Camera’s Object 
Attributes dialog box. 

The camera snaps to the right to point at the 
sphere, and a gray line extends from the 
camera to the sphere.

A line extends from the camera to the sphere 

10 Toggle back to the Animation palette.

11 Click the Play button. 

The camera moves along the trajectory, facing 
the sphere for the entire duration of the 
sequence.

To view the scene from camera view: 
1 Switch to Camera View.

2 Click the Play button to watch the wireframe 
animation. 

The camera flies through the space, all the 
while keeping the sphere at the center of the 
scene window.

3 Save your scene, call it Animation-Rough Cam.

Lesson 30: Making Camera Adjustments
The height of the camera fly-through is below the 
mirrored sphere and below the open arch on the 
left side of the building. However, the camera 
trajectory may have some kinks in it. You can drag 
the points of the camera trajectory to reshape it.
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To adjust the height:
1 Switch to the From Right view. 

2 Click the Zoom out tool, to see the entire 
camera path.

First, you’ll adjust the camera’s height so that 
it is level with the sphere as it circles around it.

3 Drag the point on the right up so that it is 
level with the sphere. 

Your scene should look like the following 
figure.

Adjusting the height. 

4 Drag the other points up, except for the first 
and last.

Your scene should look like the following 
figure.

Adjusting the camera view

To continue adjusting, you will need to look at 
the scene from a different perspective.

5 Switch to From Front view. 

Zoom out if needed.

6 Drag the endpoint of the camera trajectory up 
so that it extends from the sphere through the 
Boolean sphere and beyond the building.

Fine-tuning the adjustments

Note that you might need to Zoom out here to 
see the same view as the image above. The 
dotted line of the sphere is the location of the 
open area of the arch.

7 Click the Play button.

Watch the camera’s movement through the 
sequence. The camera ends up at the position 
you set at the previous step. 

The camera’s endpoint

Now that the camera is back on the trajectory, 
notice that the gray line between the camera 
and the sphere provides a guide for that 
straight line of sight. You can use the guide for 
other placements of your trajectory.

8 Drag the previous key point up so that it is 
aligned with that gray line. Your trajectory 
should look like the one shown.
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Positioning the key point. 

9 Switch back to Camera view.

10 Click the Play button to see your animation.

Lesson 31: Smoothing the Camera’s 
Trajectory
To smooth the Camera’s trajectory, you will adjust 
the points and work with the shape of the curve 
using the tangents of each point. To see the 
tangents, you will need to make them visible.

To display the trajectory options:
1 Switch to Director’s View.

2 Click the Object Attributes button to access 
the Camera and 2D Options. 

3 Click the Animation tab.

4 Under Trajectory Options, click the button for 
Show Always. 

5 Click the button for Show Tangents.

6 Exit the Camera and 2D Projection dialog box 
by clicking the OK icon.

The camera trajectory now has green lines 
extending from each point.

To smooth the trajectory:
Smoothing the trajectory is easiest when you 
work in Top View.

1 Switch to Top View. 

The top view

2 Toggle to the Selection palette.

3 Click the Select Families button.

4 Choose the Walls family.

5 Holding down the Shift key select Pedestal 
from the Families list. 

6 Click the Solo Mode button.

There is now a much clearer view of your 
camera trajectory and the tangents extending 
from each point. 

The trajectory path

Any kinks in the path result from a lengthy 
tangent interfering with a neighboring point. 
Shortening the tangent will smooth out the 
trajectory line.

7 Click the camera to select it.

The points appear. 
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8 Place the cursor over the point with the 
longest trajectory. 

The cursor changes to crossed arrows.

9 Press the T key (for tangent), then click and 
drag to the right. 

The tangent lines shorten.

10 Reposition any points to smooth out the 
trajectory line. 

Adjusting the trajectory path

11 Click the Solo Mode button.

12 Switch back to Camera View.

13 Toggle back to the Animation palette.

14 Click the Play button to view the animation.

15 Save your scene.

Lesson 32: Test Render
It’s time to set up a test render of your animation 
sequence. Continue with the scene file you have 
been working with, or use the Animation-Smooth 
Cam scene file from the CD. 

To create a rough animation, you need to change 
the render size of your scene to a smaller image.

To create a test render:

1 Choose File menu > Document Setup .

2 In the dialog box, change the render 
resolution to 1:0.25.

3 Click the OK icon to exit the dialog box. 

4 Click the Render button to test render your 
scene.

5 Choose File menu > Render Animation .

This dialog box allows you to choose your 
settings for this test render. 

6 In the Output Module section, click the Edit 
button. 

A Compression Options dialog box appears. 

7 Disable the option for Keyframe every 10 
frames then click OK.

8 Click the Set button. 

A Save dialog box appears, showing the 
location and name of your movie.

9 Choose the location and name of your movie.

10 Click Save.

11 Click the OK icon to exit the Render Animation 
dialog box. 

Your scene begins rendering each frame. At 
the end of the render, Bryce automatically 
launches the movie player application.

Playing the animation

12 Click the Play button to watch your animation.

13 Switch back to Bryce and save your scene file. 

Congratulations! You’ve created your first Bryce 
movie! Make sure that you exit the movie player 
application before you continue the tutorial.
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Fine-Tuning Your Animation
To finish your animation, you will convert your 
trajectory to a path. In the beginning, you used key 
frames to set the position of the camera. This 
trajectory is good for creating the physical location 
of the camera over the sequence. However, the 
points along the path tend to correspond to places, 
and not necessarily events, or velocity. 

Converting to a path will allow you to set up two 
key frames, one for the beginning and the other for 
the end, and you can adjust the velocity without 
worrying about the placement of a keyframe at that 
spot.

Lesson 33: Converting the Trajectory to 
a Path
To work on the timing and velocity of your 
sequence, you will convert your trajectory into a 
single path object. 

To convert from Trajectory to path:

1 Switch to Top View.

2 Select your camera by clicking it. 

3 Choose Objects menu > Create Path.

A new path object appears, occupying the 
same space and shape as the camera 
trajectory.

4 Select the camera again.

5 Click the triangle on the Selection Palette.

6 Choose Camera to select the camera (Notice 
that there is an option there for selecting 
paths as well).

The Camera and its trajectory line are 
selected.

7 Click the Object Attributes button.

8 Click the Linking panel.

9 For Object Parent name, select Path 1 from the 
pop-up menu of your objects.

10 Click the button next to Constrain to Path. 

11 Click the OK icon to leave the dialog box.

The blue trajectory line disappears.

The trajectory line went away when the 
camera was constrained to the path. All of the 
key-framed motion information for the camera 
went away with the trajectory. 

The location information of the trajectory is 
preserved in the path, which is present in your 
scene.

12 Click the Selection Animation toggle to switch 
to the Animation palette.

13 Click the Play button. 

The scrubber moves, but the camera does not.

You’ll re-set the key frames for camera motion for 
the beginning and end of the sequence.

Lesson 34: Creating Keyframes for the 
Beginning and End of the Path

To create key frames:

1 Click the Time First Keyframe button on the 
Animation palette.

The scrubber moves to the beginning of the 
sequence (time 00:00:00.0).

2 Click the Add Keyframe button. 

3 Click the Last Keyframe button. 

The scrubber moves to the end of the 
sequence (time 00:00:09.0).

4 Click the camera to select it.

5 Click the Object Attributes button. 

6 Type the number 100 in the Position box. 

7 Click the OK icon.

Your camera should now be located at the end 
of the path.

8 Click the Add Keyframe button.

9 Check your animation, by clicking the Play 
button. 
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Your camera should now move smoothly along 
the path.

You now have very smooth camera movement over 
a complex path, using only two key frames.

Lesson 35: Velocity Adjustment
The last thing you will do with your animation in 
this tutorial is adjust the camera’s velocity along 
the path. To do this, you will work in Bryce’s 
Advanced Motion Lab.

Your camera should be selected.

To adjust the velocity:

1 Click the Advanced Motion Lab button.

On the bottom half of the Advanced Motion 
Lab, the objects and their timelines are 
displayed. The round button at the upper right 
of the timelines is the current time display. 
Because of the length of the animation, you 
can’t see the entire timeline for this sequence.

2 Drag the round Current Time display marker 
to the left. 

The numbers and timeline bars scroll off to the 
right. 

3 Continue dragging left until the marker is at 
the left end of the timeline. 

Adjusting the timeline

4 Drag the Scale tool to the right. (It is located 
under the preview window.) 

The space between numbers decreases, and 
after a bit, the entire timeline is displayed. 

5 Release the mouse button.

Adjusting the scale

The word camera displays in red. 

6 Click the word Camera. 

7 Click the word Position.

Additionally, in the Velocity Controls section 
(also known as the Time Mapping curve), a 
diagonal line has appeared. 

Next to the window to the right is a camera 
icon and a light icon. 

8 Click the camera icon.

A green light appears and the display in the 
right window changes to show your scene 
from the camera’s perspective. 

The camera’s perspective

See how the animation preview and the 
Velocity area work together.

9 Click the Play button under the animation 
preview window. 
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The animation plays, while crosshairs mark 
the current time along the Velocity line.

You’ll use one of the preset Velocity curves to 
put a little variety in the camera motion.

10 Click the slight S-shaped curve that matches 
the one shown, from the Velocity Controls 
section.

Velocity curve

11 Click the Play button. 

The animation begins slowly, moves faster for 
a time and then slows down toward the end.

When the velocity curve is flatter, camera 
motion is slower. When the curve is steeper, 
the motion is swifter.

12 Click the arrow in the lower right corner to 
leave the Advanced Motion Lab and return to 
your scene.

13 Save your scene file.

Lesson 36: Another Test Render
Before your test render, double-check your render 
settings. 

To render:

1 Choose File menu > Document Setup .

2 In the Document Setup dialog box, ensure that 
you are rendering at the smallest ratio: 1:0.25.

3 Switch back to Camera View.

4 Select File menu > Render Animation.

5 In the Render Animation dialog, change the 
name of this test file to Render 2.

6 Click the Set button. 

7 In the Save dialog box, add “test path” to the 
name. 

8 Click Save.

9 Click the OK icon to exit the Render Animation 
dialog box. 

Your animation begins rendering.

Final Comments
Compare the two test animations. Do you see the 
difference in movement?

For your final render, you may render at a larger 
size, or, for fun, try creating a Volumetric World to 
add drama to those light rays that enter the 
building through the arches.

Congratulations! You have now created a scene, set 
up your animation, created the camera trajectory, 
converted the trajectory to a path, and adjusted the 
camera’s velocity on that path. You have walked 
through a fair portion of the power of creating and 
animating Bryce scenes.

For additional ideas about how to animate this 
scene or for other tips, check out the websites 
under the Links menu.





4
Creating Objects

Objects are the building blocks of your Bryce 
world. They can be used as props, to populate a 
scene, or to add detail to landscapes. 

An object is the most basic item in Bryce. Objects 
can be anything from terrains to pebbles. In Bryce, 
there are several ways of creating objects. Some 
objects use unique editors; others can be created 
by a simple one-step click.

There are two main tools for creating objects. The 
Create palette, which contains tools for creating 
objects with a single click, and the Preset Objects 
Library, which contains pre-made objects you can 
add to your scene.
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The Create Palette

The main tool for creating objects is the Create 
palette. This palette provides access to tools that 
let you create all the object types available in Bryce. 

The tools on the palette represent the type of 
object they create. The name of each tool appears 
in the Text Display area as you move your cursor 
over it. When you click a tool, the object appears in 
the center of the scene.

To display the Create palette:

• Click the Create button at the top of the Bryce 
window.

To use a Create tool:
1 Display the Create palette.

2 Click on the tool for the object type you want 
to create.

The object appears in the working window.

The Triangle icon next to the Create button at the 
top of the Bryce window lets you access the Preset 
Objects Library.

To open the Preset Objects Library:
• Click the Triangle icon next to the Create 

button at the top of the Bryce window.

Primitives vs. Procedural 
Objects
Bryce’s Create palette lets you create two different 
types of basic object: Primitives and Procedurals. 

Primitives are basic geometric shapes such as the 
sphere, torus, cylinder, cube, pyramid, cone, plane, 
and disk. These shapes can be thought of as 
primary geometric building blocks, from which 
more complex objects are constructed.

Primitives also have derivative groups (such as the 
ellipsoid and squashed sphere, which are derived 
from the Sphere), which allow you to create 
different shapes without having to perform the 
transformations yourself.

This train is made up of primitive and primitive derivative 
objects. 

Procedural objects are object that require special 
constructions, or “procedures,” to create, such as 
terrains, trees, rocks, symmetrical lattices, and 
Metaballs. Procedures can include operations such 
as preassigning materials, randomizing internal 
parameters, or assigning light properties.

Planes LightsPrimitivesProcedurals
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This scene shows examples of procedural objects. 

Creating Primitives
Primitives are the primary geometric building 
blocks in Bryce. You can create spheres, tori, 
cylinders, cubes, pyramids, cones, discs, and 2D 
faces.

By default all primitives are assigned a flat 
gray color.

To create a geometric primitive:

• Click one of the primitive tools:

Derivative Primitives
Derivative primitives are primitive objects whose 
shape is “derived” from basic geometric primitives.

Derivative primitives were created so that you 
could skip some of the editing procedures on most 
of the basic primitives. For example, instead of 
elongating a cube to make it into a pillar, you can 
just use the Stretched Cube derivative. Instead of 
shortening a cube to make it into a rectangle, you 
can use the Squashed Cube derivative. 

To create a stretched primitive:

• Press Shift and click the primitive tool.

To create a squashed primitive:

• Press Command/Ctrl and click the primitive 
tool.

Object Placement
When you create a new object it can be placed in 
your scene either at absolute world center or at an 
arbitrary location based on your current view. 
Object placement is determined by your preference 
setting. Refer to “To control new object 
placement:” on page25 for more information.

Selecting Objects
Before you can perform any type of editing or 
transforming operation on an object, you need to 
select it. As well as selecting objects using the 
cursor, Bryce’s Selection tools let you select objects 
by type or family. You can also cycle through all the 
objects in your scene.

Creates spheres

Creates tori

Creates cylinders

Creates cubes

Creates pyramids

Creates cones

Creates discs

Creates 2D faces
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To select an object:
• Click on any object. A selected object’s 

wireframe will appear red.
or

• Drag a marquee around the object.

To step through all the objects in your scene:

• Press the Tab key until the object you want 
selected appears in red. 

To select a number of objects:
• Drag a marquee around a number of objects.

To select an object within a group:
• Hold down Control/Ctrl and click the desired 

object.

To select all objects:
• Choose Edit menu> Select All , or

• Press Command/Ctrl+A.

To deselect all:
• Choose Edit menu> Deselect All, or

• Click anywhere outside the selected area. 

To add objects to a selection:
• Hold down the Shift key while selecting the 

object. 

To remove objects from a selection:

• Hold down the Shift key and click the selected 
object.

To select obscured objects:
1 Hold down the Shift key and select through 

the obscuring object.

All objects underneath the cursor will be 
selected. If the obscuring object is already 
selected, it will be deselected and all the 
objects behind it will be selected.

or

Hold down Command/Ctrl and click an object 
to select or deselect. Use Shift to select 
multiple objects. 

You will see a list of all objects under the cursor. 
This lets you not only view the selection status of 
all the listed objects, but change it as well. This aids 
in dealing with large scenes. 

The Selection Palette
The Selection palette is hidden behind the 
Animation controls in Bryce’s default state. The 
palette is divided into two sections: select by type 
tools and the VCR controls.

The Selection palette has tools for selecting objects in a variety 
of ways.

To display the Selection palette:
• Click the Time Selection Palette toggle in the 

lower-right corner of the Working window. 
The Selection palette appears. 

Selecting By Object Type
The Select by Type icons let you select all the 
objects in your scene that are of a particular type. 
For instance, if you click on a sphere here, Bryce 
will select all spheres and sphere-derivative objects 
in your scene. 

All of the selection controls below respect the 
previously described Shift-click techniques for 
multiple selections and deselections.

To select a specific object by type:
• Hold down the cursor over the tool for the 

type of object you want to select and choose 
the name of the object from the menu that 
appears.

By default, objects will be named with the 
object type followed by a sequential number 
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based on when you placed that object in the 
scene; for example, Sphere 1. To make it easier 
to select a particular object, you can give 
objects unique names that will appear in this 
menu. Refer to “Naming Objects” on page69 
for more on naming objects.

To select objects by family:
• Click the Families tool and choose the name of 

the family you want to select from the menu.

To select Mesh objects:
• Click the triangle icon next to the Selection 

palette and choose Select Mesh.

To select Path objects:

• Click the triangle icon next to the Selection 
palette and choose Select Path.

To select Group objects:
• Click the triangle icon next to the Selection 

palette and choose Select Group.

To select all objects except a specific type:
1 Click the tool for the object you want to 

exclude from the selection. All the objects of 
that type are selected.

2 Click the triangle icon in the Selection palette 
and choose Select Inverse from the menu.

To select all the objects in your scene:
• Click the triangle icon in the Selection palette 

and choose Select All from the menu.

The VCR Controls 

The VCR controls let you step through the various 
selection tools and activate Solo Mode.

To display the VCR Controls:
1 Click the Time Selection Palette toggle in the 

lower-right corner of the Working window. 
The Selection palette appears.

2 Pass your cursor over the right side of the 
Selection palette. The VCR Controls appear.

To step forward and backward through the 
object types in your scene:
1 Click on the larger forward arrow to step 

forward through object types within the 
current scene. The first object of its type is 
selected.

2 Click on the larger backward arrow to step 
back through object types. 

If you watch the Select By Type icons, the 
object type you are stepping to will highlight 
momentarily.

To step forward and backwards through the 
object in a selected object type:
1 Click on the smaller forward arrow to step 

forward through each object of the type in a 
selection. 

For example, you can use the large arrows to 
step to the first sphere created in your scene, 
and then the smaller arrows to step through all 
other spheres in your scene.

2 Click the smaller backward arrow to step 
backward through each object of the type in a 
selection. 

One advantage to making selections with this tech-
nique is that you can select objects within a Group. 
Simply clicking on a Grouped object will not neces-
sarily select the entire group; using the VCR controls 
to select within a Group allows you to reposition 
objects, or assign textures to objects within a Group 
without having to first Ungroup them.
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To step sequentially through every object in 
your scene:
1 Click the triangle icon in the Selection palette 

and choose Alternate VCR Mode.

2 Click the larger backward or forward arrow.

To step sequentially through families:
1 Click the triangle icon in the Selection palette 

and choose Alternate VCR Mode.

2 Click the smaller backward or forward arrow.

To temporarily remove all unselected objects 
from the scene:

1 Select an object.

2 Click the Solo Mode button in the center of 
the VCR controls. The button color changes to 
red.

In Solo Mode, you can only edit the selected 
objects; all the other objects remain in place 
but uneditable.

If you’re working on a very complex scene, 
Solo Mode speeds up your work significantly, 
as Bryce does not have to calculate and draw 
extraneous wireframe objects.

The Object Attributes Dialog
The Object Attributes dialog lets you set a number 
of properties that determine how the object 
appears in the Working window.

The dialog is where you’ll set up the object’s name, 
size, orientation, placement and display quality. It’s 
most often used to numerically transform the 
object. When you’re animating an object, the 
dialog is used to control how the object interacts 
with its motion path. Refer to “Animating” on 
page319 for more on animating.

The Object Attributes dialog contains controls for setting the 
object’s name, scale, position, and orientation. 

The dialog is divided into three tabs: General, 
Linking, and Animation. 

The General tab contains controls for setting the 
object’s name and display attributes and position. 
Refer to “Editing Object Attributes” on page230 for 
more on using the dialog to edit objects.

The Linking tab contains controls for setting up 
parent-child links and tracking. Refer to “Linking 
Objects” on page223 for more on linking and 
“Tracking Objects” on page344 for more on 
tracking.

The Animation tab lets you set the properties of the 
object when it is connected to a Motion Path. Refer 
to “Animation and Motion Paths” on page320 for 
more on motion paths.

To display the Object Attributes dialog:

1 Select an object.

2 Click Objects menu> Attributes.
or 
Click the Aicon that appears next to an 
object’s bounding box.
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Naming Objects
When you create an object, the first thing you 
should do is assign a name to it. An object’s name 
identifies it in the Working window. 

You can select objects, by name, using the 
Selection palette. The name can also help you 
distinguish a specific object when your scene 
contains more than one object of the same type. 
Refer to “Selecting Objects” on page65 for more 
information.

An object’s name is also used when you’re creating 
parent-child links and setting up object tracking. 

To name an object:

1 Select an object.

2 Click the Aicon that appears next to its 
bounding box.

Objects in the Scene
Every object in the scene has a bounding box. The 
box acts like a visual guide that tells you how much 
space it occupies in 3D space. It also provides 
access to a series of tools that let you edit an 
object’s attributes and placement.

An object’s bounding box lets you see how much space it 
occupies in 3D space. 

The buttons around the edges let you set an 
object’s attributes.

The black points on the edges of the box are called 
control handles. These handles can be used to edit 
the object’s size and orientation. As you pass your 
cursor over the handles, it changes to display the 
type of control you’re selecting.

When the cursor turns into a letter, it means that 
you’re over a constrain handle. The handle will only 
move along the axis indicated by the letter. For 
example, if the cursor changes to a Y, it means that 
the handle will move only along the Y axis.
 

If your cursor changes to a letter, it means that you’re over a 
constrained control handle. 

You can drag this type of handle to distort the 
shape of the object.

If the handle changes to a black square with a right 
angle, it means that the handle can move in any 
direction, but the object will be scaled 
proportionally.

If your cursor changes to a black box with a right angle, it 
means that you can use the handle to proportionally scale the 
object. 

To display an object’s bounding box:

1 Create an object.

2 Select the object.
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Object Preview
When you create an object, it appears as a 
wireframe in the Working window. The wireframe 
represents the structure of the object’s shape.

Objects appear as wireframes in the scene. The wireframe gives 
you an idea of the object’s shape and structure. 

The wireframe preview lets you see how an object 
looks as it’s being rotated or animated without 
having to calculate and render any complex surface 
properties. The wireframe casts a shadow on the 
ground plane below it. The shadow can be used as 
a visual guide to help you determine the object’s 
position in 3Dspace.

As you move the object its shadow follows it along the ground 
plane. When you have a number of objects, the shadows can 
help you see its exact position in the scene. 

If you move the object below the ground plane, the 
portion of the object that’s below ground is not 
drawn. This can help you avoid placing an object 
outside the view of the scene. Wireframe shadows 
do not interact with light; they appear regardless of 
the light sources in thescene.

If you move an object below ground, the portion of the 
wireframe that’s below the ground plane is not displayed in the 
scene. 

Both shadows and underground wireframes are pre-
view options that can be turned on and off. Refer to 
“Wireframe attributes” on page27 for more on 
these features.

Object Preview Modes

In addition to wireframes, there are three other 
ways you can view an object: Bounding Box, Shaded 
Preview, and Rendered Preview.

Bounding Box
If you have a large scene and you find that it’s 
taking too long to redraw the entire scene, you can 
change the display of the objects so that only their 
bounding boxes are displayed.

The Show Object as Box preview mode displays the object using 
only its bounding box. 
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You can move the box just as you would a normal 
object. The box can also cast a shadow.

To display an object as a box:

1 Select an object.

2 Click Objects menu> Show Object as Box.
or
Click the Aicon that appears next to the 
object’s bounding box to display the Object 
Attributes dialog. 

In the dialog, click the Show as Box button.

To display an object as a wireframe:
1 Select an object.

2 Click Objects menu> Show Object as Lattice.
or
Click the Aicon that appears next to the 
object’s bounding box to display the Object 
Attributes dialog. 

In the dialog, disable the Show as Box button.

Shaded Preview

Open GL mode performance is greatly increased from 
an Open GL accelerator card, but Windows 95/98 
and Windows NT® also support software-driven 
Open GL mode.

In this mode, objects appear as solids. The colors 
assigned to the object are also visible. Object 
surfaces are affected by light sources. Materials and 
textures are not visible in this mode.

In the shaded preview mode you’ll be able to see all the objects 
in your scene as solids. 

Rendered Preview
If you want to see what the object’s surface looks 
like or how it is affected by light gels, you’ll have to 
render it. 

The Nano-Preview shows you a small preview of 
what the object looks like rendered.

The Nano-Preview of the object shows you a small preview of 
what the object will look like when it is rendered. 

Refer to “Using the Nano-Preview” on page19 for 
more on the Nano-Preview.

If you want to see the object at full size you’ll have 
to render it. Once it is rendered, you can see the 
bitmap preview of the object using the Bitmap 
Preview mode. 

Refer to “Setting Up a Render” on page305 for more 
on rendering and “Display Modes ” on page26 for 
more on Bitmap Preview mode
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.

To see a full-sized preview of the object you’ll need to render the 
scene.

Creating Boolean Objects
A Boolean object is an object created by combining 
two or more objects to form a single object. 
Boolean objects are created by performing Boolean 
operations on a number of objects. You can 
perform three types of Boolean operations in Bryce: 
union, subtraction, and intersection. 

Bryce uses Object properties to perform Boolean 
operations. Objects can be Neutral, Positive, 
Negative, or Intersecting. When you combine these 
objects in a group, the result is a Boolean object.

Boolean operations do not have any effect on 
Neutral objects. When you group a neutral object 
with a Boolean object, no Boolean operation is 
performed.

If you were to group a neutral object with a Boolean object, 
both objects would remain visible, as no Boolean operation 
occurs.

Objects are neutral by default. 

If you are importing objects from Bryce 2, you may 
want to change some positive objects to neutral for 
faster rendering.

Negative+Positive

Negative +Neutral
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Boolean Operations
Boolean Union is performed by grouping two 
positive objects. The area that is common to both 
objects is removed, creating a continuous object. 
For example, when you group two positive spheres, 
you get a kind of peanut shaped object which is the 
union of the two objects.

Boolean Union is performed by grouping two positive objects.

Boolean Subtraction is performed by grouping a 
negative object with a positive object. The area 
that is common to both objects is subtracted from 
the positive object, resulting in a positive object 
with negative space. For example, when you group 
a positive sphere with a negative one, the resulting 
object looks like a sphere with a crater.

Boolean Subtraction is performed by grouping a positive object 
with a negative object.

Boolean Intersection is performed by combining an 
Intersecting object with a Positive object. The area 
that is common to both objects becomes the only 
visible portion of the group.

Boolean Intersection is performed by grouping a Positive object 
with an Intersecting object.
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Negative or Intersecting objects must share space 
with at least one Positive object in the group to 
exhibit a Boolean operation. If there is no common 
space, Negative objects are invisible when 
rendered. 

A group that contains an Intersecting object that 
does not intersect with any other object in the 
group becomes entirely invisible; this is because 
the Intersecting object is intersecting with nothing.

You can build very complex objects by 
compounding Booleans. Suppose you wanted to 
create a flute. You would first create the hollow 
tube by combining a positive cylinder with a 
negative cylinder, then create several negative 
spheres and group those with the tube, creating a 
simple flute.

This simple flute was created by grouping a hollow tube with 
several negative spheres.

By compounding more Boolean operations on top 
of this simple flute, you could create even more 
complex objects.

This sprinkler was created using compound Boolean operations.

Since Bryce performs Boolean operations using 
object attributes, you can adjust the shape of a 
Boolean object by repositioning the objects in the 
group. You can edit objects within groups using the 
Solo mode in the Selection palette. Refer to 
“Selecting Objects” on page65 for more 
information.

The final Boolean object appears only in the 
rendered image or in the Nano-Preview. You won’t 
be able to see the Boolean object in the Wireframe 
preview.

To subtract one object from another:

1 Select an object.

2 Click the Abutton next to the object’s 
bounding box, or press Command-Option-E/
Ctrl+Alt+E, or choose Objects menu> Edit 
Attributes.

The Object Attributes dialog appears.

3 Enable the Negative checkbox.

4 Move the negative object so that it intersects 
another object. 

5 Make sure that the second object’s Boolean 
attribute is set to Positive.

6 Select both objects and click the Gbutton next 
to the selection’s bounding box to group 
them.

When your scene is rendered, the area where 
the two objects intersect is removed from the 
positive object.

To create an object that is the intersection of 
two objects:

1 Select an object.

2 Click the Abutton next to the object’s 
bounding box, or press Command-Option-E/
Ctrl+Alt+E, or choose Objects menu> Edit 
Attributes.

The Object Attributes dialog appears.

3 Enable the Intersecting checkbox.
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4 Move the intersecting object so that it 
intersects another object. 

5 Make sure that the second object’s Boolean 
attribute is set to Positive.

6 Select both objects and click the Gbutton next 
to the selection’s bounding box.

When your scene is rendered, the area where 
the two objects intersect becomes the only 
visible portion of the group.

Using the Presets Object 
Library
The Presets Object Library contains all the preset 
objects distributed with Bryce as well as presets 
you add. Objects in the library are either 3Dmodels 
or geometric paths. Refer to “Creating Geometric 
Paths” on page88 for more on geometric paths.

You can place objects from the library anywhere in 
your scene and edit them just as you would any 
object.

To add an object from the Presets Object 
Library to your scene:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce environment. 
The Presets Object Library appears.

2 Click on the name of a category (to the left of 
the thumbnails).

3 Click on the preset thumbnails to view preset 
names and descriptions.

4 Click OK to add the selected object to your 
scene.

The Create palette does not need to be active for you 
to access the Presets Object Library. 

Adding and Deleting Preset Objects
You can add preset objects to categories in the 
presets library. The presets library retains all 
Boolean, grouping and textural properties of the 
objects placed within it. 

To add an object to the preset library:

1 Select the object you want to add to the 
library.

2 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 
selected object appears in the preview area of 
the Presets Object Library dialog.

3 Click a category name. The library switches to 
the category you selected. 

The new preset will be added to the category 
you select.

4 Click the Triangle icon in the bottom-right 
corner of the object preview and choose a 
view option from the menu.

Normal is the default view of your selected 
object.

Up Close displays a close-up of your object.

Render With Neutral Sky displays your object 
with a flat sky, instead of the sky applied to 
your scene.

5 Set up the preview of the object:

• Drag the preview area to rotate the view of 
the object.

• Hold down the spacebar and drag up, 
down, right, or left to pan the object 
preview.

• Hold down Command/Ctrl and drag in the 
preview area to zoom in and out of the 
preview.

6 Click the Add button at the bottom of the 
dialog. The Add Object dialog appears.

7 Enter a name for the new preset in the Preset 
Name field.
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8 Enter a description of the preset in the 
Description field and click the OK icon.

This name and description will appear beneath 
the object preview whenever the preset is 
selected. 

9 Click the OK icon. Your preset is added to the 
first available space within the current 
category.

To delete an object preset:
1 Click the Triangle icon next to the Create 

button at the top of the Bryce environment. 
The Presets Object Library appears.

2 Click on the preset you want to delete, or hold 
down Shift and select a continuous series of 
presets, or hold down Command/Ctrl and 
select a discontinuous set of presets.

3 Click the Delete button at the bottom of the 
dialog. 

Importing and Exporting Preset Objects
Importing and exporting presets is a handy way to 
exchange custom presets with other users. 

To import a Preset object file:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 
Presets Object Library appears.

2 Select the category into which you want to 
import the file.

3 Click the Import button at the bottom of the 
dialog. The file open dialog appears.

4 Locate the file that you would like to import 
and click Import.

The contents of the file are placed into the 
first available space in the current category.

To export a Preset object file:

1 Click the Triangle icon next to the Create 
button at the top of the Bryce window. The 
Preset Objects Library appears.

2 Select the category from which you want to 
export presets.

3 Select the preset or presets you wish to 
export.

4 Click the Export button at the bottom of the 
dialog. The save file dialog appears.

5 Enter a name and location for the file and click 
Save.

Adding and Deleting Preset Folders and 
Categories
Bryce comes with two preset category folders: 
Installed and User. The Installed preset category 
folder contains the presets that are installed with 
Bryce. The User preset category folder is empty by 
default. Each preset category folder can contain up 
to 14 preset categories. Each preset category can 
contain a virtually unlimited number of presets. 
You can create additional preset category folders 
and preset categories to suit your needs.

To choose a preset category folder:
• Click the triangle icon next to the preset 

category folder name at the bottom left of the 
Preset Object Library and choose a preset 
category folder from the drop-down menu.

The Preset Object Library opens that preset 
category folder and displays the categories and 
presets found in that folder.

To add a preset category folder to the Preset 
Objects Library:

1 Navigate to the folder where Bryce 5 is 
installed. 

2 Open the Presets folder.

3 Open the Objects folder. 

To add a preset category folder to the Preset Textures 
Library, open the Textures folder. To add a preset 
category folder to the Preset Materials Library, open 
the Materials folder.
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4 Create a new folder and give it a name. The 
folder name will appear in the preset category 
folders drop-down menu.

Preset folder names are limited to 8 characters. 

To delete a preset category folder:
1 Navigate to the folder where Bryce 5 is 

installed. 

2 Open the Presets folder.

3 Open the Objects folder.

To delete a preset category folder to the Preset Tex-
tures Library, open the Textures folder. To delete a 
preset category folder to the Preset Materials 
Library, open the Materials folder.

4 Delete the preset category folder. The preset 
category folder and all the preset categories 
and presets it contains will be deleted.

To add a preset category to a preset category 
folder in the Preset Objects Library:
1 Select a category in the Preset Objects Library. 

To add a preset category to the Preset Textures 
Library, select a category in the Preset Textures 
Library. To add a preset category to the Preset Mate-
rials Library, select a category in the Preset Materi-
als Library.

2 Select a preset object.

3 Click the Export button at the bottom of the 
dialog. The save file dialog appears.

4 Choose the preset category folder you want to 
add categories to as your save location. 

5 Enter a name for the new preset category and 
click Save.

The new preset category will appear in the 
preset category folder you selected. It will 
contain the object you selected before 
exporting. You can delete that object from the 
preset category and add or import your own 
objects.

Creating Infinite Planes
An infinite plane object extends in all directions to 
infinity. When you create a plane in Bryce it 
appears as a finite plane to make it easier to 
position, but when your scene is rendered the 
plane extends infinitely in all directions. 

Though procedurally these three infinite planes are 
different, they are all considered to be Infinite 
Planes for the purpose of selecting with the 
Selection tools.

When you add a plane object it appears as a finite object in the 
Working window...

...but when you render the scene it extends to infinity.

Ground
Ground planes are created at ground level. By 
default, all new scenes open with an infinite ground 
plane. 

To create a Ground plane:

• Click the Ground plane tool.
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Once the plane appears in your scene you can 
edit it like any other object.

Use the Ground plane to add ground to your environment.

The Ground plane is created with a gray color, as 
are all Bryce primitives. Once you begin assigning 
textures to objects, Ground objects (as well as all 
other primitive objects) will inherit the texture 
assigned to the previous object.

Water
Water planes are created just a bit higher than 
ground level. That way, if you have already created 
ground and terrains, you can easily place a water 
plane into your scene and immediately see the 
terrains peeking out from the water.

To create a Water plane:

• Click the Water plane tool.

Once the plane appears in your scene you can 
edit it like any other object. Refer to “Editing 
Object Attributes” on page230 for more on 
editing objects.

Use the Water plane to add bodies of water to your 
environment.

Water planes are created with a water texture 
randomly chosen from the Waters&Liquids Preset 
Materials Library. You can change this material by 
selecting a different preset or creating a new 
material.

To change the water plane’s Preset Material:
1 Click the second Triangle icon at the top of the 

Bryce environment. The Preset Materials 
Library appears.

2 Choose a library and material, then click the 
OK icon.

Refer to “Using the Materials Presets Library” 
on page164 for more on the Preset Materials 
Library.

Cloud
Cloud planes are placed much higher in your scene, 
since they’re generally the highest objects in your 
environment.

To create a Cloud plane:

• Click the Cloud plane tool.

Once the plane appears in your scene you can 
edit it like any other object.

Use the Cloud plane to add clouds to your environment.

Cloud planes are automatically assigned a 
randomly chosen texture from the Clouds&Fogs 
Preset Materials Library. You can change this 
material by selecting a different preset or creating a 
new material.

To change the Cloud plane’s preset material:
1 Click the second Triangle icon at the top of the 

Bryce environment. The Preset Materials 
Library appears. 

2 Choose a library and material, then click the 
OK icon.
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Infinite Slabs
An infinite plane is a plane object that has no 
depth. An infinite slab is a plane object that has 
depth. The plane has no effect on objects above it 
or below it; an infinite slab can affect objects within 
it. 

For example, anything you place within the slab’s 
depth will be affected by the slab’s volume color.

Slabs are usually used to create water. When you 
create a water slab, you create water with realistic 
volume. This means that if you sink an object into 
the water it will be affected by the colors or 
textures you assign to the slab’s volume.

In an infinite slab, the plane in the scene has depth that affects 
the objects within it. 

The realistic look of a water slab depends almost 
entirely on the material you assign to it. The 
Volume color plays an essential role in creating 
realistic water effects. Refer to “Volume Color” on 
page142 for more on Volume Color and materials.

To create an Infinite Slab:
1 Click the plane tool and choose the Volume 

option from the popup.

2 Select the slab.

3 Click the Aicon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

4 Enter a depth value in the Size Y field and click 
the OK icon.

Creating Terrains
Terrain objects define the landscape of your scene. 
They represent the land forms of any scene: 
mountains, deserts, islands, or even floating cities. 
In Bryce, a terrain object is a height map that 
determines the shape of your landscape. 

Bryce creates a terrain’s shape by converting 
brightness values in grayscale images into a height 
map. White areas in the image result in the highest 
altitudes and black areas result in the lowest. The 
Terrain Editor lets you generate the grayscale 
images that are used to create terrain objects.

To add a terrain object to your scene:
• Click the terrain object tool. A randomly 

generated terrain appears in your scene.

Once you have a terrain object you can customize it 
in the Terrain Editor. Refer to “Editing Terrains” on 
page91 for more on editing terrains.

Creating Trees
The tree object tool creates natural-looking tree 
shapes that can be assigned materials, shaped, and 
positioned throughout your scene. 

To add a tree object to your scene: 

• Click the tree object tool. The default tree 
appears in your scene.

Once you have a tree object, you can customize it 
in the Tree Lab. You can control the size and 
texture of the tree trunk, the thickness and number 
of branches, and the type of foliage and its 
frequency, randomness, and color. You can import 
images to be used for the trunk or foliage texture. 
You can also control how gravity affects the tree, 
making branches bend and leaves droop to varying 
degrees. Refer to “Editing Trees” on page119 for 
more on using the Tree Lab.
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Creating Stones
The Stone object tool creates random, natural-
looking Stone shapes that can be assigned 
materials and positioned throughout your scene.

To create a Stone Object:
• Click the Stone object tool.

Stones objects are mesh based, and can be 
smoothed or unsmoothed using the Select Mesh 
dialog. Refer to “Editing Imported Meshes and 
Stones” on page238 for more information.

Stones are assigned random textures automatically 
from the Rocks&Stones Preset Materials Library.

To change a stone’s preset material:
1 Click the second Triangle icon at the top of the 

Bryce environment. The Preset Materials 
Library appears. 

2 Choose a library and material, then click the 
OK icon.

Since Stones are essentially clumps of meshes, their 
realism is highly dependent on the textures 
assigned to them. For example, if you assign a flat 
texture with no bumpiness to a Stone, the results 
won’t be very Stone-like. Try to assign rocky 
textures to stones. Refer to “Using the Material 
Preview Area” on page163 for more on assigning 
textures.

Creating Symmetrical 
Lattices
A Symmetrical Lattice is a terrain object that has a 
mirror image of itself fused at its base. When you 
modify one half of the lattice, the corresponding 
changes are applied to the mirrored half.

The Symmetrical Lattice can be a great timesaving 
tool. Instead of creating symmetrical shapes by 
duplicating and aligning two halves, you just need 
to create one half of a lattice and your object is 

duplicated for you. Symmetrical Lattices are edited 
as Terrains, using the Terrain Editor. Refer to 
“Clipping Terrains” on page114 for more 
information.

Many advanced types of objects can be created 
using the symmetrical lattice object. Any object 
that’s symmetrical can be created by painting it’s 
shape in the Terrain Editor.

The hair dryer in this example was created using a symmetrical 
lattice object.

To create a Symmetrical Lattice:

• Click the Symmetrical Lattice tool.
.

Use the Symmetrical Lattice tool to create symmetrical objects.
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Creating Metaballs
Also new to Bryce are Metaballs, a new object type 
found on the Create palette. Metaballs are spheres 
that blend into each other based on proximity. 
With Metaballs, you can create a wide variety of 
realistic-looking shapes.

Metaballs are spheres that blend into each other based on 
proximity.

Metaballs let you quickly create fluid shapes that 
are otherwise time-consuming or even impossible 
to create using primitives and Boolean operations. 

When you are in Wireframe view, Metaballs are 
represented as simple spheres. To see how the 
Metaballs will blend together, you must either look 
at the Nano-preview or render the image.

Metaballs appear as distinct spheres in Wireframe view and are 
blended together when rendered.

You can blend Metaballs of different sizes. This 
gives you more control over the resulting shape. To 
blend Metaballs, simply place the Metaballs close 
to each other. The closer together they are, the 
more they will blend into each other. The farther 
apart they are, the more they will resemble distinct 
spheres.

You can also change the shape of Metaballs in your 
scene to get different effects. For example, you can 
squash or stretch a Metaball, changing the surface 
area that blends into nearby Metaballs. Two oval 
Metaballs will give you a different blend result than 
two spherical Metaballs.

For Metaballs to blend smoothly, they must have 
the same material. If you blend two Metaballs with 
of differing materials, you will not get a smoothly 
blended result. 

Creating a Pict Object
A Pict Object is a 2D picture that is applied to a 2D 
finite plane. The object is basically a picture on a 
frame. The Frame is a 2D plane, meaning that it has 
no depth. If you view it from the side, it disappears. 
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Using a Pict Object is a quick way of creating very 
complex-looking objects. The only limitation is that 
you can view them from only one angle, so the 
front of the Pict Object must always be facing the 
camera.

The Alpha channel of the object can be used to 
create transparencies in the Pict Object.

This object was created using a 2D Pict Object....

however, if you move the camera, the 2D nature of the object is 
very obvious.

A good way of ensuring that your 2D Pict Object 
never appears distorted is to have it track the 
camera. Refer to “Tracking Objects” on page344 
for more on tracking.

Alpha Channels and Pict Objects
The picture you use as a Pict Object must have an 
Alpha channel. Refer to “Alpha Channels” on 
page84 for more on Alpha channels.

The alpha channel of your Pict images will allow 
you to specify visible and invisible portions of your 
picture texture.

For example, you can clip out a picture’s 
background so that only the main object in the 
picture is visible.

This is what the car image looks like with and without an alpha 
channel applied.

The shadow cast by the image will be in the shape 
of the picture’s alpha channel, which gives a more 
realistic look.

To create a Pict object:

1 Click the Pict Object tool or any empty square 
to open up the Pictures dialog.

The Pictures dialog appears.

2 Click an image square to load an image.

3 If the image you want is not in the library:

• Click the Combination Load button. The 
load image dialog appears.

• Use the dialog controls to locate the 
picture you want to use and click Open.

or

• In another application, copy the picture 
you want to use to the clipboard.

• Access the Pictures dialog and click the 
Paste button. 

The picture is loaded into the first image box 
and its alpha channels are loaded into the 
second box.
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When you load a new picture into the Pictures dialog, the main 
image is loaded into the first box, its alpha channel is loaded 
into the second box, and the combination is loaded into the 
third.

You can invert the alpha channel by clicking 
the invert button

4 Click the OK icon to exit the dialog.

Bryce creates a 2D plane and maps the image 
onto it as a texture. The Pict Object is created 
with the same aspect ratio as the original 
picture.

When you exit the picture dialog, the image is mapped onto a 
2D plane and placed in your scene.

Working with Pictures
Pictures can be used in several ways in Bryce. They 
can be used as 2D Pict Objects or as components in 
materials or gels. 

When you use a picture as an object, it is applied to 
a 2D plane and appears as an object in the Working 
window. Refer to “Creating a Pict Object” on 
page81 for more on creating 2D Pict Objects.

This is what a picture looks like when it is used as an object.

When you use a picture as a material component, 
the image is applied to a material channel, where 
its values are used to drive the value of the channel. 
Refer to “Applying Materials” on page127 for more 
on working with Materials.

This is what a picture looks like when it is used as part of a 
material.

When you use a picture as a gel, the image is placed 
in front of the light and appears as a projection. 
Refer to “Applying Gels” on page284 for more 
ongels.
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This is what a picture looks like when it is used as a gel.

Alpha Channels
Every image contains a number of channels that 
store data about the makeup of the picture. For 
instance, channels can contain masks, colors, or 
bump information.

The alpha channel of an image is its first channel. 
The channel is like a grayscale map that 
accompanies an image that is used primarily as a 
“mask.” Areas in the alpha channel that are black 
(appearing transparent) are ignored by the Bryce as 
it computes the picture. Bryce recognizes and 
computes areas that are white (appearing opaque).

The most common use for alpha channels is to 
mask the contours of a 2D object, separating it 
from any unwanted background information. For 
instance, you may import a picture of a dog. If you 
have created an alpha channel “mask” describing 
the area of the dog as white and the “non-dog” area 
as black, then unwanted cats and mail carriers in 
the original picture’s background will not be seen 
in your rendered image.

This example illustrates how the Alpha channel mask is used to 
eliminate the unwanted areas of an image.

In Bryce, Alpha channels are also used when your 
picture is a component in a material. In this case 
the alpha channel can be used to determine 
everything from the bumps in a material to how a 
surface property is applied on an object. Refer to 
“2D Textures” on page146 for more on using 
pictures in a material.

If you want to use the picture in the library for multi-
ple purposes, you’ll need to make sure that all the 
pictures have an alpha channel.

The Picture Library
The Picture Library stores all the images available in 
Bryce and can be used to catalog pictures. You can 
store and import any number of pictures in the 
library that your system memory and disk space 
will allow. 

With Mask

Without Mask
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There are two ways of accessing the Picture Library. 
The method you use depends on how you’re going 
to use the image.

To access the Picture Library from the Create 
palette:
• Click the Pict Object tool. The library 

automatically opens.

To access the Picture Library from the 
Materials Lab:
1 Select an object.

2 Click the Micon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click on one of the columns in the grid to 
activate a component window. 

4 In the window, click the Pbutton in the 
bottom-left corner. A default picture appears 
in the window.

5 Click the Pink button at the top of the window. 
The Picture Library appears.

To access the Picture Library from the Light 
Editor:
1 Select a light source.

2 Click the Eicon that appears next to the 
object’s bounding box. The Light Editor 
appears.

3 Click the 2D Texture button at the bottom of 
the editor. The library appears.

Previewing Pictures

The three most prominent items at the top of the 
library are the RGB Image, Alpha, and Combined 
preview windows. The first window displays the 
current picture, the second window displays the 
alpha channel associated with the picture, and the 
third displays the resulting picture after the alpha 
channel is combined with the picture.

The three windows at the top of the editor display the RGB 
Image, its alpha channel, and the result of combining the two.

Picture Thumbnails
Below the three preview windows are the picture 
thumbnails that display a small preview of each 
picture in the library. The gray thumbnails 
represent empty slots in the library. When you load 
images, they are added to the first available gray 
slot.

The thumbnails below the preview windows represent all the 
pictures available in the library.

If there are a large number of pictures in the 
library, you can use the scroll bar to scroll through 
all the thumbnails.

To display an image in the library:

• Click on the picture’s thumbnail. The picture 
and its associated alpha channel appear in the 
three preview windows at the top of the 
dialog.

Loading Pictures Into the Library

You can load pictures into the library to create your 
own custom library. Pictures can be loaded into any 
of the three preview windows. If you want to add a 
new picture to the library, you need to load it into 
the last preview window, the Combined Image 
window.

RGB Image Alpha Chan-
nel Preview

Combined 
Image
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When you load a picture into the first window, 
you’re loading only the picture’s RGB (Red, Green, 
and Blue) color information.

The picture loaded into the first preview window 
replaces the currently selected picture in the 
library, so you’re replacing a picture in the library 
with the picture you’re loading.

When you load a picture into the second window, 
you’re loading only the picture’s alpha channel. 

The alpha channel determines which portions of 
the picture are visible. The areas of the picture that 
are transparent appear as a checkerboard pattern.

When you load an image into the Alpha Channel window, the 
black and white alpha channel appears in the window.

Every picture should have an alpha channel 
assigned to it. If the picture does not have an alpha 
channel, the resulting image appears completely 
white.

If your picture doesn’t have an alpha channel, you 
can copy the image from the RGB Image window 
into the Alpha Channel window. This way your pic-
ture won’t appear completely opaque.

The Alpha channel you load does not have to 
necessarily match the image. You can create some 
interesting clipping effects by combining different 
alpha channels and images.

In this example, the image was combined with a different alpha 
channel to create a new clipping effect.

To replace the RGB information in a picture:
1 Click the thumbnail of the picture you want to 

replace.

2 Click the Load button on top of the RGB Image 
window. The Load dialog appears.

3 Use the dialog controls to locate the desired 
image and click Load.

The picture appears in the first preview 
window.

To replace the Alpha channel information in a 
picture:
1 Click the thumbnail of the picture you want to 

replace.

2 Click the Load button on top of the Alpha 
Channel window. The Load dialog appears.

3 Use the dialog controls to locate the desired 
image and click Load.

The picture’s alpha channel appears in the first 
preview window.

To load a new picture into the Library:

1 Click the picture slot in the bottom of the 
library where you want to load the new 
picture.

The Load dialog appears.

2 Use the dialog controls to locate the desired 
image and click Load.

The picture’s thumbnail appears in the picture 
slot.

Copying and Pasting Pictures

Copying and pasting in the Picture Library works 
differently for each of the three image windows. 

When you copy and paste into the first window, 
you’re pasting only RGB color information, so if you 
copy an image from the Combined window, only 
the color information is pasted into the RGB 
window. 
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As with loading, any changes you make in the RGB 
Image window affects the selected image.

When you copy and paste into the second window, 
you’re working with only the Alpha Channel 
information, so any image you paste into this 
window will appear as an alpha channel image (that 
is, black and white). Any changes you make in this 
window affect only the selected image.

When you copy an image from the Combined 
window the entire image is placed on the 
clipboard. Depending on where you paste it, only a 
portion of the image may be used.

When you paste a picture into the Combined 
window, it appears as a color image with 
transparent and solid areas. All pictures are treated 
as color. So if you paste a picture copied from the 
Alpha Channel window in this window, you’ll get an 
RGB representation of the alpha channel image. As 
well, any image pasted into this window creates a 
new picture entry in the library. 

To copy and paste RGB information in a 
picture:
1 Click the Copy button below the RGB Image 

window.

2 Click the Paste button below the window 
where you want the RGB image to appear.

• If you paste the image into the Alpha 
Channel window, it is desaturated and 
used as an alpha channel. 

• If you paste it into the Combined Image 
window, the RGB image becomes a new 
entry in the library.

To copy and paste Alpha Channel information 
in a picture:
1 Click the Copy button below the Alpha 

Channel window.

2 Click the Paste button below the window 
where you want the Alpha Channel 
information to appear.

• If you paste the image into the RGB Image 
window, an RGB representation of the 
alpha channel is placed in the window. 

• If you paste it into the Combined Image 
window, an RGB representation of the 
alpha channel is placed in an empty slot in 
the library.

To create a new picture using RGB color 
information only:
1 Click the Copy button below the RGB Image 

window.

2 Click the Paste button below the Combined 
window. The RGB information is placed in an 
empty slot in the library.

To create a new picture using Alpha channel 
information only:
1 Click the Copy button below the Alpha 

Channel window.

2 Click the Paste button below the Combined 
window. The alpha channel information is 
placed in an empty slot in the library.

Deleting Pictures

When you delete a picture, you remove all the 
image information (including color and alpha 
channel) from the library.

To delete a picture from the library:

1 Click the thumbnail for the picture you want 
to delete. 

2 Click the Delete Pict button.

To delete all pictures from the library:

• Click Delete All.
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Inverting the Alpha Channel

When you invert an alpha channel all the black 
areas become white and the white areas become 
black. This means that all the areas that were 
transparent now become solid and vice versa.

To invert an alpha channel:

• Click the Invert button above the Alpha 
channel window.

The Invert button swaps all the black and white values in the 
alpha channel.

Picture Lists
A Picture List is a file that contains a group of 
pictures. A Picture list can be used to store all the 
pictures used in a given scene, or to store a series 
of pictures you use most often. 

You should also use a picture list to store any pic-
tures you’ve used as part of a material.

There are several Pict texture List files provided as 
samples for your first excursions. 

To open a picture list:

1 Click the Open List button at the bottom of 
the Picture Library. The Open dialog appears. 

2 Use the dialog controls to locate the desired 
list and click Open. The pictures in the list 
appear in the library.

To save a picture list:

1 Click the Save List button at the bottom of the 
Picture Library. The Save dialog appears.

2 Enter a name for the list and click Save. 

Name the list the same as the scene. This way, 
you can easily find the list that belongs to a 
specific scene.

Creating Geometric Paths
A geometric path is an object that acts as a motion 
path for other objects. Geometric Paths do not 
render as objects. 

You can think of these paths as railroad tracks. 
Objects can move along the track but they can’t 
move off of it.

Objects attached to a geometric path can move to any point 
along the path, but they can’t move off it. So their trajectory is 
controlled by the shape of the path.

You can control how an object is constrained to the 
path using the options in the Object Attributes dia-
log.

Geometric paths can be edited just as you would 
any other object. You rotate, position, or scale the 
path using the tools in the Edit palette. You can 
also edit a path by dragging its control points. This 
way you can change the geometry of the paths as 
well as the trajectory of any object attached to it.

Geometric paths are especially useful when you are 
creating motion animations, as they can help you 
create predictable and repeatable motion. 

The other great thing about geometric paths is that 
you can have more than one object attached to it. 
This can be very useful if you want a number of 
objects to move along the same trajectory.
 

You can attach multiple objects to the same path. The motion of 
each object on the path is constrained by the shape of the path. 
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Objects that are attached to the same path can be 
animated at different rates. So, if you can think of 
the objects as different trains on the same track, 
some trains are at the beginning of the track, 
others are in the middle, and some are at the end. 
All the object attached to the path will have the 
same trajectory.
 

All the objects attached to a path have the same trajectory, but 
they can move at different rates. 

For example, this caterpillar is made up cylinders all attached to 
the same path, but they’re moving at different rates, so it looks 
as though the body is slithering.

You can also align objects differently to the same 
path. So object may appear to tilt differently as 
they follow the same trajectory.

Since geometric paths are objects, they can also be 
attached to other paths. Some very complex types 
of motion can be created using this technique.
 

For example, you can simulate the motion of the solar system by 
attaching an object on a circular path to a circular geometric 

path. The object on the circular path would act like a moon 
orbiting a planet which is also orbiting the Sun.

To create a geometric path:
• Choose Objects menu> Create Path.

A default-shaped path object appears in your 
scene.

To convert a motion path into a geometric 
path object:

1 Select an object with a motion path.

2 Choose Objects menu> Create Path.

A path object with the same shape as the path 
you selected is created.

To link an object to a path:
1 Select the object you want to attach to the 

path.

2 Move the cursor over the Link icon that 
appears next to its bounding box.

3 Drag the linking control handle from the 
object to the path object.

Importing Objects
Bryce can open many different file formats, 
including files created in previous versions of Bryce. 
For instructions on importing files as well as a list 
of all import formats, see “Using Bryce with Other 
Applications” on page363.





5
Editing Terrains 

The Terrain Editor can be used to generate a 
grayscale image that is converted into a terrain 
object. It can also be used to edit an existing 
terrain. 

Creating terrains in the Terrain Editor is a two-
step process. First, generate the source of your 
terrain image by using the preset effects, painting 
an image using the paintbrush, or importing a 
picture. Then, use the Terrain Editor’s filtering 
tools to fine-tune the grayscale values in your 
terrain.

To access the Terrain Editor, you must have a 
terrain object in your scene. When the Terrain 
Editor opens, it temporarily replaces the screen 
and displays the current terrain in a two-
dimensional preview and a three dimensional 
preview. The height map that was used to create 
the terrain is displayed in the Terrain Canvas.

You can also animate the creation of a terrain. 
Using the Animation controls available at the 
bottom of the editor, you can change the shape of 
your terrain object over time.
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Creating Terrains
You can create terrains in several ways. You can let 
the editor do all the work of generating a terrain 
based on a series of algorithms, you can use the 
editor’s painting tools to create a custom image, or 
you can import an image into the editor. 

When you generate a terrain, you use the Terrain 
Editor’s Elevation tools, which include dozens of 
effects optimized for the purpose of heightening 
realism in Bryce terrains. 

When you paint a terrain you use the editor’s 
grayscale paintbrush to paint a topographical 
image. The image is then converted to a terrain 
object.

You can also create a terrain by importing a picture 
into the editor. The picture is converted to 
grayscale and used to generate altitude values.

Creating Landscapes
When you’re planning the shape of your terrain, 
keep in mind the kind of landscape you want to 
create. You don’t have to create all the land in your 
scene as a single terrain. You can create complex 
landscapes by combining several terrain objects. 

Before creating terrain objects, plan out the entire 
map of your landscape. Then you’ll be able to see 
where different terrain objects might be combined 
to create a single land mass.

If you have more terrains in your scene, you’ll have 
a bigger scale for the environment. This gives you 
more resolution and a more realistic-looking effect.

Before you start creating terrains you should map out all the 
land masses in your environment...

...then you’ll be able to see where you will need to combine more 
than one terrain to create a specific type of landscape.

Pay attention to where the camera is positioned in 
the scene. Terrains that are closer to the camera 
need to be more detailed than those off in the 
distance.

Animation and Terrain Editing

You can record the process of creating a terrain 
into an animation using the Animation controls. 
Refer to “Animating” on page319 for more on 
animating terrains. Some of the Elevation tools can 
produce unpredictable results when they’re 
animated, so you may want to experiment with 
animating elevations before you create your final 
terrain.
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The Terrain Editor workspace

Features of the Terrain Editor
The Terrain Editor is divided into five sections: 

• Terrain Canvas — displays the grayscale image 
used as a height map

• 3D Preview — displays a three-dimensional 
preview of the terrain you’re working on

• Paintbrush tools — let you adjust the 
paintbrush

• Animation controls — let you set up key 
frames for animating the terrain

• Editing tools — let you generate and edit the 
terrain’s height map 

To open the Terrain Editor:

1 Select a terrain object in your scene.

2 Click the E icon that appears next to the 
terrain object, 

Paintbrush controls Terrain Canvas 3D Preview

Animation controls Editing tools
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or choose Objects menu>Edit Object, 

or click the Edit text button to open the Edit 
palette, and then click the Edit Terrain tool,

or press Command/Ctrl+E.

Terrain Canvas

The Terrain Canvas displays the grayscale image 
that is used to create the terrain object. You can 
think of the Terrain Canvas as a top view of the 
terrain object you’re creating. The Terrain Canvas is 
where you paint the height map for your terrain. 

To set Terrain Canvas options:

• Click the triangle icon in the top right corner 
of the Terrain Canvas and choose an option 
from the menu:

Set Preview Size lets you change the size of 
the Terrain Canvas frame. You can choose from 
five preview sizes.

Visible Brush lets you turn the circle of the 
brush on and off.

Solid applies volumetric materials to the 
terrain. Even if you are not using volume 
materials, this selection causes the material to 
render as a solid.

Smooth allows a smooth rendering of the 
terrain. If this is not selected, the terrain is 
faceted. 

Keep Gradient makes the gradient the terrain’s 
diffuse color. 

Export lets you save a terrain in a variety of file 
formats. You can then import a saved terrain 
into another 3D application or a different 
Bryce scene. 

You can also access a number of tools in the Terrain 
Canvas, including the gradient strip, the bracket, 
controls for color mapping, the Zoom Area control, 
and the Brush Mode selector.

To access a tool in the Terrain Canvas:
• Click the menu icon at the top right of the 

Terrain Canvas. The Terrain Canvas tool area 
will open up. 

The right side of the Terrain Canvas tool area 
contains a gradient strip and bracket for clipping 
operations. In the bottom right corner, you will 
find controls for color mapping. Refer to “Adding 
Color to Terrains” on page113 and “Clipping 
Terrains” on page114 for more on these tools. 

Across the bottom of the Terrain Canvas tool area, 
you will find a Brush Mode selector and the Zoom 
Area controls. Refer to “Using the paintbrush” on 
page106 and “Using the Zoom Area” on page98 
for more on these tools.

3D Preview

The 3D Preview displays a terrain object based on 
the image in the Terrain Canvas. As you edit the 
terrain image, the preview updates to show the 
result of your changes.

The 3D Preview has several options that control 
how the preview updates and displays.

To set 3D Preview options:

• Click the triangle icon in the top right corner 
of the 3D Preview and choose an option from 
the menu:

Set Preview Size lets you change the size of 
the 3D Preview frame. You can choose from 
four preview sizes.

Flat Preview is the default preview type. In Flat 
Preview, you see a basic rendered preview of 
the terrain using a plain grayscale material 
with basic shading and lighting.
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Rendered Preview displays a fully rendered 
view of the terrain, including any materials you 
have applied.

Auto Rotate sets the 3D Preview to rotate 
when it is in Flat Preview mode. The 3D 
Preview updates as it turns.

Realtime Linking connects all terrain editing 
to the 3D Preview. Every change you make is 
applied simultaneously to the Terrain Canvas 
and the 3D Preview.

RIP To Screen displays a full-screen preview of 
your terrain. Clicking anywhere will return you 
to the main Terrain Editor. Use Command/
Ctrl+W to toggle in and out of this mode.

The preview of your terrain can be rotated so that 
you can see your terrain object from different 
angles.

To rotate the terrain preview:

• Click and drag the preview object in the 
direction you want to rotate the terrain.

Paintbrush controls

Although you can create some very spectacular 
terrains using just the elevation tools, there are 
times when you want to create a precise Terrain 
Canvas. The Terrain Editor’s Paintbrush lets you 
paint any type of terrain you wish. Using the 
Paintbrush, you can re-create real-world 
topographical maps or design landscapes with 
specific contours.

The Paintbrush controls let you select the size, 
hardness, flow, and level of the Paintbrush, as well 
as control the resolution of the grayscale data.

Paintbrush size
The Paintbrush size control lets you select the size 
of the Paintbrush.
 

To change the Paintbrush size:
• Drag left or right over the Paintbrush size 

control. Dragging towards the center 
decreases the Paintbrush size while dragging 
away from the center increases the Paintbrush 
size.

Paintbrush hardness
The Paintbrush hardness control lets you choose 
how hard to make the edges of the Paintbrush. A 
hard Paintbrush has sharp edges and will create a 
very vertical effect such as a cliff edge. A soft 
Paintbrush has feathered edges and will blend more 
with the existing terrain, providing a more gently 
sloping effect.

To change the paintbrush hardness:

• Drag left or right over the Paintbrush hardness 
control. Dragging towards the center increases 
the hardness of the Paintbrush, while dragging 
away from the center makes the Paintbrush 
softer.

Paintbrush flow
The Paintbrush flow control lets you set the density 
of the grayscale value being applied by the 
Paintbrush.

To change the Paintbrush flow:

• Drag left or right over the Paintbrush flow 
control. Dragging left decreases the flow, 
while dragging right increases the flow.
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Paintbrush level
The Paintbrush level control lets you set the 
grayscale value of the Paintbrush. Darker values 
produce lower terrain while lighter values produce 
higher terrains.
 

To change the Paintbrush level:
• Drag up or down over the Paintbrush level 

control. A small red dot in the middle of the 
control indicates the current level.

Grid selector
The grid selector controls the resolution of the 
grayscale data in the terrain. 
  

The terrain’s resolution determines the amount of 
detail in your terrain. The higher the resolution, the 
more detail appears in your terrain’s surface. 
However, higher resolution values also increase the 
rendering time for your scene and require more 
memory.

The highest resolutions should be reserved for 
terrains that are very close to your camera or where 
detail is important. For terrains that are far away, 
or where detail is not so important, lower 
resolutions are more appropriate. 

To set the Terrain resolution using the Grid 
selector:
• Click the Grid selector icon at the bottom of 

the Paintbrush controls and choose a 
resolution from the menu.

Brush sizes may appear to vary depending on your 
resolution, but in fact they remain proportional to 
the size of the Terrain Canvas. 

Animation Controls

The Animation controls at the bottom of the editor 
let you create key frames for your terrain. Any 
change you make to the geometry of the terrain 
can be stored in a key frame and animated.

The Animation controls let you create key frames for the terrain 
so you can animate the terrain editing process.

The Timeline that runs along the bottom of the 
editor displays the length of the animation. The 
Current Time Indicator within the timeline lets you 
set the current time of the animation. 

The buttons in the Animation controls let you 
preview the animation. The buttons beside the 
Preview controls let you add and delete key frames 
from the Timeline.

Using Terrain Editor Tools
The Editing tools are organized in three tabs:

• Elevation — contains tools for generating 
terrains, and applying effects.

• Filtering —  contains tools for fine-tuning the 
gray levels in your Terrain Canvas. 

• Pictures —  contains tools for importing a 
picture to use as a height map.

To access a tab:

• Click the tab label. The tools associated with 
that tab move to the front. By default, the 
Elevation tools are in front.

Most of the tools in the Terrain Editor are displayed 
as control dots. These dots let you apply an effect 
or operation to the terrain gradually or at 100%. 

Current Time Indicator

Preview controls

Key Frame controls
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To apply an editing tool to the Terrain 
Canvas:
1 Move the cursor over the tool you want to use.

2 Do one of the following:

• To apply an effect or operation at full 
strength, click the control dot once. 
Clicking a tool more than once applies 
the effect in 100% increments.

• To apply an effect gradually, click and 
drag over the control dot. 

Starting a New Terrain
By default, when you open the Terrain Editor, the 
terrain you selected in the Working window 
appears in the Terrain Canvas. If you want to begin 
with a new, flat Terrain Canvas, use the New 
button.

To create a new Terrain Canvas:

1 Click the Elevation tab. 

2 Click the New button.

or press Command/Ctrl+N.

A flat black image appears in the Terrain 
Canvas.

To gradually flatten your terrain:
• Click and drag to the right over the New 

button.

The existing Terrain Canvas gradually fades to 
black.

Many of the effects in the Elevation tab require gray-
scale values. If you apply these effects to a black map 
they may have no effect. 

To reset your terrain:

• Hold down Control and click the New button. 

The Terrain Canvas is reset to the terrain that 
appeared when you first opened the editor.

Inverting Terrains
Since the Terrain Editor uses brightness to 
determine altitude, you can change mountains into 
canyons by inverting the black and white values in 
your image. 

To invert your terrain image:

1 Click the Elevation tab. 

2 Click the Invert button, or press Command/
Ctrl+I.

All the black areas of your image become 
white and white areas become black.

To gradually invert your terrain image:
• Click and drag to the right over the Invert 

button.

The black areas in the Terrain Canvas 
progressively turn white.

Undoing Operations
You can reverse any effect you apply to your terrain 
using the Undo  button. You can toggle between 
Undo and Redo by clicking the Undo button 
repeatedly.

To undo operations in the Terrain Editor:
1 On the Elevation tab, click the Undo button, or 

press Command/Ctrl+Z

The last operation you applied is undone.

Eroding Terrains
Erosion simulates the effects of water erosion on 
your terrain objects. The calculations simulate 
rainfall and runoff based on the shades of gray 
progressing towards black. This effect works best 
on terrains that have large sloping areas.

The Erode button simulates the effects of erosion 
over relatively short periods of time, like decades. 
To simulate the effects of centuries of erosion, use 
the Eroded tool.
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This is what a terrain looks like before you apply the Erode 
effect. Notice that this image map has sloping areas that will 
make the erode effect more visible.

This is the same terrain after the Erode effect is applied. You can 
see how the surface now contains tracks created by running 
water.

To erode terrains:

1 Click the Elevation tab. 

2 Click the Erode button. To gradually apply 
erosion, click and drag while the pointer is 
over the Erode button.

Using the Zoom Area
When the Zoom Area is active, only a small portion 
of your terrain is displayed in the 3D Preview. The 
3D Preview displays the zoomed-in portion of your 
Terrain Canvas. You can use this feature to see 
small variations in the surface of your terrain. The 
Zoom Area can be moved to any point on your 
Terrain Canvas.

Use the Zoom Area to see a close up of an area in your Terrain 
Canvas in the 3D Preview. 

You can always paint while the Zoom Area is active; 
in fact this is a nice way to paint in the Terrain 
Canvas while previewing a small section in the 3D 
Preview to observe details.

To turn the Zoom Area on or off: 
• Click the Zoom Area button in the Terrain 

Canvas tool area.

This toggles a marquee on your Terrain 
Canvas. 

To move the Zoom area:

1 Move your pointer over an edge of the Zoom 
Area marquee. The pointer changes to a hand 
tool.

2 Drag the marquee to an area in the Terrain 
Canvas.

To resize the Zoom area:

1 Move the pointer over a corner of the Zoom 
Area marquee. The pointer changes to an 
arrowhead cursor.

2 Drag away from the center of the marquee to 
enlarge the Zoom Area, or towards the center 
to shrink the area.



Bryce5 99

To scale the zoom area to fill the Terrain 
Canvas:
• Click the Crop button below the Zoom Area 

button in the Terrain Canvas tool area.

The contents of your Zoom Area are scaled to 
fill the entire Terrain Canvas area. The Zoom 
Area contents replace the existing contents of 
the Terrain Canvas. 

This feature can be useful for creating new terrains 
from larger high-resolution terrains.

To fit the contents of the Terrain Canvas into 
the Zoom Area: 

• Click the Fit text button below the Zoom Area 
button in the Terrain Canvas tool area.

The entire contents of your Terrain Canvas are 
scaled down to fit into the Zoom Area marquee. 
The rest of the Terrain Canvas is filled with black.

Elevation Tools
The Elevation tools are preset effects that apply 
calculations to your Terrain Canvas. The tools are 
divided into three categories on the tab: Source 
Generator, Basic Tools, and Special Effects.

Source Generators create basic terrain surfaces. 
The Basic Tools edit the overall shape of your 
terrain, and Special Effects add realism to your 
terrain’s surface.

You can create a terrain by combining effects. For 
example, you can start off creating a basic terrain 
using the Fractal tool, then create realistic ridges 
by applying the Erode tool. From there you can 
fine-tune your terrain by applying Spikes, creating 
Mounds or adding Cross Ridges. Finally, you can 
define the basic shape of your terrain by blurring 
the edges. 

To use an elevation tool:
1 Click the Elevation tab. 

2 Click an effect tool. 100% of the effect is 
applied to the Terrain Canvas.

3 Click the tool again to increase the intensity of 
the effect.

Most elevation effects can also be applied 
gradually. 

To apply an elevation effect gradually:
1 Move the pointer over an Elevation tool. The 

pointer changes to a two-headed arrow.

2 Click and drag to the left to increase the effect 
or click and drag to the right to decrease it.

Fractal
The Fractal tool creates terrains based on fractal 
patterns. It can be applied to an existing image and 
it can be applied gradually.

The Fractal tool produces terrains based on fractal patterns. The 
terrains it creates tend to have lots of spikes and valleys. This 
tool produces good basic terrains.

Eroded
This tool applies natural erosion to your terrain. It 
can be applied to either a blank image or an 
existing image. You can also gradually apply 
erosion to an image. The Eroded tool is a more 
intense version of the Erode tool.

Notice that when animating this type of terrain, 
material is actually added to the terrain, not 
removed from it as you might expect.
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This tool produces terrains based on eroded land. The terrains 
produced by this tool have deep grooves and canyons.

Picture
This tool creates terrains from imported images. 
When you click this tool, the Open dialog appears. 
You can use this dialog to locate and load a picture 
to use as a Terrain Canvas. Refer to “Working with 
Pictures” on page83 for more information.

You can produce terrains based on a picture. You can import 
image maps created in other graphics applications. 

Using this tool you can import an image map 
created in another application like Painter or 
Photoshop. 

Raise/Lower
This tool adjusts the brightness of your Terrain 
Canvas. Click and drag to the right to lower your 
height map or click and drag to the left to raise it. 
Single clicks gradually lower themap.

This tool adjusts the brightness of your Terrain Canvas, which 
raises or lowers the height of the entire terrain.

Sharpening
This tool sharpens the gray values in your Terrain 
Canvas. Click and drag left to increase sharpening 
and right to decrease it.
 

This tool sharpens the Terrain Canvas gray values. You can use 
smoothing to create spikes or ridges.

Smoothing
This tool blurs the Terrain Canvas. Click and drag 
right to decrease the blurring effect or left to 
increase it. 

Smoothing is especially effective prior to using the 
Erode button, since the Erode algorithm works best 
when there are shades of gray in an image. If your 
canvas has too many sharp black to white 
transitions, the Erode may not be as effective.



Bryce5 101

The Smoothing tool blurs your Terrain Canvas creating 
smoother black to white transitions.

Gaussian Edges
This tool does not blur your map. It creates a 
“Gaussian curve” from dark to light, starting from 
the edges of your Terrain Canvas. This creates 
edges that gradually transition from dark to light, 
or start at the lowest possible altitude, and 
gradually progress into higher altitudes. 

Gaussian Edges eliminates the seams between 
ground and terrain objects, when the ground plane 
and the terrain have the same surface material. You 
should apply this tool to any terrain that is going to 
be sitting on a ground plane in your scene.
 

This tool creates gradually ascending edges on your terrain 
which can create a smooth transition from the ground plane of 
your scene to the terrain.

Square Edges
This tool creates an abrupt drop at the edges of 
your terrain. Use this tool when you have a terrain 
whose edges are not level, and you do not wish to 
use the Gaussian Edges tool for soft transitions.

This tool creates an abrupt drop at the edges of your terrain. 
Use Square Edges to level the edges of a terrain.

You can add a slope to the square edges of your 
terrain by applying this tool gradually. Click and 
drag left to increase the slope and right to decrease 
it. 

Round Edges
This tool creates an abrupt circular drop at the 
edges of your terrain. You can add a slope to the 
round edges of your terrain by applying this tool 
gradually. Click and drag left to increase the slope 
and right to decrease it.

This tool creates an abrupt circular drop at the edges of your 
terrain. Use Round Edges to create a circular base for your 
terrains.
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Basic Noise
This tool adds roughness to your terrain’s surface 
by adding noise to the Terrain Canvas. Click and 
drag left to increase the noise and right to decrease 
it.

This tool adds roughness to your terrain’s surface. Use Basic 
Noise to create rocky mountains.

Slope Noise
This tool adds roughness to any sloping surfaces in 
your terrain. Click and drag left to increase the 
noise and right to decrease it.

Slope Noise has no effect on flat surfaces. More 
noise is added to steep slopes.

This tool adds roughness to the sloping surfaces of your terrain.

Height Noise
This tool adds small amounts of noise at lower 
altitudes and more noise at higher altitudes. Click 
and drag left to increase the noise and right to 
decrease it.

This tool adds a little roughness to your terrain’s surface at 
lower altitudes and more at higher altitudes.

Image Filtering Effects

These tools, located below the Noise tool, apply 
filters to your terrain that act like image filters. 
They can change the look of the terrain without 
altering its basic shape.

Spikes
This tool adds spiky structures to your map. When 
you apply the right material to these structures 
they can look remarkably like trees when viewed 
from a distance.

This tool adds spikes to your terrain’s surface. Use Spikes when 
you want to add trees to your terrain.
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Mounds
This tool adds midsized splotches to your canvas. 
You can use this tool to create the appearance of 
stones or boulders under transparent water planes.

This tool adds splotches to your Terrain Canvas that look like 
boulders on flat surfaces or towers on sloped surfaces.

Dampen
This tool works like a contrast control. It will push 
gray values towards either black or white 
depending on where the gray value falls in the 
black/white range. Less than 50% goes to black, 
greater than 50% goes to white.
 

This tool controls the contrast of your Terrain Canvas. Use 
Dampen to create abrupt drops and valleys.

Equalize
This tool acts like the Equalize function you may 
have seen in 2D image editing applications. It 
redistributes gray values in your Terrain Canvas 
such that a full range from black to white is present 
in your canvas. 

This tool equalizes black and white values in your Terrain 
Canvas. Use Equalize to eliminate sharp ridges or deep valleys.

Posterize
This tool stratifies the gray levels in your Terrain 
Canvas, resulting in stair-stepped terrain structures. 
This is a good tool for creating desert plateaus.

Use Posterize to create stair-stepped desert plateaus or paddy 
fields on the side of a mountain.

Mosaic
This tool is not a button on the Elevation tab. To 
use this tool, hold down Opt/Alt as you drag over 
the Posterize button. 

Mosaic creates highly pixelated square structures 
based on the gray content of your canvas. 

This tool is excellent for instant cityscapes. Try 
adding one of the sci-fi city materials from the 
Preset Materials Library to a Mosaic terrain.
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This tool pixelizes your Terrain Canvas. Use Mosaic to create 
cityscapes.

Sawtooth
This tool modifies your Terrain Canvas based on a 
sawtooth waveform structure. The results look like 
desert canyons and icebergs.

This tool creates desert canyons or icebergs.

Subcontours
This tool works like a contrast control with the 
threshold set almost at white. Most values are 
pushed to black while only the very lightest are 
pushed to white. Subcontours produces spiky 
peaks with very low, gently sloping contours.

This tool produces spiky peaks with sloping contours.

Blob Maker
This tool creates a smooth, circular structure within 
your existing Terrain Canvas. Click and drag left or 
right to change the size of the structure. Click and 
drag up and down to set the vertical location of the 
structure. 

This tool creates circular structures within your Terrain Canvas.

Relief Noise
This tool acts like an emboss effect. It will emboss 
the grayscale data in your canvas and convert it to 
height information.
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This tool embosses the grayscale data in your Terrain Canvas.

Raise Edges
This tool acts like an inverted version of the Square 
Edges tool. It creates abrupt increases in altitude at 
the edges of your terrain.

This tool creates abrupt increases in altitude at the edges of 
your terrain.

Subplateaus
This tool smears your grayscale data in one 
direction while averaging the gray values. The 
result is natural structures not unlike those created 
by the Mounds effect, except that these structures 
are more directly related to your original graydata. 

Because it creates boulder-like structures, this tool 
is good for making tidepools.

This tool creates boulder-like structures within your Terrain 
Canvas.

Cross Ridges
This tool creates sharp ridges in a cross pattern. It 
creates very interesting canal-like structures.
.

This tool creates canal-like structures within your terrain.

Cross Ridges 2
This tool is the inverse of the Cross Ridges tool. 
Instead of creating canals, it creates peaks.
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This tool creates peak-like structures within your Terrain 
Canvas.

Bubble Ridges
Similar to the Blob Maker, the spherical structure 
this tool creates is of a consistent size. Dragging 
this button allows you to place the structure 
anywhere you like in your canvas.

This tool creates a spherical structure within your terrain that 
can be placed at any point in your canvas.

Using the paintbrush
While you’re painting, you may want to re-create a 
specific altitude in different parts of the terrain. If 
you’ve changed the brush settings, re-creating a 
specific altitude can be quite difficult. However, 
using the Height Picker tool, you can quite easily 
re-create altitudes by picking up gray levels from 
different parts of your image and applying them to 
the brush. 

To pick up gray levels from the terrain image:
1 While holding down the spacebar, move the 

cursor over the Terrain Canvas and click the 
desired altitude color. The color is applied to 
the brush.

2 Drag the brush over a different area of the 
canvas. The altitude color you picked up is 
applied to the new area. 

Brush Behaviors
The Paintbrush in the Terrain Editor paints 
elevations by default, but this is not the only way of 
painting using the brush. You can also set the brush 
to paint effects. This lets you apply elevation effects 
locally, or to increase/decrease existing gray levels 
in your Terrain Canvas.

To paint elevations:

1 Click the Menu icon on the Terrain Canvas.

2 Click the triangle icon below the Brush 
Behaviors heading and choose Elevation from 
the menu.

The brush paints in shades of gray that are 
then used to generate altitudes. This is the 
default brush behavior.

To apply an effect locally:
1 Click the Menu icon on the Terrain Canvas.

2 Click the triangle icon below the Brush 
Behaviors heading and choose Paint Effect 
from the menu.

3 Click the Elevation tab in the Editing tools 
palette.

4 Hold down the Spacebar and click the 
Elevation effect you want to paint.

5 Drag the paintbrush over an area of your 
canvas. 

To remove an effect locally:

1 Click the Menu icon on the Terrain Canvas.
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2 Click the triangle icon below the Brush 
Behavior heading and choose Unpaint Effect 
from the menu.

3 Drag the paintbrush over an area of your 
canvas where you applied an effect locally. 

The Unpaint Effect brush only affects areas 
where you applied an effect with the 
paintbrush. 

An effective way of using this brush is to paint 
an effect in broad, easy strokes, and then 
selectively unpaint areas of effect.

To erode areas of your terrain:

1 Click the Menu icon on the Terrain Canvas.

2 Click the triangle icon below the Brush 
Behaviors heading and choose Erode from the 
menu.

3 Drag the paintbrush over the area you want to 
erode. 

The paintbrush applies the erosion effect to 
the area painted over.

To lighten gray levels:
1 Click the Menu icon on the Terrain Canvas.

2 Click the triangle icon below the Brush 
Behavior heading and choose Maximum from 
the menu.

3 Drag the paintbrush over an area you want to 
lighten. 

In this mode, gray levels in your canvas that 
are below the current gray level are lightened 
to match the current level. Values above the 
current level setting are untouched.

To darken gray levels:
1 Click the Menu icon on the Terrain Canvas.

2 Click the triangle icon below the Brush 
Behavior heading and choose Minimum from 
the menu.

3 Drag the paintbrush over an area you want to 
darken. 

Gray levels in your canvas that are above the 
current gray level are darkened to match the 
current level. Values below the current level 
setting are untouched.

Modifying Brush Behavior

The Option/Alt key can modify the behavior of the 
paintbrush on-the-fly.

• In Elevation mode, Option/Alt inverts the gray 
level. For example, if you’re painting white, 
holding down Option/Alt will paint black.

• In Paint Effect mode, the Option/Alt key will 
toggle to Unpaint Effect mode. 

Hold down Shift to constrain the pen movements to 
45 degree steps.

Filtering Terrains
Filtering is the process of adjusting the grayscale 
curve of your Terrain Canvas. By adjusting the 
grayscale curve, you create a custom elevation 
effect. 

How Filtering Works
The Filter area is essentially a graph that represents 
gray level input from black to white horizontally, 
and gray level output from black to white vertically. 
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The Filtering graph expresses all the input and output gray 
values in your Terrain Canvas.

The default diagonal filter creates a graph where all 
values input as black are also output as black, and 
all values input as white are also output as white. 
That is why your Terrain Canvas appears 
unchanged—none of its gray level values have been 
altered.

By dragging in this Filter area, you can remap the 
gray values in your Terrain Canvas.

To see how filtering works:
1 Place your cursor (which changes to a Pen 

within the Filtering area) in the top left corner 
of the Filter Area.

2 Drag diagonally to the bottom right corner. 

3 Click Apply.

As you can see in the Preview area, your Terrain 
Canvas is inverted. 

The original graph showed that all values input as 
black were output as black and all the values input 
as white were output as white.

In the original Filtering graph all values input as black are 
output as black and all values input as white are output as 
white.

The new graph you created now shows that all 
values input as black are output as white and all the 
values input as white are now output as black. In 
other words all the dark values are light and all the 
light values are dark.

In the new Filtering graph all values input at 0 are output at 
255 and all values input at 255 are output at 0.

This is a drastic example. In most cases you would 
adjust more selectively, like lightening the midtone 
grays or darkening specific gray values. Remember 
that this graph represents your Terrain Canvas, so 
you’re changing the shape of your terrain object as 
you adjust gray values.

Darkest Gray Value 
Input

Lightest Gray 
Value Input

Darkest 
Gray 
Value 
Output

Lightest 
Gray 
Value 
Output

In this area, the darkest 
(black) gray levels are 
output as black.

At this point, the darkest 
(black) gray levels are 
output as white.



Bryce5 109

The Filtering Tab
The Filtering tab is divided into three areas: the 
Filtering Graph, the Preview area, and the Filtering 
Presets.

Use the Filtering tab to edit the Filtering graph and apply 
filtering presets.

The Filtering graph displays your Terrain Canvas’s 
gray levels as value inputs and outputs. You can 
edit this graph to adjust the gray level values in 
your canvas.

Next to the graph is the Preview area. This area 
shows you what your Terrain Canvas would look 
like if applied to the current Filtering graph.This 
area automatically updates as you make changes to 
the graph.

Along the top of the tab are the nine Filtering 
presets you can apply to the graph. Each preset 
represents a different predefined graph. They are 
designed to create specific changes in gray levels, 
like smooth gradients and abrupt transitions.

Working in the Filtering Tab

Altering the Filtering Graph

The best way to start adjusting the Filtering graph 
is to determine the type of effect you want to 
create. For example, if your canvas is too dark, raise 
the value of the darker gray value inputs by 
drawing a ridge in the left side of the graph.

Drawing a ridge on the left side of the graph...

...raises the value of the darkest grays in your Terrain Canvas.

To alter the Filtering graph:
1 Click the Filtering tab.

2 Drag your pointer over the area of the Filtering 
graph you want to adjust.

When you drag over a black area, the pencil 
draws in gray; dragging over a gray area draws 
in black.

Tracing over any lines you’ve drawn erases 
them.

To undo all changes to the Filtering graph:
1 Click the Filtering tab.

2 Click the Reset text button below the Filtering 
graph.

Preview AreaFiltering Graph

Filtering Presets

Before

After
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The graph returns to the default Filtering 
graph.

To soften harsh transitions in the graph:

1 Click the Filtering tab.

2 Click the Smooth text button below the 
Filtering graph.

3 Click the Smooth button again to soften the 
transitions more.

Applying Presets

Filtering presets are provided to help you get 
started adjusting the Filtering graph. These presets 
are designed to provide different effects. The best 
way to understand these presets is to apply them to 
your graph and see what happens.

To apply presets:

1 Click the Filtering tab.

2 Click one of the preset buttons along the top 
of the tab. The current graph is replaced with 
the preset graph.

Applying Filtering Changes to Your Terrain 
Canvas

Although any changes you make to the graph are 
applied to the Preview area, they do not 
automatically affect your Terrain Canvas. You have 
to apply the changes before they affect the canvas. 

You can temporarily apply your changes to the 3D 
Preview in real-time by holding down Control/Ctrl 
as you click and drag over the Filtering graph.

To apply the Filtering graph to the 3D 
Preview:

• Click and hold the mouse button over the filter 
graph preview. The 3D Preview updates. 

When you release the mouse the 3D Preview 
switches back to the unfiltered terrain.

To apply filtering changes to the Terrain 
Canvas:
• Click the Apply text button beneath the 

Preview area.

Blending the Filtering Graph With the Ter-
rain Canvas

The Filtering Tab offers several ways of applying 
your Filtering graph to the Terrain Canvas. You can 
apply the graph directly or you can blend the graph 
with the canvas.

When you use a blending option you’re essentially 
drawing a grayscale gradient and then blending it 
with your original canvas. 

This terrain was altered by directly applying a filtering effect.

This terrain was altered by blending a filtering effect with the 
original canvas.
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To blend the Filtering graph with the Terrain 
Canvas:
1 Adjust the Filtering graph to achieve the 

desired effect.

2 Click the triangle icon below the Filtering 
graph and choose an option from the menu: 

• Horizontal horizontally blends your 
Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas.

• Vertical vertically blends your Filtering 
graph, expressed as a grayscale gradient, 
with your Terrain Canvas.

• Horizontal Add horizontally blends your 
Filtering graph, expressed as a grayscale 
gradient, with your Terrain Canvas.

This option uses a slightly different 
algorithm than the previous Horizontal 
option: it’s not a traditional Additive, but 
an average of the existing terrain grayscale 
values with the maximum of the Terrain 
and Filter values.

• Vertical Add vertically blends your Filtering 
graph, expressed as a grayscale gradient, 
with your Terrain Canvas.

This option uses a slightly different 
algorithm than the previous Vertical 
option: it’s not a traditional Additive, but 
an average of the existing terrain grayscale 
values with the maximum of the Terrain 
and Filter values.

3 Click Apply.

Using Creation Models
Bryce provides a selection of terrain models. When 
you select a terrain from the list of models, you get 
a randomized version of that model.

To access a terrain model:
1 Click the Pictures tab in the Editing tool 

palette.

2 Click Load.

3 Select a model from the menu that appears.

The last model you select becomes the default 
model.

Creating Terrains Using 
Pictures
The Terrain Editor converts grayscale values in the 
Terrain Canvas into altitudes to create terrain 
objects. You can take advantage of this process to 
create unique terrains based on the grayscale 
values in a picture.

The Terrain Editor’s Picture tab lets you import a 
picture into the Terrain Canvas. You can then apply 
elevation effects or filters just as you would to any 
other Terrain Canvas.

The Pictures Tab
The Picture tab has three picture squares and a 
blend control. The first two picture squares let you 
load a picture to use as a terrain and the third 
square shows you the result of combining the two 
pictures. The blend control lets you specify how the 
pictures are combined. 
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Use the Picture tab to load and blend pictures to create unique 
terrains.

Working in the Pictures Tab

Loading Pictures

You can load any two pictures from your system. 
You can also paste images from the Clipboard.

To load pictures:
• Click the Load text button above the picture 

box into which you want to load the picture.

From the Picture button in the Elevation tab, hold 
down the Option/Alt key to load the picture’s color 
data directly into the 3D Preview. This allows you to 
see the interaction between the picture and the gray-
scale-to-height interpretation of its luminance val-
ues. The color data is only for viewing purposes and 
will not render with the terrain.

To copy and paste a picture into the Picture 
tab:
1 In another application, copy the picture you 

want to use to the Clipboard.

2 In the Picture tab, click the Paste text button 
below the picture box where you want the 
picture to appear.

When you use Command/Ctrl+V to paste from the 
Clipboard, the picture always appears in the first 
square. 

Blending Pictures

Once you have a picture in each of the first two 
squares, you blend them to create a third image 
that is used to create the new Terrain Canvas.

To blend pictures:

1 Load pictures into the first two squares.

If you load only one picture a white square is 
used as the second blend image.

2 Click the triangle icon under the third picture 
box and choose a Blend mode from the menu:

• Blend compares each corresponding pixel 
from the first two squares, and displays an 
average of the two in the corresponding 
location of the third square.

• Minimum compares each corresponding 
pixel from the first two squares, and 
displays the darker of the two in the 
corresponding location of the third square.

• Subtract compares each corresponding 
pixel from the first two squares, subtracts 
the brightness value of one from the 
brightness value of the other, and displays 
the result in the corresponding location of 
the third square.

• Add compares each corresponding pixel 
from the first two squares, adds the 
brightness value of one to the brightness 
value of the other, and displays the result 
in the corresponding location of the third 
square.

3 Drag the pointer over the Blend control.

Click and drag to the left to use more of the 
first image in the blend. Click and drag to the 
right to use more of the second image.
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Applying Changes to the Terrain Canvas

Although the result of blending pictures appears in 
the third picture box, it is not automatically applied 
to your Terrain Canvas. 

To apply a picture to the Terrain Canvas:

• Click the Apply text button beneath the third 
picture square.

Adding Color to Terrains
Color in the Terrain Editor is used as a visual aid to 
help you see the relationship between color values 
and altitude. This color only exists in the Terrain 
Editor and is not applied to the terrain object.

You can apply a color gradient to your Terrain Canvas to help 
you visualize the relationship between color values and altitude.

When you apply color in the editor, it maps a 
gradient to the altitudes in your Terrain Canvas. For 
example, if you apply a gradient from blue to 
yellow, blue might represent the lowest altitude 
while yellow may represent the highest. Which 
colors are mapped to which altitudes is left 
completely up to you.

Gradients can be extremely useful when you’re 
filtering terrains, as they emphasize the differences 
between gray levels.

 

You can apply a color gradient to your Terrain Canvas. The 
color gradient also appears in the Filtering tab. This makes it 
easier to see the differences in gray levels.

Mapping Color to Your Terrain Canvas
The Terrain Editor’s color picker contains all the 
gradients you can apply to your terrain. The 
gradient you select is applied to both the Terrain 
Canvas and the 3D Preview.

Use the Color Picker button to choose a color gradient and the 
gradient bar to set color mapping.

To map colors to your Terrain Canvas:
1 Click the Color Picker button in the bottom 

right corner of the Terrain Canvas Frame and 
drag over a gradient in the palette.

Gradient Bar

Color Picker

Color/Grayscale Toggle
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The gradient you select appears in the 
Gradient bar and is mapped to the Terrain 
Canvas and the 3D Preview.

2 Drag the gradient up or down to map the 
colors to altitudes. 

The colors at the bottom of the gradient 
represent the lowest altitude and those at the 
top represent the highest.

The Gradient Bar has two modifiers: 

• Opt/Alt resets the Gradient Bar.

• Command/Ctrl+F flips the colors in the 
gradient.

To return to grayscale:
• Click the Color/Grayscale toggle to switch back 

to the default gray gradient.

Although gradients are meant to be used only in 
the Terrain Editor, you can apply the gradient to 
the terrain’s Diffuse channel. The gradient then 
becomes the terrain’s Diffuse color. This allows you 
to render the gradient with the terrain.

To remove a gradient from a terrain’s Diffuse 
channel:
1 Open the terrain in the Terrain Editor.

2 Click the Color/Grayscale toggle.

Clipping Terrains
Using the Terrain Editor’s clipping controls, you 
determine which values in your terrain are 
rendered as the final terrain object. The Clipping 
controls next to the Gradient bar represent the 
render range for the terrain. Anything outside the 
range included in the brackets will not be rendered. 

You can use these controls to eliminate unwanted 
information from the terrain without altering its 
basic shape. For example, you can keep the main 
terrain while eliminating the black square on which 
it sits.

Using the Clipping Bracket you can eliminate unwanted areas 
from the terrain’s edges. This feature can be useful when you’re 
creating islands. 

The clipping feature is particularly useful when 
editing a Symmetrical Lattice. The maximum lower 
range of the Clipping Bracket determines where the 
two halves of the Symmetrical Lattices are joined.

To set the clipping range:

1 Drag the top of the Clipping Bracket to set the 
maximum upper range. 

Any areas in the Terrain Canvas whose gray 
levels fall outside the bracket’s maximum 
upper range will appear colored to indicate 
they will be omitted from rendering.

2 Drag the bottom of the Clipping Bracket to set 
the maximum lower range. 

Any areas in the Terrain Canvas whose gray 
levels fall outside the bracket’s maximum 
lower range will also appear colored to 
indicate they will be omitted from rendering.

The out-of-range colors for upper and lower limits 
are different, to better enable you to distinguish 
upper and lower clipped areas at a glance. Upper 
out-of-range color is usually yellow, and lower out-
of-range is usually red, though the colors change 
for many of the color maps.

To reset the Clipping Bracket:
• Hold down Option/Alt and click the bracket.
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To move the entire Clipping Bracket at once:
• Click the center of the Clipping Bracket and 

drag up or down.

Terrain objects are hollow, so if you clip the upper 
range off your terrain, you’ll be able to see through 
the top of the terrain to whatever is underneath. To 
make the top solid, you should select Solid from 
the drop-down menu at the top right of the Terrain 
Canvas.

Saving Terrains
Since the terrains you create in the Terrain Editor 
are objects in the scene, you can save any terrain in 
the Preset Objects Library just as you would any 
object. Refer to “Adding and Deleting Preset 
Objects” on page75 for instructions on saving 
objects to the preset library. 

Exporting Terrains
The Export Terrain Lab allows you to convert Bryce 
terrains into polygonal meshes. The Lab provides 
you with full control over the level of detail in the 
polygonal mesh. 

You can adjust the number of polygons with 
realtime feedback so you can instantly see the 
resulting change to your mesh. 

In addition, the Lab allows you to manage the all-
important texture maps so that your exported 
meshes retain the cool look as generated within 
Bryce. 

To access the Export Terrain Lab:

Do one of the following:

• Select a terrain in your scene and go to File 
menu >Export Object, 

or 

• Edit and save a terrain in the Terrain Editor 
and click Export, which is located at the 
bottom of the map view.

Features of the Export Terrain Lab
The Export Terrain Lab is divided into two areas:

• The polygonal mesh previewer with polygon 
count slider.

• The image map controls.

The mesh previewer allows you to instantly 
examine the quality of the current tessellation. 

To manipulate the mesh:
• To rotate the mesh, click and drag in the 

previewer. 

• To zoom the mesh in and out, Command/
Control-click and drag in the previewer. 

• To change the previewer display mode, select 
one of the buttons to the right of the 
previewer. 

Available preview modes are: Wireframe, 
Shaded, Textured, and Textured With 
Wireframe Overlay. 

• To adjust the colors of the wireframe and the 
shaded preview, select the color swatches 
underneath the preview mode buttons. 

• To adjust the polygon count, move the slider 
below the previewer. This changes the quality 
of your mesh. The number of polygons in the 
mesh is displayed in the right bottom corner 
of the previewer.

Preview Options
Selections on the right hand side of the Preview 
window allow you to preview your terrain in the 
following ways:

• Wireframe

• Shaded

• Textured
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• Textured with Wireframe Overlay

Types of Tessellations
You can create two types of tessellations in the 
Export Terrain Lab: Grid and Adaptive.

The default method is Grid Triangulation. The 
initial tessellation is set to 5,000 polygons. If this is 
not sufficient you can add polygons by selecting 
Add Polygons in the drop down menu at the right 
bottom corner of the previewer. 

To switch between tessellation types:

To switch between Grid and Adaptive tessellations, 
click on the triangle to the left of the previewer and 
select the tessellation type.

Grid Tessellations

Grid tessellates the original height field with a grid. 

In order to achieve a good mesh representation of 
the source terrain, selecting Grid requires a large 
number of polygons. This method is suitable for 
geometric shapes. 

Adaptive Tessellations

Adaptive achieves much lower polygon counts with 
good representation of the terrain.

 This is an excellent choice when the terrain models 
natural landscapes. 

Exporting to MetaStream
When exporting to MetaStream, you can select 
additional options: Clamp Minimum and Clamp 
Maximum. 

These options define the lowest and highest 
polygon counts within the multi-resolution mesh. 

To reset the Clamp Minimum and Clamp 
Maximum:

• Select Reset Clamps within the Options menu.

To apply the Clamps:
1 Use the slider to set the desired lower polygon 

count.

2 Select Options menu>Clamp Minimum.

3 Use the slider to set the desired higher 
polygon count.

4 Select Options menu>Clamp Maximum. 

If Clamp Minimum and Clamp Maximum are set to 
the same amount, the MetaStream file will contain a 
single resolution.

Handling Image Maps
The second area of the Export Terrain Lab deals 
exclusively with handling image maps. 

A large part of the appeal of Bryce terrains are 
Bryce materials, which consist of different 
significant properties. Each of these properties can 
be exported, along with their geometry, through 
the Export Terrain Lab. 

The image map controls let you refine which of the 
material properties you wish to export by selecting 
out of the list of ten. By default any material 
properties of the terrain that use image maps will 
be exported. 

Depending on the selected export file format, the 
image maps will be embedded within the export 
file. If, however, the export file format does not 
support embedding of image maps, they will be 
saved as separate image files in the same folder as 
the export file. The filename of each separated 
image will be the name of the export file appended 
with the name of the appropriate material 
property.

To adjust the resolution of the exported image 
maps:
• Select one of the presets in the Size menu. 
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To save the tessellated terrain and all its 
image maps: 
• Click on the OK icon. 

If you do not wish to save, click on Cancel.

To export a terrain:
1 Create a terrain and apply materials.

2 Either select the terrain and go to File>Export 
Object or enter the Terrain Editor and click 
Export.

3 Choose the desired file format and target 
folder.

4 Adjust the complexity of the mesh.

5 Select material properties to be exported as 
image maps.

6 Select image map size.

7 Click the OK icon to cause the tessellated 
mesh to be written to the exported file.

Tips for Speeding Up the Terrain Editor 
on Slower Machines
To speed up performance on slower machines, 
disable both the Realtime Linking and AutoRotate 
options. 

To speed up the Elevation effects, use the single-
click method rather than the click- drag “dial in” 
method, as the latter can be quite slow. 

The larger terrain grid sizes, such as Massive, 
Gigantic, and Planetary, require a significant 
amount of memory and computing power. Only use 
these terrain grid sizes when necessary. If you are 
working on a slower machine, you may experience 
problems such as “out of memory” errors.

When you create a terrain in your Bryce scene, a 
natural impulse is to immediately dress it up with a 
cool material and render it right away to see what 
it looks like. For serious composition, consider 
keeping your terrains free of textural attributes 
until the final stages, as procedural textures take 

longer to render than smooth shaded surfaces. This 
will keep you working rapidly on your composition. 
Then, before your final output, you can take some 
time to design textures for your terrain.





6
Editing Trees

New in Bryce 5 is the ability to create organic tree 
shapes. This lets you add realistic or ‘fantasy’ trees 
to your scenes. You can then customize your trees 
in the Tree Lab by assigning materials, controlling 
the shape of trees, and more. 

Trees have four essential components: the overall 
shape, the trunk, the branches, and the foliage. 
How these elements are shaped and organized 
around each other defines the appearance of the 
tree. 

The overall shape of trees varies greatly between 
species. In general, trees have several feet of trunk 
before they begin to branch out, and the branches 
eventually form a crown. The shape of the tree can 
vary greatly within these criteria. For example, the 
sugar maple has an almost spherical silhouette; a 
poplar tree has a cylindrical shape that tapers to a 
point at the top; and conifers such as pine trees 
have a triangular shape.

The width of the trunk generally indicates the age 
of the tree; however, different species of trees 
have different widths when mature. A birch tree, 
even when quite old, will not have as wide a trunk 
as an oak tree of the same age. The texture of the 
trunk can also be a good indicator of the species 
or age of the tree; the trunk generally becoming 
coarser with age.
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The characteristics of branches, such as their 
thickness, how the branches are arranged on the 
trunk, how they are positioned relative to each 
other, and how they are affected by gravity can also 
vary greatly between species. For example, a 
weeping willow tree has branches that begin 
growing upwards from the trunk but are so thin 
that gravity bends them towards the ground, giving 
the tree a distinctive, drooping appearance. Some 
species of conifers have symmetrically spaced and 
sized branches, giving them a very geometric 
appearance.

Finally, the foliage of the tree is probably the most 
obvious indicator of species. Species of trees have 
greatly varying leaf shapes and colors. Oak and 
ginkgo trees are both easily recognized by the 
distinctive shape of their leaves.

The variations in trees are virtually limitless. You 
need only look at the wide variation found in 
nature for inspiration when creating and 
customizing trees in Bryce.

Working with the Tree Lab
The Tree Lab lets you control the various attributes 
of tree objects. Using the tree lab, you can edit the 
trunk, branches, and foliage of a tree object to 
achieve a particular look. 

You cannot access the Tree Lab unless you have a 
tree object in your scene. When the Tree Lab 
opens, it temporarily replaces the screen and 
displays the currently selected tree object in the 
Tree Preview.

To open the Tree Lab:

1 Select a tree object in your scene.

2 Click the E icon that appears next to its 
bounding box, or choose Objects menu>Edit 
Object. The Tree Lab appears.

Min/Max Sliders
The Tree Lab uses a unique kind of slider for setting 
some of the attributes of the trunk and branches. 
These sliders, called Min/Max sliders, let you set 
both the minimum and maximum values for an 
attribute using the same slider. Bryce will choose a 
random value between the specified minimum and 
maximum when generating the tree.

A Min/Max slider.

To set the maximum value:

• Drag the arrow below the Min/Max slider to 
the desired value.

To set the maximum value numerically:
1 Click the field to the right of the Min/Max 

slider.

2 Type a value in the field.

To set the minimum value:
• Drag the arrow above the Min/Max slider to 

the desired value.

To set the minimum value numerically:

1 Click the field to the left of the Min/Max slider.

2 Type a value in the field.
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Features of the Tree Lab

The Tree Lab is divided into four sections:
• Tree Preview — lets you preview changes to 

your tree.

• Branch/Trunk — lets you control the size of 
the tree trunk; the placement, number, and 
thickness of branches; and the materials used 
for the trunk and branches.

• Tree — lets you control the overall shape of 
the tree, the randomness of the tree, and how 
gravity affects the tree.

• Foliage — lets you control the overall shape of 
individual leaves, the scale and number of 
leaves, the distribution of the leaves, and the 
materials used for the leaves.

Tree Preview
The Tree Preview, located in the center of the Tree 
Lab, displays the resulting tree object based on 
changes you make to the settings in the Tree Lab. 
The Tree Preview does not update automatically; 
after you have made a series of changes, click the 
Tree Preview to update it.

The Tree Preview has two preview modes: Normal 
View and Up Close. Normal View displays the entire 
tree object. Up Close displays a more detailed view 
by zooming in on the tree object.

Branch/
Trunk 
Settings

Foliage 
Settings

Tree Settings

Tree Preview
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There are also two render modes for the Tree 
Preview: Render With Neutral Sky and Render With 
Neutral Ground. These options are enabled by 
default and are designed to speed up the Tree 
Preview rendering.

The Tree Preview.

To update the Tree Preview:
• Click anywhere in the Tree Preview.

To choose a preview mode:
1 Click the triangle below the Tree Preview.

2 Choose a preview mode in the drop down 
menu.

To turn a render mode on or off:
1 Click the triangle below the Tree Preview.

2 Click the render mode in the drop down menu. 
When the render mode has a checkmark 
beside it, it is currently active.

To speed up rendering in the Tree Preview, turn on 
both Render With Neutral Sky and Render With Neu-
tral Ground.

Branch/Trunk Settings
You can use the Branch/Trunk settings located on 
the left side of the Tree Lab to control the thickness 
of the trunk and branches, the distribution of 
branches around the trunk, the number of 

segments, the number of branches per segment, 
the starting and ending angles of the branches, and 
the texture used for the trunk and branches.

Trunk Thickness
The Trunk Thickness slider lets you specify a 
minimum and maximum width of the trunk, from 1 
to 200. The minimum width controls the thickness 
of the twigs at the outermost reaches of the tree 
while the maximum width controls the base of the 
tree.

To set the maximum trunk thickness:
• Drag the arrow below the Trunk Thickness 

slider to the desired value, or type a value in 
the field to the right of the slider.

To set the minimum trunk thickness:

• Drag the arrow above the Trunk Thickness 
slider to the desired value, or type a value in 
the field to the left of the slider.

Branch Thickness
The Branch Thickness slider lets you specify a 
minimum and maximum percentage width for the 
branches, from 1 to 100. This setting doesn’t 
control the actual width of the branches; it is the 
percentage width of child branches. For example, if 
the branch thickness is set to 50%, each child 
branch will be 50% of the width of the parent 
branch it is spawned from. 

To set the maximum branch thickness:
• Drag the arrow below the Branch Thickness 

slider to the desired value, or type a value in 
the field to the right of the slider.

To set the minimum branch thickness:
• Drag the arrow above the Branch Thickness 

slider to the desired value, or type a value in 
the field to the left of the slider.
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Number of Segments
Each branch of the tree is divided into a number of 
segments. Each segment is a location on a “parent” 
branch where “child” branches will be formed. 

To set the maximum number of segments:
• Drag the arrow below the Segments slider to 

the desired value, or type a value in the field to 
the right of the slider.

To set the minimum number of segments:

• Drag the arrow above the Segments slider to 
the desired value, or type a value in the field to 
the left of the slider.

Branches Per Segment
The Branches Per Segment slider lets you specify 
how many “child” branches will be formed in each 
branch segment.

To set the maximum number of branches per 
segment:

• Drag the arrow below the Branches Per 
Segment slider to the desired value, or type a 
value in the field to the right of the slider.

To set the minimum number of branches per 
segment:
• Drag the arrow above the Branches Per 

Segment slider to the desired value, or type a 
value in the field to the left of the slider.

Branch Angles
The starting and ending angles for branches help 
determine the overall shape of a tree. The branch 
start angle is the angle of the branch at the thickest 
part of the tree. The branch end angle is the angle 
of the branch at the thinnest part of the tree. 

To set the branch start angle:
• Drag the Branch Start Angle slider. Drag right 

to increase the angle and left to decrease it.

To set the branch end angle:
• Drag the Branch End Angle slider. Drag right 

to increase the angle and left to decrease it.

Trunk and Branch Texture
You can use a uniform color, an image, or a 
material as the texture for the trunk and branches 
of a tree. All the branches and the trunk of the tree 
will have the same texture; you cannot vary the 
texture for the branches and the trunk.

To use a uniform texture:

1 Click the Uniform button.

2 Click the Uniform Color swatch and choose a 
color from the color picker.

To use an image texture:

1 Click the Image button.

2 Click the Edit button to the right of the Image 
button. The Picture Library appears.

Refer to “Working with Pictures ” on page83 for 
more on the Picture Library.

To use a material texture:

1 Click the Material button.

2 Click the Edit button to the right of the 
Material button. The Materials Lab appears.

Refer to “The Materials Lab” on page160 for more 
on the Materials Lab.

Tree Settings
You can use the tree settings to set the overall 
shape of a tree, and how the tree is affected by 
gravity. You can set the amount of randomness for 
the tree, ensuring that even with the same settings, 
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no two trees will look alike. You can also use the 
Tree Lab’s memory dots to store settings as you 
experiment with different tree attributes.

Tree shape
The overall shape of a tree varies greatly for 
different species of trees. Using the Shape drop 
down list, you can choose a species of tree for the 
overall shape of the tree.

To choose a tree shape:

• Click the Shape drop down list and choose a 
species of tree. 

Gravity
The branches and leaves of a tree can be affected by 
gravity. When gravity is high, the branches of a tree 
will droop and the leaves will be oriented towards 
the ground. When gravity is low, the same branches 
may be more upright, and the leaves may be 
oriented in all directions. The Gravity slider lets you 
specify how much gravity will be applied to a tree.

To set the gravity amount:
• Drag the Gravity slider right to increase the 

amount of gravity and left to decrease it, or 
enter a value in the field.

Randomness
Trees in nature are not perfectly shaped. Two trees 
of the same species growing under identical 
conditions will vary greatly from one another. In 
Bryce, you can control the randomness of a tree so 
that, even with the identical settings, no two trees 
will be identical. The randomness setting affects 
both branch angles and leaf angles.

To set a value for randomness:

• Drag the Randomness slider right to increase 
the amount of randomness and left to 
decrease it, or enter a value in the field.

Saving Tree Lab settings
The memory dots in the Tree Lab let you store your 
favorite Tree Lab settings. Using these dots you can 
safely explore many Tree Lab configurations 
without losing your favorite settings along the way. 
Memory dots appear at the bottom of the Tree Lab.

The memory dots in the tree lab let you store your favorite Tree 
Lab settings.

To save Tree Lab settings:
• In the Tree Lab, click on an empty dot (empty 

dots are gray).

All the current Tree Lab settings are stored in 
the selecteddot. 

To switch to a saved Tree Lab setting:

• Click on a full dot (full dots are blue). The 
current settings are replaced with the settings 
stored in the dot. 

An active dot will be blue with a white point 
inside it.

To reset Tree Lab settings to default:

• In the Tree Lab, click the leftmost memory dot. 
This dot always appears full.

To delete a saved Tree Lab setting:
• Option/Alt+click on a full memorydot.

The leftmost dot cannot be cleared.

Foliage Settings
You can use the foliage settings to control the 
appearance of the leaves on a tree. Using the 
foliage settings, you can choose a leaf shape, size, 
and quantity, and determine how the leaves are 
distributed on the branches. You can also specify a 
texture for the leaves.



Bryce5 125

Foliage shape
The leaves of different species of trees have 
different shapes. The Shape setting lets you choose 
a leaf shape from a drop down list.

To choose a leaf shape:
• Click the Shape drop down and choose a 

species of tree from the list.

Foliage Scale
You can control the size of the leaves on a tree 
using the Scale slider. The Scale slider measures the 
size of the leaves as a percentage of the size of the 
tree.

To choose the size of leaves:
• Drag the Scale slider. Drag right to increase 

the scale and left to decrease it.

Number of Leaves
The Number of Leaves slider lets you choose how 
many leaves will appear on each branch.

To set the number of leaves:
• Drag the Number of Leaves slider right to 

increase the number of leaves and left to 
decrease the number of leaves, or enter a 
value in the field.

Foliage distribution
In nature, different species of trees have different 
arrangements of leaves. Some trees have leaves 
that are clustered together while others have leaves 
that spiral around a branch in an almost 
symmetrical pattern. Bryce offers five different leaf 
arrangements: Stacked, Staggered, Spiral, Bunched, 
and Coniferous.

To choose a leaf distribution:

• Click the button beside one of the following 
options:

Stacked — leaves are arranged in pairs on 
each side of the branch. If there is an odd 
number of leaves, a single leaf will be placed at 
the tip of the branch.

Staggered — leaves alternate on each side of 
the branch. If there is an odd number of leaves, 
a single leaf will be placed at the tip of the 
branch.

Spiral — leaves are arranged around the 
branch in a spiral formation.

Bunched — leaves are clustered at the tip of 
the branch.

Coniferous — leaves are placed along the 
middle of the branch.

Foliage Texture
You can use a uniform color, an image, or a 
material as the texture for leaves of a tree. All the 
leaves will have the same texture; you cannot vary 
the texture of leaves.

To use a uniform texture:

1 Click the Uniform button.
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2 Click the Uniform Color swatch and choose a 
color from the color picker.

To use an image texture:

1 Click the Image button.

2 Click the Edit button to the right of the Image 
button. The Picture Library appears.

Refer to “Working with Pictures ” on page83 for 
more on the Picture Library.

To use a material texture:

1 Click the Material button.

2 Click the Edit button to the right of the 
Material button. The Materials Lab appears.

You can only change the material of the leaves if you 
access the Materials Lab through the Tree Lab. If you 
select a tree and access the Materials Lab or the 
Materials Preset Library from the Edit palette and 
choose a material, the material will only be applied 
to the trunk and branches of the tree.

Refer to “The Materials Lab” on page160 for more 
on the Materials Lab.



7
Applying Materials

Materials are what brings your Bryce environment 
to life. A material defines the surface properties of 
an object in your scene. It has the power to turn a 
bunch of polygons into an island or the peaks of 
the Himalayas. You can also alter the basic 
function of an object. A simple cylinder becomes a 
pillar, a tree trunk or a metal pipe, just by 
adjusting the properties of the material applied to 
it.

In Bryce, a material isn’t just a picture that’s 
wrapped around an object; it’s a truly 3D surface. 
The material properties you assign to an object 
are applied to the whole object—inside and out. 

Bryce’s new volume materials let you apply a 
material to the interior of the object as well as to 
its surface. The Volume Material controls let you 
set how the entire object’s volume reacts to its 
environment. 
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Material Structure
A material is made up of fourteen channels. Each of 
these channels defines a different property of an 
object’s surface. When you combine all the 
channels together you get a material.

A material has fourteen channels that define its surface 
properties. The combination of the values of all the channels 
produces a material.

New materials are created by adjusting the values 
for each channel. 

There are two types of materials you can create in 
Bryce: surface materials, which define the 
properties of an object’s surface, and volume 
materials, which define the properties of an 
object’s volume.

Understanding Surface Material 
Channels
The fourteen channels of a surface material each 
represent a different surface property. These 
properties simulate different physical properties of 
a surface, and the combination defines how the 
object’s surface interacts with light in the Bryce 
environment. 

To understand how the channels work, you need to 
understand a little about how you perceive light 
and color. 

The color and size of an object are determined by 
how the light that hits the object is reflected back 
to your eye. Objects appear green because they 
reflect green light. An object appears shiny because 
it reflects light back at you. 

An object appears transparent because light passes 
through its surface, hits the objects behind it and is 
reflected back through the surface. Bryce’s material 
channels simulate all these behaviors. When you 
set a channel value, you’re setting how your 
object’s surface interacts with the light that hits it, 
whether that light is from a direct source like the 
sun, or an indirect source like light reflected off 
other surfaces.

Material channels simulate the physical properties of an object. 
When you set channel values, you’re defining how the object’s 
surface or volume interacts with light.

When you’re creating volume materials, your 
settings not only control how light interacts with 
the surface of the object, but also how it interacts 
with the object’s volume.

The effects of the channels are additive, meaning 
that each value you set directly affects all the other 
values. So, if you set the Diffuse Color to yellow and 
the Ambient Color to blue, the object will have a 
greenish tint. 

Channels are interdependent. For example, you 
won’t see the effects of the Transparent Color if the 
object is not transparent.

Material Channels

Material

Light Source
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When you’re using these channels it’s important to 
understand the physical property they’re 
simulating. Only in this way can you make 
meaningful adjustments to the component values. 

For example, if you set both Transparency and 
Reflection to 100, you’ll get an unusually bright 
object that doesn’t look very realistic. The reason 
for this is that the object is emitting more light 
than it is receiving, something it couldn’t do in 
reality. 

Since material channels simulate real-world surface 
properties, you should try to keep channel values 
within a realistic range.

For example, here Transparency and Reflection are both set to 
100. With these settings you’re saying that 100% of the light 
that hits the object passes through its surface, and 100% of the 
light that hits the object is also reflected off its surface. 

The result is an object that emits more light than it receives 
because it’s reflecting the light that hits it as well as the light 
from behind it. 

In reality, an object can only reflect a portion of the light that’s 
passing through it. So, Transparency and Reflection values 
should always add up to 100.

A good rule of thumb to keep in mind while you’re 
setting these channels is that the Transparency and 
Reflection channels should always add up to 100, 
and the Diffusion and Ambience values should also 
always add up to 100. 

Each surface material is made up of fourteen 
channels, divided into three groups:

Color channels
• Diffuse Color

• Ambient Color

• Specular Color
• Transparent Color

• Specular Halo

• Volume Color

Value channels
• Diffusion
• Ambience

• Specularity

• Metallicity
• Bump Height

Optics channels
• Transparency

• Reflection

• Refraction

Color Channels

The Color group contains all the channels that 
control the color reflected off an object’s surface. 
The channels in the Color group are Diffuse Color, 
Ambient Color, Specular Color, Transparent Color 
and Volume Color.

Diffuse Color, Ambient Color, and Specular Color 
define the colors the surface reflects when direct 
light hits it. For example, Diffuse Color defines the 
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color that is reflected in all directions when direct 
light hits the object, and Specular Color is the color 
that appears in the object’s highlight. 

These color channels are directly related to the 
Diffusion, Ambience, and Specularity channels. 
Diffusion, Ambience, and Specularity control how 
light reflects off the object, while Diffuse Color, 
Ambient Color and Specular Color control the color 
of that light.

So, for example, if you selected yellow as the 
Diffuse Color, the object appears yellow. The 
intensity of the yellow color is controlled by the 
Diffusion channel. Refer to “Diffuse Color” on 
page134, “Ambient Color” on page136, and 
“Specular Color” on page137 for more 
information. 

Transparent Color sets the color of any light that 
passes through the surface of the object, and 
Specular Halo controls the size of the highlight that 
appears when an object has a shiny surface. Refer 
to “Transparent Color” on page140 and “Specular 
Halo” on page137.

The remaining color channel, Volume Color, 
controls the color of the interior of the object. 
Refer to “Volume Color” on page142 for more 
information. 

Value Channels

The second group of channels, the Value group, 
controls how much light affects an object. The 
channels in the Value group are Diffusion, 
Ambience, Specularity, Metallicity and Bump 
Height.

Diffusion, Ambience, and Specularity define how 
the surface interacts with direct light. They let you 
control how much direct light affects the surface of 
an object. In a physical environment, these 
channels control how shiny, dark, or bright the 
object appears. Refer to “Diffusion” on page133, 
“Ambience” on page135 and “Specularity” on 
page136 for more information.

Metallicity is related to Reflection. It determines 
how much reflected light is filtered through the 
Diffuse Color. Refer to “Volume Material Channels” 
on page142 for more information.

Bump Height controls the height of any bumps or 
dents on the object’s surface. Refer to “Bump 
Height” on page138 for more information.

Optics Channels

The Optics group of channels controls the intensity 
of optical effects produced by the object’s surface. 
The channels in the Optics group are Transparency, 
Reflection and Refraction.

Transparency and Reflection channels control how 
indirect light interacts with the object’s surface. In 
a physical environment, these channels control 
how transparent or reflective the object appears. 
Refer to “Transparency” on page139 and 
“Reflection” on page141 for more information.

Refraction is directly related to Transparency. The 
Refraction channel sets how much the light that 
passes though the object is bent. Refer to 
“Refraction” on page141 for more information. 

Understanding Volume Material Channels
Surface materials define the properties of the 
surface of an object. The interior of the object is 
empty. If you were to fly through the object you 
would see one layer of material, emptiness, and 
then another layer of material. A volume material is 
applied to the entire object, both inside and out. If 
you were to fly through a volume material you 
would be surrounded by material. 
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When you create a volume material, the channels define not just 
the surface of an object, but its volume as well.

When you’re setting channel values for a volume 
material, you’re setting up how light will interact 
with the object’s volume. Channels control whether 
the interior of an object is bright, dark, shiny, or 
transparent. 

In most cases the interior of an object will be filled 
with a texture. If so, the channels control the 
surface properties of the elements within the 
texture. 

For example, if you apply blue spots as a volume 
material, you get a volume filled with blue spheres. 
The channels then control whether those spheres 
are bright, dark, shiny, or dull.

When the interior of an object is filled with a texture, the 
material channels control the surface properties of the elements 
within the texture. 

In this example, the Specularity channel is used to make the blue 
spheres within an object shiny.

Volume materials are made up of thirteen channels, 
divided into three groups:

Color channels
• Diffuse Color
• Ambient Color

• Specular Color

• Transparent Color
• Specular Halo

• Volume Color

Value channels
• Diffusion

• Ambience
• Specularity

Volume channels
• Base Density

• Edge Softness

• Fuzzy Factor
• Quality/Speed

Blue spots become blue spheres when the 
texture is applied as a Volume Material.
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The channels in the Color and Value groups work 
exactly as they do for surface materials, except that 
the channel settings are applied to the object’s 
volume instead of its surface.

Volume Channels
The Volume channels control special volume 
properties of the object’s interior.

Base Density controls the density of the object. 
This channel defines how much material there is in 
the interior of an object. As a result, Base Density 
controls how much light passes into the object. A 
solid object doesn’t allow any light to pass through 
it, while less dense objects allow more light in. 
Refer to “Base Density” on page143 for more.

Edge Softness, Fuzzy Factor, and Quality/Speed 
control the appearance of texture elements within 
the material. Edge Softness and Fuzzy Factor 
control the quality of the edges and sharpness of 
the texture, while Quality controls the render 
quality of the material. Refer to “Edge Softness” on 
page143, “Fuzzy Factor” on page143, and 
“Quality/Speed” on page144 for more.

Understanding Material Components
Each Bryce material channel can contain up to 
three components that determine the channel’s 
setting. A component can be a color, a texture or a 
numerical value. A texture can be either a 2D 
texture (picture) or a 3D texture. 

Each Bryce material channel contains components that 
determine its settings.

You can have up to three texture components in a channel, and 
some channels let you use four textures and a value as 
components.

Colors can only be used in the Diffuse, Ambient, 
Specular Transparent, Specular Halo and Volume 
channels. Values are used in the Diffusion, 
Ambience, Specularity, Metallicity, Bump Height, 
Transparency, Reflection, Refraction, Base Density, 
Edge Softness, Fuzzy Factor, and Quality/Speed 
channels.

When you’re using a texture as a component, the 
information in the texture’s channels is used as the 
value of the material channel. For example, if you’re 
using a texture to set Diffuse Color, the texture’s 
color channel is used. If you’re using a texture to 
set the Diffusion value, the texture’s alpha channel 
determines the Diffusion intensity.

Components are combined using one of three 
modes: Mode A, Mode AB and Mode ABC. In Mode 
A, only one component is used to set the channel’s 
value. In Mode AB, two components are combined 
to set the channel’s value, based on altitudes. The 
values from texture A are applied at low altitude 
and values from texture B are applied at higher 
altitude. 

Component
Color

2D/3DTexture
Value

Channels
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In Mode ABC, the values of two textures, A and B, 
are blended based on the alpha channel of texture 
C.

When you’re using textures as a component, you 
can choose from a number of preset textures, or 
you can open the Texture Editor and create your 
own textures. Refer to “Combining Components” 
on page154 for more information.

In some channels, you can use both a texture and a 
value. In this case, the value determines how much 
of the texture’s value is used to drive the channel. 
For example if you apply a Blue Checkers texture to 
the Bump Height channel, the texture sets the 
shape of the bumps and the value sets how 
prominent those bump appear.

In this example the shape of the bumps on the object is set by 
the texture component in the Bump Height channel, but the 
height of those bumps is set by a value.

A Word About Alpha Channels

One of the outputs a texture component can 
produce is an alpha channel. The alpha channel is a 
grayscale representation of the texture pattern or 
grain. When you use a texture as a component in a 
material channel, these grayscale values are used to 
map surface properties. White areas in the alpha 
channel represent 100% of the effect, and black 
areas represent 0%.

Images, or 2D textures, also contain an alpha 
channel. In images, the alpha channel acts as a 
mask for the image. The image’s alpha channel is 
used in the same way as a texture’s alpha channel.

Surface Material Channels
This section provides details on each of the surface 
material channels.

Diffusion
Diffusion determines how much direct light is 
reflected diffusely, or scattered, in all directions. 

The small arrows projecting off the surface of the object 
illustrate how diffusion works.

When light hits an object with diffusion set to 
100%, all the light that hits it is reflected back 
scattered in all directions. This gives the object a 
flatly lit appearance. If the object’s diffusion is set 
to 0%, no light is reflected off its surface, so the 
object appears black.

Diffusion controls how much light is diffusely reflected off the 
object’s surface.

Direct Light

Viewer

Surface 
reflects light 
diffusely

Diffusion set to 0% Diffusion set to 100%



Applying Materials134

Setting Diffusion Using a Texture

When you assign a texture to the Diffusion channel, 
the texture’s alpha channel determines which areas 
of the surface have high diffusion and which have 
low diffusion. Bright areas in the alpha channel 
have a high diffusion value, and darker areas have 
low diffusion values.

When you use a texture to set the Diffusion channel, the 
grayscale values in the texture’s alpha channel determine the 
diffusion of the objects.

Diffuse Color
Diffuse Color acts like a filter through which all 
diffuse light passes. When light hits the object, the 
amount of light that’s reflected diffusely is 
determined by the Diffusion channel setting, and 
the color of that light is set by the Diffuse Color 
channel. 

This graphic shows how diffuse light passes through the Diffuse 
Color.

When Diffusion is set to a value greater than zero, 
the Diffuse Color appears wherever the object is hit 
by direct light.

Diffuse Color is the color of diffusely reflected light.

Be careful when using pure constant colors as the 
Diffuse Color because you may not get the results 
you’re expecting. If you use a pure color, only that 
color is reflected off the object. So if you’re using 
100% green, only green light is reflected off the 
surface. This doesn’t cause a problem when the 
object is hit by white light because there is green in 
white. However, if you use 100% red light on the 
object, it will appear black, since there is no green 
in 100% red, so no light is reflected off the object. 

Higher Diffusion 
values

Lower Diffusion 
values

Alpha Channel

Direct Light

Viewer

Surface 
reflects light 
diffusely

Diffuse Color

Diffuse Color 
applied to areas hit 
by direct light
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Ambience
Ambience simulates the effects of light hitting the 
object from all directions. The Ambience value 
controls the amount of light that is reflected off the 
surface uniformly. 

The large arrows represent ambient light hitting the object’s 
surface. The smaller arrows represent the light reflected off the 
object’s surface.

When Ambience is set to a value higher than zero, 
the object will reflect light from all over its surface, 
not only from the area hit by light. This makes the 
object look brighter.

The higher the Ambience value, the brighter an 
object appears. At 100%, the object appears 
unnaturally bright, regardless of the light source. If 
you want to create a realistic effect, the sum of the 
Ambience and Diffusion values should add up to 
100.

Ambience controls the general brightness of an object.

An object’s ambience is directly related to the 
general ambience of the environment. So, the 
ambient value you set for the object is directly 
affected by the Ambient Color you set in the Sky & 
Fog palette. 

The Ambient Color in the Sky & Fog palette 
controls how much ambient light is available in the 
environment. The Ambience channel controls how 
much of the available ambient light is reflected off 
the object’s surface.

So, if you set the Ambient Color in the Sky & Fog 
palette to black, or 0% ambience, then the 
Ambience channel value has no effect. If you set the 
Ambient Color to white, or 100% ambience, the 
Ambience channel value will control how much of 
the available light is reflected off the object’s 
surface.

Setting Ambience Using a Texture

When you assign a texture to the Ambience 
channel, the grayscale values from the texture’s 
alpha channel determine which areas of the surface 
have high ambience and which have low ambience. 
Bright areas in the alpha channel have high 
ambience values, and darker areas have low 
ambience values.

When you use a texture to set the Ambience channel’s value, the 
values are determined by the grayscale values in the texture’s 
alpha channel.

Generally, it’s best to set Ambience using a value. 
However, you can get some interesting effects 
using textures instead. For example, if you use a 

Light from all 
directions is 
scattered 
back

Ambience set to 0% Ambience set to 
100%

Higher Ambience
values

Lower Ambience val-
ues

Alpha Channel
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splotchy texture, you’ll get, mixed in with normal 
surface areas, areas that appear to glow regardless 
of external light.

Ambient Color
Ambient Color is the color that is reflected off the 
surface of an object regardless of where the light 
source hits the object. The Ambient Color is 
directly linked to the Ambience channel setting. If 
the Ambience is set to zero, the Ambient Color is 
invisible.

Ambient Color is the color that reflects off the entire surface of 
the object and is directly related to Ambience.

The Ambient Color tints the entire surface of the 
image.

Ambient Color is the color that appears no matter where light 
strikes the object.

The Ambient Color channel is also related to the 
ambient color you set in the Sky&Fog palette. The 
ambient color of the environment is added to the 

ambient color of the object, so if your environment 
is blue and your object’s ambient color is yellow, 
your object appears green.

Setting Ambient Color Using a Texture

When you assign a texture to the Ambient Color 
channel, the color channel in the texture is used as 
the Ambient Color. In other words, the texture’s 
color is applied to any area of the object that’s in 
shadow.

Specularity
Specularity controls how much light is reflected 
back from the surface of the object directly at the 
viewer. 

Specularity is the highlight reflected directly back at the viewer.

Since the direct reflection creates a highlight on 
the object, you can think of Specularity as the 
channel that determines the intensity of the 
highlight that appears on the object, or the 
“shininess” of the object.

The higher you set the Specularity, the shinier the 
object appears. When the Specularity is set to zero, 
the object appears dull.

Ambient Color

Ambient Color 
tints the entire sur-
face

Surface is 
reflective

Incoming Light

Reflected Light

Viewer sees high-
light
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Specularity controls the intensity of the highlight of an object.

Setting Specularity Using a Texture

When you assign a texture to the Specularity 
channel, the grayscale values in a texture’s alpha 
channel are applied to the object’s highlight. Bright 
areas of the alpha channel increase the intensity of 
the highlight, and darker areas decrease the 
intensity. The alpha channel may also create 
patterns in the highlight.

When you use a texture to set the Specularity channel’s value, 
the highlight’s intensity is determined by the texture’s alpha 
channel values.

Specular Color
Normally, the color of an object’s highlight would 
reflect the color of the light source. However, using 
Specular Color you can set a specific color for your 
highlight.

Specular Color is the color of the object’s highlight.

Specular Color is directly linked to the Specularity 
channel. If the Specularity is set to zero, the 
Specular Color is invisible.

By adding Specular Color, you can make it appear 
as though a colored light is shining on the object. 

Setting Specular Color Using a Texture

When you assign a texture to the Specular Color 
channel, the texture’s color channel is used as the 
Specular Color. In other words, the texture’s color 
is applied to the object’s highlight.

Specular Halo
The Specular Halo channel lets you control the size 
of the Specular highlight.

The size is controlled by the luminance value of the 
component you select. Brighter colors create larger 
highlights and darker colors create smaller 
highlights.

Specular Halo controls the size of the highlight on your object.

Specularity set to 
0%

Specularity set to 
100%

High Specularity 
values

Lower Specularity 
values

Alpha Channel

Specular Color 
applied to object’s 
highlight

Specular Halo set 
using bright colors

Specular Halo set 
using dark colors
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Colors are expressed as RGB (Red, Green, and Blue) 
values. Specular Halo channels use the values from 
each of these channels to set the size of the 
highlight. If the values are all in balance (that is, all 
the same), the highlight appears uniform. However, 
if one value is higher that the rest (for example, 
R=200, G=100, B=100), you’ll get a highlight with 
a slightly colored ring (for example, a red ring). 

Depending on the component you use in this 
channel, you may be able to set each color value 
differently to create different highlight effects. The 
easiest way to use this channel is with a color.

When using a color, try picking more desaturated 
colors. These colors produce more predictable 
results because the difference between RGB values 
is less.

Check out the Specularity Lesson series in the Fast & 
Simple category in the Preset Materials Library to 
see Specular Halo in action.

Setting Specular Halo Using a Texture

When you assign a texture to the Specular Halo 
channel, the RGB value of the texture’s color 
channel is used for the Specular Halo. 

Metallicity
The Metallicity channel value acts as a filter for 
reflected light. This value controls how much of the 
reflected light is filtered through the Diffuse Color.

At 50%, half the reflected light is tinted with the 
Diffuse Color; at 100%, all the light that’s reflected 
is tinted.

Metallicity is linked to Reflection. If Reflection is 
set to zero, the Metallicity channel has no effect.

Metallicity controls how much of the reflected light is tinted 
with the Diffuse Color.

Metallicity makes objects look metallic because it 
tints the color of reflections. If you want to create 
specific types of metals, you need to adjust the 
Diffuse Color. For example, to create gold use a 
yellow Diffuse color.

Setting Metallicity Using a Texture

When you apply a texture to the Metallicity 
channel, the texture’s alpha channel is used to 
determine the intensity of the Diffuse Color. 
Lighter areas of the alpha channel increase the 
intensity of the color, and darker areas decrease 
the intensity.

Bump Height
The Bump Height controls the height of bumps in 
an object’s surface. The bumps on an object’s 
surface are determined by the texture’s Bump 
channel. The Bump Height channel is linked to the 
Bump channel in the texture. If you use a texture 
without a Bump channel, the Bump Height channel 
has no effect. You can enter negative values in this 
channel, which turns bumps into dents.

Metallicity set to 
50%

Metallicity set to 
100%
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Bump Height controls the height of bumps on the surface of 
your object.

Transparency
The Transparency channel controls how much light 
can pass through the object’s surface. 

The amount of light that can pass through an object’s surface is 
set with the Transparency channel.

The higher the Transparency value, the more of the 
surrounding environment is visible through the 
object’s surface. If there is no other light being 
reflected, an object set at 100% Transparency 
appears invisible.

Transparency controls how much of the surrounding 
environment is visible through the object’s surface.

To create a realistic transparent object, you need to 
pay attention to details. You’ll need to combine the 
effects of the other channels to simulate a realistic 
object. For example, transparent bubbles all have 
highlights, so you’ll need to add Specularity. 
Balloons have a flatter surface so you’ll need to add 
more Diffusion to the surface. Glass has a refraction 
effect associated to it, so you’ll need to add 
Refraction to the surface.

Setting Transparency Using a Texture

When you apply a texture to the Transparency 
channel, the texture’s alpha channel is used to 
determine which areas of the object are 
transparent. Lighter areas of the alpha channel are 
not transparent while darker areas are.

You can create some interesting effects using 
textures. For instance, a checkerboard texture will 
result in an object that’s alternately transparent 
and solid. 

The final look of the Transparency channel is 
determined by the Shading mode. When the 
material is applied using normal shading, 
Transparency creates an optical effect. 

When the material is applied using Blend 
Transparency mode, Transparency creates a punch-
out effect. The areas of the surface that are 100% 
transparent are completely ignored during shading 
so that they appear as gaps or holes it the surface. 
Any areas that are less than a 100% result in a 
normal transparency effect.

Bump Height set to 
-100%

Bump Height set to 
+100%

Direct Light

Transparency set 
to 0%

Transparency set to 
100%
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Refer to “Shading Modes” on page155 for more on 
Shading modes. 

You can create some interesting effects using textures in the 
Transparency channel, like this checkerboard object. This 
example was created using regular shading.

This is what the same material looks like when you use Blend 
Transparency.

Transparent Color
The Transparent Color channel determines the 
color of the transparent areas of your object. Light 
is filtered through this color as it passes through 
the object’s surface. As a result, anything you can 
see through your object is tinted with the 
Transparent Color you select.

Transparent Color tints any light that passes through the 
object.

Keep in mind that the Transparent Color interacts 
with the other colors in the material. If the Diffuse 
Color is white, then the Transparent Color takes 
precedence. If the Diffuse color is yellow, and the 
Transparent color is red, the object appears 
orange. However, when you’re using Refraction, the 
Transparent Color blends with the Diffuse Color.

The Transparent color tints everything you see through the 
surface of your object.

Transparent Color is linked to the Transparency 
channel. If the Transparency is set to zero, the 
Transparent Color is invisible. 

Setting Transparent Color Using a Texture

When you assign a texture to the Transparent Color 
channel, the texture’s color channel is applied to 
the transparent areas of your object.

Cage texture 
applied to
Transparency
channel

Transparent 
Color

Transparent Color 
applied to the 
object
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Refraction
The Refraction channel determines whether light 
bends when it passes through the surface of an 
object. 

Light may bend as it passes through an object, depending on the 
Refraction value.

Higher Refraction settings produce slight 
reflections as some of the light is bent directly back 
at its source. Higher Refraction settings also change 
the color of the object’s surface as the colors 
reflected from the environment affect the object’s 
color. 

Refraction controls how much light bends as it passes through a 
transparent surface.

The Refraction value is what makes transparent 
surfaces look like glass. 

As you increase the Refraction value, the edges of 
the object will become reflective. This simulates 
the effect of light being refracted so sharply that it 
does not penetrate the object’s surface. 

In these examples you can see how the edges become more 
reflective as you increase the Refraction value.

The higher you increase the Refraction value, the 
more the Diffuse Color is blended with the 
Transparent Color. The higher the value, the more 
Diffuse Color is visible in the object’s surface. Any 
light that’s visible through the surface of the object 
is then tinted through both the Diffuse Color and 
the Transparent Color.

Refraction values are expressed as 100 x Refraction 
Index value. The Refraction Index contains refraction 
values for specific types of surfaces. For example, the 
Refraction Index of water is 1.3; this value is 
expressed as 130 in the Materials Lab.

Refraction is linked to Transparency. If 
Transparency is set to zero, this channel has no 
effect.

Reflection
The Reflection channel controls how much light, 
direct or indirect, is reflected off the object’s 
surface. Unlike diffusion, which scatters light, 
reflection directs light back at its source, giving the 
object a mirrorlike appearance. 

Light is fil-
tered through 
Transparent 
Color

Light is bent 
if Refraction 
is greater 
than 100

Refraction set to 
0

Refraction set to 
116

Refraction set to 
140

Refraction set to 
300
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Reflection determines how much light is reflected off the surface 
of the object.

The higher the Reflection setting, the more 
reflective the surface. At 50%, half the light that hits 
the object’s surface is reflected; at 100% all light is 
reflected.

Reflection controls how much light is reflected off the surface of 
an object.

As you increase the Reflection value, the color of 
the object changes, since you can see more of the 
environment in the object’s surface. 

Setting Reflection Using a Texture

When you apply a texture to the Reflection 
channel, the texture’s alpha channel is used to 
determine which areas of the object are reflective. 
Lighter areas of the alpha channel are reflective, 
while darker areas are not.

Volume Material Channels
Volume materials use most of the same channels as 
surface materials. These channels all work the same 
as they do for surface materials. The only difference 
is that the channels control the properties of the 
object’s volume, not its surface. 

In addition to the channels already discussed, 
Volume materials have several specialized 
channels.

Volume Color
The Volume Color channel controls the color 
applied to the interior of an object. Everything 
inside the object will appear tinted with this color 
as all light is filtered through the Volume Color.

The interior of an object can have color, which you set with 
Volume Color.

The Volume Color interacts with the Transparent 
Color. If your surface is transparent, light is tinted 
by the Transparent Color and the Volume Color.

Surface is 
Reflective

Incoming Light

Viewer sees object on the 
surface of object

Reflected Light

Reflection set to 
50%

Reflection set to 
100%

This portion of 
the light is 
tinted by the 
Volume 
Color
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The Volume color tints everything inside the object.

Volume color is an excellent way of creating 
underwater light effects.

Base Density
Base Density controls how dense the object is. In 
areas where the object is very dense, no light 
passes through the object. Where the object is less 
dense, more light passes through its volume. Base 
Density works like Transparency in 3D space. Areas 
that are less dense appear to be more transparent. 

High values create very solid objects like rocks, 
while lower settings create less dense objects like 
clouds.

Base Density controls the density of the area within an object. 
Objects with a low density will appear more transparent.

You should use this channel cautiously. The more 
transparent objects are, the more time they take to 
render. 

Setting Base Density Using a Texture

When you use a texture to set this channel, the 
alpha channel is used to determine which areas of 
the object are solid and which are empty.

Edge Softness
Edge Softness controls the softness of the edges of 
the silhouettes of objects with a volume material. 
For example, a sphere with a low Edge Softness 
value will have a “hard” silhouette, meaning that 
you’ll be able to clearly see the edges of the sphere. 
A high Edge Softness value will almost totally 
obscure the edges of the sphere.

Edge Softness controls the softness of an object’s silhouette.

This channel is useful for obscuring the general 
shape of an object.

Fuzzy Factor
Fuzzy Factor controls the dullness or sharpness of a 
material. Values greater than 100 adjust the 
dullness of the material, and values less than 100 
adjust the sharpness of a material. At 100 there is 
no dullness or sharpness applied.

Fuzzy Factor controls dullness/sharpness of the texture within 
your object.

As you increase the dullness of your object, it 
becomes less dense, so you may have to increase 
the Base Density to compensate. Likewise, as you 
increase the sharpness of the object it becomes 
more dense.

Volume Color 
applied to the inte-
rior of the object

Base Density set to 
100

Base Density set to 
0

Edge Softness set 
to 0

Edge Softness set 
to 100

Fuzzy Factor set 
to 0

Fuzzy Factor set 
to 200
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You can use this channel to smooth sharp-looking 
clouds, or sharpen dull stone textures.

Quality/Speed
Quality/Speed controls the render quality of the 
texture. This channel represents the inverse 
relationship between render quality and rendering 
speed. As you increase the render quality of the 
material, you decrease the speed at which it’s 
rendered. As you increase the speed at which a 
material is rendered, you decrease its quality.

The Quality/Speed value controls the quality of the texture’s 
render in relation to how fast it renders.

The material loses detail as the quality decreases. 
Detail is introduced as quality increases. 

For still images you probably want to increase the 
quality of the material and sacrifice speed, since 
the scene only has to be rendered once. For 
animations, you probably want to sacrifice quality 
since the scene will have to be rendered once for 
each frame in the movie.

Material Components
This section describes the various components you 
can use to set a material channel value. It also 
describes how to set the parameters for each 
component.

Color Components
A color component is an RGB color that is directly 
applied to a channel. Colors can only be used in the 
Color channels: Diffuse, Ambient, Specular, 
Specular Halo, and Volume.

When you’re using a color in these channels you 
cannot combine it with a texture. If you choose a 
texture component for any of the Color channels, 
the color oval appears blank. The Volume channel 
can only be set with a color.

To use a color as a component:

1 In the Materials Lab, click the color oval in one 
of the channel rows on the Material Grid and 
choose a color from the palette.

• To choose a color using the Color Picker, 
hold down Option/Alt when you click the 
color oval.

The selected color appears in the color 
oval. If you click on one of the columns, 
the color oval appears blank.

Value Components
Value components are numerical values you use to 
set the intensity of a channel. Values can only be 
used in the Value, Optics or Volume channels.

A value is indicated by either the numerical field in 
the left side of the channel in the Material Grid, or 
the slider that extends out from the channel. The 
sliders let you quickly set the value of a channel, 
and the numeric field shows the current setting.

The value slider in a channel lets you set a numerical value for 
the intensity of the channel and displays the channel’s current 
setting.

Values can be used with textures. In this case the 
value sets how much of the texture is applied to the 
channel. For example, if you use an orange-colored 
texture to set the Diffuse Color channel, the value 
would indicate how much of the texture color is 
used as the Diffuse Color. 

Quality/Speed set 
to 0

Quality/Speed set 
to 100
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A value of 100 means that all the texture 
information is used in the channel; a value of 0 
means that none of the texture is used.

Not all channels use values. The Color channels 
only use colors or textures. The Refraction channel 
can only be set with a value.

To use a value as a component:

• In the Materials Lab, drag the slider next to the 
channel whose value you want to set. As you 
drag, the numerical value appears in the 
number field.

Some channels let you set negative values.

Texture Components
When you use a texture as a component, Bryce 
extracts values from the texture to use as a value 
for the material channel. There are two types of 
texture components you can use: pictures and 3D 
textures. Pictures are images you import from 
either the Picture Library or from another 
application. 3D textures are procedural textures 
generated by Bryce and stored in a texture library.

You can assign up to four textures as components 
for a material. These textures can be any 
combination of pictures and 3D textures. 

Each texture component is assigned a letter: A, B, 
C, or D. The texture you assign to a component is 
used throughout the material, so the texture you 
assign as component A in the Diffusion channel is 
the same component A used in the Ambience 
channel and so on. 

When you’re setting channel values, you can mix 
and match components. For example, you can 
assign component A to Diffusion and component D 
to Ambience. You can also combine textures within 
the same channel using the blend modes AB and 
ABC. In this case the texture you assigned to A is 
blended with the textures assigned to B and C to 
set a material channel value. Refer to “Combining 
Components” on page154 for more on blend 
modes.

The Texture Component Window

The Texture Component window displays the 
attributes of a selected texture component. You 
can have up to four windows visible in the 
Materials Lab.

The Component window displays the selected component and its 
current attributes.

The six buttons on the Texture Component window 
let you set the type of component, the texture 
mapping mode, and access the texture 
transformation controls and the Deep Texture 
Editor.

To use a Texture as a component:
• Click a column in the material grid. A Texture 

Component window appears.

The component window corresponds to the 
columns in the grid, so if you click column A in 
the grid, texture component A becomes active. 

3D Textures

3D textures have three different types of outputs: 
Color, Alpha channel, and Bump. These outputs are 
used differently by the material channels. 

Color channels use the texture’s color to set the 
value of the channel. For example, if you use a 
texture in the Diffuse channel, the colors in the 
texture appear wherever the object reflects light 
diffusely.

Display Texture 
Transformation 
Palette

Texture Name

Display Deep Texture Editor

Texture Library 
list

Use 3D Texture Current Mapping Mode

Mapping ModesUse Picture



Applying Materials146

When you use a texture to set the value of a Color channel, the 
color information is used to set the material channel value. In 
this example, the Diffuse color was set using a texture.

Value, Optics, and Volume channels use the alpha 
channel information from a texture to set the value 
of the material channel. For example, when you use 
a texture to set Specularity, the texture’s alpha 
channel information determines which areas of the 
object are shiny. As a result, you’ll see the pattern 
of the texture on the object. 

When you use a texture to set the value of an Intensity channel, 
the alpha channel information is used to set the material 
channel value. In this example, Specularity was set using a 
texture.

The Bump information in a 3D texture is used only 
by the Bump Height channel. The Bump channel in 
the texture determines the pattern of bumps or 
dents in the object. In fact, you won’t be able to see 
the effects of the Bump Height value unless you 
assign a texture to the channel.

Bump channel information from a texture is used to determine 
the pattern of bumps or dents in an object. You must assign a 
texture to the Bump Height channel to see the bumps or dents. 

To use a 3D texture as a component:

1 In the Materials Lab, click a channel column. 

A randomly selected texture appears in the 
Component window.

2 If you want to change this texture, click the 
triangle button next to the texture name at 
the top of the window and choose a preset 
texture from the menu.

The texture you selected appears in the 
Component window.

2D Textures

2D textures are pictures you’ve created in another 
application or ones you select from the Pictures 
Library. The data in the channels of these pictures 
are used as values in the material channels.

To use a 2D texture as a component:
1 In the Materials Lab, click a channel column. A 

texture appears in the texture component 
window.

2 In the Component window, click the P button 
at the bottom of the Component window.

The P button changes the component to a 2D picture.

A default picture appears in the Component 
window.

Diffuse color set 
using a color

Diffuse color set 
using a texture

Specularity set 
using a value

Specularity set 
using a texture

Bump Height set 
using a value

Bump Height set 
using a texture
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3 To change the picture, click the pink button at 
the top of the component window. 

The pink button displays the Pictures Library.

The Pictures Library appears. 

4 Click an image square to load an image.

5 If the image you want is not in the library:

• Click the Load text button. The Load Image 
dialog appears. 

• Use the dialog controls to locate the 
picture you want to use and click Open.

or

• In another application, copy the picture 
you want to use to the Clipboard.

• Access the Picture dialog and click the 
Paste text button. 

The picture is loaded into the first image box 
and its alpha channels are loaded into the 
second box.

You can invert the alpha channel by clicking 
the invert button.

6 Click the OK icon to exit the dialog.

The picture appears in the Component 
window.

Using the Pictures Editor
The Pictures Editor in Bryce, also known as the 
Picture Library, has three square previews at the 
top of the window. These three previews represent 
one image three different ways. The left image is 
the RGB information of the image, the middle one 

is the alpha channel, the right one is the combined 
image. You can apply filters to each of the three 
parts independently.

How to select a plug-in folder:
• Click on the triangle to the right of the desired 

preview type. 

If a plug-ins folder has been previously 
selected, a pull-down menu appears that 
displays the available Photoshop filters.

• If, for some reason, the Photoshop filters 
cannot be found, or you wish to select a new 
plug-ins folder, select Select Plug-ins Folder at 
the bottom of the menu.

Select a folder for the plug-in.

How to add blank images into the library:
1 Load an image into the library and click on the 

New button at the upper right of the Pictures 
Editor.

The New Image dialog appears.

2 Enter a name for the image as well as the 
image size and default color.

3 Click the checkmark to return to the Pictures 
Editor.

The Pictures Editor will contain the new image 
in one of the tiles.

Once the picture is available in your library, you can 
load different alpha channels or different RGB 
information. You can also run any Photoshop filter 
on either of the two components of this image or 
on the entire image. 

How to apply filters to pictures:
1 Select a picture from the picture tiles.

The picture appears in the top preview frames 
of the picture editor.

2 Select a plug-in from the currently selected 
plug-in folder.

3 The filter is applied to your image.
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Texture Mapping Modes
Once you’ve decided on a texture to use as a 
component, you need to decide how the texture is 
mapped onto your object. The appearance of the 
texture can change dramatically depending on how 
it’s applied to the object.

Each texture you apply can have a different 
mapping mode. When you’re mixing textures 
(Mode AB or Mode ABC), you can choose which 
portions of your textures you want to combine.

To select a mapping mode for a texture:
1 In the Materials Composer, click a channel.

2 Select a mode for the channel.

3 Click the title of the Component window and 
choose either 2D Texture or 3DTexture.

4 Click the current Mapping Mode title and 
choose a mapping mode from the menu.

Object Space

In this mapping mode, textures are scaled 
proportionally to the size of your object. If you 
change the size of your object, the texture scale 
changes with it. The texture also rotates along with 
the object. This means that the texture does not 
appear to move as you reposition or rotate the 
object.

In Object Space mode, textures are applied to the object so the 
texture will not move as you move the object.

World Space

In this mode, the texture is applied throughout 
infinitely large 3D space, and only a small portion is 
applied to your object. This means that the texture 
appears to change as you move your object, since 
the object is moving through the texture in 3D 
space.

In World Space mode, the texture is applied to the entire world, 
so the texture appears to move as you move the object.

Parametric

In this mode, the texture is applied onto the object 
as if it were a decal. For example, if you use this 
mapping mode on a cube, one iteration of the 
texture is placed on each face.

Parametric mode applies the texture as a 2D decal.

The texture is mapped onto the object so it rotates 
and scales as the object is scaled or rotated.

This mode works best with 2D Pict textures.
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Parametric Scaled

This mode works like the World Space mode, only 
in 2D. Textures mapped using this mode are not 
scaled with the object.

Parametric Scaled mode applies the texture as a decal, but does 
not scale the texture as you scale the object.

Use this mode when you want to map a 2D picture 
onto constructed objects like buildings.

World Top

In this mode a 2D projection of the texture is 
applied to the object from directly above it. If you 
move your object or rotate it, the texture does not 
move with the object; it remains constant while the 
object moves through it.

World Top mode applies the texture to the top of the world. The 
texture appears as a projection on top of the object and streaks 
down its sides.

Spherical

In this mode, a 2D projection of your texture is 
mapped onto a virtual sphere that surrounds your 
object. It is then projected from the sphere onto 
your object.

Spherical mode applies the texture to a virtual sphere and then 
projects it onto your object.

Cylindrical

In this mode, your texture is mapped onto the front 
of your object, wrapping around the right and left 
sides all the way to the back. Edge pixels going to 
the center appear on the top and bottom of your 
object.

Cylindrical mode wraps a texture around the object starting 
from the front.
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Reflection Map

In this mode, a 2D projection of your texture is 
applied to a virtual sphere that surrounds your 
scene. The texture is then reflected off of the 
sphere and onto your object.

Reflection Map mode applies a reverse image of your texture to 
your object.

This mode works best on objects with irregular 
surfaces. It also works well with terrains.

Random

This mode randomly applies a 2Dprojection of the 
texture all over the surface of your object.

Random mode applies the texture all over the object in a 
random pattern.

Object Top

This mode applies a 2D projection of the texture to 
the top of your object. The texture rotates and 
scales along with the object.

Object Top mode applies the texture to the top of the object.

Object Front

This mode applies a 2D projection of the texture to 
the front of your object. The texture rotates and 
scales along with the object.

Mapping Mode Modifiers

You can modify the mapping modes in the 
following ways.

Parametric 
Scaled

Reflection 
Map

Object Front mode applies the texture to the front of the object.
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Symmetric Tiling
When you tile a texture onto an object in 
symmetrical tiling mode, each repeated instance of 
your texture is tiled horizontally and vertically. as 
needed to seamlessly produce a symmetrical 
pattern over the surface of the object.

In Symmetrical Tiling mode, textures are seamlessly tiled across 
the object.

Repeat Tiling
Unlike symmetrical tiling, in which a seamless tiled 
pattern is achieved by flipping the texture 
horizontally and vertically, Repeat Tiling repeats 
your texture across the surface of your object 
without any alteration in orientation. The number 
of instances of the texture depends on the scale 
applied to the texture. 

Scale Pict Size
This mode modifier only affects picture textures. 
When selected, the image behaves like a sticker 
placed on the surface of the textured object. Unless 
Scale Pict Size is selected, the picture will repeat 
itself across the surface in a similar way to Repeat 
Tiling.

Centered Transforms
Centered transforms works with parametric 
mapping modes to force the transformation of the 
textures to be applied around the center of the 
object surface.

Decal Colors
Decal colors blends the color of a texture with the 
affected component’s base color. It uses the 
texture’s alpha channel to control the amount of 
blending. This can make decalcomania effects 
easier to achieve.

Alpha Scaling
Normally, if you drive a component’s value with a 
texture, the texture’s alpha channel will set the 
value without regard to the amount that was set 
using the component’s slider. With alpha scaling 
turned on, the amount set with the slider will 
“scale” the amount provided by the texture’s alpha 
channel. This gives you more subtle control over 
the influence of the texture on the material 
component’s value.

Pict Interpolation
This mode modifier is enabled by default. It 
interpolates the pict file you are using, allowing the 
pict file to be applied smoothly to an object. With 
Pict Interpolation disabled, the image may appear 
to be pixelated or jagged.

Transforming Textures
Since a 3D texture exists in three-dimensional 
space, it can be transformed along the X, Y, or Z 
axis—just like a 3D object. Using the texture 
transformation tools, you can scale, position, or 
rotate your texture. 

The final look of the transformation depends on 
the mapping mode you use to apply the texture to 
the object. In some modes, texture transformations 
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may not be very noticeable, while in others, like 
Parametric, transforms can have a large impact on 
the look of the material. 

You may find it necessary to experiment with 
different settings to get the results you want. If you 
find that the texture isn’t reacting the way you 
want it to, try changing the mapping mode. Refer 
to “Texture Mapping Modes” on page148 for more 
on mapping modes. 

The transformation tools give you very fine control 
over the final appearance of the texture. 

Scale

Using the Scale control, you can control the 
frequency of the texture. Increasing the scale of a 
texture decreases the frequency of the pattern, 
since it doesn’t have to be repeated as many times 
to cover the surface of the object. 

Since a 3D texture exists in 3D space, you can change its size in 
all three axes. Adjusting the scale in X changes the size of the 
texture along the X axis.

Adjusting the scale in Y changes the size of the texture along the 
Y axis.

Adjusting the scale in Z changes the size of the texture along the 
Z axis.

Rotation

Using the Rotation control, you can control the 
angle of the texture on the object’s surface. You 
can create very different texture effects depending 
on the texture’s orientation.

Since a 3D texture exists in 3D space you can change its 
orientation in all three axes. Adjusting the rotation in X changes 
the angle of the texture along the X axis.

Adjusting the orientation in Y changes the angle of the texture 
along the Y axis.

Adjusting the orientation in Z changes the angle of the texture 
along the Z axis.

Scale X=0% Scale X= 50% Scale X=100%

Scale Y=0% Scale Y= 50% Scale Y=100%

Scale Z=0% Scale Z= 50% Scale Z=100%

Rotation
X=0°

Rotation 
X=45°

Rotation 
X=90°

Rotation 
Y=0°

Rotation 
Y=45°

Rotation 
Y=90°

Rotation 
Z=0°

Rotation 
Z=45°

Rotation 
Z=90°
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You can transform a texture numerically by 
adjusting the X, Y, and Z coordinates or 
interactively using the transformation tools.

Position

Using the Offset controls, you can control where 
the texture appears on the object’s surface. When 
you’re using a picture as a component, placement 
can be vital to the look of the material. For 
example, if you’re placing a decal on an object, use 
the Position controls to precisely place the image in 
the center of the object or on the correct face.

Since a 3D texture exists in 3D space, you can change its 
position in all three axes. Adjusting the position in X changes 
the placement of the texture along the X axis.

Adjusting the position in Y changes the placement of the texture 
along the Y axis.
 

Adjusting the position in Z changes the placement of the texture 
along the Z axis.

To transform a texture numerically:
1 In the Texture Component window, click the 

first button on the left at the top of the 
window. 

The Transformation palette appears. 

Use the texture transformation palette to adjust the scale, 
position, and orientation of the texture component.

2 Move your cursor over the control for the 
transformation you want to apply.

3 Drag the cursor over the X, Y, or Z value you 
want to adjust. 

Drag left to increase the value or right to 
decrease it.

As you adjust the value, the material preview 
updates to show the results of your changes.

4 Click the OK icon to apply your changes.

To transform a texture interactively:
1 In the Texture Component window, click the 

first button on the left at the top of the 
window. 

The Transformation tools appear.

2 Move the cursor over the tool you want to use 
until the mode you want is active. 

3 As you pass the cursor over the tool, the tool 
changes to display the different modes 
available.

Position 
X=0BU

Position 
X=50BU

Position 
X=100BU

Position 
Y=0BU

Position 
Y=50BU

Position 
Y=100BU

Position 
Z=0BU

Position 
Z=50BU

Position 
Z=100BU
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4 Drag the mouse in the direction you want to 
move, scale, or rotate the texture.

5 Click the OK icon to apply your changes.

Editing Textures

You can edit the makeup of an existing texture or 
create a completely new texture using the Deep 
Texture Editor. This editor uses some rather 
complex texture-generation concepts to create 
textures for Bryce. You can either choose to learn 
all these concepts to create your textures precisely, 
or use the editor as a type of lab where you 
combine random settings and see the results. 

Refer to “Creating and Editing Textures” on 
page169 for more information about learning 
texture-generation concepts.

Combining Components 
You can combine material components using one 
of three blending modes:

• Mode A
• Mode AB

• Mode ABC

Mode A

In Mode A, only one component is used to set the 
value of a channel. The component can be a value, a 
picture, or a 3D texture.

Mode AB

In Mode AB, two textures are blended together 
based on altitudes. At the lowest altitudes, the 
values from texture A are used; at higher altitudes, 
texture B is used to set the value of the channel. 

Altitude is based on the distance between the 
ground level and the highest object in your scene.

When you use this mode, an object’s surface 
material is a blend between two texture 
components. Texture B appears at the bottom of 
the object and Texture A appears at the top. In 

between is a blend between texture B and texture 
A. Bryce creates the blend by interpolating between 
the two textures. 

For example, if you use ModeAB in the Diffuse 
Color channel, the color in texture A appears at the 
bottom of an object’s surface, and the color from 
texture B appears at the top. A color gradient 
between color A and color B appears in the middle 
of the object 

In this example, Mode AB was used to set the Diffuse Color 
channel. Values from texture A set the Diffuse Color channel at 
lower altitudes, while values from texture B set the channel at 
higher altitudes.

Mode AB can be used to create snow covered peaks 
on terrains or murky depths in infinite water slabs.

To use mode AB to blend textures:
• In the Materials Lab, Control/Ctrl+click the B 

column of a channel.

Component indicators appear in both the A 
and B columns of the channel.

Mode ABC

In Mode ABC, two textures, texture A and texture B, 
are blended based on the alpha channel of texture 
C. In this mode, the alpha channel from texture C 
acts like a map that tells Bryce where to apply the 
values from texture A and texture B. All the white 
areas of the alpha channel use values from texture 
A; black areas in the alpha channel use values from 
texture B. Gray areas in the alpha channel use a 
combination of both textures.

Texture A

Texture B
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In the example that follows, three textures were 
combined using Mode ABC in the Diffuse Color 
channel. 

When Mode ABC is used to combine the three textures, the spot 
texture (A) appears in the white areas of the checker texture’s 
alpha channel (C) and the lines texture (B) appears in the black 
areas of the alpha channel.

To use Mode ABC to blend textures:

1 In the Materials Lab, Control/Ctrl- click the C 
column of a channel.

Component indicators appear in the A, B and C 
columns of the channel.

Shading Modes
Shading refers to the process of applying material 
channel values to an object. When an object is 
shaded, the different values in the material are 
applied to the object. The shading modes available 
in Bryce determine how material channels are 
applied to create different effects.

Using a material, you can define whether a surface is shiny, 
smooth, or opaque.

Using a shading mode, you determine how those properties are 
applied to the object.

The shading mode can not only determine how the material is 
applied to the surface of the object, but how it’s applied to the 
object’s volume as well.

To choose a shading mode:
• Click the triangle icon next to the material 

type buttons at the top of the Materials Lab.

Alpha Channel Texture Used

Texture A

Combination of A 
and B

Texture B

Texture A

Texture B

Texture C
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Surface Material Shading Modes
This section explains the surface material shading 
modes.

Normal

Normal mode applies the values of the material 
without modifying them in any way. Objects are 
shaded according to the values you set in the 
material channels. This mode has no special effects; 
it simulates a real-world appearance using the 
material channel values. 

This is the default mode and is appropriate for 
most objects.

Blend Transparency

In Blend Transparency mode, visibility is controlled 
by Transparency. When this mode is active, areas of 
the object that are 100% transparent are ignored. 
Transparent areas are not shaded and do not cast 
shadows. These areas appear as gaps or holes in the 
object’s surface.

This mode lets you create punch-outs when using a 
texture.

This cage was created by using blend transparency to “punch-
out” areas of the object’s surface.

Anything less than 100% Transparency results in 
normal transparent areas.

Fuzzy

Fuzzy mode changes the effective transparency 
based on the thickness of the object. As a result, 
objects appear fuzzy on the edges and solid at the 
center. 

Using Normal Shading

Using Blend Transparency Shading
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When you apply a material using Fuzzy shading mode, the 
edges of the object appear blurred, while the center remains 
solid.

Since Bryce uses depth information to synthesize 
this blurry effect, it is not available for 2D objects 
such as Squares or Disks. 

Use the Transparency setting to adjust the degree 
of fuzziness.

Light

Light is a very specialized shading mode best used 
to create visible lighting effects. Objects shaded 
with this mode appear transparent and self-
illuminating. 

The Light shading mode is designed to create simple light 
effects. If you apply it to a cone object, it looks like a cone of 
light.

Only the Diffuse, Ambient, and Transparent Color 
channels are used to determine the color of the 
light. All other channels are ignored.

This mode is useful for creating point lights 
without the rendering overhead that comes with 
true volume light objects (that is, light-sensitive 
volume materials).

Volume Material Shading Modes
This sections explains the volume material shading 
modes.

Flat Shading

Flat shading mode is designed for clouds, gases and 
other self-luminous gaseous materials. Flat shading 
mode does not shade an object, meaning that light 
sources have no effect on the color or brightness of 
the object. 

The Flat shading mode applies your material as a volume 
material, but does not apply any shading.

When this mode is active, Diffusion, Ambience, 
Specularity, Ambient Color, Specular Color and 
Transparency Color have no effect.

The color of the material is determined entirely by 
the Diffuse Color channel.

Basic Shading

Basic shading mode is designed to apply shading 
and light effects to the exterior surface of a 
volumetric object without affecting the interior. 
When this mode is active, volumetric objects are 
shaded as if they have a surface material applied to 
them rather than the actual volume material.
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In this mode, light sources have a limited effect on 
the color and brightness of an object. Only the 
exterior surface of the object will be affected by 
light sources; light and shadows will not be 
generated within the object.

Full Shading

Full shading mode is designed for hard edged, 
sharp objects like rocks. When Full shading mode is 
active, the visible portions of the material are 
shaded and can be affected by light sources. 

The Full shading mode applies your material as a volumetric 
material, and applies shading to the visible portions of the 
material.

Since light sources can affect portions of your 
material, shadows will appear within the object. 
This can greatly increase rendering time. If you 
don’t need to see shadows in the object, make sure 
the Receive Shadows filter is disabled. Usually you 
should disable this filter unless you’re creating very 
specialized effects.

Light Sensitive

Light Sensitive mode is designed for creating visible 
light effects such as light beams. Light Sensitive 
mode does not shade objects, but the particles in 
your material are sensitive to light. 

In this mode, Density doesn’t control density as 
much as it sets the light sensitivity of material 
particles. Higher values create brighter particles 
and lower values create darker particles.

To get the best results for light objects, use the Addi-
tive blend mode.

The color of the particles is determined entirely by 
the Diffuse Color channel.

The result is like shining a light through a volume. 
If you were shining a light through a cloud 
material, you would be able to see the clouds 
within the light cone. 

When this mode is active, Diffusion, Ambience, 
Specularity, Ambient Color, Specular Color and 
Transparency Color have no effect.

The Light Sensitive mode was used to apply material inside the 
bottle on the left. When the bottle is lit by a light source, the 
particles of the material become visible creating the effect of a 
light beam passing through the bottle.

Uniform Density

Objects can have varying densities. By default, 
objects have a density that varies from center to 
surface. The object is most dense at the center and 
becomes less dense as you approach the surface. 
You can control the starting point of this variation 
in density by using the Edge Softness control.

However, you may want to create objects that do 
not vary in density. Uniform Density mode sets the 
object to have a consistent density throughout the 
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object. The density at the starting point is used 
throughout the object. This results in harder-
looking objects and faster rendering times.

Sky Integration

Sky Integration mode is designed to increase the 
realism of volume objects in scenes that have hazy 
or foggy atmospheres. When Sky Integration mode 
is active, the sky effects such as haze and fog are 
taken into account when the volume object is 
rendered. This helps blend objects realistically into 
the atmosphere.

This mode is very useful for creating realistic cloud 
objects or fog objects.

Shading Mode Modifiers
Shading mode modifiers are not shading modes, 
but they modify an existing shading mode. When 
you select a modifier it remains enabled until you 
disable it. You can also apply more than one 
modifier at the same time.

Additive

When this modifier is active, material channels are 
applied to the environment behind the object 
instead of to the object’s surface. 

If you put an object on a bright background, it 
appears almost white. For best results, set your 
Ambient Color control to zero and render against a 
dark, plain background. Objects with this shading 
mode modifier selected will not cast shadows. 

When you modify a shading mode using Additive, objects 
appear as ghost images.

This mode is very useful for creating planets and 
quarter moons, light beams, and ghost images. 

Distance Blur

This modifier is designed to minimize the problem 
created by highly bumpy textures fading into 
infinity (i.e., the horizon). Often, moiré-like 
patterns appear in these cases as the pixels try to 
resolve the infinitely receding high frequencies of 
bumpy water or grooved sand, and so on. The 
Distance Blur modifier fades the bumpiness well 
before it hits the horizon.

Receive Shadows

This modifier prevents an object’s surface from 
accepting shadows cast by objects around it. The 
object itself will cast a shadow, but it won’t accept 
shadows from other objects.

When the Receive Shadow filter is disabled, no shadows will 
appear on the object’s surface. 
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Cast Shadows

This modifier prevents an object from casting 
shadows. The object’s surface still reacts normally 
with light but it does not cast any shadows. 

Self Shadows

This modifier prevents an object from casting a 
shadow onto itself, yet still shadow all the other 
elements of the scene.

Volume Blend-Altitude

This modifier gradually blends in the Volume color 
based on altitude. Areas at lower altitudes are 
tinted with the 100% Volume Color; as you move 
higher up, less of the Volume Color is added.

Using the Volume Blend-Altitude, you can simulate the effects of 
sinking deeper into a volume of water. The lower you sink, the 
darker it becomes.

This modifier can be used to create a sense of 
depth in an infinite water slab. If you blend 
between a light Diffuse Color and a darker Volume 
Color, you can create the illusion of depth as you 
sink deeper into the water.

Volume Blend-Distance

This modifier blends the Diffuse and Volume Colors 
of your material based on the distance from the 
camera. Areas that are closer to the camera will be 
tinted less with the Volume Color. As you move 
further away, more of the Volume Color is visible.

Using the Volume Blend-Distance, you can simulate the effects of 
looking through murky water. Distant objects appear darker 
than closer ones.

This modifier is excellent for creating underwater 
depth effects. If you blend a darker Diffuse Color 
with a lighter Volume Color in an infinite slab, you 
can simulate the effects of murky water on distant 
objects.

The Materials Lab
The Materials Lab is where you create and edit your 
materials in Bryce. This unique editor lets you 
combine a wide variety of components and 
channels to create an infinite number of different 
surfaces and volumes.

To display the Materials Lab:
1 Create an object.

2 Select the object in the Working window. A 
number of object attribute icons appear to the 
right of the object.
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Use the quick access buttons next to a selected object to access 
editors and get information about the object.

3 Click the M icon. Alternatively, you can choose 
Objects menu> Edit Material or display the 
Edit palette and click the Edit Material tool.

The contents of the composer depend on the 
material currently applied to the object. If there is 
no material, the default material’s settings appear. 

A Quick Tour of the Materials Lab
The Materials Lab is set up like a visual chart that 
lets you see all the different channels that make up 
your material. At a glance, you can see all the 
settings for each material channel and the texture 
components used to drive channel values. 

In the top left corner is the mode toggle button. 
This button lets you switch between surface 
material and volume material. The buttons also 
indicates what type of material you’re creating. 
Surface is enabled by default. When you toggle to 
Volume, the channels in the lab change to display 
the volume channels.

Material Preview Window

On the left side of the Materials Lab is the Material 
Preview. This little window shows you what your 
material will look like when it is applied to an 
object. The preview updates as you adjust the 
channels.

The Materials Grid

The center of the Materials Lab is called the 
Materials Grid. This is where you combine values, 
colors and textures to set channel values. The 
Materials Grid is divided into three sections each 
containing logical groups of channels. 

The Material Grid gives you a one-glance view of all the 
channels that make up your material.

The Color channels group contains all the material 
channels that define the colors that appear on the 
object surface when it’s struck by light.

Each channel in the Color group has a color oval 
next to its title. This oval lets you quickly set a 
color for the channel.

The Value group contains all the channels that 
define how the object’s surface or volume reacts to 
light. In other words, they control whether the 
object is shiny, metallic, bright or dark.

The Optics group contains all the channels that 
define any optical effects associated with the 
object.

When you’re creating volume materials, the Optics 
group is replaced by the Volume group. This group 
contains all the channels that define the 
appearance of an object’s volume.

All of the channels in these three groups have 
sliders on the left side of each row. The sliders let 
you quickly set the value of each channel. Values 
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can be used in conjunction with textures or on 
their own. In the case of the Refraction channel, 
you must use a value.

Each channel is divided into four columns: A, B, C, 
and D. These columns represent texture 
components you can use to set the value of the 
channel. At the top of each column is a Frequency 
slider. This slider lets you quickly set the frequency 
of a texture component. Setting the frequency is 
the same as scaling the texture.

When a texture component indicator appears in a 
column, it means that a component is being used 
to drive the value of the channel. The column in 
which the indicator appears indicates which texture 
component is being used. For example, if a texture 
component indicator appears in column A of the 
Ambience channel, component A is being used to 
drive the Ambience value.

Texture Component Windows

Along the right side of the lab are the Texture 
Component windows. These four windows are 
labeled A, B, C, and D. When a texture component 
is active, these windows display a preview of the 
texture and provide access to texture editing tools.

The four Texture Component windows correspond to the four 
columns in each channel in the Materials Grid

Along the bottom of the Materials Lab are the 
Animation controls. These controls let you animate 
between textures or animate the properties of a 
single texture over time. 

Use the Animation controls to animate a material over time.

Working in the Materials Lab
This section describes how to use the Materials Lab 
to create and store materials.

Building Materials
A material is a combination of values, colors and 
textures applied through fourteen different 
channels. You build materials by selecting 
components (colors, values, or textures) and 
combining them on the Materials Grid. 

To create a new surface material:

1 Select an object.

2 Display the Materials Lab.

3 Set the material channels to define the 
properties of your material.

Remember, channels can be set using values, colors 
or texture components. You may want to experiment 
with different setting to see the results of your 
changes.

4 If you’re using texture components, you can:

• Edit the scale, position or rotation of the 
texture using the texture transformation 
controls.

• Edit the makeup of the texture using the 
Deep Texture Editor.

• Set a mapping mode for the texture.

5 Choose a shading mode for the material by 
clicking the triangle icon at the top of the 
Materials Lab and choosing a mode from the 
menu. 

Component A

Component B

Component C

Component D
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6 Click the OK icon. The new material is applied 
to the selected object.

To create a new volume material:

1 Select an object.

2 Display the Materials Lab.

3 Click the toggle button to switch to Volume.

4 Set the material channels to define the 
properties of your material.

Remember, channel values are applied to the object’s 
volume not its surface, so adjust the material’s chan-
nels accordingly.

5 If you’re using texture components, you can:

• Edit the scale, position or rotation of the 
texture using the texture transformation 
controls.

• Edit the makeup of the texture using the 
Deep Texture Editor.

• Set a mapping mode for the texture.

You should always use a texture component in the 
Base Density channel.

6 Choose a shading mode for the material by 
clicking the triangle icon at the top of the 
Materials Lab and choosing a mode from the 
menu. 

The shading modes for volume materials are 
different from those for surface materials.

7 Click the OK icon. The new material is applied 
to the selected object.

To activate a component in the Materials 
Grid:
• Click an empty channel column. A component 

window appears.

To use a component in a channel:
• In a material channel, click the column that 

corresponds to the component you want to 
use.

To switch between components:

• Click in a new column.

To combine a component with a value:

1 In a material channel, click an empty column.

2 Drag over the value control for the channel.

Copying and Pasting Materials

The Materials Lab has its own dedicated clipboard 
that lets you store materials. You can have an 
object in your clipboard, then enter the Materials 
Lab and copy a material without disturbing the 
contents of your clipboard.

To copy a material to the Materials clipboard:

• Click the Copy button below the Material 
Preview window.

To paste a material to the Materials 
clipboard:
• Click the Paste button below the Material 

Preview window.

Using the Material Preview Area

There are several different ways you can see the 
effects of your material on an object. 

To switch preview modes:

• Click the triangle at the bottom of the material 
preview and choose an option from the menu:

Normal  displays your object as it looks in 
your scene. This is the default view of your 
selected object.

Up Close  displays a zoomed-in view of your 
object.
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Render With Neutral Sky displays your 
object against a plain sky. When this option is 
disabled, your preview contains the current 
sky settings. This option makes it easier to see 
the material without being distracted by 
patterns in the sky.

Render With Neutral Ground displays your 
object with a plain ground. When disabled, the 
ground in your preview has the same texture 
as the object. 

Current Selection displays the selected 
object exactly as it appears in the your scene.

Box  displays the material applied to a cube.

Sphere displays the material applied to a 
sphere.

Cone displays the material applied to a cone.

Cylinder displays the material applied to a 
cylinder.

Terrain displays the material applied to a 
randomly generated terrain object.

Ground displays the material applied to an 
infinite plane.

Torus displays the material applied to a torus 
object. Torus objects are good for displaying 
material properties like altitude changes, slope 
and height changes, and metallicity.

To change the view angle of the preview area:
• Drag the Preview area in the direction you 

want to view it from. 

The preview switches to wireframe as you 
move it. The angle of the preview does not 
affect the angle of the object in your scene.

Material Presets
Material presets are predefined materials. Presets 
contain channels values that simulate a wide 
variety of commonly used surfaces. Presets are 
stored in the Material Presets Library.

Presets are a great way of understanding how 
materials are made. You can open one of the 
presets and see what channel and components 
were used to create the final material. 

The Material Presets Library can also be used as a 
cookbook. Some of the shaders are organized as 
lessons that can lead you through the process of 
creating interesting effects. For example, try 
opening the Specularity lessons in the Simple & 
Fast category.

Using the Materials Presets Library
The Materials Presets Library contains all the 
material presets available in Bryce. You can place 
them on your objects directly and edit them just as 
you would any other material.

To add a material from the Materials Presets 
Library to an object:

1 Select an object.

2 In the Working window, click the triangle icon 
next to the Edit text button at the top of the 
Bryce environment. The Materials Presets 
Library appears.

or

In the Materials Lab, click the triangle icon at 
the top-right of the Material Preview window.

3 Click one of the Category names along the left 
side of the dialog.

4 Click the thumbnail of the preset you want to 
add.

5 Click the OK icon to add the selected material 
to your object.

You can also select presets in one motion by clicking 
the Materials Presets icon then dragging directly to 
the desired material preset and releasing the mouse 
button. You can also drag over the category names 
to change categories into the category’s presets, and 
then release mouse button.
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Adding and Deleting Preset Materials

You can add the material from any object to the 
Preset Materials Library. This is a good way of 
saving your favorite materials.

To add a material to the library:

1 Select the object whose material you want to 
add to the library.

2 Click the triangle icon next to the Edit text 
button at the top of the Bryce environment. 
Your selected object will appear in the preview 
area of the Preset Material Library dialog.

The preview area displays the object you selected.

3 Click a category name. The library switches to 
the category you selected. 

The new preset will be added to the category 
you select.

4 Click the triangle icon at the bottom right 
corner of the preview and choose a view 
option from the menu. 

Normal  is the default view of your selected 
object.

Up Close  displays a close-up of your object.

Render With Neutral Sky displays your 
object with a flat sky instead of the sky applied 
to your scene.

Render With Neutral Ground displays your 
object on a flat ground plane instead of the 
ground used in your scene.

Current Selection displays your object 
exactly as it appears in your scene.

Box  displays your material applied to a cube.

Sphere displays your material applied to a 
sphere.

Cone displays your material applied to a cone.

Cylinder displays your material applied to a 
cylinder.

Terrain displays your material applied to a 
terrain. You might want to disable Render 
With Neutral Ground as terrain materials look 
better when placed on a ground plane with the 
same material.

Ground displays your material applied to an 
infinite plane.

Torus  displays your material applied to a 
torus object.

5 Drag the preview area to rotate the view of 
your object.

6 Hold down the Spacebar and drag up, down, 
right, or left to pan the object preview.

7 Hold down Command/Ctrl and drag in the 
preview area to zoom in and out of the 
preview.

8 Click the Add button at the bottom of the 
dialog. The Add Material dialog appears.

9 Enter a name for the new preset in the Preset 
Name field.

10 Enter a description of the preset in the 
Description field and click the OK icon.

The name and description will appear next to 
the material preview whenever the preset is 
accessed. 

You can edit the name and description of any preset 
at any time by clicking the name or description.

11 Click the OK icon. Your preset will be added to 
the first available space within the current 
category.
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To delete a material preset:
1 Click the triangle icon next to the Edit text 

button at the top of the Bryce environment. 
The Preset Materials Library appears.

2 Click the preset you want to delete.

or 

Hold down Shift and select a continuous series 
of presets.

or 

Hold down Command/Ctrl and select a 
discontinuous set of presets.

3 Click the Delete button at the bottom of the 
Preset Materials Library dialog. 

Importing and Exporting Preset 
Materials
Importing and exporting presets is a handy way to 
exchange custom presets with other users. 

To import a preset material file:

1 Click the triangle icon next to the Edit text 
button at the top of the Bryce environment. 
The Preset Materials Library appears.

or 

In the Materials Lab, click the triangle icon 
next to the Material Preview window.

2 Click the Import button at the bottom of the 
Preset Materials Library dialog. The Open 
dialog appears.

3 Locate the file you want to import and click 
Import.

The contents of the file are placed into the 
first available space in the current category.

To export a preset material file:
1 Click the triangle icon next to the Edit text 

button at the top of the Bryce environment. 
The Preset Materials Library appears.

2 Select the preset or presets you want to 
export.

3 Click the Export button at the bottom of the 
Preset Materials Library dialog. The Save File 
dialog appears.

4 Enter a name and location for the file and click 
Save. 

You can create your own folders for presets, letting 
you organize presets into your own categories. 
Refer to “Adding and Deleting Preset Folders and 
Categories” on page76 for more information on 
creating your own preset folders and categories.

Animating Materials
Animating materials can add an exciting new 
dimension to your materials—time. Using the 
Animation controls, you can interpolate between 
textures over time or change the properties of a 
single texture over the course of an animation. 

The animation tools are a great way of adding life 
to your scene. Instead of creating an animation 
with simple motion, you can create subtle effects 
like changing a cube from water to ice or changing 
the seasons on a mountain. 

Refer to “Animating Materials” on page350 for 
complete instructions on animating materials.

Speeding Up Materials
While there is almost an infinite number of 
materials with the added complexity of creating 
materials using multiple components and adding 
volumes, you need not use all the features of the 
lab all at once. 

The more complex your material, the longer it 
takes to render so you should use complexity only 
where it’s necessary.

Rendering Transparency, Reflection, and Refraction 
always requires longer rendering time, but when 
you add the complexity of creating transparent, 
reflective, or refractive volumes, your rendering 
time can increase exponentially. If you find that 
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your scene is taking too long to render, you may 
want to try setting the Transparency, Reflection 
and Refraction values to zero. 

Additionally, use Full Shading Volume textures 
sparingly. This type of material creates specific 
types of effects, so you should limit these materials 
to specific areas of your scene. If you spread Full 
Shading Volume textures everywhere throughout 
your scene, be prepared for a long wait while the 
scene renders.





8
Creating and 
Editing Textures

One of the things that makes Bryce so unique is its 
materials. A material can bring any object to life, 
and textures are the power behind the material. A 
material can make your object shiny, dull, or 
transparent, but the textures within that material 
are what make it look like wood, rock, water, or 
clouds. 

Textures define the color, pattern or bumps 
within a material. A material can contain up to 
four textures. By altering the make-up or pattern 
of a texture you can dramatically alter the 
appearance of a material. 
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Texture Structure
A Bryce texture can be made up of three 
components. These components contribute the raw 
patterns or textures within a texture. Each 
component can then contribute one of three types 
of output to the final texture. These outputs are 
then combined to create the final texture. 

This diagram shows the structure of a texture.

Within each component is a combination of colors 
and noise that create a pattern. The shape of the 
noise inside a component is determined by the 
phase of the noise and the filter applied to it. The 
filter can create coherent patterns, random spots or 
anything in between. Refer to “Noise” on page177, 
“Phase” on page183 and “Filtering” on page186 
for more on noise, phase and filtering. 

This diagram shows the structure of a texture including the 
structure of a component.

A component can contribute one of three types of 
output to the final texture: Color output, which 
determine the colors in a texture, Alpha output, 
which determines the bright and dark areas in a 
texture, and Bump output, which determines the 
size and pattern of bumps in the texture. 

The component can contribute any combination of 
outputs. So you can have a final texture that 
contains Color output, Alpha output, and Bump 
output, or it can have all Color output or all Bump, 
or any combination of the three. 

The outputs in a texture are used by the material, 
so the type of output you have in a texture depends 
entirely on how you want to use the texture in the 
material. For example, if you’re using the texture as 
a bump map for the Bump Height channel in a 
material, you’d probably want all the components 
to contribute only Bump output. 

A texture can contain up to three components. It 
can be made up of all three components or just 
one, depending on the type of texture you want to 
create. The more components you use, the more 
complex your texture. 

Components are combined using Blend Modes. 
These modes can create a wide range of effects. 

The way components are combined to create the final texture is 
determined by the Blend Mode you select.

Components are combined differently depending 
on how many you use. If you use one or two they 
are combined according to the blend method you 
select. If you use three, the first two components 
are combined, and the resulting texture is then 
combined with the third component to create the 
final texture.
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When you use three components, the first two components (C1 
and C2) combine to create a hybrid texture which is then 
combined with the third component (C3) to create the final 
texture. So they’re combined using the formula 
(C1+C2)+C3=FINAL.

The texture components are combined together to 
form the final Combination texture. The final 
texture can have its own color scheme, noise, phase 
or filter. Any changes you make to the combination 
texture changes the final texture. These types of 
operations are called Global changes. Refer to 
“Global Changes” on page194 for more on global 
changes.

The end result of the Global changes is the final 
texture which can then be used in the Materials lab 
to create a material.

Components vs. Texture Components
Before you get any deeper into the discussion of 
texture structure you should understand a little 
terminology. 

A texture is a part of a material. It can be used to 
drive any of the material’s channels. When you use 
a texture in a material, it’s called a material 
component.

The texture itself also has components. It can be 
made up of up to three components that determine 
the look and color of the texture. The components 
that make up a texture are called components.

The difference between components and texture components 
may be a bit confusing. Just remember that when you’re talking 
about a texture, you’re dealing with components. When you’re 
working with materials, you’re using texture components.

Understanding Component Structure
A texture can have up to three components. When 
combined, the components create the final texture. 
A component consists of noise and color. 

A component can have up to three colors. The 
combined texture can also have a different set of 
three colors which is added to the colors from the 
components. In total your texture can contain up to 
twelve colors. 

The noise in a component is made of base Noise 
which is modified by the Phase, which controls the 
complexity of the noise, and the Filter, which 
determines the shape or pattern of the noise.

A component consists of noise and color. The Noise is modified 
by the Phase and the Filter. Each component can then produce 
Color, Alpha or Bump output.
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Components and Output

A component’s output type determines what type 
of information it’s going to contribute to the final 
texture. The Output type also determines the 
component’s structure. A component that does not 
have a Color output won’t contain any color 
information. The same is true for the two other 
types of output. If there’s no Alpha or Bump output 
there’s no Alpha or Bump information in the 
component.

Component Output
The main purpose of creating a component is to 
use it as part of a material which will then be 
applied to an object. How and what a texture 
contributes to a material is determined by the type 
of output it produces.

A texture can produce three different types of 
output: Color, Alpha and Bump.

When you apply a texture to a material, you can see 
the output types in the Texture Component 
Window in the Materials Lab.

The three boxes in the Texture Component Window in the 
Materials Lab represent the three output types available for a 
texture. 

If a texture does not produce a particular output the box 
appears gray.

Refer to “Texture Components” on page145 for 
more on using textures in materials.

In the Deep Texture Editor, the output type for a 
component is indicated by the three output 
buttons along the right side of the Component 
Window.

Assigning Output Types
A texture can produce all three output types or 
only one. The number of output types for the final 
texture depends on the output you assign to the 
components. A component can produce one or all 
three types of outputs. 

You can assign more than one component to the 
same output type. If you do have more than one 
component with the same output type, the output 
information will be blended to produce a final 
output.

For example, if you have two components that 
produce Color output, when you combine them the 
colors from both components are blended together 
and the result is applied to the final texture.

In order to produce an output type, a final texture 
must contain at least one component that produces 
the type of output you want. For example, if you 
want your final texture to contain color output, at 
least one of its components must produce color 
output.

Each output type contributes something different 
to the final material. 

Color Output

Color output is used by the color channels of a 
material. The color values you assign to a texture’s 
components are combined to form a final texture. 
The combined values are then used to drive the 
Diffuse, Ambient, Specularity, Specular Halo, or 
Transparency color channels. Refer to 
“Understanding Surface Material Channels” on 
page128 for more on these channels.

The colors in a texture usually appear in the form of 
a pattern or grain. When you assign the texture to a 
material, this pattern appears in the final material.

Color output

Alpha output

Bump output
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The texture in this example was applied to the Diffuse color and 
Ambient Color channels of the object’s material. You can see 
how the color pattern in the texture appears in the material.

To assign Color output to a texture:
1 Display the Deep Texture Editor.

2 In the desired component window, click the C 
button on the right side of the component 
window.

Alpha Output

Alpha output is used by the various Intensity and 
Optic channels of the material. When a texture’s 
Alpha output is assigned to a material, it’s used 
either to determine an effect’s intensity or as a 
guide map for combining multiple textures.

When there is only one texture component in a 
material channel, the texture’s Alpha output is 
usually used to determine the intensity of a channel 
effect. For example, if you assign a texture to the 
Diffuse channel, the texture’s Alpha output is used 
to determine which areas are the most diffuse and 
which are the least diffuse.

The texture in this example was applied to the Diffuse channel 
of the object’s material. You can see how the alpha pattern in 
the texture controls the diffuse intensity on the object’s surface.

To assign Alpha output to a texture:
1 Display the Deep Texture Editor.

2 In the desired component window, click the A 
button on the right side of the component 
window.

Bump Output

The Bump output is used only by the Bump Height 
material channel to determine the pattern and 
height of the bumps in a material.

The texture in this example was applied to the Bump Height 
channel of the object’s material. You can see how the bump 
output in the texture controls the pattern of bumps on the 
object’s surface.

To assign Bump output to a texture:

1 Display the Deep Texture Editor.

2 In the desired component window, click the B 
button on the right side of the component 
window.

Original Texture

Material containing texture

Original Texture

Material containing texture

Original Texture

Material containing texture
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Component Elements
A texture is made up of components. Each of those 
components can contain several elements that 
determine the color, pattern, grain or bumps in the 
component.

The Component window
You can have up to three components in your 
texture. As you activate components, a component 
window becomes active. Each window displays a 
preview of the component elements. 

The three buttons on the Component window let 
you access the Noise palette, the Filtering palette 
and the Phase palette. The buttons along the right 
side of the window indicate the type of output 
produced by the component.

To activate a component:

1 Display the Deep Texture Editor.

2 Click the component selector in the top-left 
corner of the editor.

The component selector lets you pick how many components you 
want to use to build your texture.

The selector lets you choose from 1, 2, or 3 
components.

Color
The colors in a component determine its color 
scheme. Each component can have up to three 
colors. Colors can be chosen using the color picker 
or the Color dialog. 

The color in a component is affected by the noise, 
filter and phase. You can create some very 
interesting patterns of color by modifying the 
noise. The color pattern created by the changes in 
the noise is applied directly to the final texture. So 
even if Color is the only output type for the 
component you’ll still see a pattern in your final 
texture.

When the Color Output is selected for a 
component, only the color information is combined 
with the other components. Also, when you apply 
the texture to a material, the colors in the 
component contribute to the colors used in the 
Color channels of the material.

There are two color models you can use to create 
colors in the components: RGB and HLS. RGB 
combines red, green and blue to create color. HLS 
combines Hue, Lightness and Saturation values to 
create color. The method you choose depends on 
the final output of your Bryce scene. RGB works 
best for most types of output.

If the Color output is not active for a component, 
changing the colors or Color Blending Modes has no 
effect.

To activate Color output for a component:
1 Display the Deep Texture Editor.

The Component window displays the selected component and its 
current attributes.

Open Noise palette

Open Filtering pal-
ette

Alpha output
Color output

Component Col-
ors

Open Phase 
palette

Bump Output

Color Modes

Randomize 

Reset Component
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2 In the desired component window, click the C 
button. 

An output type is active when the button 
appears light gray.

To choose colors for a component:
1 Display the Deep Texture Editor.

2 In the desired component window, make sure 
the C button is active.

3 Click one of the color indicators along the left 
side of the component window and choose a 
color from the palette. 

The three color indicators along the left side of the window 
display the colors used in the component.

To mix colors for a component:

1 Display the Deep Texture Editor.

2 In the desired component window, make sure 
the C button is selected.

3 Option/Alt-click the one of the color indicators 
along the left side of the component window. 
The Color dialog appears. 

4 Choose a color model by clicking one of the 
buttons along the bottom of the dialog.

5 Enter color values or adjust the sliders to mix 
a new color.

6 Click the OK icon.

Color Blending Modes

There are several blending modes you can use to 
create a color scheme.

To choose a Color Blending mode:
1 Display the Deep Texture Editor.

2 In the desired component window, make sure 
the C button is active.

3 Click the triangle icon in the lower left corner 
of the window and choose a mode from the 
menu. 

None
No blending is applied. 

Red or Hue
When the RGB model is used, this mode outputs 
only red color values. When the HLS model is used, 
only Hue values are output. 

This mode and the Green or Light, and Blue or Satu-
ration mode are available so that you can separate 
color values among the components. For example, 
you could set each component to output one of the 
different color values.

Green or Light
When the RGB model is used, this mode outputs 
only green color values. When the HLS model is 
used, only Lightness values are output. 

Blue or Saturation
When the RGB model is used, this mode outputs 
only blue color values. When the HLS model is 
used, only Saturation values are output. 

Spline Interpol
This mode creates a blend between all the colors in 
the component.
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This is what a color blend looks like using Spline Interpol.

Linear Interpol 2
This mode creates a linear blend between the first 
two colors selected for the component.

This is what a color blend looks like using Linear Interpol 2.

Linear Interpol 3
This mode creates a linear blend between all the 
colors in the component.

This is what a color blend looks like using Linear Interpol 3.

Randomized
In this mode the three colors are blended and then 
applied randomly throughout the component. 

This is what a color blend looks like using Randomized.

Earth Map
In this mode extra colors are generated according 
to the contours of the component’s bump map. The 
three colors you selected for the component are 
applied to the middle range of the bump map. Blue 

is applied to the lowest bump values and white is 
applied to the highest values to simulate polar 
caps. Earth Map is excellent for creating planets. 

This is what a color blend looks like using Earth Map.

Banded
In this mode colors are applied in bands. The bands 
are determined by color values. Colors with the 
lowest value (i.e. dark colors) are applied to the 
bands furthest from the center, colors with middle 
range values are applied next and colors with the 
highest values (i.e. bright colors) are applied closest 
to the center. 

This is what a color blend looks like using Banded.

Perturbed
In this mode colors are applied in irregular 
patterns. 

This is what a color blend looks like using Perturbed.

Interferences
In this mode the red, green and blue values of the 
first color in the component are used to create a 
repeating pattern around the contours of the 
component’s noise. 
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This is what a color blend looks like using Interferences.

Interpol + Interferences
This mode is a combination of Linear Interpolation 
and Interferences. 

This is what a color blend looks like using Interpol + 
Interferences.

Altitude
In this mode a white layer is added above the colors 
at high altitudes. Any portion of the object below 
ground is automatically colored blue. Altitudes are 
based on the object’s height. 

This is what a color blend looks like using Altitude.

Spline with Snow
This mode performs a spline interpolation of the 
colors in the component, but adds a white layer 
above the colors at high altitudes. Altitudes are 
based on the object’s height. 

This is what a color blend looks like using Spline with Snow.

Slope
In this mode the three colors are applied to the 
object depending on its slope. 

This is what a color blend looks like using Slope.

Orient
In this mode the three colors are applied to the 
object according to its east-west orientation. 

This is what a color blend looks like using Orient.

Noise
Noise is the background turbulence that creates the 
basis for texture patterns. 

In audio terms you can think of noise as the 
background static that you hear on old recordings. 
Sound is layered on top of this noise to create 
music. Like in audio, you layer other functions on 
top of the noise in your texture to create the final 
pattern or look of your texture. 

There are two ways of creating noise: the Noise 
palette or the Noise Editor.

The Noise palette can increase or decrease the 
amount of noise in any of the texture components. 
However, using the palette, you can only edit the 
existing noise. 

To display the Noise palette:

1 Display the Deep Texture Editor.

2 Click the Noise button at the bottom of the 
editor. The Noise palette appears.

or
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Click the Noise button in the top-left corner of 
on any of the component windows.

The Noise Editor is much more powerful than the 
Noise palette. It contains controls for creating 
noise from scratch. 

The Noise Editor lets you create noise and adjust its properties.

To display the Noise Editor:
1 Display the Deep Texture Editor.

2 Click the Noise button at the bottom of the 
editor. The Noise palette appears.

3 Click the top-left corner of the palette. The 
corner turns green as you pass your cursor 
over it. 

Creating Noise

The Noise Editor is the tool you’ll use to create 
noise with a component or combined texture. The 
noise creation process involves several steps:

• Choose the number of dimensions in the 
noise.

• Choose a Noise Type. This will give the basis 
for creating a noise pattern or grain.

• Adjust the frequency of the noise.

• Adjust the direction of the noise.

• Apply a modifier to your noise, by choosing a 
Noise Mode.

The following sections describe the various parts of 
the editor and how to use them in the noise 
creation process.

Noise Dimensions

Texture in Bryce can exist in 3D so your noise can 
have up to three dimensions. Noise dimensions 
determine which axes you can use to adjust the 
orientation and frequency of the noise.

It’s easier to see the number of dimensions for your 
noise if you use a cube in the Noise Preview.

These three examples show the difference between 1D, 2D and 
3D noise.

To choose the number of dimensions for your 
noise:
1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click one of the dimension buttons at the 
bottom of the editor.

Noise Type

There are 27 different types of noise available in 
the Noise Editor. Random noise is the default 
(RND). 

Each noise type provides you with a different basic 
pattern to start your texture. Some are more linear 
or geometric while others are more random.

Noise Mode

Noise PreviewNoise Type

Octaves

No. of Dimensions Frequency Controls

Direction Controls 1D Noise 2D Noise 3D Noise
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More complex noise types require more rendering 
time. The time it takes to render the preview is a 
good indication of how long the final texture will 
take to render. 

You should use the more complex noise types 
cautiously. 

These are examples of the some of the types of noise available.

The best way of choosing a noise type is to apply a 
few to your component and see how they look. 
Remember that this noise is only the basis of the 
texture. You can still edit this noise using the other 
controls in the editor, so don’t discard a noise type 
because it’s not perfect. The other controls can 
help you fine-tune the noise.

To choose a noise type:

1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click the Type field at the top of the editor and 
choose a noise type from the menu.

Noise Frequency

Noise Frequency determines how often the pattern 
within a texture repeats. Frequency is like scaling 
the noise. Higher frequencies decrease the scale of 
the noise so you can see the pattern more often. 
Lower frequencies increase the scale of the noise so 
the pattern repeats less often. 

You can change noise frequency using the 
Frequency fields. The fields let you enter numerical 
values to adjust the noise frequency along the X, Y 
or Z axis. You can also adjust the values using the 
scroll arrows. 

The number of dimensions in the noise determines 
how many axes you can use to adjust the 
frequency. For 1D noise you can only use the X axis. 
With 2D noise you can use both the X and Y axes. 
For 3D noise you can use all the axes.

If you try to adjust the Z axis frequency for a 2D 
noise, your changes will have no effect.

Adjusting the frequency can radically change the 
look of your noise. If you adjust the frequency in 
separate axes, you can achieve even more 
interesting effects.

Noise frequency settings control the repetition of patterns in a 
component.

In this example, the noise frequency was changed in only the Y 
axis.

To change the frequency of noise:

1 Display the Deep Texture Editor.

Frequency 
=10

Frequency 
=50

Frequency 
=100

Frequency X=10 Y=80 Z= 10
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2 Display the Noise Editor.

3 Drag over the X field in the Frequency area to 
set the noise frequency in the X axis. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the Y field in the Frequency area to 
set the noise frequency in the Y axis.

5 Drag over the Z field in the Frequency area to 
set the noise frequency in the Z axis.

You can also drag over the scroll arrows to speed up 
the increments.

Noise Orientation

Noise Orientation controls the direction of the 
noise. When you adjust the noise orientation, you 
change how the noise is laid out within the texture.

When you apply a texture, the direction of the 
noise within the texture remains constant 
regardless of the orientation of the object. 

Since noise can exist in three dimensions, you 
adjust the direction of the noise in the X, Y, or Z 
axis.

The number of dimensions in the noise determines 
how many axes you can use to adjust the 
orientation. For 1D noise you can only use the X 
axis. With 2D noise you can use both the X and Y 
axes. For 3D noise you can use all the axes.

You can edit the noise orientation using the 
Direction numerical fields.The fields let you enter 
precise angles for noise orientation. You can also 
use the scroll arrows to set the angle in increments. 

Changing noise orientation can dramatically 
change the look of your noise. You’ll see just how 
different your noise can look when you rotate it 
along a single axis. 

Noise orientation controls the direction of the noise.

To change the orientation of noise:
1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Drag over the XY field in the Direction area to 
set the noise angle in the X and Y axes. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the YZ field in the Direction area to 
set the noise angle in the Y and Z axes.

You can also drag over the scroll arrows to speed up 
the increments.

Noise Octaves

Noise octaves are like musical octaves. In a musical 
scale, if you play F and then F an octave down, 
you’re playing the same note, only it sounds lower. 
If you play both notes at the same time, the sound 
is more complex than if you played only one note. 
The same is true of noise. When you add an octave 
to noise it becomes more complex but the type of 
noise remains the same. 

These examples use RND Continuous noise and RND Linear 
noise to show the effects of increasing octaves.

Increasing the octaves adds processing time to the 
component.

Rotation in 
X 

Rotation in 
XY

Rotation in XYZ

1 Octave 2 Octaves 3 Octaves
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To change the number of octaves:
1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Drag over the octaves field at the top of the 
editor. 

Noise Modes

Noise modes modify the octaves of a noise. As you 
add complexity by increasing the octaves, the Noise 
Modes let you modify the additional noise so that it 
produces different effects. 

Many of the Noise modes use dark and light values 
to modify the existing noise. Also, you may not see 
the effects of the modes if the Octave is set to 0.

To choose a Noise Mode:
1 Display the Deep Texture Editor.

2 Display the Noise Editor.

3 Click the Mode field at the top of the editor 
and choose a mode from the menu. 

There are thirteen noise modes available:

Standard
This mode adds a new octave to the noise at half 
the frequency and twice the amplitude. This is the 
default mode.

In this example, Standard mode was applied to RND Continuous 
noise.

Irregular
This mode adds a new octave to the noise at half 
the frequency and twice the amplitude. However, in 
this mode higher frequency noise is modified more 
than the rest. The end result is that more detail is 
added to the noise.

In this example, Irregular mode was applied to RND Continuous 
noise.

More Irregular
This mode works exactly like Irregular except that 
this mode is more intense.

In this example, More Irregular mode was applied to RND 
Continuous noise.

Maximum
This mode uses the only the highest values, or 
lightest areas, to produce the modified noise.

In this example, Maximum mode was applied to RND 
Continuous noise.

Mulitfractal
In this mode lighter areas create higher contrast 
noise.

In this example, Mulitfractal mode was applied to RND 
Continuous noise.
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With Rotation
In this mode each additional octave is rotated. With 
Rotation mode it’s easier to see linear noise types.

In this example, With Rotation mode was applied to RND Linear 
noise.

Minimum
This mode uses only the lowest values, or darkest 
areas, to produce the modified noise.

In this example, Minimum mode was applied to RND 
Continuous noise.

Multiply
In this mode all the values in the noise are 
multiplied together. The results is a darker noise.

In this example, Multiply mode was applied to RND Continuous 
noise.

Difference
In this mode all the values in the noise are 
evaluated. All the values that are equal create black 
areas. When the values are different, the lower 
value becomes darker. The more octaves you have 
in the noise, the darker the modified noise. 
Difference works even at 0 octaves.

In this example, Difference mode was applied to RND 
Continuous noise.

Maximum 90
This mode repeats the noise at a 90° angle from its 
original orientation and combines the original and 
copy using only the highest values. This mode is 
good for creating woven patterns.

In this example, Minimum 90 mode was applied to RND 
Continuous noise.

Minimum 90
This mode repeats the noise at a 90° angle from its 
original orientation and combines the original and 
copy using only the lowest values.

In this example, Maximum mode was applied to RND 
Continuous noise.

Auto-phased
This mode automatically introduces phase shifts 
into the noise.

In this example, Auto-phased mode was applied to RND 
Continuous noise.
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Displaced Max
This mode creates a copy of the noise, displaces 
noise by a small amount, and then lightens any 
areas where the two overlap. This mode is good for 
creating stone textures.

In this example, Displaced Max mode was applied to RND 
Continuous noise.

Phase
Phase introduces turbulence into your noise. The 
phase displaces the grain or patterns within the 
noise. When you design the phase, you’re creating 
a displacement map along which the noise will be 
modified.

You can control how the phase interacts with your 
noise using the Phase palette. You can design your 
phase using the Phase Editor. 

The Phase palette controls the amplitude. The 
phase amplitude controls the intensity of the 
displacement. As the amplitude is increased, there 
is more interference with the original noise. 

You won’t have to increase the amplitude very 
much before you start seeing the phase pattern you 
designed interfere with the existing noise. In fact, 
it’s probably a good idea to keep the phase 
amplitude low so that the phase pattern doesn’t 
overwhelm the noise. 

This graph shows how the phase interacts with the noise at 
different amplitude settings.

To display the Phase palette:
1 Display the Deep Texture Editor.

2 Click the Phase button at the bottom of the 
editor. The Phase palette appears.

• Click the Phase button in the bottom-right 
corner of any of the component windows.

The Phase Editor looks a lot like the Noise Editor. It 
has the same type of tools and they work exactly 
like they do in the Noise Editor. The difference is 
that you’re using noise patterns, orientations, 
frequencies and modes to design how the basic 
Noise will be displaced.

Using the Phase Editor you can perform several 
functions:

• Create 1D, 2D, or 3D phase.

Original Noise

Phase =10

Phase =50

Phase Noise

Phase = 30

Phase = 250
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• Change the type of noise.

• Change the frequency of the phase.
• Change the orientation of the phase.

• Change the noise octaves.

• Change the noise modulations.

The Phase Editor lets you create noise to use as phase.

While the Phase Editor lets you create the noise 
pattern or grain within the phase, the Phase palette 
controls how that phase is applied to the 
component or the combined texture. 

To display the Phase Editor:
1 Display the Deep Texture Editor.

2 Click the Phase button at the bottom of the 
editor. The Phase palette appears.

3 Click the top left corner of the palette. The 
corner turns green as you pass your cursor 
over it. 

Creating Phase

Phase is designed using the Phase Editor. The phase 
creation process involves several steps:

• Choose the number of dimensions in the 
phase.

• Choose a noise type. This gives the basis for 
creating a phase pattern or grain.

• Adjust the frequency of the noise.
• Adjust the orientation of the noise.

• Apply a modifier to the noise by choosing a 
Noise Mode.

You’ll notice that many of the steps for creating the 
phase are the same as those for creating noise. 
That’s because you are creating noise. The 
difference is that instead of applying the noise to 
the texture, the noise you create for the phase is 
used to displace the existing noise.

The following sections describe the various parts of 
the editor and how to use them in the noise 
creation process.

Phase Dimensions

Just like noise, you can set the dimensions of the 
phase. The number of dimensions determines 
which noise axes will be displaced when you apply 
the phase. For example, if you apply a one-
dimensional phase to a three-dimensional noise, 
only the X axis of the noise will be displaced.

Its easier to see the number of dimensions for your 
phase if you use a cube in the Phase Preview.

Octaves 

Noise Mode

Noise Type
Phase Preview

No. of Dimensions

Direction Controls

Frequency Controls
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In this example, a 1D phase was applied to a 3D noise.

To choose the number of dimensions for your 
phase:

1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Click one of the dimension buttons at the 
bottom of the editor.

Phase Noise Type

There are 27 types of noise available in the Phase 
Editor. Random Noise is the default (RND). 

Each noise type provides you with a different basic 
pattern for the phase. The noise types available in 
the Phase Editor are the same as those in the Noise 
Editor, so you can refer to “Noise Type” on 
page178 for more on noise types. 

Phase Frequency

Phase frequency determines how often the pattern 
within the noise repeats. Frequency is like scaling 
the noise. Higher frequencies decrease the scale of 
the noise so you can see the pattern more often. 
Lower frequencies increase the scale of the noise so 
the pattern repeats less often. 

You can change phase noise frequency using the 
Frequency numerical fields. The fields let you enter 
numerical values to adjust the noise frequency 
along the X, Y or Z axis. You can also adjust the 
values using the scroll arrows. 

The number of dimensions in the phase determines 
how many axes you can use to adjust the noise 
frequency. For 1D phase you can only use the X 
axis. With 2D phase you can use both the X and Y 
axes. For 3D phase you can use all the axes.

Adjusting the frequency of the Phase noise 
disproportionately can have some very interesting 
effects on your noise. 

In this example, the phase noise frequency was changed in only 
the Y axis and then applied to 3D noise.

To change the frequency of phase noise:
1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Drag over the X field in the Frequency area to 
set the phase noise frequency in the X axis. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the Y field in the Frequency area to 
set the Phase noise frequency in the Y axis.

5 Drag over the Z field in the Frequency area to 
set the Phase noise frequency in the Z axis.

You can also drag over the scroll arrows to speed up 
the increments.

Combined Texture

3D Noise 1D Phase

Frequency X=10 Y=80 Z= 10
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Phase Noise Orientation

Phase noise orientation controls the direction of 
the noise within the phase.

The number of dimensions in the phase determines 
how many axes you can use to adjust the 
orientation.

You can edit the noise orientation using the 
Direction numerical fields.The fields let you enter 
precise angles for noise orientation. You can also 
use the scroll arrows to set the angle in increments. 

Like frequency, changing the orientation of the 
phase noise in only one or two axes can create 
some very interesting results. 

In this example, the phase noise orientation was changed in only 
the Y axis and then applied to 3D noise.

To change the orientation of phase noise:

1 Display the Deep Texture Editor.

2 Display the Phase Editor.

3 Drag over the XY field in the Direction area to 
set the noise angle in the X and Y axes. 

Drag left to decrease the value or right to 
increase it.

4 Drag over the YZ field in the Direction area to 
set the noise angle in the Y and Z axes.

You can also drag over the scroll arrows to speed up 
the increments.

Phase Noise Octaves

Phase noise octaves work exactly like the noise 
octaves. They introduce an extra level of 
complexity to the noise. Refer to “Noise Octaves” 
on page180 for more on octaves.

Phase Noise Modes

Phase noise modes work exactly like the noise 
modes. They modify the octaves of a noise. Refer to 
“Noise Modes” on page181 for more on octaves.

Filtering
The filter you apply to the noise in a component 
can change the entire look of the noise. The filter 
refines the noise so that it has more or less detail, 
increases its contrast, applies it only at high 
altitude or changes its spatial orientation. 
Whatever the change, the filter has a profound 
effect on the final look of your texture.

Filters are expressed as equations with variables. 
When the equation is applied to the noise, it 
changes some aspect of the noise. You can control 
how the equation affects the noise by changing the 
values of the variables. 

The filter only affects the noise. The phase cannot 
be altered using a filter. The phase is blended with 
the noise. 

Filters are edited using the Filtering palette. The 
palette displays the current filter and provides 
tools for editing the filter graph.
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The Filtering palette displays the current filter and provides 
tools for editing it.

To display the Filtering palette:

1 Display the Deep Texture Editor.

2 Click the Filtering button at the bottom of the 
editor.

or

• Click the Filtering button in the top-right 
corner of any of the component windows.

Editing the Filter

Filters are equations which have variables. Each 
equation can have up to three variables labeled a, b 
and c. The values for each variable are displayed at 
the bottom of the palette. Generally, a controls the 
intensity of the filter effect while b controls the 
overall height. In some filters a and b may stand for 
other things.

There are two ways you can adjust a filter: by 
changing the variable values or by changing the 
shape of the graph (which automatically changes 
the variable values). The method you use depends 

on how much you know about a particular filter. If 
you’re not sure what the filter does, change the 
graph—it’s a much more intuitive way of working.

To edit the Filtering graph:
1 Display the Filtering palette.

2 Drag over the Filtering graph area. The shape 
of the graph changes as you drag. 

The graph area of the Filtering palette lets you interactively 
adjust the filtering effect.

Notice that the variables also changes as you 
move the graph.

• Dragging horizontally changes the value of 
a.

• Dragging vertically changes the value of b.

To change variable values:

1 Display the Filtering palette.

2 Drag over the variable field you want to 
change. Drag left to reduce the value or right 
to increase it.

The shape of the graph changes as you adjust the 
values.

Choosing a Filter

Each filter available in the Filtering palette offers 
something unique. The best way of choosing which 
filter you want to use is to apply it to a component 
and see what happens.

To choose a filter:
1 Display the Deep Texture Editor.

2 Display the Filtering palette.

Filtering 
Graph 

Filtering 
Equation 

Reset Button Filter Variables 

Component 
Indicator



Creating and Editing Textures188

3 Click the Filtering Equation area and choose a 
filter from the menu.

There are fourteen filters available. The following 
sections describe the filters and gives you some 
idea of how to edit them.

None
This option deactivates the filter. No filtering is 
applied to the component.

Quantize
This filter works like a Posterize effect. When it’s 
applied, gray values jump from one value to the 
next, creating a blocky stair-step type of effect. 

In this filter a and b control the contrast and height, 
while c controls the number of levels between 
white and black.

In this example, Quantize was applied to RND Continuous noise.

Saw Wave
When the graph for this filter has only a small 
curve, it acts like a contrast filter. As it approaches 
the height limits (set by b), it bounces back on 
itself. This creates high-contrast breaks in the 
noise. 

For color output use this filter to get areas of high-
contrast alternating color. 

When you set the value of a to a high number you’ll 
get areas with a larger amount of noise.

In this example, Saw Wave was applied to RND Continuous 
noise.

Sine Wave—Sin (aX) + b
This filter creates noise that appears as large 
number of lines that are oriented in the same 
direction. Use this filter to generate wood grains. 

The a variable controls the number of lines. Higher 
values create a better effect.

In this example, Sine Wave was applied to RND Continuous 
noise.

Absolute—Abs(aX + b)
This filter works like a Difference effect. When it’s 
applied, you’ll get more light areas in your noise 
and a higher level of detail in a bump map. 

To get additional bump information using this 
filter, set a to 2 and b to -1.

In this example, Absolute was applied to RND Continuous noise.

RND Continuous
Noise

RND Continuous
Noise + Quantize
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XPower—(X PWR a) + b
This filter smooths out the darkest areas of your 
noise. However it has less effect on lighter areas 
and no effect on white.

In this example, XPower was applied to RND Continuous noise.

Gaussian—(a(X + b))
This filter smooths out darker areas of your noise 
and makes lighter areas noisier. White areas 
become the noisiest.

In this example, Gaussian was applied to RND Continuous noise.

Clip aX + b
Clip is probably the filter you’ll use most. It’s a 
contrast filter. 

The a variable controls the contrast and b controls 
the overall brightness. 

For a low contrast effect make the wave in the 
graph smaller. Decrease the value of a to reduce 
the size of the wave and increase b to move the 
wave up. Using this wave, all the values will be 
expressed as mid-gray.

For a high contrast effect, adjust the wave so that it 
hits both the top and bottom edges of the preview. 
Increase the value of a and make b negative to 
move the curve down. 

To invert the colors in your noise, make a negative 
and increase b.

In this example, different levels of Clip were applied to RND 
Continuous noise.

Altitude Minus Slope—Xb + a (Altitude-
Slope)
This filter applies noise only at certain 
combinations of slope and altitude. When a is 
positive and b is negative, noise is applied at high 
altitudes and on flat surfaces.

When a is negative and b is positive, noise is 
applied at low altitudes and on steep slopes.

The Altitude Minus Slope filter works on the slope 
and altitude of an object in World Space. 
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In this example, Altitude Minus Slope was applied to RND 
Continuous noise and then to objects in a scene.

Slope—X(a * Slope + b)
This filter applies noise based on an object’s slope. 
Slope can range anywhere from flat and horizontal 
to steep and vertical. This is an excellent filter to 
use if you want to isolate a texture to vertical cliffs 
or flat surfaces. 

In this filter a determines the steepness of the noise 
(-4 is flat, 4 is vertical). The b variable controls the 
starting point of the transition.

• To place noise on vertical surfaces make a=4 
and b=2.

• To place noise on flat surfaces make a=-4 and 
b=1.5.

The Slope filter works on the slope of an object in 
World Space. 

In this example, Slope was applied to RND Continuous noise and 
then to objects in a scene.

Altitude—X(a* Altitude + b)
This filter modulates the scale of the noise 
according to an object’s altitude. 

In this filter a determines how fast the noise is 
scaled by altitude. A lower value creates a gradual 
transition, while higher values create sharper 
transitions. 

To apply noise at higher altitudes make sure a is 
positive. At high altitudes b controls the transition. 
The higher the transition, the lower the number. 
So, at high altitudes b should be a negative number.

To apply noise at lower altitude, reverse the 
variables so that a is negative and b is positive.

The Altitude filter works on the altitude of an object 
in World Space. 
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In this example, Altitude was applied to RND Continuous noise 
and then to objects in a scene.

Orientation—X(a * Orientation + b)
This filter applies noise based on an object’s east-
west orientation. 

In this example, Orientation was applied to RND Continuous 
noise and then to objects in a scene.

Smooth Clip
This filter works exactly like the Clip filter. It’s also 
a contrast filter, except that this filter smooths out 
the transitions between darks and grays. 

The a variable controls the contrast and b controls 
the overall brightness.

In this example, Smooth Clip was applied to RND Continuous 
noise.

Snow Puddles
This filter turns noise into snow patches. Snow is 
applied according to an object’s slope and altitude. 

The a variable controls how much the noise 
interferes with the smoothness of the snow. When 
a=0 the noise doesn’t interfere at all so the snow is 
perfectly smooth. When the a value is higher, the 
snow starts looking like the noise.

The b variable shifts the altitude or snow level. It 
sets where the snow begins.

The c variable controls how steep an object has to 
be before the snow appears on its surface. The 
higher the number, the flatter an object has to be 
before snow appears on its surface. 

In this example, Snow Puddles was applied to RND Continuous 
noise and then to objects in a scene.
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Combining Components
The Deep Texture Editor gives you unparalleled 
control over the look and feel of each one of the 
components that make up a texture, but the 
control doesn’t stop there. The Deep Texture 
Editor also lets you control how those components 
are combined to create the final texture. 

Blend Modes
Components are combined using Blend modes. 
These modes are filters applied to the components 
to determine how the properties in each 
component are combined with the other 
components’ properties to form the final texture.

The number of blend modes you can use varies 
depending on how many components you’re using 
to build the texture. 

If you’re using only one component, the properties 
in the component are applied directly to the final 
texture. When you’re using two components, 
they’re blended using a single blend mode, and the 
result is then applied as the final texture. 

When you’re using three components, the first two 
components are blended together using a blend 
mode, then the result of that blend is combined 
with the third component using a second blend 
mode. The result of all the blending is then applied 
as the final texture.

This diagram explains when the blend modes are applied as you 
combine components to form a texture.

Depending on the Blend mode, the different types 
of output can affect each other during the 
combination process. So its possible that the Bump 
output of one component may affect the Color 
output of another.

To apply a blend mode:

1 Display the Deep Texture Editor.

2 Click the text above a component and choose 
a mode from the menu.

• Click the text above Component 1 to 
choose a Blend Mode to combine 
components 1 and 2. 

• Click the text above Component 3 to 
choose a Blend Mode to combine the 
results of Component 1 and 2 with 3.

There are nineteen blend modes you can use to 
combine your components:

Parallel

This mode does not blend components. Use it 
when each component has a different output type. 
If two components share an output type, only the 
first output will be applied to the final texture. 
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For example, if Component 1 has output= Color 
and Bump, and component 2 has output=Color 
and Alpha, only the color from Component 1 will be 
applied to the texture.

Combine

Combine is a blend mode for colors only. When you 
use this blend mode, the first color in Component 2 
is used as an alpha channel. Wherever that color 
appears in Component 2, it is replaced with the 
colors from Component 1. 

For example, lets say Component 2 has Yellow, 
Green and Blue and Component 1 has Orange, 
Purple and Black as its color scheme. 

When you combine them using the Combine blend 
mode, Yellow disappears from Component 2. 
Everywhere that Yellow appeared, you’ll see 
Orange, Purple and Black.

Average

Average is normal blend mode where all the 
component values are mixed with equal weight. So 
if one component is white and the other is black, 
the result is gray.

This is a good all-purpose blend mode to use for 
creating textures.

Multiply

When you use this blend mode to combine 
components, you’ll get a darker result. In this 
mode, when a black component is combined with a 
gray component, the result is black. When a gray 
component is combined with a white component, 
the result is gray. When two shades of gray are 
combined, the result is proportionally darker.

In the case of Bump output, this mode will flatten 
most areas since black is flat and darker values 
create flatter bumps.

Maximum

When two components are combined using 
Maximum, the two components are compared and 
the one that’s lighter becomes the result.

Blend Maximum

Blend Maximum works the same as Maximum, 
except that it creates blurring at points of sharp 
transition.

When Blend Maximum is applied to Bump output, 
the resulting bump map will have many high points 
and few deep pits. 

This mode works best on Bump output.

Minimum

This mode is the opposite of Maximum. When two 
components are combined, they’re evaluated and 
the darker areas of both are combined to produce 
the result.

Blend Minimum

Blend Minimum works the same as Minimum 
except that it creates blurring at points of sharp 
transition.

When Blend Maximum is applied to Bump output, 
the resulting bump map will have mostly low areas 
with very few high points. 

Add

Add combines colors so that they appear 
dramatically lighter. However, it doesn’t have the 
same effect on Bump output.

Subtract

When you combine grayscale components using 
Subtract, they tend to turn out black or very dark. 
When you use it with colored components, the 
result is brilliant colors that tend to compliment 
the original colors.
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Blend v1 and v2

These two blend modes let you use one of the 
components as an alpha channel for blending. 

When you choose Blend v1, the noise in the first 
component is used as an alpha channel to blend the 
two components. 

When you choose Blend v2, the noise in the second 
component is used as an alpha channel to blend the 
components. 

Blend Slope

Using Blend Slope, components are combined 
according to an object’s slope. The first component 
is applied to areas that are flat and the other is 
applied to areas that are steep.

Fast Slope

Fast Slope works exactly like Blend Slope except 
that the transition from one component to the 
other is more abrupt.

Blend Altitude

This mode blends components according to an 
object’s altitude. The first component appears at 
low altitudes and the second appears at high 
altitudes.

Blend Orientation

In this mode, one component is applied in all 
directions, while the other is applied in only one 
direction. You can use this mode to simulate things 
like moss that only grow on one side of a tree.

Blend Random

This mode introduces an extra layer of noise and 
uses it as an alpha channel for combining the two 
components. Component 1 appears in some areas 
of the new noise, and Component 2 appears in 
other areas. 

Since this mode adds another layer of noise, you’re 
also adding more processing time.

Procedural Blend

Procedural Blend combines two components so 
that the color and values of Component 1 are 
applied to Component 2 based on the gray values 
in Component 2. In essence, the Alpha output from 
Component 2 is used as a guide for blending.

Where Component 2 is light, Component 1 is not 
applied. Where Component 2 is dark, Component 1 
is made darker. Where Component 2 is gray, 
Component 1 is applied without change.

This mode usually results in more saturated colors.

Difference

Difference finds the difference between the noise in 
the two components and displays the result. 

This mode only works on output of like types. So if 
Component 1 has Alpha and Color output while 
Component 2 has only Alpha, the two Alpha 
outputs are combined and the Color output is left 
unchanged.

Global Changes
The component window in the center of the editor, 
called the Combination component, represents the 
final combined texture. Any changes you make to 
this final component are considered global changes 
since they affect the entire texture.

The Combination component can have its own 
color scheme, filter, noise pattern or phase. These 
attributes are applied to all the component 
elements. For example, the Combination noise 
values affect the noise within each component. 

Global changes give you a way of applying a last 
layer of complexity to your texture.
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Global Colors

The colors in the Combination component interact 
with the combined colors in the three components. 
They act as a final color filter for the texture. After 
the colors in each component are combined, they 
are blended with the combination component 
colors to produce the colors in the final texture.

You can also apply a final Color Blending method to 
the combination component. The Blending method 
you apply to the combination component is applied 
on top of the other modes used in the components. 

For example, if you choose Altitude in the 
Combination component, the texture color is 
applied using the blend modes in the components 
and then also applied by altitude.

This example shows a texture containing a texture with 
different Color Blending modes in it.

To add colors directly to a texture:

1 Click the top color circle in the Combination 
component window and choose a color from 
the palette.

The color circles in the Combination component window let you 
apply colors directly to the final texture.

2 Repeat for each of the other two color circles. 

Global Noise

When you change the noise in the Combination 
component, (i.e., globally) it applies to all the 
components equally. So if you increase the noise in 
the final component, the noise in each of the 
components increases. Likewise, when you 
decrease the noise globally, the noise in each 
individual component decreases.

Global noise can be different than component 
phase, so you can introduce a completely different 
type of noise into the texture. 

Use this option cautiously. The more noise you intro-
duce into your texture, the longer it takes to render 
and draw. If you introduce too much complex noise 
patterns into a texture, you may find your render 
time increased significantly.

You can adjust global noise in the same way you 
would for a single component, using the Noise 
palette or the Noise editor.

To adjust noise globally:

1 Click the top left button in the combination 
component window.

The Noise palette appears.

2 Drag the slider to adjust the noise value.

or

Click the top left corner of the Noise palette to 
display the Noise Editor.

Use the editor’s controls to design the global 
noise pattern or grain.

Global Phase

As you adjust the Global Phase value, new phase is 
introduced into each of the components.

Global phase can be different than component 
phase, so you can introduce a completely different 
type of phase into the texture. 



Creating and Editing Textures196

You can adjust global phase in the same way you 
would for a single component using the Phase 
palette or the Phase Editor.

To adjust phase globally:
1 Click the bottom-right button in the 

combination component window.

The Phase palette appears.

2 Drag the slider to adjust the phase amplitude.

or

Click the top left corner of the Phase palette to 
display the Phase Editor.

Use the editor’s controls to design the global 
phase.

Global Filtering

The Filter affects the final look of the noise within a 
component. The Global Filter affects the look of the 
combined noise. The Global Filter is applied to the 
noise in the Combination component.

The global filter only affects the noise, not the 
phase in the component. Any of the filters you used 
in the components can be used as the global filter.

Use this option cautiously. The more complex the 
noise in your texture, the longer it takes to render 
and produce. If you introduce too much complexity, 
you may find your render time increased signifi-
cantly.

To filter noise globally:
1 Click the top-right button in the combination 

component window.

The Filtering palette appears.

2 Choose a filter and adjust its variables to 
create the desired effect.

The Deep Texture Editor
The Deep Texture Editor can be used in two ways: 
by working with equations and algorithms or by 
exploring and experimenting. 

If you’re comfortable with equations and 
algorithms, the Deep Texture Editor gives you the 
freedom to create any textural pattern or surface 
you can imagine. 

For those who don’t want to calculate, the Deep 
Texture Editor can be used as a large palette. Take 
a little of this and little of that, blend them all 
together and see if you like the result. You will find 
that experimenting with these deep functions can 
produce unexpected results. 

When experimenting with the Deep Texture Editor, 
you may inadvertently create a very complex 
texture that could add considerably to your 
rendering time. However, this is an easy pitfall to 
avoid. The last section of this chapter gives you 
some tips on reducing the complexity of your 
textures. Refer to “Tips for Speeding Up Textures” 
on page199 for more.

Tip: When you’re just exploring the editor, set all the 
component outputs to Alpha. This lets you see the 
effects of your changes more clearly.

To display the Deep Texture Editor:

1 Display the Materials Lab.

2 Click the A, B or C column of the material 
channel to which you want to assign a texture.

A component window becomes active.

3 Click the pink button at the top of the 
Component window.

The Deep Texture Editor appears.
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A Quick Tour: The Deep Texture Editor
The layout of the Deep Texture Editor is a visual 
representation of the texture creation process. The 
three components along the top combine to form 
the final texture, shown in the middle. The layout 
makes the editor very easy to use. 

Along the top of the editor you’ll see the preview 
options. These three icons let you choose how you 
want to display the component.

The three icons at the top of the editor let you choose a preview 
mode.

Below the preview control on the left, you’ll see the 
component selector. This tool lets you choose the 
number of components you want to use to build 
your texture. 

The component selector lets you choose how many components 
you want to use to build a texture.

The rest of the editor displays the component 
window. The three windows along the top 
represent the three components you can use in a 
texture and the center window represents the 
combined texture. 

The three buttons along the bottom of the editor 
let you display the three editing palettes. The 
palettes let you control the noise, phase and 
filtering applied to the texture.

You can access the Noise and Phase Editors from 
within the Noise and Phase palettes.

Working in the Deep Texture 
Editor
This section describes how to use the Deep Texture 
Editor to create and store textures.

Building Textures
A texture is a combination of components. You 
build textures by designing or editing components 
(i.e., colors, noise, phase or filters) and combining 
them using Blend modes. 

 To build a texture:

1 Display the Deep Texture Editor.

2 Click the Component Selector to choose the 
number of components you want to use to 
build the texture.

The component windows become active.

3 In the first component window, click one of 
the Output buttons to choose an output type.

4 If your component contains color, click one of 
the color circles and choose a color to apply to 
the texture.

You can choose up to three colors for each 
component.

5 Click the triangle icon below the color circles 
and choose a Color Blending mode for your 
colors.

6 Click the Noise button at the bottom of the 
editor. The Noise palette appears. 

7 Adjust the noise in the component by:

• Dragging the Noise slider on the Noise 
palette to increase or decrease the amount 
of noise in the component.

• Click the top left corner of the palette to 
display the Noise editor, then use the 
editor controls to design or edit the noise 
in the component.

8 Click the bottom-right button on the 
Component window. The Phase palette 
appears.

9 Adjust the phase in the component by:

• Dragging the Phase slider on the Phase 
palette to increase or decrease the 
amplitude of the phase in the component.
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• Click the top left corner of the palette to 
display the Phase editor, then use the 
editor controls to design or edit the phase 
in the component.

10 Click the Filtering button at the bottom of the 
editor. The Filtering palette appears.

11 Choose a filter to apply the component noise 
and adjust that filter’s variables.

12 Repeat steps 3–11 for each component in the 
texture. 

As you edit the noise, phase, or filter of the 
remaining components, make sure you move 
the component indicator at the top of each 
palette to be sure you’re editing the right 
component’s attributes.

13 Click the text above Component 1 and choose 
a Blend mode from the menu.

14 If you have more than two components, click 
the text above Component 3 and choose a 
second blend mode.

The result of blending all the components 
appears in the Combination window.

15 Click the color circles in the Combination 
component window, and choose colors for the 
final texture.

You can also choose a Blending mode.

16 If you want to change the noise of combined 
component, display the Noise palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

17 If you want to change the phase of combined 
component, display the Phase palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

18 If you want to change the filter of combined 
component, display the Filtering palette. 

If it’s already displayed, make sure the 
component indicator is on the fourth 
component.

19 Click the OK icon at the bottom of the editor. 
The texture appears in one of the component 
windows in the Materials Lab.

Using Drag and Drop in the Editor
The Deep Texture Editor lets you drag and drop 
component elements between component 
windows. This a quick way of copying elements 
between components. 

For example, if you were setting up a red, green 
and blue separation of the colors in your texture, 
you could drag the same elements to all three 
component windows and change the Color 
Blending mode.

To drag and drop between windows:

• Drag from the window you want to copy to the 
window where you want the elements to 
appear. Release the mouse button to drop the 
component elements. 

The elements you drop into a window replace 
the existing elements.

Changing Component Preview
Each component window has a preview of the 
component’s elements. You can choose to display 
the elements mapped onto a flat surface, a cube or 
a sphere. 

Displaying the component on a cube makes it 
easier to see 3D noise and phase changes.

To choose a preview mode:
• Click the flat surface, cube or sphere in the 

top-right corner of the editor.
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Randomizing Textures
A quick way of designing a texture without going 
into designing noise or filters is to create random 
components. 

The randomize buttons in the component windows 
let you randomize the elements in the component 
window. The type of output you choose for the 
component determines what part of the 
component is randomized. 

This is an excellent way of exploring the editor. Just 
randomize the components elements and combine 
them to see what happens.

To randomize component elements:

• Click the knob in the bottom-right corner of 
the component window.

Undoing Changes
The Reset control lets you undo all the changes 
you’ve applied to a component and returns to the 
component displayed when you first entered the 
editor.

To reset a component:
• Click the knob in the top-left corner of the 

component window.

Saving Textures
You can save your texture as part of texture list so 
you can access it quickly from the Materials Lab.

To save a texture:
1 In the Combination component window, click 

the knob in the top-right corner of the 
component window.

The Save Texture dialog appears. 

2 Enter a name for the new texture and click the 
OK icon.

The new texture appears at the bottom of the 
texture list. The list can be accessed from the 
Materials Lab.

Tips for Speeding Up 
Textures
Textures can be the most powerful effects you 
create in Bryce. They can also be the most costly. 
The more complex the texture, the longer it takes 
to calculate and the longer it takes to apply to an 
object, which finally increases the rendering time.

When you’re creating the texture, you always have 
to keep in mind that it’s part of a material, which is 
part of an object. All these parts can contribute to 
the rendering time:

• The material that contains the texture may 
have several complex attributes of its own, like 
Transparency and Reflection. 

• The size of the object may also contribute to 
the rendering time. 

Consider the effect of applying a complex texture 
to a complex material onto an infinite plane. The 
time to calculate this object would be staggering.

A good rule of thumb when working with complex 
objects and textures is to make the texture element 
as simple as possible.

These tips are meant only as a precaution to prevent 
you from inadvertently creating a huge texture. That 
doesn’t mean that you shouldn’t use the more com-
plex features as well, after all they were created for a 
reason. You should just use them cautiously.

Noise
• Use a simpler noise type. Some noise types 

(like Vortex) require more time to process than 
others. 

• Restrict the amount of noise you add to each 
component. In fact, not all the components 
need to have noise.
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• Watch the frequency of the noise. Higher 
frequency noise requires more time to 
calculate then lower frequency noise.

• Watch the number of octaves in the noise. 
Each octave adds another level of complexity.

Phase
• When you’re designing the phase, you may 

want to use simpler noise.
• Cut down on the number of phase types you 

combine. If each component has a different 
type of phase, combining them can increase 
calculation times.

• Watch the amplitude of the noise. Higher 
amplitude phase takes much longer to 
calculate.

• Apply Global Phase cautiously. This is the 
quickest way of increasing the complexity of 
your texture because global phase introduces 
more complexity into each component 
simultaneously.

Filtering
• Filtering introduces complexity or detail into 

the noise of a component. Make sure that you 
aren’t using a filter unnecessarily. Not all noise 
needs filters.

Be careful when you apply a Global Filter as this 
adds even more complexity to the noise.



9
Arranging Objects

In a scene, the arrangement of objects is as 
important as their form. You can design beautiful 
landscapes, or build complex models, but if 
they’re the wrong size or in the wrong position, 
they won’t look right in the scene. To get the right 
look, you’ll need to position or rotate the objects 
to make sure they are in the right places within 
the scene, or you may need to resize an object so 
that it is in proportion to the rest of the objects. 
These kinds of operations are called 
transformations.

Bryce supports three basic types of 
transformations: size, position, and rotation. The 
tools in the Edit palette let you interactively 
perform these operations on any object in your 
scene. As well, the Object Attributes dialog lets 
you transform objects numerically for greater 
precision.

As you arrange objects, you’ll probably need to 
create some kind of object hierarchy. An object 
hierarchy lets you create a structure in your scene 
that organizes objects according to their spatial or 
logical relationships. The structure can make 
arranging objects much easier and faster.

You can create an object hierarchy by grouping 
and linking objects.
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This chapter describes how to use the 
transformation tools and the Object Attributes 
dialog to resize, reposition, rotate, align and 
randomize objects. It also describes how to create 
object hierarchies.

Bryce and 3D Space
Since all the objects in your scene exist in 3D space 
(defined by XYZ), any transformation you perform 
is a 3D transformation. This means that you’re 
changing the attributes of the object in each axis.

Bryce has three ways of defining 3D space: World 
Space, which is constant, Object Space, which 
changes as the object changes and Camera Space, 
which changes as the camera changes.

When you’re using the interactive transform tools 
on the Edit palette you can use any one of the 3D 
space definitions. Refer to “Transformation Tools” 
on page206 for more on using these tools.

World Space
World Space is the coordinate system that defines 
all the space in the Bryce universe. It is constant 
and cannot be modified. It is also the default space 
used for transformations.

World Space is defined by three axes, X, Y and Z, 
that all meet at world center. This center is defined 
numerically as 0, 0, and 0 for the X, Y and Z axes. By 
default, all new objects appear at world center.

The Y axis that extends from world center defines 
all vertical space. Positive values represent 
distances above ground level and negative values 
represent distances below ground. The X axis 
represents distances left and right and the Z axis 
represents distances backward and forward.

World Space is defined by three axes that extend infinitely from 
a center point called world center.

When you use World Space for transformations, 
objects move in relation to this absolute coordinate 
system.

When you transform objects in relation to World Space, they 
move along the three absolute axes.

Object Space
When Bryce creates an object, it defines the up, 
down, right, left, back and front of the object. 
These definitions remain with the object no matter 
what transformations you apply to it. So in a sense, 
each object carries with it its own coordinate 
system.
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Object space is defined by three axes that extend from the center 
of the object.

When you transform an object using Object Space, 
the object moves in relation to its internal 
coordinate system. For example, you can increase 
the height of an object based on its own Y axis.

When you transform an object using Object Space, it moves 
along an axis that extends from its center, not an absolute axis.

Because Object Space ignores the absolute 
coordinates, the object becomes taller without 
being skewed. If you used World Space, the object 
would become deformed since it increases along 
the absolute Y axis.

This is an example of an object transformed using World Space 
and then using Object Space.

Camera Space
Camera Space is defined by three axes, X, Y and Z, 
that extend from the camera center. Wherever you 
move the camera, these axes move along with it.

Camera Space is defined by three axes that extend from the 
center of the camera.
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When you use Camera Space for transformations, 
you’re moving objects in relation to the camera. 
When you drag along the X axis in Camera Space, 
you’re moving left or right from the camera. When 
you move along the Y axis in camera space, you’re 
moving up or down from the camera. When you 
move along the Z axis, you’re moving away or 
towards the camera.

Since the camera can be rotated and repositioned, 
it can sometimes be hard to tell which way is up, 
left or right, because your view from the camera is 
no longer aligned to the absolute XYZ axes.

Suppose you’ve rotated the camera and then you 
move an object along the Y axis in World Space. 
Instead of moving up, it may appear to move off to 
the left, since your view of the scene is not aligned 
to the World Space Y axis. However, in Camera 
Space, the object will move up, because the object 
moves along the camera’s Y axis.

When you transform objects using Camera Space, they move 
along an axis that extends from the center of the camera.

To choose a 3D spatial option for 
transformations:

1 Click the Edit button at the top of the Bryce 
window to display the Edit palette.

2 Click the triangle icon below one of the 
transformation tools and choose a 3D spatial 
option from the menu.

Each of the transformation tools has a triangle icon below it, 
which lets you access additional tool options.

Bryce Units
Bryce maintains an invisible, absolute, infinite 3D 
grid internally. This grid is comprised of 3D cube 
increments, each of which is 20.48 x 20.48 x 20.48 
“Bryce units” in size. All primitive objects (spheres, 
cubes, etc.) are created at the same size as a 3D 
cube increment (20.48 x 20.48 x 20.48) called unity.

Unity is the base size of all primitive objects created in Bryce. 
Unity is always 20.48 x 20.48 x 20.48.

All interactive 3D transformations are relative to an 
absolute (unity) size, position, and orientation for 
all objects.

To reset primitive objects to unity:

•  Hold down Control/Ctrl+Option/Alt and click 
one of the object’s control points. The object 
is reset to 20.48 x 20.48 x 20.48.

Coordinate Systems
When you’re transforming objects numerically in 
the Object Attributes dialog, you can use one of 
two coordinate systems: Absolute Coordinates or 
Definition Coordinates.

Absolute Coordinates
Absolute Coordinates use the World Space axes as 
the reference for object transformations. When you 
enter transformation values using Absolute 

ZX
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Coordinates, you’re defining how the object is 
transformed along the World Space, or absolute, X, 
Y, and Z axes.

Absolute Coordinates use the World Space axes as reference, so 
you’re repositioning the object along the absolute X, Y, and Z 
axes.

Definition Coordinates
Definition (Object Space) Coordinates define how 
an object is actually created. In object space, the 
origin of the object is located at X=0, Y=0, Z=0. 
All the other points in the object are defined by 
coordinates along the object’s internal X, Y and Z 
axes.

Definition Coordinates define how an object is created. The 
origin is at 0, 0, 0, while all the other points that define the 
object’s shape and size are coordinates along the X, Y and Z-
axes within the object.

This coordinate system uses the object’s internal 
axes as a reference for transformations. When you 
enter transformation values using this system, you 
change how the object is defined to include the 
position of its origin, its size, and orientation.

Definition Coordinates use the object’s internal axes as 
reference, so you’re redefining the object’s position along its 
internal X, Y, and Z axes.

In Definition transformations, the origin point of 
the object always remains at Object Space 0, 0, 0. 
As you move or scale the object, it changes, moves 
or grows along its internal axes, but the origin 
remains at 0, 0, 0. This can cause some 
unpredictable results. For example, if you scale an 
object using Definition Coordinates, the origin 
point will no longer be in the exact center of the 
object. When you rotate the object, it won’t rotate 
around its center.
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In this example, an object was scaled using Definition 
Coordinates and then rotated. You can see that it no longer 
rotates around its center.

Transforming using Definition Coordinates is not 
the same as using Object Space with one of the 
Transformation tools. When you choose Object 
Space for one of the transformation tools, 
transformations are performed using Object Space 
axes as a reference, but the final position, or size, is 
calculated using Absolute Coordinates. So in this 
case the object origin and all its points move along 
with the object. 

When you use Definition Coordinates to transform 
an object, you’re redefining how the object is 
created, so its origin does not change as the size 
and position change.

Relative Coordinates
Relative Coordinates use the World Space axes as 
reference for object transformations, but the values 
represent changes relative to the object’s current 
position, or size. For example, if you enter a 
position change of 2 units, the object moves two 
units from its current position along one of the 
World Spaceaxes

Relative Coordinates use the World Space axes as reference, but 
transformations are relative to the current position or size of the 
selected object.

Relative Coordinates is the only coordinate system 
available in the 3D Transformation dialog.

Transforming Objects

Transformation Tools
The transformation tools let you perform all the 
object transformation operations available in 
Bryce. The tools act as interactive controls. As you 
drag over the tool, the operation is performed on 
the selected object.

The transformation tools are located on the Edit 
Palette.

To select a tool:
1 Click the Edit button at the top of the Bryce 

window to display the Edit palette.

2 Select an object.

3 Drag over the tool to perform a 
transformation operation.
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Resize Tool

Use the Resize tool to resize objects along one or 
all of the three axes.

Rotate Tool

Use the Rotate tool to rotate objects in 3D space.

Reposition Tool

Use the Reposition tool to reposition objects along 
any of three axes.

Align Tool

Use the Align tool to align objects along their tops, 
bottoms, left sides, right sides, fronts, backs or 
centers.

Randomize Tool

Use the Randomize tool to scatter or disperse 
objects in 2D or 3D space.

Object Origin Points
Every object in Bryce has an origin point. This point 
defines the object’s center of rotation.

The object’s origin point defines the object’s center of rotation.

In the Working window, the origin point appears as 
a small green dot. By default the origin point 
appears at the center of the object’s bounding box. 
You can adjust the position of the origin point to 
any point along the object’s surface or outside of 
the object.

Where you place the origin point depends on the 
effect you want to create. For example, if you 
rotate an object when its origin point is at its 
center, it spins in place. When the point is placed 
outside the object, it rotates around the origin 
point like a planet around the sun.

When the origin point is at the center of the object it rotates in 
place. When you move the origin point outside the object, it 
orbits around its point.

Origin 
Point
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To display the origin point:
• Enable Show Origin Handle in the General tab 

of the Object Attributes dialog box.

To reset the origin point to the default 
position:
• Hold down Shift while clicking on the origin 

point of an object. 

To set the origin point to the averaged center 
of objects in the scene
1 Select the objects for which the averaged 

center is to be determined.

2 Hold down Command/Ctrl+Shift while 
clicking on the origin point of a selected 
object.

To cause the origin point to stay in position 
while the object moves
• Drag the object, and then hold down the 

spacebar as you continue to drag the object to 
a new position.

Nano-Edit Mode 
Nano-Edit Mode activates the Nano-Editor which 
lets you perform camera transformations on a small 
preview of your scene, instead of the full scene.

When this mode is active, the Nano-Editor appears 
any time you perform a camera transformation. The 
Nano-Editor window displays a small preview of 
your scene. The transformation is applied to the 
preview. When you close the editor, the 
transformation is applied to the full scene.

Use the Nano-Edit mode to quickly see the effects of 
transformation on a preview of your image.

This mode is useful when you’re working on a large 
scene, as it saves on redraw time.

To activate Nano-Edit Mode:
1 Click the Nano-Edit button on the Display 

palette.

When the smaller square inside the icon 
(which represents an active Nano-Editor) is red, 
the Nano-Edit Mode is on; when it is white, it is 
off.

2 Reposition the camera using the Camera 
controls.

To temporarily activate Nano-Edit Mode:

• Hold down Option/Alt+Spacebar before you 
perform transformations. The Nano-Editor 
appears only during the operation.

Resizing Objects
When you create an object, it appears at a default 
size. Once you place it in your scene, you may need 
to resize it to make it proportional to the other 
objects in your scene. 

There are three ways of resizing objects in Bryce: 
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• using the Resize tool, in the Edit palette, to 
resize an object along different axes

• using the 3D Transformation dialog which lets 
you enter precise values to resize objects

• using the control points on the object’s 
bounding box to interactively resize the object

Objects are measured in Bryce units. When you 
resize an object, you’re increasing or decreasing its 
size based on unity size. When you resize an object 
to 150%, you’re sizing it to 150% of unity. Refer to 
“Bryce Units” on page204 for more.

Using the Resize tool
The Resize tool lets you resize a selected object 
along any axis. Objects are resized from their origin 
point.

The Resize tool has seven different states. As you 
move the pointer over the tool each state becomes 
active.

The Resize tool has seven states. As you move your cursor over 
the tool each state becomes active.

The different states let you resize the object along 
different axes. Resizing along the Y axis increases/
decreases the object’s height. Resizing along the X 
axis increases/decreases the object’s width. Using 
the Z axis for resizing increases/decreases the 
object’s depth.

To resize an object along a specific axis:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit text button at the top of the 
Working window.

2 Move the cursor over the Resize tool.

3 When the state you want to use becomes 
active, drag to resize the object.

For example, if you’re using Resize Y Up, drag 
to the right to increase the object’s height in 
the Y axis. The more you drag, the taller the 
object becomes.

Hold down Shift to constrain the resize 
increments to 50% intervals when increasing 
the size of the object. 

To resize an object in all directions:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit text button at the top of the 
Working window.

2 Click the center of the Resize tool and drag 
right to increase the size of the object, or left 
to decrease it.

To resize an object from two directions along 
a single axis:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit text button at the top of the 
Working window.

2 Move the cursor over the Resize tool.

3 When the state you want to use becomes 
active, hold down Option/Alt and drag in the 
direction you want to resize the object.

For example, if you’re using Resize Y Up, when 
you hold down Option/Alt as you drag, the 
object becomes longer both up and down 
along the Y axis.

Objects can be resized using any of the three 
spatial definitions (World, Object or Camera). The 
definition you choose depends on the effect you 
wish to create. 

Resize Y Up
Resize Z BackResize X Left

Resize Z Front Resize X Right

Resize Y Down

Resize XYZ From 
Center
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To choose a spatial option for resizing:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Resize tool 
and choose an option from the menu.

3 Object Space resizes your selection relative to 
itself (see “Object Space” on page202).

World Space resizes your selection in absolute 
world coordinates (see “World Space” on 
page202).

Camera Space resizes your selection relative to 
the camera (see “Camera Space” on page203).

When you set Object, World, or Camera Space for 
the Resize tool, it is also the option set for the 
other two transformation tools. However, spatial 
options are global for the transformation tools 
only. The option you select in the Edit palette does 
not affect the 3D Transformations dialog.

Flipping Objects

Flipping is not the same as rotating an object 180°. 
Flipping mirrors an object along an axis instead of 
rotating it.

This example shows an object that has been rotated 180° and 
the same object flipped on its X axis.

To flip an object:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Resize tool 
and choose a flip option from the menu:

Flip X inverts your object’s dimensions along 
the X axis.

Flip Y inverts your object’s dimensions along 
the Y axis.

Flip Z inverts your object’s dimensions along 
the Z axis.

To undo resize operations:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Select an object.

3 Click the triangle icon next to the Resize tool 
and choose Unscale from the menu.

Original object

Rotated 180° on its X 
axis

Flipped on its X axis
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Numerical Resizing
Sometimes you will need more precise control over 
the size of your object. The 3D Transformations 
dialog lets you enter specific resize values for a 
selected object.

All transformations you enter in this dialog are 
performed in World Space regardless of the spatial 
option you chose for the Resize tool.

Resize values are expressed as a percentage of the 
current size of the selected object. You cannot 
enter negative numbers in this dialog.

To resize an object numerically:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Select an object.

3 Click the triangle icon below the Resize tool 
and choose 3D Transformations from the 
menu. The 3D Transformations dialog 
appears.

4 Enter a percentage in one or all of the axis 
fields.

The percentage determines the new size of the 
object based on its original size. For example, 
to double the object’s size in all directions, 
enter 200 in the X, Y, and Z fields. To resize 
along a single axis, enter values in only one 
axis field.

Since you are dealing with World Space 
transformations in this dialog, if you resize an 
object along only one or two axes you may 
unintentionally skew the object’s shape. 
To resize the object without skewing it, use the 
numeric entry fields in the Object Attributes dialog. 
Using this dialog can resize the object based on its 
original position, with no unintentional skewing. 
Refer to “Definition Coordinates” on page205 for 
more.

Interactive Resizing
While you can resize objects using the Resize tool 
or the 3D Transformation dialog, there are resize 
controls on the object’s bounding box that let you 
resize objects directly in the Working window. You 
may find this a much more intuitive way of 
transforming your objects.

When you select an object, a bounding box appears 
surrounding your selection. At each corner of the 
box, and at the center of each face, is a control 
point. 

An object’s bounding box has control points at the corners and 
at the center of each face that can be used to resize the object. 

As your cursor passes over the corner control 
points, it changes to a generic Resize cursor. As it 
passes over the control points on the faces, it 
changes to an X, Y or Z. This indicates the axis 
along which you can resize the object by clicking 
and dragging at that point.

The corner control points resize the object along all three axes. 
The control points on the faces of the bounding box resize the 
object along a single axis.

To resize an object along a single axis 
interactively:
1 Select an object.

Control 
Points
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2 Drag one of the control points at the center of 
a bounding box face. 

As you pass your cursor over the face, the 
cursor changes to an X, Y or Z to indicate the 
axis you’re resizing along.

To enlarge or shrink an object interactively:
1 Select an object.

2 Drag one of the control points on the corners 
of the bounding box.

Drag right to enlarge it, or left to shrink the 
object.

• Hold down Command/Ctrl while dragging 
to resize in the opposite direction from 
the selected corner point. 

• Hold down Option/Alt while dragging to 
resize from the center of the object. 

• Hold down Shift to constrain resizing to 
50% increments.

To resize an object from the bottom center:
1 Select an object.

2 Click the Y face control point and hold down 
the mouse button, then press Command/
Ctrl+Option/Alt and drag the point.

The object resizes in all directions from the 
bottom center of the object. This 
transformation may be useful if the object is 
on the ground and you want it to remain there. 

Using the Keyboard

You can also use the keyboard keys to resize 
objects:

Press * to double a selected object’s size.

Press / to halve a selected object’s size.

Press =  to return the object to unity size and 
snap it to the Grid.

Rotating Objects
Most object have a specific up, down, left, right, 
back and front associated with them when you 
create them. When you place the object in a scene, 
its orientation may need to be altered to achieve a 
desired effect. For example, an airplane that’s 
taking off should be tilted upwards, or tilted 
downward when it’s descending.

There are three ways of rotating objects in Bryce: 
• using the Rotate tool to resize an object along 

different axes 

• using the 3D Transformation dialog, which lets 
you enter precise rotation angles

• using the object’s control points to 
interactively rotate the object 

Using the Rotate tool
The Rotate tool lets you rotate a selected object 
along any axis. Objects can be rotated in World 
Space, Object Space or Camera Space.

The Rotate tool has three states. As you move the 
cursor over the tool, one of the states becomes 
active.

As you move your cursor over the tool a rotation state becomes 
active.

To rotate an object around an axis:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Move the cursor over the Rotate tool. 

Rotate 
around X

Rotate 
around Y

Rotate 
around Z
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3 When the state you want to use becomes 
active, drag in the direction you want to rotate 
the object. 

Hold down Shift while dragging to constrain 
rotation operations to 45 degree increments.

To choose a spatial option for rotation 
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Rotate tool 
and choose an option from the menu:

Object Space rotates your selection relative 
to itself (see “Object Space” on page202).

World Space rotates your selection in 
absolute world coordinates (see “World Space” 
on page202).

Camera Space  rotates your selection relative 
to the camera (see “Camera Space” on 
page203).

The three spatial options are also available for the 
Resize and Reposition tools. When you select 
Object, World, or Camera space for the Rotation 
tool, it is also set for the other two tools. The 
option you choose in the Edit palette does not 
affect the 3D Transformations dialog.

To undo rotation operations:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Rotate tool 
and choose Unrotate from the menu.

Numerical Rotation
In a complex scene, orienting objects may require 
more precision than the Rotation tool offers. The 
3D Transformations dialog lets you enter specific 
rotation angles for a selected object.

All transformations performed using this dialog use 
World Space coordinates regardless of the spatial 
option you chose for the Rotate tool.

Rotation values are expressed as degrees, with 360° 
being a single full rotation. Since rotations are 
relative, you may enter negative values and 
cumulative values (greater than 360° or less than -
360°).

To rotate an object numerically:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Select an object.

3 Click the triangle icon next to the Rotate tool 
and choose 3D Transformations from the 
menu. The 3D Transformations dialog 
appears.

4 Enter a degree value in one or more of the 
Rotate fields.

The degrees determine the angle of rotation. 
For example, to rotate an object 45° around Y, 
enter 45 in the Rotate Y field. To rotate around 
other axes, just enter values in the appropriate 
fields.

Since you’re dealing with World Space 
transformations, objects are rotated with respect 
to the World Space X, Y, and Z axes. 

You can also rotate an object numerically using the 
Object Attributes dialog. The values in the 
Attributes dialog rotate the object using either 
Absolute coordinates or Object Space coordinates. 
Refer to “Absolute Coordinates” on page204 and 
“Definition Coordinates” on page205 for more on 
these coordinate systems.

Interactive Rotation
Using the control points on an object’s bounding 
box, you can freely rotate an object directly in the 
Working window.
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Rotation control points appear when you hold 
down Command /Ctrl and pass your cursor over the 
object’s bounding box. The corner control points 
let you free-rotate your object. The control points 
at the center of each face rotate the object along a 
single axis. 

An object’s bounding box has control points at the corners and 
at the center of each face that can be used to rotate the object.

To rotate around a single axis:
1 Select an object.

2 Hold down Command /Ctrl and drag on any 
face control point. 

You can tell which axis you’re rotating around 
by releasing the Command /Ctrl key for a 
moment. The cursor changes to an X, Y or Z.

To free rotate an object:
1 Select an object.

2 Hold down Command /Ctrl and drag on any 
corner control point. 

Holding down Option/Alt while dragging on a 
corner control point lets you rotate the object 
in very fine increments.

Positioning Objects
The composition of your scene depends on the 
position of the objects relative to other objects. In 
most cases, you’ll need to use the Reposition tool 
in conjunction with the Resize and Rotation tools 
to create the desired relationships.

Positioning applies to objects, groups and families 
as well as lights and the camera. In this section the 
term “object” also refers to the camera and lights.

Bryce lets you position objects in four ways: using 
the Position tool to move objects along a specific 
axis; using the 3D Transformation dialog to enter 
specific offset positions, by dragging the object to a 
different location; or by using the arrow keys to 
nudge objects.

Using the Reposition Tool
The Reposition tool has three different states: 
Reposition X, Reposition Y, and Reposition Z. As 
you move the pointer over the tool, one of its 
states becomes active.

The Reposition tool has three states. As you move your cursor 
over the tool, a state becomes active.

To position an object along a specific axis:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Move the cursor over the Reposition tool. 

3 When the state you want to use becomes 
active, drag in the direction you want to move 
the object. 

Control 
Points

Reposition Y

Reposition Z Reposition X
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To choose a spatial option for repositioning:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Reposition 
tool and choose an option from the menu:

Object Space moves your selection relative to 
itself (see “Object Space” on page202).

World Space moves your selection in 
absolute world coordinates (see “World Space” 
on page202).

Camera Space  moves your selection relative 
to the camera (see “Camera Space” on 
page203).

The three spatial options are also available for the 
Resize, and Rotate tools. When you select Object, 
World, or Camera Space for the Rotation tool, it is 
also set for the other two tools. The option you 
choose in the Edit palette does not affect the 3D 
Transformations dialog.

To undo position operations:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Reposition 
tool and choose Unreposition from the menu.

Numerical Repositioning
The most precise method of positioning objects is 
by using the 3D Transformations dialog. This dialog 
lets you enter specific offset values for a selected 
object.

All transformations performed using this dialog use 
World Space coordinates regardless of the spatial 
option you chose for the Reposition tool.

Offset values are expressed in Bryce units of 
measure (refer to “Bryce Units” on page204). You 
may enter negative numbers in the Reposition 
fields.

To reposition an object numerically:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Select an object.

3 Click the triangle icon next to the Reposition 
tool and choose 3D Transformations from the 
menu. The 3D Transformations dialog 
appears.

4 Enter a value in one or all of the Offset fields.

The value determines the number of Bryce 
units the object is offset from its current 
position.

Remember that since this dialog only performs 
transformations in world space, you are moving the 
object relative to world X, Y, and Z coordinates.

You can also position an object numerically using 
the Object Attributes dialog. The values in the 
Attributes dialog position the object using either 
Absolute coordinates or Object space coordinates. 
Refer to “Absolute Coordinates” on page204 and 
“Definition Coordinates” on page205 for more on 
these coordinate systems.

Interactive Repositioning
The simplest way of positioning objects is by 
dragging them to different locations in your scene.

When you drag an object, you’re repositioning it 
with respect to the camera. 

To reposition an object interactively:

• Drag the object to a new location.

• Hold down X while dragging to constrain 
movement to the X axis. 

• Hold down Y while dragging to constrain 
movement to the Y axis. 

• Hold down Z while dragging to constrain 
movement to the Z axis. 
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Nudging Objects
Nudging lets you move objects by pressing the 
arrow keys and the PageUp and PageDown keys.

Nudging uses World Space coordinates to 
reposition objects. Each time you press a key, the 
object is moved in 1/4 unity size increments (5.12 
Bryce units). Refer to “Bryce Units” on page204 for 
more on Unity.

Use the Arrow, PageUp and PageDown keys to nudge objects in 
World Space.

To nudge an object along the X axis:
1 Select one or more objects.

2 Press either the Right or Left arrow keys.

• Hold down Shift to nudge objects in 1/2 
unity size increments (10.24 Bryce units)

• Hold down Option/Alt to nudge objects in 
1/256 unity size increments (0.08 Bryce 
units).

To nudge an object along the Y axis:
1 Select one or more objects.

2 Press either the PageUp or PageDown keys.

• Hold down Shift to nudge objects in 1/2 
unity size increments (10.24 Bryce units)

• Hold down Option/Alt to nudge objects in 
1/256 unity size increments (0.08 Bryce 
units).

To nudge an object along the Z axis:
1 Select one or more objects.

2 Press either the Up or Down keys.

• Hold down Shift to nudge objects in 1/2 
unity size increments (10.24 Bryce units)

• Hold down Option/Alt to nudge objects in 
1/256 unity size increments (0.08 Bryce 
units).

Aligning Objects
Bryce’s alignment features let you position several 
object with respect to each other. 

Alignment transformations are performed with 
respect to the Grid. Bryce maintains an internal 
grid that is comprised of 3D cube increments, 20.48 
x 20.48 x 20.48 Bryce units in size. 

The Grid gives you a common reference for all alignment 
operations. If all your objects are at unity size you can use grid 
units to precisely align objects.

The Grid is used for Snap To operations and acts as 
common reference for alignment operations. One 
grid unit is equal to unity size, and unity position is 
always snapped to a position on the grid. 

Using the Grid
The Grid can be used as a guide to help you 
precisely position objects in your scene. 

The example provided in the following procedure 
illustrates how the grid can be used to position a 
pyramid beside a cube.

PageUp

PageDown

Right

Down

Up

Left
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To precisely position objects using the grid:
1 Make sure all the objects are unity size.

• When you create primitives like cubes or 
spheres, they are unity size (20.48 x 20.48 
x 20.48 Bryce units). 

• You can return existing objects to unity by 
holding down Command/Ctrl+Option/Alt 
and clicking one of its control points.

First, return all the objects you’re aligning to unity, they fill 
exactly one grid unit...

This returns the objects to a perfect multiple 
of Bryce’s grid units.

2 Determine the objects’ positions relative to 
the grid.

• When you create an object, it usually 
appears at World Center or 0, 0, 0. 

• For existing objects, use the Snap to Grid 
Align option in the Edit palette to move 
the object to a point on the grid.

...then align the objects to the grid using the Snap To Grid 
option...

3 Use the nudge controls to move the object. 
Nudging moves objects in grid increments. 

Finally, use the Nudge controls to move in precise increments 
along the grid.

Using the Align Tool
The Align tool has ten states. As you move the 
pointer over the tool, the states become active.

 As you move your cursor over the Align tool, a state becomes 
active.

To align objects along an axis:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Select two or more objects. 

3 Move the cursor over the Align tool. 

4 When the state you want to use is active, click 
the mouse button. 

Anchor and Non-Anchor Based Aligning
Bryce provides two options for aligning multiple 
objects: anchor-based aligning and non-anchor-
based aligning.

Align X left

Align X center
Align X right

Align XYZ center

Align Z back

Align Z centerAlign Z front

Align Y bottom

Align Y center

Align Y top
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Anchor-based aligning considers the first selected 
object to be the anchor of the aligning operation. 
All other objects are aligned to this object.

With non-anchor-based aligning, objects are 
aligned to the bounding box of all the selected 
objects.

To choose an aligning option:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Align tool, 
and enable/disable Anchor-Based Aligning. 

Snap To Options
The Snap To Options let you automatically align 
objects to the grid, an anchor object, World Center, 
or ground level.

To snap objects to the Grid:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Select an object. 

3 Click the triangle icon next to the Align tool 
and choose Snap to Grid.

Refer to “Using the Grid” on page216 for more 
on the grid.

An anchor object is the object in an alignment 
operation that does not move.

To snap objects to the center of the anchor 
object:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Click the triangle icon next to the Align tool, 
and choose Anchor-Based Aligning. 

3 Select the objects you want to align. 

The first object you select is the anchor object.

4 Click the triangle icon next to the Align tool 
and choose Snap Together. 

The X, Y, and Z centers of all selected objects 
are aligned the X, Y, and Z center of the anchor 
object. 

To snap an object to World Center:
1  Make sure the Edit palette is visible. If it’s not, 

click the Edit text button at the top of the 
Working window.

2 Select an object. 

3 Click the triangle icon next to the Align tool 
and choose Snap to World Center.

The selected object moves to coordinates 
X=0, Y=0, Z=0, or World Center.

To drop or lift objects to ground level:

1 Make sure the Edit palette is visible. If it’s not, 
click the Edit button at the top of the Bryce 
window.

2 Select an object. 

3 Click the triangle icon next to the Align tool 
and choose Snap to Ground.

Landing Objects

The Snap to Land option lets you snap an object to 
any object directly below it, much like creating a 
gravity effect.

When you activate the Snap to Land option, Bryce 
snaps the selected object to the top of any object 
directly below its center “Y” control handle. 
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Using Snap to Land, a selected object snaps to the top of any 
object that’s directly below its Y control handle.

The second object must be directly below the Y 
control handle, otherwise the object lands on the 
ground plane.

In this example, a corner of the selected object is over the “land” 
object, but since there are no objects directly under its Y control 
handle, the selected object lands on the ground.

Landing operations work best with objects that have 
not been rotated, and that have no sloped character-
istics. 

This option can create many interesting effects. For 
example, you can quickly create falling rock 
animations by placing rock objects throughout 
your scene with a terrain below them in one frame. 
Then, in a different frame, select all the rocks and 
choose the Snap to Land option. When you run the 
animation, all the rocks will appear to fall onto the 
terrain. Refer to “Animating” on page319 for more 
on animation.

These objects were aligned using the Land Selection option.

To snap an object to the top surface of an 
object below it:
1  Make sure the Edit palette is visible. If it’s not, 

click the Edit text button at the top of the 
Working window.

2 Select an object. 

3 Click the triangle icon next to the Align tool 
and choose Snap to Land from the menu.

or 

Click the Down arrow icon that appears next 
to the object’s bounding box.
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Aligning Numerically
The most precise method of aligning objects is by 
using the 3D Transformations dialog. The dialog 
uses Bryce units for positioning, so you can use 
these increments to align objects based on grid 
increments (20.48=one grid unit).

Randomizing Objects
The Randomize tool is a great way of randomly 
dispersing objects throughout your scene without 
having to manually position each object. 

Using the Randomize Tool
The Randomize tool has eight states. When you 
click on the tool, it cycles though its different 
modes.

To randomize objects:
1 Make sure the Edit palette is visible. If it’s not, 

click the Edit button at the top of the Bryce 
window.

2 Select a number of objects. 

3 Click the Randomize tool repeatedly until the 
mode you want to use is active.

 or

Click the triangle icon next to the Randomize 
tool, and choose a mode from the menu. 

There are eight modes available:

2D Disperse scatters your selection randomly 
along the horizontal (X and Z) plane.

2D Disperse/Rotate scatters and rotates your 
selection randomly along the horizontal (X and 
Z) plane.

2D Disperse/Size scatters and resizes your 
selection randomly along the horizontal (X and 
Z) plane.

2D Disperse/Size/Rotate scatters, resizes and 
rotates your selection randomly along the 
horizontal (X and Z) plane.

3D Disperse scatters your selection randomly 
in 3D space.

3D Disperse/Rotate scatters and rotates your 
selection randomly in 3D space.

3D Disperse/Size scatters and resizes your 
selection randomly in 3D space.

3D Disperse/Size/Rotate scatters, resizes and 
rotates your selection randomly in 3D space.

4 Click and drag over the Randomize Amount 
sphere. 

The Randomize Amount sphere is the blue 
sphere to the top-right of the Randomize tool.

2D Disperse

2D Disperse/Rotate

2D Disperse/Size

2D Disperse/Size/Rotate

3D Disperse

3D Disperse/Rotate

3D Disperse/Size

3D Disperse/Size/Rotate

 As you click the Randomize tool each of its states becomes 
active.
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Object Hierarchies
An object hierarchy lets you create relationships 
between objects.

A hierarchy adds structure to the objects in your 
scene. This can make arranging and animating 
objects much easier. When you’re arranging 
objects, a hierarchy can make positioning and 
rotating easier since you can transform an entire 
hierarchy all at once instead of separately. The 
same is true for animating. You can quickly create 
motion animations by changing the position of a 
parent object, since all its children will move with 
it.

Hierarchies can be created by either grouping or 
linking objects. 

Grouping vs. Linking
Both grouping and linking let you create functional 
or spatial relationships between objects. The 
difference is how the objects within each hierarchy 
work. 

Within a group all the objects act as one. When you 
resize a group of objects, you are resizing all 
objects in the group simultaneously. This type of 
hierarchy is good for creating complex objects with 
static parts, like a tree or a large terrain.

Group hierarchies are good for creating complex objects that 
have no moving parts like this terrain group. As you move the 
group all the objects in the group move.

Within a linked hierarchy objects behave differently 
depending on which object within the hierarchy is 
being transformed. Any transformation you apply 
to the parent object is applied to all its children. 

However, transformations applied to a child object 
do not affect the parent. This type of hierarchy is 
good for creating objects that have moving parts or 
animating two objects simultaneously.

Linked hierarchies are good for creating objects that have 
moving parts like this train engine. As you move the parent all 
the objects in the hierarchy move, as the child moves the parent 
remains unchanged.

You can control exactly which transformations are 
applied to a child object using the options on the 
Linking tab in the Object Attributes dialog.

Hierarchical Structure
A hierarchical structure consists of a parent object 
or objects and its descendants. In the case of 
linking, the parent object is at the top of the 
hierarchy and its children are below it. Children in 
the hierarchy can also have children creating a 
branched hierarchy. 

In a hierarchy created using links, the parent object 
is the primary object in the link. The children are 
any objects linked to the parent. If you have 
multiple linked objects in a hierarchy, the parent 
object at the top of the hierarchy is the parent 
object in the first link you created.
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In this link hierarchy, the parent object has one child and that 
child has two children one of which also has a child. So if you 
were to transform this hierarchy, any operation you perform on 
the Parent at the top of the hierarchy is applied to all its 
children.

In a hierarchy created using groups, the parent 
object is the group. All the objects within the group 
are the children. If you have multiple groups within 
a group, the parent object is the final group you 
create.

In this group hierarchy the parent group has four children one 
of which is a group that contains three children. If you were to 
transform this hierarchy, any operation you perform on the 
parent group would be applied to all the children.

A hierarchy can be made up of both linked and 
grouped objects. One way of creating this type of 
hierarchy is by grouping the parent objects from 
different link hierarchies together. In this case, the 
final group you create would become the parent 
object of the hierarchy. 

You cannot create a group using a child object. Only 
parent objects can be part of a group. When the par-
ent is in a group all its children are also part of the 
group since they must follow the parent.

You could also create a hierarchy where a group is 
linked to a parent object. In this case, the parent 
object of the hierarchy would be the parent from 
the first link you created.

In this hierarchy the parent object is a group that has four 
children one of which is the parent object of a link hierarchy 
that has two children.

Viewing Object Hierarchies
The Hierarchy List area of the Advanced Motion Lab 
lets you see a list of all the objects in your scene. 
Object hierarchies are indicated by indents. A 
parent object is listed at the far left of the area; its 
children appear indented beneath it. 

The name of an object that appears in the 
Hierarchy List can be set using the Object 
Attributes dialog. If no name is set, a default name 
is used (for example Sphere 1). 

These names are unique for each item in the scene, 
and are not reused regardless of the number of 
objects you create or whether the object has been 
deleted.

To view a listing of the hierarchy:
1 In the Working window, make sure there are 

no objects selected. This will let you see all the 
hierarchies in your scene.

2 Click the Advanced Motion Lab button at the 
bottom of the window. The Advanced Motion 
Lab appears.

Parent 
Object

Child Object

Parent Object

Child Object

Parent Object

Child Object
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The Advanced motion Lab buttons displays the Advanced Motion 
Lab where you can see the hierarchy listing for your scene.

The Hierarchy List area, located along the 
bottom-left side of the lab, displays all the 
hierarchies in your scene.

Expanding and Collapsing a Hierarchy

The arrow buttons next to an object’s listing 
indicate whether the hierarchy is expanded or 
collapsed. A collapsed hierarchy shows only the 
parent objects in the hierarchy. An expanded 
hierarchy shows a listing for all the children.

To expand/collapse a hierarchy listing:

• Click the arrow icon that appears next to a 
listing’s name to expand it. 

Click the arrow again to collapse the listing.

Linking Objects
When you link two objects, you connect them in a 
Parent-Child link.

In a parent-child link, the parent controls the 
actions of the child. This means that when the 
parent object moves, so does the child object. 
However, when the child object moves, the parent 
object does not.

In a parent-child link, the movement of the parent object 
dictates the movement of the child.

However, the parent object is unaffected by the child object.

A child object will start its movement from its 
original position and always maintain a constant 
distance from the parent. The distance is 
determined by the original positions of the objects 
before they were linked.

The movement of the child object depends entirely 
on the type of transformations you apply to the 
parentobject. 

If you rotate the parent, the child will orbit around it like a 
moon around a planet.

If the parent is moving along a path, the child will match the 
trajectory of the parent’s path, but maintain a constant distance 
from the parent object.

Parent moves

Child moves

Parent doesn’t move

Child moves
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If both the parent and the child are moving along a path, the 
child object moves along its path while matching the trajectory 
of the parent object’s path.

To link objects in the Working window:

1 Select the object you want to set as the child 
object. A series of icons appear next to the 
object’s boundingbox.

The icons along the right side of the object’s bounding box let 
you interactively link objects.

2 Click the Link icon and drag the linking line to 
the object you want to use as the parent 
object. 

You cannot create a link where the parent object is 
the child of its own child object (i.e. a loop).

The parent object turns blue.

The first object you select becomes the child object. The object 
you drag the link line to becomes the parent object.

To link objects using the Object Attributes 
dialog:

1 Select the object you want to use as the child 
object. 

2 Click the A icon that appears next to the 
object’s bounding box. The Object Attributes 
dialog appears.

3 Click the Linking tab.

4 Click the Object Parent Name menu and 
choose the name of the object you want to use 
as the parent object.

5 Click the OK icon to link the two objects.

To break a link:
1 Select a child object.

2 Click the A icon that appears next to the 
object’s bounding box. The Object Attributes 
dialog appears.

3 Click the Linking tab.

4 Click the Object Parent Name menu and 
choose None.

5 Click the OK icon to unlink the two objects.
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Linking Options

Using the options available in the Linking tab on 
the Object Attributes dialog, you can control which 
parent object transformations are applied to child 
objects and how objects are constrained when 
they’re linked to a path.

Parent to Child Transformations Options
Once you’ve created a link, you can determine 
exactly which transformations applied to the 
parent will affect the child. 

To set which parent object transformations 
are applied to a child:
1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Disable the buttons for the transformation you 
don’t want applied to the child. 

Geometric Path Linking Options
A Geometric path is an object that acts like a track 
for controlling the motion of objects. Normally, 
when you link an object to a Geometric Path, it is 
constrained to the path. However, using the linking 
options in the dialog you can disable or enable 
constraining. 

When an object is constrained to the path, it can 
only move along the path. When it’s not 
constrained it acts like a regular child of the path. 
Its movement is not constrained to the path.

The options in this dialog also let you set where on 
the path an object begins its motion. 

For more information about geometric paths, refer 
to “Creating Geometric Paths” on page88.

To constrain/unconstrain an object to a 
geometric path:
1 Select an object linked to a geometric path.

2 Display the Object Attributes dialog.

3 Click the Linking tab.

4 Enable the Constrain to path button to 
constrain the object to the path.

• Disable the button to unconstrain it.

To set where the object sits on the path:

1 Select an object linked to a geometric path.

2 Display the Object Attributes dialog.

3 Click the Linking tab.

4 Enter a percentage in the Position field. 

100% places the object at the end of the path, 
and 0% places it at the beginning.

Grouping Objects
As your scene becomes more complex, you’ll need 
to group objects. Grouping lets you control a set of 
objects as a single unit. When you perform a 
transformation on a group, all the objects are 
equally affected. If you scale a group, all the objects 
change size, or if you rotate a group, all the objects 
rotate around a single axis.

Your choice of objects to place in a group depends 
on how you want to organize your scene. You may 
want to group the objects that comprise more 
complex objects, like the walls and turrets of a 
castle. 
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You can group objects to keep all the components of a complex 
object like this train engine together.

You can also create groups to maintain the spatial 
relationships between objects as you transform 
them. 

You can also create a group to maintain the spatial 
relationships between objects as you transform them, like the 
boards in this fence.

You can place as many objects as you like in your 
group. You can even nest groups within groups. 
Nesting can be an easy way of managing more 
complex scenes.

Groups are essential to creating Boolean objects. 
Boolean operations will not work unless the objects 
are part of a group. Refer to “Boolean Operations” 
on page73 for more on Boolean objects.

You cannot create a group using a child object. If a 
child object is part of your selection the “G” icon will 
not appear.

To create a new group:

1 Select all the objects you want to group.

2 Choose Objects menu>Group Objects, or 
press Command/Ctrl+G. 

You can also click the G button next to the selected 
objects’ bounding box. 

Click the G button next to a selection’s bounding box to create a 
group.

To select objects within a group:

1 Hold down Control/Ctrl and click on an object 
inside the group bounding box.

2 Select the object you want from the menu.

Families
Families are a way of creating “logical groups.” 
Unlike regular groups, families are not treated as a 
single unit with regards to transformations. 
Families help you keep track of elements in your 
scene, and can be used for selection purposes. For 
example, you can put all the elements that make up 
the background of your scene in to one family, all 
the items with a particular material in another, all 
trees in another and so on.
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Each family has a different object color. The color 
appears only when the object is not selected, since 
a selected object’s bounding box appears red.

You can easily see which objects belong to the same family when 
there no objects selected in the Working window.

To create a new family:

1 Select all the objects you want in the family.

2 Click the dark gray box next to the selection’s 
bounding box. The Family dialog appears. 

Click the dark gray box next to a selection’s bounding box to 
create a family.

3 Click on a color. The color is applied to the 
wireframes of all the objects in the family.

4 You adjust these colors by dragging the 
rectangular color swatch at the bottom of the 
dialog. Avoid using black or white since they 
are difficult to see, or red since it’s the color of 
a selected object.

5 Enter a name for the family in the text field.

To select a family:

1 If the Animation controls are visible at the 
bottom of the Bryce window, click the Time/ 
Selection Palette toggle to display the 
Selection palette. 

2 Click the Family button and choose the name 
of the family you want to select from the 
menu.

The Families button in the selection palette displays a list of all 
the families in your scene.
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Editing Objects

Every object in Bryce has attributes that allow you 
to control everything from its position in the 
scene to how it animates along a path. Some 
objects have special editors specifically designed 
to adjust the attributes that are unique to the 
object type.

This chapter describes how to edit object 
properties and also covers how to use the Torus 
and Mesh editors.
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Restoring Objects
Every object in Bryce has a default size and shape. 
When you create an object, the default size is used 
to define its size and placement. 

As you transform and edit objects, these default 
properties are discarded and replaced. However, 
you can return an object to its original state at any 
time. 

The Restore control returns the object to its default 
size and orientation, regardless of the number of 
transformations you’ve applied to it.

When you use the Restore control, the cursor changes to a 1 
when passed over the object’s bounding box.

To restore an object:

• Hold down Control/Ctrl+Alt and click one of 
the bounding box handles. 

Editing Object Attributes
Every object in Bryce has several attributes that let 
you control the object’s size, position, rotation, 
Boolean state, preview, and whether or not it’s 
locked.

There are two ways of editing an object’s 
attributes: the Object Attributes dialog and the 
Object Controls that appear next to the object’s 
bounding box. 

Object Attributes Dialog
The Object Attributes dialog contains three tabs 
which let you set various object properties:

• General contains options that let you set the 
object name, position, size, rotation, and 
display quality.

• Linking contains options that let you set up a 
link between two objects. You can also use 
this tab to set up a tracking link.

• Animation contains options for controlling the 
display of motion paths and setting the 
motion path type.

To display the Object Attributes dialog:
1 Select an object.

2 Choose Objects menu> Edit Attributes, or 
press Command-Option-E/Ctrl+Alt+E, or click 
the Abutton next to the object’s bounding 
box.

Object Attribute Icons
The Object Attribute icons appear as a list of 
buttons along the right side of an object’s 
bounding box. The icons that appear in this list 
vary depending on the type and number of objects 
selected.

These icons let you:

• access the Object Attributes dialog, the 
Material Composer and any editors associated 
with the object

• group objects in a selection

• add objects to families
• land objects

• link objects

• set up object tracking

The Object Attribute icons that appear next to an object’s 
bounding box let you access different editors and set object 
attributes.
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If your selection falls outside of your Working 
window, the icons appear in the rightmost area 
available on the screen.

To display Object Attribute icons:
• Select an object or group of objects.

Object Attributes Icon

This control displays the Object Attributes dialog. 
When the dialog opens, it shows the current name, 
position, orientation, and scale of the object.

To display the Object Attribute dialog:

1 Select an object or group of objects.

2 Click the A icon that appears next to the 
object’s bounding box.

Families Icon

This control indicates the family to which the 
object belongs. It also displays the Family dialog. 
Refer to “Families” on page226 for more 
information. 

To add selected objects to a family:

1 Select all the objects you want to add to the 
family.

2 Click the Family icon that appears next to the 
object’s bounding box. The Family dialog 
appears.

3 Choose a color that represents an existing 
family, or enter a name to create a new family.

4 Click the OK icon. The color you select 
becomes the object’s wireframe color.

Linking Icon

This control lets you set up a parent-child link 
between two objects. When the objects are linked, 
the transformations you apply to the parent object 
affect the child. Refer to “Linking Objects” on 
page223 for more information.

To link one selected object to another:

1 Select the object you want to be the child 
object within the link.

2 Click the Link icon and drag it to the object 
you want to be the parent object. Release the 
mouse button when the parent object turns 
blue.

A link line extending from the child object to 
the parent appears as you drag.

As you drag the Link icon, a link line extends from the child 
object.

Tracking Icon

This control lets you set up a Tracking link between 
two objects. When an object tracks another, the 
selected object pivots as the target object changes 
position. As a result, the object always faces its 
target. Refer to “Tracking Objects” on page344 for 
more on tracking.
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To set a selected object to track another:
1 Select the object you want to be the stationary 

object.

2 Click the Tracking icon and drag it to the 
object you want to be the target object. 
Release the mouse button when the target 
object turns blue.

A tracking line extending from the stationary 
object to the target appears as you drag.

As you drag the Tracking icon, a tracking line extends from the 
stationary object.

Group Icon 

This control appears only if your selection contains 
multiple objects. When you click this control all the 
objects in the selection are grouped. Refer to 
“Grouping Objects” on page225 for more on 
grouping.

If this icon does not appear when you have a 
multiple selection, it means that you can’t group 
the selected objects because of an object hierarchy 
conflict. Refer to “Object Hierarchies” on page221 
for more information.

To group selected objects:

1 Select all the objects you want grouped.

2 Click the G icon that appears next to the 
object’s bounding box. A group bounding box 
appears around all the objects.

A large bounding box around a number of objects indicates a 
group.

Ungroup Icon 

This control only appears if you’ve selected a group 
or a number of objects contained in a group. When 
you click this control, any group in the selection is 
ungrouped. If the selection contains nested groups, 
you can continue clicking this control until all the 
groups are ungrouped, or until the control 
disappears.

To ungroup a selected group of objects:
1 Select all the objects you want ungrouped.

2 Click the U icon that appears next to the 
object’s bounding box. 

Material Icon

This control displays the Materials Lab. Refer to 
“Applying Materials” on page127 for more on 
Materials. When you use this control, the Materials 
Lab displays the material currently applied to the 
selected object, and the object appears in the 
Material Preview area of the lab.

To display the Materials Lab:
1 Select an object or group of objects.
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2 Click the M icon that appears next the 
bounding box.

Edit Object Icon

This control only appears if the object you selected 
is a terrain, a symmetrical lattice, a torus, a stone, 
an imported polyhedron object or a light. When 
you click this control, the editor for the object type 
you have selected opens. 

To display an object’s editor:

1 Select an object or group of objects.

2 Click the E icon that appears next to the 
bounding box.

Land Object Icon

This control appears as either an arrow pointing up 
or down, depending on the position of the object 
selected.

When you click this control, the object snaps to the 
top of the object below it. This control works like 
the Land Selection option available in the Edit 
palette. Refer to “Landing Objects” on page218 for 
more information.

To land a selected object:

1 Select the object you want to land.

2 Click the Arrow icon that appears next to the 
object’s bounding box. The object snaps to the 
top of the object directly below it.

If the selected object is below ground, it snaps 
to the bottom of the object directly above it.

Editing Object Names 
The Object Name field in the General tab of the 
Object Attributes dialog lets you name a selected 
object. An object’s name identifies it within the 
scene. 

When you have many objects of the same type, 
object names are used to select a specific object. 
The name is also used to identify an object in a 
hierarchy. Object hierarchies appear in the 
Hierarchy List area of the Advanced Motion Lab. 
Refer to “Object Hierarchies” on page221 for more 
on hierarchies.

Editing Boolean Attributes 
Boolean attributes, listed in the General tab of the 
Object Attributes dialog, control how an object acts 
in a Boolean operation. For example, if a boolean 
attribute is set to Negative, the object subtracts an 
area from a positive object. 

These are examples of some of the objects you can create using 
Boolean operations.

Refer to “Boolean Operations” on page73 for a 
complete discussion of Boolean operations.

To set an object’s Boolean attributes:
1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable one of the check boxes at the top of 
the dialog:

Neutral  defines any selected object, objects, 
or group as non-Boolean. No Boolean 
operation can be performed on a neutral 
object. This is the default setting for all 
objects.
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Positive defines any selected object, objects, 
or group as solid when grouped. 

Negative defines any selected object, objects, 
or group as negative when grouped. Think of a 
negative object as a “cutting object.”

Intersect defines any selected object, objects, 
or group as an intersecting object when 
grouped.

Editing Display Quality Attributes
The display options available in the General tab of 
the Object Attributes dialog let you control how 
the object appears in the Working window. Some 
of these options can speed up the redraw of your 
scene.

Hidden

When you apply this option to an object, it is not 
rendered when you render your scene. The object 
remains visible in the Working window, where you 
can still select and edit it, but it will not display in 
the final render.

To hide an object:
1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Hidden button.

Locked
This option locks any selected object, objects, or 
group, preventing unintentional changes to size, 
position, rotation, or material assignment. Locked 
objects appear grayed out in your wireframe view. 

To lock an object:
1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Locked button.

To select a locked object:
1 Click the Time Selection Palette toggle at the 

bottom of the Working window to display the 
Selection palette.

Use the Time Selection Palette toggle to switch between the 
Animation controls and the Selection palette.

2 Click an object type button, and choose the 
desired object from the menu that appears.

If you want to unlock the object, disable the Locked 
button in the Object Attributes dialog.

Show as Box
This option displays any selected object, objects, or 
group as a box. This is useful when you just want to 
work with the object’s position. It can speed up 
work in a complex scene because it displays 
simpler objects. You can still manipulate your 
object using the bounding box control points.

To display an object as a box:
1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Show as Box button.

Show Origin Point

This option displays the selected object’s origin 
point. You can then edit the position of the point 
to change the object’s center of rotation. Refer to 
“Object Origin Points” on page207 for more on 
origin points.

To display an object’s origin point:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enable the Show Origin Point button.
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Editing Transformation Attributes
The numeric entry fields on the General tab of the 
Object Attributes dialog describe an object’s 
position, orientation, and size in 3D space. You can 
adjust these attributes by entering values in one or 
all of the numeric fields.

The values in this dialog use either Absolute or 
Definition coordinates for transformations. 
Absolute coordinates use the World Space X, Y, and 
Z axes as a reference for transformations. 
Definition coordinates redefine how the object is 
created in Object Space. Refer to “Coordinate 
Systems” on page204 for more on these 
coordinate systems. 

Using Definition coordinates can create some unpre-
dictable results because you’re redefining the entire 
object when you change the Offset, Rotate and Size 
values.

To set an object’s origin point:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter values in the Origin X, Y and Z fields.

To set an object’s position:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Position X field to set the 
object’s position on the X axis. This axis moves 
the object left or right.

4 Enter a value in the Position Y field to set the 
object’s position on the Y axis. This axis moves 
the object up or down.

5 Enter a value in the Position Z field to set the 
object’s position on the Z axis. This axis moves 
the object backward or forward.

When you select multiple objects and access 
this dialog, there are no values displayed in the 
Position fields. If you then enter a value in any 

field, the selected objects are moved to the 
new coordinate.

To rotate an object:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Rotate X field to set the 
object’s rotation around the X axis. 

You can enter negative values, values greater 
than 360 or values less than -360. Bryce 
reduces the value to an absolute value within a 
range of 0 - 360.

4 Enter a value in the Rotate Y field to set the 
object’s position on the Y axis.

5 Enter a value in the Rotate Z field to set the 
object’s position on the Z axis.

To set an object’s size:

1 Display the Object Attributes dialog.

2 Make sure the General tab is displayed.

3 Enter a value in the Size X field to set the 
object’s size in the X axis.

You can enter negative values here if you need 
to.

4 Enter a value in the Size Y field to set the 
object’s size in the Y axis.

5 Enter a value in the Size Z field to set the 
object’s size in the Z axis.

When you select multiple objects and access 
this dialog, there are no values displayed in the 
Size fields. If you then enter a value in any Size 
field, the selected objects are scaled to the 
new coordinate.

Editing Link Attributes
Link attributes control how an object is linked to 
another. The controls on the Linking tab of the 
Object Attributes dialog let you set parent-child 
link attributes and tracking attributes.
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Linking 

When you link an object to another, you create a 
parent-child relationship. Transformations applied 
to the parent object affect the child, but 
transformations applied to the child object do not 
affect the parent. Refer to “Linking Objects” on 
page223 for more on linking.

The Link options let you set the parent object for 
the selected object and choose which parent object 
transformations will affect the child.

To link objects:
1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Click the Object Parent Name field and choose 
a name from the menu that appears.

Choose None to break a link.

4 Enable a Propagate option. These options 
control which Parent object transformations 
affect the child.

Tracking

When you set up a tracking link, the stationary 
object tracks the target object as it moves or 
rotates. Whenever the target object moves, the 
stationary object pivots so that it’s always facing 
the target.

The Tracking options let you set the target object 
for the selected object and define which axis of the 
stationary object will face the target.

To set an object to track another:
1 Display the Object Attributes dialog.

2 Click the Linking tab.

3 Click the Track Object Name field and choose a 
name from the menu that appears.

Choose None to break a tracking link.

4 Enable one of the Orientation options. These 
options set which object axis will track the 
target.

Editing Animation Attributes
Animation attributes control the display of an 
object’s motion path. A motion path is a graphical 
representation of an object’s trajectory over the 
course of the animation. Refer to “Motion Paths” 
on page330 for more on motion paths.

The options on the Animation tab of the Object 
Attributes dialog let you control how an object’s 
motion path is displayed in the Working window 
and how that path is drawn.

Motion Path Display Options

Normally, a motion path is displayed as it is being 
drawn and when the object is selected. The motion 
path display options on the Animation tab of the 
Object Attributes dialog let you control when the 
motion path is displayed. 

The Motion Path Display options let you control when an 
object’s motion path appears.

To set motion path display options:
1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one or all of the display options:

Hide Trajectory enables or disables the display 
of the motion path. When it is disabled, no 
motion path is drawn.

Show When Selected displays the motion path 
only when the object is selected.

Show Always displays the motion path at all 
times, even when the object is not selected.
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Motion Path Attributes

When a motion path is created, it looks like a curve 
that extends out from an object. The motion path 
attributes let you display additional information on 
a motion path. 

To set motion path attributes:

1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one or all of the attributes:

Show Handles displays or hides the path’s 
control handles. The handles represent key 
frames.

Show Tangents hides or displays lines 
extending from each control handle. Tangents 
help you see the slope of the curve.

Show as Ribbon displays the motion path as a 
flat ribbon in the working window. This makes 
the path easier to see when you move the 
camera.

Align Options

Normally, unless you apply a rotation, an object’s 
orientation remains constant as it moves along a 
motion path. The align options let you force the 
object’s orientation to match the slope of the 
motion path so that as the path curves up, the 
object tilts up.

To set align options:
1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one of the following options:

Do Not Align disables aligning. The shape of 
the curve has no effect on the object’s 
orientation. This is the default setting.

Align adjusts the object so that its orientation 
matches the shape of the path.

Motion Path Geometry Options

The shape of a motion path is determined by the 
position of the object as it moves through the 
animation. The motion path geometry options let 
you change the shape of the path to create 
different effects.

To set motion path geometry options:
1 Display the Object Attributes dialog.

2 Click the Animation tab.

3 Enable one or all of the options:

Make One Shot performs the motion once and 
does not repeat the motion.

Make Repeat creates a loop in the action. The 
motion on the path will continuously repeat.

Make Pendulum creates a repeating cycle in 
the action along a path. The object will move 
forward on the path and then back.

Make Circular closes the path to create a 
circular path. The object will move along the 
path until it reaches the end. It then swings 
around to the front of the path and starts over. 
You must have at least four position key frame 
points for this feature to work.

Editing Toruses
A torus object is any pre-made donut-shaped object 
in Bryce. The Torus editor lets you adjust the inner 
radius of any torus object. The preview is 
automatically updated as you change the inner 
radius. You can zoom in and out of the preview 
window, and you can preview the torus object from 
different angles by rotating the preview image.
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Use the Torus editor to adjust the inner radius of a torus object.

To display the Torus editor:

1 Click a Torus object.

2 Click the Ebutton that appears next to the 
object’s bounding box.

To adjust the inner radius of a torus:
1 In the Torus editor, drag on the Torus in the 

preview window. Release the mouse when the 
radius is the size you want.

You can also specify the inner radius by typing a 
value in the Radius field.

2 Click the check mark.

To zoom in and out:

• In the Torus editor, hold down Control/Ctrl + 
Option/Alt and drag on the Torus in the 
Preview window. 

To preview a torus from different angles:
• In the Torus editor, hold down Control/Ctrl 

and drag on the Torus in the preview window.

or

Press Caps Lock to toggle the continuous spin 
mode.

Editing Imported Meshes and 
Stones
Imported objects (such as DXF or 3DMF objects) 
and native Stone objects are both treated as 
meshes inside Bryce. 

The Mesh Editor lets you adjust the smoothness of 
an object’s surface. You can smooth objects that 
are very rough or remove the smoothing previously 
applied to DXF objects. 

It is not a good idea to smooth or unsmooth 
stones. These objects are highly dependent upon 
the clumpiness of the polyhedral shape as well as 
the bumpiness in the assigned procedural texture 
to retain their realism. Smooth stones look very 
unnatural.

To smooth imported objects or stones:

1 Click the imported object or stone.

2 Click the Ebutton that appears next to the 
object’s bounding box.

3 Adjust the value of the smoothing range by 
dragging the gauge along the left side of the 
dialog.

The gauge sets the maximum angle you wish 
to be smoothed.

For instance, you may wish to smooth all 
angles under 90° to preserve the sharpness of 
cubes. In that case, set the maximum angle to 
85 before smoothing.

4 Click the Smooth button until you achieve the 
desired effect. The more you click, the 
smoother the object becomes.

To unsmooth imported objects or stones:

1 Click the imported object or stone.

2 Click the Ebutton that appears next to the 
object’s bounding box.

3 Adjust the value of the smoothing range by 
dragging the gauge along the left side of the 
dialog.
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The gauge sets the maximum angle you wish 
to be unsmoothed.

For instance, you may wish to unsmooth all 
angles under 90°. In that case, set the 
maximum angle to 85 before unsmoothing.

4 Click the Unsmooth button until you achieve 
the desired effect. The more you click, the 
sharper the object becomes.

To export a mesh object:
1 Select the mesh object you want to export.

2 Click the E button next to the object’s 
bounding box.

The Edit Mesh dialog appears.

3 Click Command/Ctrl+D.

The Save dialog appears.

4 Choose a location and filename for the mesh 
object.

Converting Objects 
The Convert tool in the Edit palette lets you covert 
any type of object into another type of object with 
a single click. You can change a square into a light, 
a terrain into a sphere, or an infinite plane into a 
cone. 

Any transformations you applied to the original 
object are preserved through the conversion.

The Convert tool lets you quickly turn an object into any other. 
In this example, the object changed from an Egyptian pyramid...

...to a rocky desert by converting the pyramid primitive into a 
plane.

Conversions cannot be animated. You can’t have a 
box that turns into a cone over time.

To convert an object to another type of 
object:
1 Select the object you want to convert.

2 Click the Edit button at the top of the Bryce 
window to display the Edit palette.

3 Click the double-headed arrow in the top-left 
corner of the palette and choose an object 
type from the palette that appears.
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Creating Skies

A Bryce sky defines the virtual environment of 
your scene. Unlike many other 3D applications, 
the Bryce virtual environment is not merely a 
backdrop; it is an infinite 3D representation of 
natural environmental phenomena.

All of the elements in your sky interact with each 
other just as they would in the real world. Colors 
in your environment interact with everything in 
your scene just as they would in nature. For 
example, red sunlight is invisible until it strikes an 
object; then the object exhibits red highlights. If 
it’s a blue object, it takes on a purple cast and so 
on.

The colors in the sky change depending on the 
position of the sun, and how much moisture 
(Haze, Fog) is present in the atmosphere. All this, 
plus natural reflection, refraction, and more make 
the Bryce Sky&Fog palette responsible for a great 
deal of the natural, or supernatural, look and feel 
of Bryce images.
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The objects in your scene may look incredibly realistic on their 
own ...
, 

...but when you add a sky, the scene becomes a window looking 
out into a real world.

You can add even more realism to a sky by enabling 
one of the many environmental effects available for 
skies. Using these effects you can create night skies 
full of stars, or have a bright rainbow streaking 
across the roof of your world. One of the most 
spectacular effects is the Volumetric World effect. 
When this effect is enabled all the light in your 
scene appears as visible rays. This is similar to the 
effects of light shining through clouds on a hazy 
day.

The other-worldly look of this spaceship landing was created 
using Volumetric World.

Like any other scene setting, skies can be animated. 
Any property of a sky can be changed at different 
points along the animation timeline. When the 
animation plays, the sky property will appear to 
change over time. Using this technique, you can 
create a scene that changes from day to night, or 
from clear to cloudy. Refer to “Animating Skies” on 
page354 for more on animating skies.

The Sky & Fog Palette
The Sky&Fog palette is where you’ll set up the 
attributes of your environment. The palette uses 
visual controls in the form of thumbnails to help 
you see how changing the value of an attribute 
affects your sky.



Bryce5 243

The Sky&Fog palette’s thumbnails let you set values for sky 
attributes. 

The name of the control you’re adjusting appears in 
the Text Display area of the Control palette. You 
can also use this area to help guide you if you 
prefer numeric precision, as when you are adjusting 
the setting of a control; this area displays the 
current control’s value.

Each control has at least one color swatch along 
the bottom of the thumbnail. These swatches are 
used to set the color for a given sky attribute, like 
cloud color or fog color.

Next to the thumbnails are a series of controls that 
let you set the frequency and amplitude of clouds, 
set the position of the sun or moon, and store sky 
properties. You can see their effects in the Preview 
area.

The set of controls at the end of the palette does not have visual 
guides, but you can see their effects in the Preview area.

Working with Sky Lab
The Sky Lab button provides access to the Sky Lab 
dialog. This dialog contains controls for fine-tuning 
environmental effects like clouds, rainbows, and 
sun and moon rings. Click the Sky Lab button, 
which looks like a cloud with a rainbow, in the 
Sky&Fog palette to display the Sky Lab dialog. You 
can also click the triangle icon below the memory 
dots and choose Sky Lab from the menu.

The dialog contains three tabs:

• Sun&Moon contains controls for positioning 
the sun and moon as well as adding effects like 
rings and horizon illusions.

• Cloud Cover contains controls for editing 
cloud textures and setting up cloud 
animations.

• Atmosphere contains controls for rainbows, 
visible lights, and color blending. 

You can preview your changes in the Sky Lab 
dialog. 

• To view the different preview options, click 
the downward pointing triangle at the lower 
corner of the preview area. You can also 
change the camera position in the preview 
area. 

Sky Mode

Sky Mode Options

Shadow Intensity

Fog Height

Haze Intensity

Cloud Coverage

Cloud Height

Ambient Color

Fog Color

Haze Color
Sky Dome Color

Cloud Color

Sky Lab

Randomize Skies Memory Dots

Sun Color

Sun/Moon Position

Sky&Fog 
Options

Day/Night Toggle

Cloud Frequency
and Amplitude
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• To change the position of the camera, drag the 
preview. To orbit around the scene, drag the 
preview in the direction you want to move the 
view of your scene.

Working with the Sky & Fog palette
The Sky&Fog palette has several settings that you 
can use to control how the palette affects your 
scene and how the sun tracks your camera view. 
You can also use the palette’s memory dots to store 
settings as you experiment with different 
environmental attributes.

Using the Control Thumbnails

The thumbnails are visual guides, and they are also 
used to set the attributes of Sky&Fog effects.

To change the intensity of an effect:

• Drag to the left or right inside the thumbnail 
to change the intensity of the effect. 

To pick a color for an effect:
• Click the color bar below the thumbnail. A 

color picker appears and your pointer changes 
to an eyedropper. 

Click on the bar below the thumbnail to access the color picker.

While the eyedropper is active, you can select 
colors from anywhere in your scene, or even 
different parts of the interface.

For more control after picking with the color picker, 
try Option-click/Alt-click to get the second color edi-
tor, switch to HLS mode and adjust saturation or 
lightness (less saturated colors can make for more 
realistic fog and haze effects), or you can enter 
numeric values if you need to precisely match specific 
colors.

Setting Palette Options

The Sky&Fog palette options let you link the 
palette controls directly to your scene. To link 
Sky&Fog attributes directly to your scene:

• Click the triangle icon below the memory dots 
at the right edge of the palette and choose 
Auto Update from the menu.

• When this option is enabled, every change you 
make to the Sky&Fog palette settings will 
start a render of your scene with the new sky 
settings.

Unless you have marqueed a small region to be 
updated, every change you make will begin a com-
pletely new render.

To reset Sky&Fog palette settings to their 
defaults:
• Click the triangle icon below the memory dots 

at the right edge of the palette and choose 
Reset Sky from the menu.

Saving Sky & Fog settings

The memory dots in the Sky&Fog palette let you 
store your favorite Sky&Fog settings. Using these 
dots you can safely explore many Sky&Fog 
configurations without losing your favorite settings 
along the way. Memory dots appear along the right 
side of the palette.

Use the Memory dots to store your favorite Sky&Fog settings.

To save Sky&Fog settings:
• In the Sky&Fog palette, click on an empty dot 

(empty dots are gray).

All the current Sky&Fog palette settings are 
stored in the selecteddot. 
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To switch to a saved Sky & Fog setting:
• Click on a full dot (full dots are blue). The 

current settings are replaced with the settings 
stored in the dot. 

An active dot will be blue with a white point 
inside it.

To reset Sky&Fog settings to default:
• In the Sky&Fog palette, click the uppermost 

memory dot. This dot always appears full.

To delete a saved Sky&Fog setting:
• Option/Alt-click on a full MemoryDot.

The uppermost dot cannot be cleared.

Memory dots are saved with the scene, but not 
between sessions, so you may want to save your 
favorite skies as presets before ending a Bryce ses-
sion.

Randomizing Skies

Randomizing skies is a very powerful way of 
exploring possibilities you may never find any other 
way. When you randomize the sky all the settings 
in the palettes are replaced by randomly generated 
values.

Click the Randomize Sky button to randomly generate sky 
settings.

To randomize your sky:

• Click on the Randomize Sky Button.

Remember, you can always return to the 
default settings by clicking on the top Memory 
Dot.

Working with Sky Modes
The Sky modes act as the base of your sky. The Sky 
modes control lets you set the base colors and light 
tones for your environment. There are four modes 
available: Soft Sky, Dark Sky, Custom Sky, and 
Atmosphere Off.

As you switch between the modes, the thumbnail 
also changes to give you a preview of what the 
mode looks like.

To select a sky mode:

• Click the Sky mode thumbnail to cycle through 
the four modes, or 

• Drag left or right inside the thumbnail to cycle 
through the modes, or 

• Click the triangle icon next to the thumbnail 
and choose a mode from the menu.

Sky Modes
Soft Sky  is the default state of the sky. It features 
softer shades of blue and lighter tones.

Darker Sky is a darker version of Soft Sky. It uses 
darker shades of color and tones. This mode is 
good for creating more brooding skies.

Custom Sky  lets you choose your own colors for 
the sky; this way you can create some truly alien 
environments. When this mode is selected, the 
standard behavior of colors in the sky with respect 
to sun position is disabled.
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In Custom Sky mode you can pick your own colors for the sky.

Atmosphere Off disables the standard sky color 
behaviors, relative to sun position, and uses a 
single color for the sky. This mode is useful when 
you need to render objects against a simple colored 
(or black or white) background. The Sun color still 
affects objects in this mode. If you have red 
sunlight, for instance, objects in your scene will 
reflect red light.

To set custom sky colors:
1 Click the triangle icon next to the Sky Mode 

thumbnail and choose Custom Sky from the 
menu. The thumbnail changes to the Custom 
Sky control.

2 Click the Sky Color swatch and choose a color 
from the color picker.

The Sky Color is the main sky color in this 
mode, regardless of sun position.

3 Click the Sun Glow Color swatch and choose a 
color from the color picker.

This is the color of the halo around the sun.

4 Click the Horizon Color swatch and choose a 
color from the color picker.

This color will in certain cases affect your 
scene below ground level if you have a haze 
setting of greater than zero. It will also impact 
the color of Stratus clouds near the horizon.

In most cases, this will be the least obviously 
used color in your scene; unless you are 
making outer space scenes, in which case this 
could be very useful for you.

To render objects against a plain background:
1 Click the triangle icon next to the Sky Mode 

thumbnail and choose Atmosphere Off from 
the menu. The thumbnail changes to the 
Atmosphere Off control.

2 Click the Atmosphere swatch and choose a 
color from the color picker.

3 Drag left inside the Haze control and set the 
value to 0. This setting eliminates the 
suggestion of a horizon.

Setting Sky Attributes
Once you’ve selected a Sky mode, you have the 
basis for your virtual environment. All the other 
atmosphere effects you add later will interact with 
the base mode. There are two other attributes that 
affect how all the other effects will appear: 
Shadows and Ambient color.

Shadows in Your Scene
All the objects in your scene cast shadows. Using 
the Shadow control you can set the intensity and 
color of all the shadows in your scene.

Use the Shadows control to set the color and intensity of 
shadows in your scene.

Sun Glow 
Color

Horizon 
Color

Sky Color

Shadow

Color
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As you change the value of the Shadow control, the brightness 
of shadows changes.

The shadow control is not the only control for 
shadows. The position of shadows is dependent on 
the position of the sun. Since the sky interacts 
directly with objects in the scene, the color of the 
sun also affects the color of shadows. 

The object’s material properties also affect the 
color of shadows. Semi-transparent or transparent 
objects with a transparency color will change the 
color of the object’s shadow. As well, volume 
materials can dramatically change the shape and 
color of shadows.

Use the Shadows control to set the color and intensity of 
shadows in your scene.

By default, the Clouds in Bryce do not cast shadows. 
If you want the cloud layer to cast shadows on the 
ground below, enable the Cloud Shadows option. 
Refer to “Cloud Cover” on page256 for more on this 
option. 

To set shadow intensity:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Drag left or right inside the Shadow control 
thumbnail. Dragging left decreases the 
intensity and dragging right increases it.

The cursor changes to a two headed arrow as you drag over the 
control.

To set shadow intensity numerically:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

Use the Sky Lab dialog to set sky attributes numerically.

3 Click the Sun & Moon tab to display the Sun & 
Moon palette.

4 Click the Sun/Moon Shadows field, then enter 
a value, or drag the slider. This field governs 
the intensity of shadows rendered in your 
image. The range is 0 to 100, and the default 
value is 90.

Shadows=10 Shadows=90
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Ambient Color
The Ambient Color is the color of all the light that 
surrounds the objects in your scene. Light from the 
sun interacts with ambient color to produce the 
color for both highlights and shadows.

Ambient Color is used as the source color for 
material Ambience. The Ambient Color tints the 
surfaces of all objects in your scene that have some 
level of ambience. Any other color you apply to the 
object’s surface is mixed with the Ambient color to 
create the final surface color. For example, if the 
Ambient Color is red, any color you assign to an 
object’s surface ambience is mixed with red.

Refer to “Ambience” on page135 for more on 
material ambience. 

To set Ambient Color:

• Click the color swatch below the shadow 
control thumbnail and choose a color from the 
color picker.

For realistic effects, at noon, or in the 
afternoon, ambient color should be a little 
blue to get nice blue-ish shadows. At dawn, 
you can set Ambient Color to red or pink, and 
at night you can set it to gray-blue.

You can also set the ambient color by using the 
Ambient color swatch in the Sky Lab.

Adding Fog and Haze
Fog and Haze are two atmospheric effects that can 
add realistic depth to your scene. Fog can make 
objects appear to disappear the farther they get 
from the camera. Haze can add the illusion of a 

distant horizon. The Fog and Haze controls in the 
Sky&Fog palette let you control the color and 
intensity of these effects.

Use the Fog and Haze controls to set the intensity and color of 
Fog and Haze effects.

Fog
Fog can add an element of sensuality, mystery, and 
even realism to your scenes. It acts like a thin layer 
of cloud close to the ground. Using Fog you can 
create the illusion of depth without having to add 
distant objects.

Fog can create a sense of depth in your scene. In this scene, the 
fog was used to add depth to the road as it moves away from 
the camera. Notice how the feeling of depth was created 
without the addition of background objects.

You can set intensity, height, and color attributes 
for the fog. 

Fog

Haze Intensity

Haze Color

Fog Color
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For example, you can see how the fog changes in these skies as 
the Fog value changes.

The fog acts as a global layer covering the entire 
scene. Its color and intensity are the same 
throughout the scene. 

To set the amount of Fog:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog text button.

2 Drag horizontally inside the Fog thumbnail to 
increase or decrease the amount of fog in your 
rendered scene. Drag to the left to decrease 
the amount of fog, and to the right to increase 
it.

To set Fog height:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog text button.

2 Drag vertically inside the Fog control to 
increase or decrease the height of your fog. 
Drag up to increase the height and down to 
decrease it.

The height and amount values are displayed in the 
Text area of the Control palette as you drag.

To set Fog color:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog text button.

2 Click the color swatch beneath the Fog 
thumbnail and choose a color from the color 
picker.

To set Fog attributes numerically:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Atmosphere tab.

4 Click the Fog Density and/or Thickness fields, 
then enter a value. These fields set the amount 
of fog rendered in your image. The range is 0 
to 100%, and the default value is 0%.

5 Click the Base Height field, then enter a value. 
This field sets the height of fog rendered in 
your scene, assuming there is a value greater 
than zero in the Fog field. The range is 0 to 
100%, and the default value is 0%. It translates 
the entire atmospheric effect up or down 
without changing the density or thickness.

Base Height provides control over density at 
low altitudes, such as in valleys. In earlier 
versions of Bryce, you had to move the entire 
scene up or down relative to the atmosphere.

Blending the Fog Color

Since the fog remains constant throughout the 
scene, you may get some odd looking results when 
you’re creating a sunset or sunrise. In these cases 
the sun is very close to the ground plane where the 
fog exists, so the fog should react to the sunlight. 
The Blend with Sun feature lets you create exactly 
this effect. As the sun approaches the Fog, the color 
and intensity of the fog changes to interact with 
the color of the sun.

Fog=10 Fog=90
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In this example, the Fog is linked to the sun so you can see the 
changes in the fog color and intensity as the sun gets closer to 
the horizon.

To link Fog color to the Sun controls:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Atmosphere tab.

4 Click the Blend with Sun button.

5 Make sure the Blend Fog button is enabled.

6 Enter a value in the Color field, or drag the 
slider, to set how much of the fog color is 
blended with the sun.

7 Enter a value in the Luminance field, or drag 
the slider, to set the intensity of the fog color 
when it’s blended. 

To get the best effect, set both these fields to 
100.

Localized Fog

There may be times when you want to create 
localized pockets of fog. For this type of effect 
you’ll need to use an object with a volume material 
applied to it; this way the object looks like fog. The 
area covered by the fog is then controlled by the 
size of the object. A flattened sphere usually makes 
a good fog volume.

This technique can also be used to create visible 
smoke, or gas.

In this example, the effect of puffy smoke was created by 
applying a volume material to a flattened sphere object.

To create localized fog:
1 Display the Create palette.

2 Click the Sphere tool. A sphere object appears 
in the scene.

3 Squash and stretch the sphere, until it is the 
desired shape. Refer to “Transforming 
Objects” on page206 for more on 
transforming objects.

4 With the object selected, click the M icon that 
appears next to its bounding box. The 
Materials Lab appears.

5 Click the Volume button at the top of the lab. 

6 Set up the values for channels in the material. 
Refer to “Building Materials” on page162 for 
more on creating materials.

• Choose a cloud-like texture from texture 
components. Stratus, Cumulus or one of 
the CloudBump textures work well.

• Pay special attention to the Base Density 
channel as this sets the transparency of 
your fog.

• You need to set a high value for the Edge 
Softness channel to blur the edges of the 
sphere object.
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7 Click the OK icon to exit the lab.

8 In the Working window, move the object to 
the area where you want the fog to appear.

Haze
Haze is the natural effect you see when a plane (like 
the ocean) stretches out towards the horizon. At 
this distant point a different color appears over the 
horizon and light becomes fuzzy. 

Haze creates the illusion of a distant horizon. In this scene, the 
haze is used to create the distinction between the water plane 
and the sky.

The Haze control lets you set the intensity and 
color of the Haze effect in your Bryce scene. 

With haze set to zero, your horizon will have an 
unnaturally hard edge. Also note that the Cloud 
Altitude control will affect the height of this band 
of haze. The higher the altitude of the atmosphere, 
the wider the band of haze at the horizon.

You can see how the haze changes in these skies as the Haze 
value changes.

Haze is applied to the entire scene equally. The 
haze always appears at the horizon. 

To set Haze intensity:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Drag horizontally inside the Haze thumbnail 
to increase or decrease the degree of haze in 
your scene. Drag to the left to decrease the 
amount of haze and to the right to increase it.

To set Haze intensity numerically:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the button at the top of the 
Bryce window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Atmosphere tab.

4 Enable the Haze option.

5 In the Haze area, enter values in the Haze 
Density, Thickness, and Base Height fields. 
These fields govern the amount of haze 
rendered into your scene. The range is 0 to 
100, and the default value is 4.

Density controls density of the lower part of 
the atmosphere, and affects the scattering of 
light around the sun.

Thickness scales the whole atmosphere up or 
down, with the density at “sea level” remaining 
unchanged.

Base Height provides control over density at 
low altitudes, such as in valleys. It translates 
the entire atmospheric effect up or down 
without changing the density or thickness. In 
earlier versions of Bryce, you had to move the 
entire scene up or down relative to the 
atmosphere.

To set Haze color:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

Haze=0 Haze=90
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2 Click the color swatch beneath the Haze 
thumbnail and choose a color from the color 
picker.

Fog and Haze colors should be the same, or almost 
the same. For realism, the haze should be a little 
brighter and bluer than the fog. At nighttime, you 
have less illumination, so an effective nocturnal 
haze color could be dark blue-gray. 

Blending the Haze color with the Sun

Since the Haze always appears at the horizon it 
should change color as the sun sets or rises. The 
Blend with Sun feature lets you simulate this effect. 
When the two elements are linked, the haze color 
and brightness change depending on the position 
of the sun. This creates very realistic looking 
sunsets. 

In this example, the haze is linked to the sun. You can see how 
the color of the horizon changes as it gets closer to the sun.

When you’re using this feature to create sunsets, 
you should choose the haze color carefully so as to 
create a natural-looking color scheme.

To link Haze to the Sun controls:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Atmosphere tab.

4 Click the Blend with Sun button.

5 Make sure the Blend Haze and Blend Fog 
buttons are enabled.

6 Enter a value in the Color field, or use the 
slider, to set how much of the haze color is 
blended with the sun.

7 Enter a value in the Luminance field, or use the 
slider, to set the intensity of the haze color 
when it’s blended. 

8 To get the best effect, set both these fields to 
100.

Setting the Color Perspective

Color perspective is the change in color with 
distance that characterizes the appearance of 
distant scenes in Nature: Dark areas turn blue and 
light ones yellow to orange to red. In Bryce you can 
make things change any color you like with 
distance. Color perspective is half of aerial 
perspective, while the other half is the loss of 
contrast with distance. 

Color perspective controls the rate at which the 
red, green and blue components of the atmosphere 
come in with distance. In Nature, the atmosphere is 
white or a pale shade of gray. The blue component 
of that shade comes in faster than the green, which 
in turn comes in faster than the red. This is because 
the Earth's atmosphere scatters blue light more 
efficiently than green, and red least efficiently of 
all. The net result is that as a dark area recedes into 
the distance, it will turn blue before it turns white 
or pale gray in the far distance. Similarly, white 
areas will turn yellow, then orange, then red with 
increasing distance. The default values of color 
perspective are very delicate: if you change them, 
expect unpredictable results!

To set the color perspective:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.
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3 Click the Atmosphere tab.

4 Click the Color Perspective button.

5 Click the RGB controls to control the rate at 
which the red, green, and blue components of 
the atmosphere come in with distance.

Clouds in Bryce
There are two kinds of clouds in Bryce: clouds in 
the environment and cloud planes. 

Clouds you add to your sky interact with the light 
in your scene. They can block out the light of the 
sun and change the color of the light that hits the 
objects in the scene. These clouds are infinitely 
distant so you cannot fly through the clouds in the 
sky. If you want to have this effect, use a cloud 
plane. Sky clouds can also cast shadows on the 
ground below.

The clouds in this scene were created using Cumulus clouds from 
the Sky and Fog palette.

You can change the look of the clouds by editing 
the texture used to create them. By changing the 
texture you can alter the shape and position of the 
clouds within the sky. 

Cloud planes are infinite planes that act as objects 
in your scene. They cast shadows and can interact 
with other objects. 

An infinite cloud plane was used to create the mist above the 
water in this scene.

Both types of clouds can be animated. The clouds 
in the sky can be animated by changing their color, 
position or frequency, and cloud planes can be 
animated just like other objects. They can also be 
animated using the Cloud Motion controls. These 
controls let you set parameters for automatically 
animating clouds. Refer to “Animating Skies” on 
page354 for more on animating clouds.

Adding Clouds
The Sky&Fog palette provides several controls 
that set the attributes of clouds in your sky. The 
Cloud Coverage, Cloud Altitude, and Cloud 
Frequency and Amplitude controls let you set the 
general appearance of your clouds. The Cloud Color 
sets the color of the clouds.

Use the cloud controls to set the attributes of the clouds in your 
scene.

You can add clouds to your scene in five easy steps:

Cloud Cover
Sky Dome Color Cumulus Color

Cloud Height

Cloud Frequency and Amplitude
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• Select the type of cloud 

• Adjust the cloud texture
• Set the cloud coverage and color

• Set cloud height

• Set the frequency and amplitude of clouds

Cloud Types

There are two types of clouds you can add to your 
Bryce environment: Cumulus and Stratus. Cumulus 
clouds are generally found at lower altitudes and 
appear thicker and fluffier.
.

The sky in this scene uses Cumulus clouds.

The Stratus appear at higher altitudes and appear 
thinner and more wispy.
 

The sky in this scene uses Stratus clouds.

To add Cumulus clouds to a sky:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the Sky&Fog button at the 
top of the Bryce window.

2 Click the triangle in the corner of the palette 
and choose Cumulus Clouds.

Cumulus clouds are thicker, darker clouds at a 
lower altitude. These clouds will take on tints 
of Sunlight color, Ambient color, or Cumulus 
color.

To add Stratus clouds to a sky:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the Sky&Fog button at the 
top of the Bryce window.

2 Click the triangle in the corner of the palette 
and choose Stratus Clouds.

Stratus clouds are bright white, thin, clean 
clouds that appear at high altitudes. These 
clouds are very responsive to Sunlight color 
and Sky Dome color, and less responsive to 
Cumulus color or Ambient color.

You can also choose both cloud types, or neither. 
Selecting neither cloud type creates a clear sky.

Editing Cloud Textures

Clouds in Bryce are created using a procedural 
texture with a cloud pattern. The color, position, 
size, and pattern within the texture determines the 
final look of the cloud in your sky. You can edit this 
texture using either the Sky Lab palette, or for 
more complex editing, you can use the Texture 
Editor. 

The texture used for a cloud can come from either 
the Bryce texture library or you can create your 
own.

To edit cloud texture in the Sky Lab dialog: 

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the Sky&Fog button at the 
top of the Bryce window.
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2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Cloud Cover tab.

The Cloud Cover tab provides controls that let you edit the 
textures that are used to create the clouds in your scene. As you 
change a texture, the texture preview updates.

4 Click the grey + or - Turbulence buttons to 
increase or decrease the amount of noise in 
the texture. 

• Increasing the Turbulence creates a more 
dense pattern within the texture.

5 Click the blue + or - Complexity buttons to 
increase or decrease the amount of detail in 
the texture. 

• Increasing the Complexity increases the 
complexity of the patterns within the 
texture.

6 Click the Reset button to restore the original 
settings, if you want to start over.

7 Click the OK icon to apply your changes.

To edit cloud textures in the Deep Texture 
Editor:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the Sky&Fog button at the 
top of the Bryce window.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Cloud Cover tab.

4 Click the Edit button below the type of clouds 
you want to edit.

5 Click the Edit button. The Deep Texture Editor 
appears.

The cloud texture and its components appear 
in the component windows.

If you’re not familiar with using the Deep Texture 
Editor you may get some very unpredictable results 
which may result in clouds that don’t look much like 
clouds. Before you start editing the clouds texture 
you may want to refer to“Creating and Editing Tex-
tures” on page169 for more instruction on how to 
use the editor.

6 If you want to add additional turbulence to the 
cloud texture, adjust the texture’s Noise:

• Click the Noise button at the bottom of the 
editor. The Noise control appears.
The Noise control lets you adjust the 
frequency of the noise in any of the 
texture’s components.

• At the top of the Noise control, click the 
button associated with the component you 
want to edit. 

• Adjust the Noise slider to increase/
decrease the frequency of the noise in the 
texture.

7 If you want to change the colors of a 
component, click one of the color indicators in 
the component window and choose a new 
color.

8 If you want to add more complexity to the 
texture, adjust its Phase:

• Click the Phase button at the bottom of 
the editor. The Phase control appears.
The Phase control lets you adjust the 
amplitude of the phase in any of the 
texture’s components.
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• At the top of the Phase control, click the 
button associated with the component you 
want to edit. 

• Adjust the Phase slider to increase/
decrease the amplitude of the phase.

9 If you want to change the pattern in the 
texture, apply a filter:

• Click the Filter button at the bottom of the 
editor. The Filtering control appears.
The Filtering control displays a graphical 
representation of the filter applied to your 
texture. By changing the equation of the 
filter to the value of the variables, you can 
change the patterns within the cloud 
texture.

• At the top of the Filtering control, click the 
button associated with the component you 
want to edit. 

• Change the filter equation and variable 
values to adjust the filter applied to your 
texture.

Filtering is a rather complex operation. Try experi-
menting with different equations and see what hap-
pens.

10 Click the OK icon to exit the editor.

Cloud Cover

Cloud Cover controls the quantity of clouds you can 
see in the sky. A high coverage means that there is 
a very dense cloud layer, and a low setting means 
that there are very few clouds in the sky.

Cloud cover also indirectly controls the brightness 
of the environment. The more cloud coverage you 
have in a sky, the darker the environment, since 
less sunlight can pass through the clouds.

Adjusting cloud coverage changes the quantity of 
clouds but not the frequency. You can think of it as 
adjusting the volume on a radio without changing 
the station.

The Cloud Coverage control in the Sky & Fog palette lets you 
interactively set the quantity of clouds in the sky.

For example, you can see how the clouds change in these skies as 
the cloud coverage value changes.

To set cloud coverage:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the Sky&Fog button at the 
top of the Bryce window.

2 Drag left or right inside the Cloud Coverage 
control thumbnail. Drag left to decrease 
coverage and right to increase it.

To set cloud coverage numerically:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the Sky&Fog button at the 
top of the Bryce window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the Cloud 
Cover field. 

To set cloud color:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button.

2 Click the color swatch beneath the Cloud 
Coverage thumbnail and choose a color from 
the color picker.

Cloud Coverage

Cloud Color

Cloud Coverage=10 Cloud Coverage=90
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Cloud Height

The height of your clouds has an impact on the 
appearance of your sky. Greater heights will result 
in smaller, more distant cloud formations, as well 
as a thicker band of haze at the horizon. Lower 
heights result in larger, more languorous cloud 
formations and a thinner band of haze at the 
horizon. 

The Cloud Height controls in the Sky & Fog palette let you 
interactively set the height of the cloud layer in the sky.

For example, you can see how the clouds change in these skies as 
the cloud altitude value changes.

There are two things to remember when working 
with this control. First, the Cloud Height will affect 
the size of your Haze band, if you have a haze 
setting greater than zero. The higher the altitude, 
the wider the haze region will be on the horizon. 
Second, remember to lower your altitude setting if 
you are creating a nighttime scene. Since high 
altitudes increase the size of the horizon Haze 
region, the sky will be too unnaturally bright for 
realistic night scenes.

To set cloud height:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking Sky & Fog on the menu bar.

2 Drag horizontally inside the Cloud Height 
control thumbnail. Drag left to decrease 
altitude and right to increase it.

To set cloud height numerically:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog text button.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the Cloud 
Height field. 

Frequency and Amplitude

The Frequency and Amplitude control lets you set 
the types of cloud formation you’ll see in your sky. 
By combining these two controls you can change 
your clouds from light and fluffy to dark and 
brooding.

Use Frequency and Amplitude to control the types of cloud 
formations in your scene.

Cloud Height

Cloud Height=10 Cloud Height=90
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This graph shows the effects of different Frequency and 
Amplitude settings on a sky. Frequency values range from 2 at 
the top to 150 at the bottom. The Amplitude values range from 
50 at the left to 500 on the right.

To set Cloud Frequency and Amplitude:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 In the Cloud Frequency and Amplitude control, 
drag horizontally to control the frequency of 
your cloud formations. 

Drag right, and the “spikes” will get closer 
together, resulting in smaller formations. Drag 
left for larger, more luxurious formations.

The Text Display area shows you the numerical value 
of the amplitude as you drag.

3 Drag vertically to control the amplitude of 
your cloud formations. 

Drag away from the horizontal center, and the 
spikes increase in height, resulting in 

formations with harder edges. Drag toward the 
horizontal center for softer-edged formations. 

Note: It is possible to invert the spikes. This means 
that you can exchange positive and negative spaces 
in your sky. If you invert the amplitude, everything 
that was previously clear sky will be clouds, while 
everything that was cloud will be clear sky.

To set Frequency and Amplitude numerically:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Frequency field. The Frequency field controls 
the frequency (scale) of cloud formations in 
your scene.

5 Drag the slider or enter a value in the 
Amplitude field. The Amplitude field controls 
the amplitude (edge softness) of clouds in your 
scene. 

Sky Dome Color

Sky Dome Color lets you create a color wash over 
your scenes, even if there is no sunlight present. 
This color simulates the natural effect that occurs 
when you have color in the sky even though the sun 
has set. Sky Dome Color lets you create late 
afternoon or evening scenes.

The Sky Dome Color control in the Sky & Fog palette lets you 
choose a color from either the color picker or the color dialog.

For late afternoon and early evening realism, try 
using a touch of orange or yellow. This will create a 
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cast of color over your entire scene, regardless of the 
position or color of the sun or moon.

To set Sky Dome color:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the text item on the menu 
bar.

2 Click the color bar beneath the Cloud Height 
control thumbnail and choose a color from the 
color picker.

Linking Clouds to the Camera View

If you move the camera view during an animation, 
the clouds in your environment will appear to 
zoom by, creating a kind of time-lapsed effect. If 
you want the clouds to appear fixed as you move 
the camera, link the cloud in the sky to the camera 
view. This way, wherever the camera moves the 
clouds will follow, so that they seem to remain 
stationary.

To link clouds to view:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Click the Link Clouds to View button.

Refer to “Animating Skies” on page354 for 
more on animating skies.

Using a Fixed Cloud Plane

As you move higher up in a Bryce environment, the 
cloud pattern shifts, so that it appears as if you’re 
getting closer to the clouds. If you want to counter 
this effect, you can use the Fix Cloud Plane option 
to freeze the cloud pattern so that it doesn’t 
change as you move higher up.

To use a fixed cloud pattern in your sky:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Click the Fixed Cloud Plane button.

Setting the Cloud Motion

You can set the speed and turbulence of clouds as 
well as specify the direction of motion.

To set cloud speed:
1 If it’s not already visible, display the Sky&Fog 

palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Drag the slider, or enter a number in the 
Speed field.

To set cloud turbulence:

1 If it’s not already visible, display the Sky&Fog 
palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Cloud Cover tab.

4 Drag the slider or enter a value in the 
Turbulence field.

To set the direction of motion:

1  If it’s not already visible, display the Sky&Fog 
palette by clicking the text item on the menu 
bar.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.
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3 Click the Cloud Cover tab.

4 Drag the Cloud motion control to specify the 
angle of motion.

Working with the Sun
The sun is the source of all natural light in your 
scene. Its attributes have a profound effect on the 
look of your scene. 

The color of the sun affects all the colors of all the 
objects in the scene; Sunlight color tints all the 
other visible colors. 

The position of the sun controls the time of day in 
your scene. If the sun is above the horizon, it is day; 
if it is below, it is night, and if it is at the horizon, it 
is sunrise or sunset. 

The sun can be animated just like all the other 
elements of your Bryce scene. You can create time-
elapsed effects by changing the position of the sun 
over the course of an animation. Refer to 
“Animating Sun or Moon Position” on page356 for 
more on animating the Sun.

Positioning the Sun
The sun position control sets the direction your 
natural light is coming from whether it is sunlight 
or moonlight. The position can be set using the Sun 
control in the Sky & Fog palette. The control works 
like a trackball, with the sun at one end and the 
moon at the other.

The control works like a trackball. As you drag over the control, 
both elements move in the direction you drag.

You can think of the control as a compass: if the 
highlight on the Sun Control sphere is positioned 
at 12 o’clock, the light comes from the north, and 
so on.

As you change the position of the sun, the “time of day” 
changes. When the sun position is closer to the edges of the 
control, the sun appears closer to the horizon, making the scene 
darker. 

Moon

Sun
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When the sun is in the center of the control, the sun shines from 
directly above the sun, like it would at high noon.

The colors in your sky will change depending on 
the position of the Sun Control, or the “time of 
day...” just like in the real world.

The angle of the shadows changes as the sun 
changes. If your object is shiny, and there are no 
other light sources, the position of the sun controls 
where the highlight appears. 

In this example, you can see the effects of the sun’s position on 
several reflective and shiny objects.

Day and Night

Your sky normally contains two bodies: the sun and 
the moon. There is always one body visible in your 
sky. At night it is the moon and in the day it is the 
sun. 

The two bodies are connected and always remain at 
opposite ends of the sky. As you move the sun 
you’re also moving the moon. This means that 
when the sun dips below the horizon in front of 
you, the moon is rising behind you.

The link between the sun and the moon can be seen by 
positioning the sun at the horizon in front of the camera.

If you turn the camera 180°, you’ll see the moon just rising over 
the horizon as well.

To switch between night and day:
1 Display the Sky&Fog palette.

2 Click the Day/Night toggle button in the top-
left corner of the sun position controls.

Sunrise/Sunset

You can create a sunset or sunrise by positioning 
the sun so that it is visible on your horizon.

You can position the sun manually by using the 
Sun/Moon control, or numerically by specifying 
values in the Sky Lab. You can also position the sun 
exactly where you want it to appear in your scene.
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Sunsets or sunrises can be created by moving the sun closer to 
the horizon.

The colors in the sky automatically change to 
create the illusion of the sunrise or sunset colors. 
You can also use the Sky Dome color to give your 
sunset/sunrise added color.

For a more realistic sunset you may want to link the 
fog and haze to the sun so that they react to the 
sun color as it approaches the horizon. Refer to 
“Blending the Fog Color” on page249 and 
“Blending the Haze color with the Sun” on 
page252 for more on this feature.

You may also want to enable the Horizon illusion 
for the sun. This feature makes the sun appear 
larger as it approaches the horizon. Refer to “Sun/
Moon Horizon Illusion” on page267 for more on 
this effect.

To position the sun manually:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Drag the larger highlight area in the Sun 
Position controls to the position where you 
want the light to originate.

You can position the sun, or the moon, on the hori-
zon as you like by nudging the Sun Control until the 
light is visible in your scene.

To position the sun numerically:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab palette 
appears

3 Click the Sun & Moon tab.

4 In the Sun Controls area, type a value into the 
Azimuth field. The Azimuth field controls the 
east-to-west position of the sun. The range is 0 
to +360. 

5 Enter a value in to the Altitude field. The Y 
field controls the height of the sun relative to 
your scene. The range is -90 to +90. 

Positive values are above the horizon, negative val-
ues below. 

To position the sun with precision:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Hold down Control+Option/Ctrl+Alt, and 
double-click the Sun control.

3 Hold down Control+Option/Ctrl+Alt, and in 
the working window, click where you want to 
position the sun.

Linking the Sun to the Camera

Normally, you’d have to reposition the sun every 
time you changed the camera to maintain a certain 
effect or sunlight angle. However, if you apply the 
Link Sun to Camera, your sun will track the camera. 
The position of the sun relative to the camera 
remains the same no matter where the camera is 
positioned. This way you can set up the sun 
position once and then not worry about losing the 
effect as you move the camera. 
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When the sun is linked to the camera, the sun moves relative to 
the Camera. Wherever the camera moves the sun follows. As it 
moves, the sun maintains a constant distance from the camera.

This feature can also be very useful when you’re 
animating your scene. Refer to “Animating” on 
page319 for more.

To link the sun to the camera:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog text button.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Sun & Moon tab.

4 Click the Link Sun to View button.

When this option is enabled, your sun will 
always remain in the same position relative to 
the camera. Wherever you move the camera 
the sun will follow. This is an easy way of 
seeing how a sunset will look against different 
skylines.

Sun Color

Light in nature is not usually visible until it strikes 
an object. When you’re using normal light, a purple 
sunlight color will not paint your entire sky purple, 
but objects in your scene will reflect purple.

When you’re using Visible World, choosing purple 
will paint your entire scene purple.

The grayscale bar at the bottom of the color palette 
lets you set the intensity of the sun. Black turns the 
sun off and white sets the sun to its brightest 
intensity.

You can also use the color palette to set the intensity of the sun. 
Black represents the lowest intensity and white the highest.

To set the Sun Color:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog text button.

2 Click the Sun Color swatch, and choose a color 
from the color picker.

Disabling the sunlight

You can remove the sunlight in your scene by 
disabling it. When the sunlight is disabled, the sun 
remains in the scene, but does not throw light. The 
only light visible in your scene comes from 
individual light sources. (The scene will still be 
illuminated.)

To disable the sunlight:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog text button.

2 Click the Sky Lab button. The Sky Lab palette 
appears

3 Click the Sun & Moon tab.

4 Click the Disable Sun Light button.

Working with the Moon
The moon is normally the most prominent object in 
the night sky. In a night scene it provides all the 
natural light in the environment. Like the sun, the 
moon’s attributes can greatly affect the final look 
of your scene. 
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Its position in the sky affects all the angles and 
intensities of all the shadows in the scene. 

The brightness is affected by the illumination 
reflected off the earth. The brighter the earthshine, 
the brighter the moon appears.

Unlike the sun, the moon has phases which 
simulate the effects of the moon’s shadow 
becoming more or less prominent during a month. 

The moon’s position and phases can be animated 
using the Animation controls and the timeline. 
Refer to “Animating Sun or Moon Position” on 
page356 for more on animating the moon.

Positioning the Moon
The moon is positioned at the same time as the 
Sun. The two are always at opposite ends of the 
sky, so wherever the sun is positioned, the moon is 
directly opposite. 

In the Sun/Moon control on the Sky & Fog palette, 
the moon’s position is represented by the smaller 
highlight portion of the Sun Position trackball.
.

The position of the moon is represented by the smaller highlight 
portion of the position control trackball. You can position the 
moon by either moving the smaller highlight or by dragging the 
sun. The moon is always opposite the sun.

You can position the moon manually by using the 
Sun/Moon control, or numerically by specifying 
values in the Sky Lab. You can also position the 
moon exactly where you want it to appear in your 
scene.

To position the moon manually:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 Drag the smaller highlight area in the Sun/
Moon Position control to the position where 
you want the light to originate.

You can position the sun, or the moon, on the hori-
zon as you like by nudging the Sun/Moon control 
until the light is visible in your scene.

To position the moon numerically:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Day/Night toggle to display the moon 
icon.

4 Click the Sun & Moon tab.

5 In the Sun Controls area, type a value into the 
Azimuth field. The Azimuth field controls the 
east-to-west position of the sun/moon. The 
range is 0 to +360, and the default value is 60. 

• The moon will be positioned exactly 
opposite these values, so you can invert 
them to position the moon numerically, or 
place the Sun behind the camera so that 
the moon appears in front of it.

6 Enter a value into the Altitude field. The 
Altitude field controls the height of the sun/
moon relative to your scene. The range is -99 
to +99.

Positive values are below the horizon, negative val-
ues above. 

To position the moon with precision:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Day/Night toggle to display the moon 
icon.

3 Hold down Control+Option/Ctrl+Alt, and 
double-click the Sun control.
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4 Hold down Shift+Control+Option/Ctrl+Alt, 
and in the working window, click where you 
want to position the moon.

Moon Phases 
The moon phases control simulates different 
aspects of the moon as it orbits the earth. 

The change in the phases of the moon can indicate the passage 
of time.

The moon phase is a visual clue to the time of the 
month. In an animation, you can use the moon 
phase to simulate the passage of a time. Refer to 
“Animating Sky & Fog settings” on page355 for 
more. 

The phase is controlled using the Moon Phase 
controls in the Sky Lab palette. 

To set the moon’s phase:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Sun & Moon tab.

4 Enable the Moon Phase option.

5 Drag over the Moon Phase control. The phase 
changes as you drag.

6 Click the OK icon to exit the dialog.

The Moon Phase control lets you set the phases of the moon.

Moon Brightness and Sharpness
The moon is directly affected by the light reflected 
from the earth. The brighter the reflection, the 
brighter the moon’s shadow. In Bryce this effect is 
controlled by the Earthshine setting which makes 
the moon brighter or darker. 

A realistic moon does not have sharp edges and 
may appear blurry on hazy nights. The Softness 
control lets you set the moon’s edge softness to 
give a more realistic feel.

To set the brightness of the moon’s shadow:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Sun & Moon tab.

4 Enable the Moon Phase option.

5 Drag the Earthshine slider. Drag right to 
increase the brightness and left to decrease it.

• Enter a value in the Earthshine field to set 
Earthshine numerically.
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6 Click the OK icon to exit the dialog.

To set the moon’s edge softness:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Sun & Moon tab.

4 Enable the Moon Phase option.

5 Drag over the Softness control. Drag right to 
soften edges, or left to sharpen them. 

• Enter a value in the Softness field to set 
Softness numerically.

6 Click the OK icon to exit the palette.

Adding Environmental Effects
The elements in a sky aren’t constant; the sky is 
always changing, reflecting weather patterns or the 
time of day. If it rains, there’s a rainbow. If it’s 
night, there are stars. If it’s sunset, the sun looks 
bigger. If you look right at the sun on a hazy day, 
you’ll see rings around it. Sometimes, if it’s hazy 
enough you can even see the sunlight streaking out 
of the clouds. All these illusions are called 
environmental effects and the Sky Lab palette 
contains all the controls you’ll need to add them to 
your scene.

Sun/Moon Rings
If you look directly at the sun on a hazy day, you’ll 
be able to see rings surrounding it. These rings are 
created by the reflection off ice particles in the air. 
In Bryce, you can use the Sun/Moon Rings to create 
this effect.

In this example, rings have been added to the sun to make the 
scene look like a sweltering desert. 

This effect creates concentric circles around the 
image of the sun or moon. Using the Sky Lab 
palette, you can set the radius of the rings and add 
a secondary ring to increase the effect. The color of 
the rings is controlled by the color of the sun/
moon. 

To add Sun/Moon rings:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Sun & Moon tab.

4 Enable the Sun/Moon Visible option.

5 Enable the Halo Rings option.

6 In the Rings area, enter a value in the Intensity 
field, or drag the slider, to set the brightness 
of the ring. 

7 Enter a value in the Radius field, or drag the 
slider, to set the radius of the ring. 

If you want to add a secondary Sun/Moon ring, 
enable the Secondary Ring option .
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Sun/Moon Horizon Illusion
If you’ve ever watched a sunset, you probably 
noticed that the sun appeared to get larger as it 
approached the horizon. The same is true for the 
moon. At certain times of the month it appears 
huge. This illusion can be simulated using Sun/
Moon size.

The spooky look of this night scene was created by applying a 
Horizon Illusion. 

When the illusion is active, the sun or moon will 
appear to grow larger as it approaches the horizon. 

To change the size of the Sun or Moon as it 
approaches the horizon:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Sun & Moon tab.

4 Enable the Sun/Moon Visible option.

5 Enable the Sun/Moon size Option.

6 In the Sun/Moon size area, enter a value in the 
Disk Size field, or drag the slider, to set the 
overall size of the sun/moon anywhere in the 
sky. 

7 Enter a value in the Horizon Illusion field, or 
drag the slider, to set multiplier used to 
determine how much larger the sun or moon 
gets as it approaches the horizon.

Rainbows
In the real world rainbows appear after rainstorms 
as arcs of light displaying all the color in the 
spectrum. In Bryce a rainbow is an atmospheric 
effect that can be added to any sky. 

A rainbow is only visible if the sun is visible, 
meaning you can’t have a rainbow at night. As well, 
you can add a secondary rainbow to create the 
illusion of reflection. 

Rainbows are linked to the sun. As the color or 
intensity of the sun changes, so does the rainbow. 
In addition, the position of the rainbow in the sky is 
dependent on the position of the sun.

Rainbows appear to be infinitely distant from the 
camera. You can’t approach them by moving the 
camera, so the pot of gold is always just out of 
reach.

To add a rainbow to your sky:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab dialog 
appears.

3 Click the Atmosphere tab.

The Atmosphere tab of the Sky Lab dialog contains all the 
controls you’ll need to create rainbows.

4 Enable the Rainbows option.
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5 Drag the slider or enter a value in Radius field 
in the Rainbow area. This value sets the width 
of the rainbow.

6 Drag the slider or enter a value in the Opacity 
field. This controls the rainbow’s transparency.

If you want to add a secondary rainbow to your sky, 
enable the Secondary Bow option.

Volumetric World
The Volumetric World effect simulates the effects 
of particles in the air being illuminated by light 
sources. In Bryce this effect turns all the light 
sources in your scene into visible light sources.

In this example you can see how the Volumetric World effect 
transforms a scene.

Sunlight also becomes visible, so that any color you 
applied to the sun appears everywhere in the scene. 
Visible sunlight is volumetric, meaning that it is 
affected by all the objects withinit. 

Although Volumetric World is a very beautiful effect, 
it’s also a time consuming one. It will add consider-
ably to your scene’s rendering time. 

To add visible sunlight to your scene:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Atmosphere tab.

4 Click the Volumetric World button.

5 Drag the Quality slider or enter a value in the 
Quality field. 

6 Drag the Density slider or enter a value in the 
Density field. Higher values result in brighter, 
more visible sunlight.

Star Fields
Bryce lets you create night skies complete with 
stars and comets by using the Sky Lab. 

Stars appear in the night sky and are affected by 
the moon’s brightness and color. They are also 
infinitely distant; they do not get closer as you 
move the camera.

In this example, you can see how the moon affects the color and 
intensity of the stars aroundit.

You can create a star field that is based on a 
randomly generated star map, or a star field based 
on the stars we see from the Earth.

Normal Environment

Volumetric World
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To add a Star Field based on a random star 
map:
1 Display the Sky&Fog palette by clicking the 

Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab appears.

3 Click the Sun & Moon tab.

4 Enable the Celestial option.

5 Enable the Random field option. This will 
create a star field based on a randomly 
generated star map. 

You can get a different random configuration of 
stars by Option/Alt-clicking the Random Field but-
ton. Shift-clicking the Random field button generates 
the default random star field.

To add a Star Field based on Earth’s star 
map:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab appears.

3 Click the Sun & Moon tab.

4 Enable the Celestial option.

5 Enable the Custom field option.

Customizing Star Fields

After you have generated your star field, you can 
customize certain parameters of the star field. You 
can control the intensity of the stars, the amount of 
stars that are visible, and the portion of the star 
field that is visible in your scene. 

Star Field Intensity
Changing the intensity of a star field lightens or 
darkens the visible stars. When you are using a star 
field based on the stars we see from Earth, 

changing the intensity lightens and darkens the 
stars uniformly; their relative intensities do not 
change. 

To change the intensity of a star field:
1 Display the Sky & Fog palette by clicking the 

Sky & Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab appears.

3 Click the Sun & Moon tab.

4 Enable the Celestial option.

5 Enable the Stars option.

6 Drag the Intensity slider or enter a value in the 
Intensity field.

Star Field Amount
You can increase or decrease the number of stars in 
the star field by changing the Stars Amount. When 
you change the amount, new stars are not 
generated. Instead, stars that are usually too dim to 
see become more visible.

To change the amount of visible stars in a star 
field:

1 Display the Sky & Fog palette by clicking the 
Sky & Fog button at the top of the Bryce 
window. 

2 Click the Sky Lab button. The Sky Lab appears.

3 Click the Sun & Moon tab.

4 Enable the Celestial option.

5 Enable the Stars option.

6 Drag the Amount slider or enter a value in the 
Amount field.

Star Field Position Control
The Star Field Position Control lets you choose 
which portion of the star field is visible in your 
scene. The control works like a trackball, with the 
stars of the northern hemisphere on one side and 



Creating Skies270

the stars of the southern hemisphere on the other. 
As you drag over the control, the star field moves in 
the direction you drag.

Comets
You can add comets to your night skies. Since 
comets are not a common sight in the night sky, 
you’ll usually only get one or two comets per star 
field.

To add comets to a night sky:

1 Display the Sky&Fog palette by clicking the 
Sky&Fog button at the top of the Bryce 
window.

2 Click the Sky Lab button. The Sky Lab palette 
appears.

3 Click the Sun & Moon tab.

4 Enable the Celestial option.

5 Enable the Comets option.

You can adjust the intensity and amount of comets 
by dragging the Intensity and Amount sliders or 
entering a value in the Intensity and Amount fields.

You can only add comets to a star field that is based 
on a randomly generated star map.

Using the Preset Skies 
Library
The Preset Skies Library contains all the preset 
skies available in Bryce. You can place them in your 
scene and edit them just as you would another 
object.

To add a sky from the Preset Skies library to 
your scene:

1 Click the triangle icon next to the Sky&Fog 
text button at the top of the Bryce window, or 
click the arrow next to the preview area in the 
Sky Lab dialog. The Preset Skies Library 
appears.

2 Click on the preset thumbnails to view preset 
names and descriptions.

3 Click the OK icon to add the selected sky to 
your scene.

The Sky&Fog palette does not need to be active for 
you to access the Preset Skies Library. 

You can select presets in one motion by clicking and 
holding the triangle icon, dragging directly to the 
desired preset, and releasing the mouse button.

Adding and Deleting Preset Skies
You can add the sky from any open scene to the 
Preset Skies Library. This is a good way of saving 
your favorite skies.

To add a sky to the preset library:

1 Click the triangle icon next to the Sky&Fog 
text button at the top of the Bryce 
environment. The sky from your scene appears 
in the preview area of The Preset Skies Library 
dialog.

The preview area displays the sky from your scene.

2 Click the Add button at the bottom of the 
dialog. The Add Object dialog appears.

3 Enter a name for the new preset in the Preset 
Name field.

4 Enter a description of the preset in the 
Description field and click the OK icon.

This name and description will appear beneath 
the object preview whenever the preset is 
accessed. 
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You can edit the name and description of any preset 
at any time simply by pressing the Tab key, or click-
ing on the name or description.

5 Click the OK icon. Your preset will be added to 
the first available space within the current 
category.

To delete a sky preset:
1 Click the triangle icon next to the Sky&Fog 

text button at the top of the Bryce 
environment. The Preset Skies Library appears.

2 Click on the preset you want to delete, or hold 
down Shift and select a continuous series of 
presets, or hold down Command/Ctrl and 
select a discontinuous set of presets.

3 Click the Delete button at the bottom of the 
Preset Skies Library dialog. 

Importing and Exporting Preset Skies
Importing and exporting presets is a handy way to 
exchange custom presets with other users. 

To import a preset sky file:

1 Click the triangle icon next to the Sky&Fog 
text button at the top of the Bryce 
environment. The Preset Skies Library appears.

2 Click the Import button at the bottom of the 
Preset Skies Library dialog. The file open 
dialog appears.

3 Locate the file which you would like to import 
and click Import.

The contents of the file are placed into the 
first available space in the current category.

To export a preset sky file:

1 Click the triangle icon next to the Sky&Fog 
text button at the top of the Bryce 
environment. The Preset Skies Library appears.

2 Select the preset or presets you wish to 
export.

3 Click the Export button at the bottom of the 
Preset Skies Library dialog. The save file dialog 
appears.

4 Enter a name and location for the file and click 
Save. 





12
Creating and 
Editing Lights

How much of your scene is visible is determined 
by the lighting. The position of the light sources in 
your scene can determine everything from 
visibility to the time of day to the color of the 
atmosphere.
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Lights
Lighting is what makes your scene visible. Different 
types of lighting can dramatically alter the 
appearance of your scene and the objects in the 
scene. 

In Bryce, most of the lighting in your scene is 
provided by either the sun or the moon. As in 
nature, the position of the Bryce sun and moon 
controls the general brightness and ambient color 
of scenes. Refer to “Working with Sky Lab” on 
page243 for more on positioning and setting up 
the sun and the moon.

You can add additional light sources to create a 
variety of effects, such as adding headlights to a 
car, or creating the glare of a distant city.

You can use light sources to shine light from areas where 
sunlight couldn’t shine, like the light from inside a lighthouse.

Viewing Lights
In Wireframe mode, lighting effects are not visible 
in the Working window. Instead, all light sources 
are displayed as wireframes to make it easier for 
you to edit and position them. Lighting appears in 
three places: the Nano-Preview, the Shaded Preview 
mode, and the final rendered scene.

In Nano-Preview, you can see a small preview of 
your lighting effects while working in 
Wireframemode.

Lighting effects appear in the Nano-Preview.

In Shaded Preview mode, all the objects in your 
scene appear as flat solids. Any lighting you apply 
creates simple highlights on the surface of the 
object. This mode does not show materials.

In Shaded Preview mode the objects in your scene are displayed 
as solids. You can also see the effects of different lighting.

Shaded Preview mode is available only if you have a 
system that supports OpenGL, SREE 3D, or Direct 
3D. Refer to “Display Modes” on page26 for more 
on this mode.

If you want to see the effects of lighting on object 
materials, you’ll need to render the final image. 
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When you render your scene you can see the effects of light 
position and color on your object’s materials.

Visible Lights

One of the most spectacular uses of light sources is 
visible light. Visible light effects are like cones of 
light that appear in your scene, such as a 
searchlight cutting through the fog.

The effect of a searchlight cutting through the fog can be 
created using a visible light.

There are two types of visible lights: surface visible 
lights and volume visible lights. Surface visible 
lights make the light object visible in the scene, but 
the light does not interact with the environment, 
so you get a light cone or sphere. Volume visible 
lights interact with the environment, affect all the 
objects that they strike, and are directly affected by 
environment color and brightness. For instance, 

volume visible lights can show shadows crossing 
the air that the light illuminates. Surface visible 
lights cannot.

The volume visible light source interact with the other light 
sources in the scene.

Refer to “Creating Visible Lights” on page282 for 
more information on surface and volume visible 
lights.

Setting Up Lights
There are two types of lights in Bryce—natural and 
direct. Natural lighting is provided by the sun. By 
default every scene contains a sun. Direct light is 
provided by light sources. 

The light from direct light sources can be used to 
either add hyper realism to natural scenes, or add 
light to objects that cast light in the scene, like 
lamps. The lighting setup you choose can greatly 
affect the look of your scene, so experiment with 
various lighting setups.

Creating Direct Light Sources
There are five types of direct lights you can create: 
Radial, Spot, Round Parallel, Square Spot, and 
Parallel.

You can create as many light sources as you need. 
The only limit is your system’s memory. Creating 
additional lights (or light sources) may add 
significantly to the render time of your scene.
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The size, position, and orientation of a light source 
can be edited exactly like any other object. Refer to 
“Transforming Objects” on page206 for more on 
transforming objects.

You can also link lights to specific objects so that a 
light source moves as the object moves. You can 
also set a light to track an object. When it’s 
tracking an object, the light reorients itself so that 
it’s always facing the object no matter where it 
moves. Linking and tracking are quick ways of 
animating light positions. Refer to “Linking 
Objects” on page223 for more on linking, and 
“Tracking Objects” on page344 for more on 
tracking.

The motion of all the light sources in this example were 
animated using the track feature.

Light attributes can be edited in the Lighting Lab.

Radial Light

Radial Lights throw light equally in all directions. 
Use this as a general light source, and remember 
that you can make these lights as tiny as you like 
and use as many as you need.

The lighting in this scene was created using a Radial Light.

Spotlight

Spotlights throw light along a cone-shaped path, 
creating the classic “stage spot” effect.

The lighting in this scene was created using a Spotlight.

Round Parallel Light

Round Parallel Lights produce cylindrical tubes of 
light and cast circular spots where the light falls.
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The lighting in this scene was created using a Round Parallel 
Light.

Square Spotlight

Square Spotlights are the same as spotlights, 
except they cast light along a pyramid-shaped path, 
creating a square spot where the light falls.

The lighting in this scene was created using a Square Spotlight.

Parallel Light

Parallel Lights cast parallel rays, resulting in no 
spatial distortion of shadows. This type of light is 
very useful for creating specific shadow patterns, or 
when used with gels, for creating a slide projector.

The lighting in this scene was created using a Parallel Light.

To create a light source:

1 Make sure the Create palette is visible. If it’s 
not, click the Create button at the top of the 
Bryce window.

2 Click one of the Create light tools:

Creates Radial Lights

Creates Spotlights

Creates Round Parallel 
Lights

Creates Square Spotlights

Creates Parallel Lights
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Lighting Lab

Use the Lighting Lab to set the attributes of your light sources.

You can edit the attributes of a light using the 
Lighting Lab. For example, you can control the 
intensity and sharpness of a light source, and 
change its color and falloff pattern.

To access the Lighting Lab:

1 Select a light. The Object Controls appear next 
to the light’s bounding box.

2 Click the E button. 

Light Preview
The Light Preview area displays the effects of any 
changes you make to the attributes of a light 
source.

This preview can display the light against a neutral 
background or show the light in the scene. You can 
also choose between a faster, low-quality preview, 
and a slower, high-quality preview.

To set the preview options:
• In the Lighting Lab, click the triangle icon at 

the bottom right corner of the preview area, 
and choose a preview option:

Animation Controls
Memory dots

Light Preview

Preview 
Options

Gradient
Preview

Color Swatch
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Render in Scene displays your scene in the 
Preview area. This lets you see how the 
changes you make to the selected light will 
impact your entire scene.

Render Against Neutral displays the light 
against a flat background. This lets you isolate 
the light so you can clearly see subtle changes.

Fast Preview lets you achieve faster updates.

Full Rendering displays a high-quality 
rendered scene or light.

Light Attributes
You can change the intensity of a light source, set 
its color, and adjust a light’s edge softness. When 
your light source is a spotlight, you can also control 
the spread of the light.

To adjust light intensity:

• In the Lighting Lab, drag the Light Intensity 
control.

Drag right to increase light intensity, and left 
to decrease intensity.

To set a light’s color:
1 In the Lighting Lab, enable the Uniform option 

in the Color area.

2 Click the Color swatch, and choose a color 
from the color picker.

By applying a gradient, you can also make a light 
change color as it travels. Refer to “Gradient Lights” 
on page280 for more on gradients.

The Edge Softness attribute lets you set the 
sharpness/softness of the edges of the spot 
projected by a light.

To adjust a light’s edge softness:

• In the Lighting Lab, drag the Edge Softness 
control.

Drag left to sharpen the edges, and right to 
soften the edges.

The spread of the spotlight (also called the Half 
Angle) controls the size of the projected light cone. 
The size of the light’s wireframe determines the 
spread of the light. The bigger the wireframe, the 
larger the spread.

The size of a light’s wireframe controls the light’s spread.

To adjust the spread of a spotlight:
1 Select a spotlight in the Working window.

2 Drag one of its bounding box control points to 
set the wireframe’s size.

Increase the size to increase the spread and 
decrease the size to decrease the spread.

Shadow Ambience and Softness
By default, any light source in Bryce causes objects 
in its way to cast shadows. You can control the 
ambience and softness of a shadow to produce 
realistic-looking shadows or surrealistic effects. 

When you change a shadow’s ambience, you add a 
color to the shadow and adjust the amount of the 
new color in the shadow. When you adjust the 
softness of a shadow, you blur or sharpen the 
shadow’s edges. Soft shadows blend more 
smoothly with the background.

You can disable the shadow casting of a light 
source. This results in a light that illuminates 
surfaces but does not create shadows.
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To change a shadow’s ambience:
1 In the Lighting Lab, ensure the Cast Shadows 

option is enabled. 

2 In the Shadow Ambience area, click the 
Shadow Color swatch, and choose a color from 
the color picker.

3 Drag the Amount control right to increase the 
amount of the new color, or left to decrease 
the amount.

To adjust the softness of a shadow

1 In the Lighting Lab, ensure the Cast Shadows 
option is enabled.

2 Drag the Soft Shadows control right to soften 
the shadow’s edges, or left to sharpen them.

To disable shadow casting for a light source:
• In the Lighting Lab, disable the Cast Shadows 

option.

Light Falloff
Light falloff lets you control the relationship 
between the intensity of a light and the distance 
from the light. In the real world, the farther you are 
from a light source, the less influence it has on the 
illumination of your surroundings. In other words, 
the greater the distance, the weaker the light.

In Bryce there are four falloff types you can apply to 
a light:

• None (No Falloff) causes the intensity of the 
light to stay the same regardless of the 
distance.

• Linear Falloff causes the light’s intensity to fall 
off at a constant rate. When you use this type 
of falloff, the light’s range is rather large. This 
type of falloff is useful for creating outdoor 
lights like searchlights.

• Squared Falloff causes the light’s intensity to 
fall off rapidly. When you use this type of 
falloff, the light’s range is quite limited. This is 
useful for creating indoor lights, like lamps.

• Ranged Falloff causes the light to change 
abruptly from full intensity to zero (no 
illumination) after a distance range you define. 

To set a light’s falloff:
1 In the Lighting Lab, enable one of the 

following options: None, Linear, Squared, or 
Ranged.

To define the range of a light’s ranged falloff:

1 In the Lighting Lab, enable the Ranged option 
in the Falloff area.

2 Drag the Amount control right to define a 
greater range, or left to define a smaller range. 

Gradient Lights
Gradient lights change color as they get further 
away from the light source, thus coloring surfaces 
along the way differently. For example, when you 
apply a red-to-yellow gradient to a light, the 
resulting gradient light colors nearby surfaces red 
and distant surfaces yellow. The mid-range surfaces 
will reflect blends of red and yellow light. This 
feature is useful for creating custom light falloff 
patterns. 

You can create a gradient in Bryce, or you can 
import a gradient created with another application. 
When you create or import a gradient, it is 
automatically applied to the active light.

To create a gradient:
• In the Lighting Lab, enable the Gradient option 

in the Color area. 

To import a gradient:
1  In the Lighting Lab, enable the Gradient 

option in the Color area.

2 Enable the Import option.

3 Locate the drive and folder where the gradient 
file is stored.

4 Double-click the filename.
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Editing Gradients

The Lighting Lab lets you control the range and 
offset of gradients. You can also change a 
gradient’s colors and transparency.

Gradient Range and Offset 
The range of a gradient is the distance in Bryce 
units that the gradient spans. When a gradient light 
is this distance from its source, the gradient’s end 
color is applied to the light (provided you’ve 
accepted the default offset value of zero). 

The offset of a gradient determines how the 
gradient colors will be applied to the light source. 
By default, the offset value is zero, which means 
that the light will start with the start colors of the 
gradient. When you increase the offset, 
intermediary gradient colors will be applied to the 
light at its source. The maximum offset value of 100 
results in a light source which begins with the end 
color of the gradient. 

To change a gradient’s range:

• In the Lighting Lab, click the Range control in 
the Color area, and type a value in the field.

To change a gradient’s offset:
• In the Lighting Lab, click the Offset control in 

the Color area, and type a value in the field.

You can also change a gradient’s offset by dragging 
the Offset button next to the Gradient preview.

Using the Edit Gradient Dialog
The Edit Gradient dialog lets you edit gradients 
added to lights. You can change a gradient’s colors 
and transition points, add colors to a gradient, or 
remove unwanted colors. You can also change the 
transparency of a gradient to create various light 
patterns.

The Gradient Preview is automatically updated as 
you edit a gradient.

You can modify a gradient light using the controls in the Edit 
Gradient dialog.

To modify a gradient’s colors:
1 In the Lighting Lab, click the Edit button. The 

Edit Gradient dialog appears.

2 In the Adjust area, enable the Color option.

3 Click a color node below the Gradient Control. 
A black arrow displays below the node 
indicating that the color node is selected.

4 Click the Color swatch, and choose a color 
from the color picker.

5 Repeat steps 3 and 4 to modify other colors in 
the gradient.

A transition point is an imaginary line between two 
colors in a gradient. Changing the transition point 
lets you change the ratio between the two colors 
and produce color blends dominated by one of the 
two colors. 

To change a transition point in a gradient:
1 In the Lighting Lab, click the Edit button. 

2 In the Adjust area, enable the Color option.

3 Drag a transition node left to make the end 
color dominant, or right to make the start 
color dominant.

You can also change the transition point by typing 
values in the Location field.

Color 
node

Transition 
node

Gradient 
Control
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To add colors to a gradient:
1 Click the Add (+) button next to the Gradient 

control. A new color node appears below the 
center of the Gradient control. 

2 Click the Color swatch, and choose a color 
from the color picker. 

3 Drag the color node left or right to position it. 

4 Repeat steps 1 to 3 to add other colors.

When you no longer need a color, you can remove it 
by selecting the corresponding color node below the 
Gradient box and clicking the Delete (-) button.

By default, all gradients created in Bryce are fully 
opaque. You can change the transparency of a 
gradient to create light sources that fade in or out. 
You can also create complex transparency patterns 
by adding transparency nodes with various opacity 
values.

To change the transparency of a gradient:
1 In the Lighting Lab, click the Edit button. 

2 In the Adjust area, enable the Transparency 
option.

3 Click a transparency node below the 
Transparency control. A triangle appears 
below the transparency mode indicating that 
the mode is selected.

4 Type a value in the Opacity field.

If you want to adjust the transparency 
between two transparency nodes in a gradient, 
drag the transition node above the 
Transparency control to the left or right.

You can also use the above procedure to change the 
transparency of imported gradients. 

To add transparency nodes:
1 In the Lighting Lab, click the Edit button. 

2 In the Adjust area, enable the Transparency 
option.

3 Click the Add (+) button next to the 
Transparency box. A new transparency node 
appears below the center of the Transparency 
control.

4 Type a value in the Opacity field.

5 Drag the new transparency node to where you 
want to change the transparency.

To remove an unwanted transparency change, select 
the corresponding transparency node and click the 
Delete (-) button.

Creating Visible Lights
Visible lights make your light source visible in the 
scene, like the ball of light that appears around a 
lamppost on a foggy night.

There are two types of visible lights:

• Surface Visible Lights

• Volume Visible Lights

When you create a surface visible light, the light 
from the object appears as a semitransparent shape 
extending from the light source.

Surface Visible lights have the same attributes as 
non-visible lights, so you can use the Edge Softness 
control to make the shape that extends from the 
light fuzzier at the edges, to give it a more realistic 
feel, or the Falloff options to adjust the range of 
the light.

The properties within the light are controlled by 
the default Surface Material applied to the light 
object. The material can be edited in the Materials 
Lab. By changing the material, you can change the 
color of the light, the intensity of the light’s color, 
and many other properties.
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When you create a surface visible light source, it appears as a 
semitransparent object in the scene.

When you create a Volume Visible light source, a 
preset Light-sensitive Volume Material is applied to 
the light source. This makes the light coming from 
the light source appear visible in the scene, so in 
the case of a spotlight, the light would appear as a 
cone. The light also becomes volumetric and reacts 
to other lights around it. Objects within the cone 
interact with the light. They can block it, reflect it, 
etc. Any textures applied to the light also have 
volume.

The material applied to the object is pre-defined for 
you, but you can edit its properties in the Materials 
Lab. By editing the material you can change the 
light’s intensity, color and transparency.

When you create a volume visible light source, the light 
emanating from the light source is visible in the scene. This light 
has volume and interacts with the objects inside it.

The real difference between the two types of lights 
becomes apparent when you apply a gel to the 
light. In Surface Visible lights, the gel texture is 
wrapped around the light cone like a skin. Making 
it semitransparent makes it look more real, but it 
doesn’t make it interact fully with objects inside 
the cone.

On the other hand, volume visible lights create a 
real illuminated volume. The texture gel exists 
everywhere inside the cone, and the objects within 
the cone are directly affected by the texture. The 
light also interacts with the surrounding light 
sources.

In this example, the same objects were first illuminated by a 
surface visible light...

...and then a volume visible light.

It’s a good idea to choose to apply the Infinite Light 
option to both types of visible lights, as this option 
extends the light’s range. This gives the light a more 
realistic look. 

To create a surface visible light:

1 Create a light source.



Creating and Editing Lights284

2 Select the light in the Working window.

3 Click the E button that appears next to the 
light’s bounding box. The Lighting Lab 
appears.

4 In the Render options area, enable the Visible 
object and Surface options. A number of 
preset Surface material properties are applied 
to the light, creating a visible cone of light.

If you want to extend the light’s range, enable 
the Infinite option.

To create a volume visible light:
1 Create a light source.

2 Select the light in the Working window.

3 Click the E button that appears next to the 
light’s bounding box. The Lighting Lab 
appears.

4 In the Render options area, enable the Visible 
object and Volume options. A number of 
default Volume material settings are applied 
to the light source, creating a softer visible 
cone of light.

If you want to extend the light’s range, enable 
the Infinite option.

Editing Visible Light Materials
The materials applied to a visible light control 
many of its properties. Although these materials 
can be edited, just like any other object’s material, 
you should keep in mind that when you’re editing a 
light’s material in the Materials Lab, you’re 
changing how the light source will appear in the 
scene. 

Any texture components you apply to the light’s 
material will appear as gels.

For Surface Visible lights, the light’s material is a 
Surface material. For a Volume Visible light the 
material is a Volume Material.

Refer to “Surface Material Channels” on page133 
for more on editing Surface materials, and “Volume 
Material Channels” on page142 for more on 
editing Volume materials.

Applying Gels
Gels are filters placed directly in front of lights to 
change the colors cast by the light, or to cast 
specific kinds of shadows. 

In Bryce, you can use any image or procedural 
texture as a gel. Once you’ve assigned a gel to a 
light source, you’ll be able to see the pattern of the 
gel on any object it shines on. For example, if you 
apply an image to a Square Spotlight, you can 
create a slide projector. You can apply an unusual 
texture across your entire scene by assigning a 
Texture gel to a Radial Light. 

This lighting effect was created using a gel.

When you apply a gel to a visible light, the texture’s 
pattern is visible throughout the visible light.

To use an image as a gel:

1 In the Lighting Lab, enable the Use Gel option.

2 Click the Image button. The Picture dialog 
appears.

3 Choose an image from the preset library, or 
click the Load button and load an image.

Refer to “Working with Pictures” on page83 
for more on the Picture dialog.
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4 Click the check mark. The picture is applied as 
a gel.

To use a texture as a gel:

1 In the Lighting Lab, enable the Use Gel option.

2 Click the Procedural button.

3 The Preset Materials Library appears.

4 Select a material from one of the categories 
available. 

Refer to “Using the Materials Presets Library” 
on page164 for more on the Preset Materials 
Library.

5 Click the check mark. The texture in the 
material is applied as a gel.

To use a texture as a Gel, you must select a 
preset that contains a texture. Preset materials 
that contain only color or optic information 
(such as many found in the Simple & Fast 
category) will have no effect.

If you selected a color other than white in the Light-
ing Lab, that color overrides colors from Texture 
gels. However, the luminance patterns are still used.

Saving Light Settings
You can save up to five light settings using Memory 
dots. This feature lets you experiment safely with 
various light attributes without losing your favorite 
light effects.
 

You can use Memory dots to save light settings. 

You can switch between different saved light 
settings to compare them. Also, you can reset the 
light settings to default at any time. When you no 
longer need a configuration of light settings, you 
can delete it. 

To save light settings to a memory dot: 
• Click an empty memory dot. Empty dots 

appear grey. Full dots appear blue.

To switch between saved light settings:
• Click a full (blue) dot. Active dots appear blue 

with a white dot in the middle.

To reset light settings to default:

• Click the default memory dot. The default 
memory dot stands apart from the rest.

To delete saved light settings:
• Option/Alt-click a full dot. The dot turns gray.

Positioning Lights
Light wireframes can be edited exactly like any 
other object, either directly in the scene using its 
bounding box, or indirectly using the tools in the 
Edit palette. 

Refer to “Positioning Objects” on page214 for 
more on positioning objects.

Linking and Tracking with Lights
Since lights act just like other objects, you can link 
them to other objects, or have them track other 
objects in the scene. 

In an animation, lights that track an object can 
create some very complex lighting effects. 

Refer to “Linking Objects” on page223 for more on 
linking, and “Tracking Objects” on page344 for 
more on tracking.

Animating Lights
You can animate lights by using the animation 
controls in the Lighting Lab. For example, you can 
animate a light’s edge softness and intensity.

Refer to “Animating” on page319 for more on 
animation controls.

Saved Light 

Default 
Light 
Settings
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You can think of the view of your scene as a 
window to a whole new world. The view you see 
through this virtual window is determined by the 
orientation and position of a camera. As you move 
the camera, you get a different view of your world.
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The View of Your Scene
The view of your scene refers to the portion of the 
scene visible in the Working window. There are 
eight views of your scene available in Bryce: the 
Camera View, which is the view produced by the 
Camera in the scene; the Director’s View, which 
shows your scene from the perspective of a director 
sitting outside of the scene; and the orthogonal 
views (Top, Bottom, Left, Right, Back and Front) 
which are perspective-free views of your scene. 

Camera View
Camera View is produced by the Camera in 3D 
space, meaning that you can view your scene from 
anywhere within your Bryce environment—even 
from underneath it. The Camera View can be 
positioned using the positioning tools or by 
repositioning the Camera in the scene.

The Camera has a wireframe, which can be dragged 
in the Working window and its motions recorded 
as an animation. However, the wireframe is visible 
only in the Director’s View or one of the orthogonal 
views.

Director’s View
The Director’s View gives you the freedom to look 
at your scene from any perspective, while still 
being able to manipulate the Camera as an object. 

The Director’s View motions are not recorded as 
part of an animation. This means that you can 
move to any position without inadvertently 
changing the view of your scene in the animation. 
The Director’s View can also be an invaluable tool 
for animating the view of your scene. While in this 
view, you can select the Camera and reposition it 
anywhere in the scene to create camera motions.

Director’s View is the default view of thescene. 

This is what your scene looks like when you view it in Director’s 
View.

Orthogonal Views
These six views let you see the scene from all sides. 
They do not show you any perspective, but you can 
see all the objects in the scene, including the 
camera. 

These views are only flat projections of the scene, 
so you can’t move around them using the camera 
controls. 

Setting Up the View of Your 
Scene
There are eight different views of your scene 
available in Bryce: Camera View, Director’s View, 
and the six orthogonal views. The Camera View and 
Director’s View let you see the scene from any 
perspective, while the orthogonal views let you see 
projections of the scene from the top, bottom, left, 
right, front and back.

To choose a view:
• Click the triangle icon next to the View 

Control icon and choose a view from the 
menu.
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Camera View
This view of your scene in the Working window is 
seen through the lens of the Camera object in your 
scene.

Since your scene exists in 3D, you can view it from 
any vantage point: above, below, or even from 
inside an object. To see from these different 
perspectives, you change the position of the 
Camera. The positioning tools available in the 
Control palette let you position the Camera along 
specific axes and change its orientation. 

As you create and position the objects in your 
scene, you can use the position and orientation of 
the camera (called Camera Space) as a reference for 
several transformation operations. You can rotate, 
position and resize objects using Camera Space. 
Refer to “Camera Space” on page203 for more 
information.

When you’ve completed your scene, the Camera 
View can be used to create the final rendered image 
or animation. You can reposition the camera and 
render the scene from several different viewpoints. 

The camera can also be animated just like any other 
object. You can record changes in its position at 
different points along the timeline. When you run 
the animation, the view from your camera appears 
to change like the view seen from an airplane as it 
flies through a landscape. Refer to “Animating the 
Camera” on page346 for more on animating the 
camera.

When you’re in Camera View, a small camera icon 
appears in the View control.

The camera icon in the View control indicates that you’re in 
Camera View.

To switch to Camera View:
• Click the triangle icon next to the View 

Control icon and choose Camera View from 
the menu.

or 

• Click and drag over the View Control until the 
Camera icon appears.

Setting Camera Object Properties

Since the Camera acts as an object, there are 
several object properties you can use to set how it’s 
displayed, linked, or animated. Refer to “Editing 
Link Attributes” on page235 for more on linking 
properties and “Editing Animation Attributes” on 
page236 for more on Animation properties.

You can hide the camera wireframe to get a better 
view of objects in your scene. When you want to 
change the camera properties, you can display the 
hidden camera wireframe. Also, you can lock the 
position of the camera.

To hide the camera wireframe:
1 Switch to Director’s View or an orthogonal 

view so you can see the camera’s wireframe.

2 Select the camera in the Working window.

3 Click the A icon that appears next to it. The 
Camera & 2D Projection dialog appears. 

4 Enable the Invisible option.

To display the hidden camera wireframe:

1 Click the Time\Selection Palette toggle at the 
bottom-right corner of the Working window 
to display the Selection palette.

2 Click the triangle icon on the Selection palette, 
and choose Select camera.

To lock the camera position:

1 Switch to Director’s View or an orthogonal 
view so you can see the camera’s wireframe.

2 Select the camera in the Working window.
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3 Click the A icon that appears next to its 
bounding box. The Camera & 2D Projection 
dialog appears. 

4 Enable the Locked option.

Director’s View
Director’s View lets you view your Bryce 
environment through the eyes of a director sitting 
outside the scene and directing the action of all the 
objects—including the camera. The camera that 
generates the Director’s View cannot be seen or 
positioned like an object. You have to use the 
positioning controls to move this view. Unlike the 
Camera View, the motion of this view cannot 
recorded as part of an animation.

When you’re working on a still image, you can use 
Director’s View to get a second perspective on your 
scene. You can also render the Director’s View of 
your image.

In a still image, you can use both the Director’s View and the 
Camera View to get different perspectives of your scene.

The real power of the Director’s View becomes 
obvious when you’re working on camera 
animations. Animating camera motions while in 
Camera View can be tricky. However, in Director’s 
View you can see the camera as an object, which 
means that you can set up camera motion just as 
you would any other object.

To switch to Director’s View:
• Click the triangle icon next to the View 

Control icon and choose Director’s View from 
the menu.

Swapping Director’s View for Camera View

The Director’s View and the Camera View are 
interchangeable. So you can move the Camera View 
to the position of the Director’s View, or vice versa. 

Even though you can’t directly position the camera 
that produces the Director’s View in the Working 
window, you can set up a Director’s camera position 
by dragging the Camera to a position in the scene 
and then swapping the Camera position with the 
Director’s View position.

To swap the Director’s View position for the 
Camera View position:

• Click the triangle icon next to the Camera Axes 
controls and choose either Camera to Director 
or Director to Camera from the menu.

Orthogonal Views
There are six other views available through the 
View controls, but these views are not generated by 
any camera. The views (Top, Bottom, Left, Right, 
Back and Front) are perspective-free views of your 
scene called orthogonal projections. When you’re 
using one of these views, you cannot use the 
Camera controls. 

Refer to “Orthogonality and Views” on page21 
more on orthogonal views. 

Camera View

Director’s View
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The orthogonal views are another way of seeing the 
camera as an object in the scene. This can be 
invaluable when you’re animating the camera, or 
setting up a complex scene.

Using the orthogonal views, you can quickly move to different 
views of your scene. These views also let you see the camera as 
an object.

Positioning the View of Your 
Scene
When you position a view, you’re affecting the 
location and orientation of a camera, not the scene 
itself. The scale and position of objects remains 
constant; only your view of the scene changes. 

The controls described in this section can be used 
to position either the Camera View or the 
Director’s View. However, some controls, like the 
Trackball, are limited when you’re in Camera View.

Bryce has two sets of controls for positioning your 
view of the scene: the Trackball and the Camera 
controls.

The Trackball lets you adjust the position of the 
camera, as well as its orientation. 

Use the Trackball to adjust the camera’s position.

The Camera controls change the position of the 
camera along the X, Y, and Z axes.

The Camera controls let you adjust the position of the camera 
along the X, Y and Z axes.

Camera Modes
The cameras in Bryce have four modes that affect 
the behavior of the Trackball. Three of the modes 
are available only when you’re in Director’s View. 
The only mode available in Camera View is Free 
Camera.

Trackball Mode

In this mode the camera orbits around your scene. 
The center of the orbit, or origin, is the center 
point of a box that encompasses all the objects in 
your scene.

Y-Z Control

X-Z Control

X-Y Control
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In Trackball mode the camera orbits around the center point of 
a box that surrounds all the objects in your scene.

When the size of your scene changes, so does the center of 
rotation of the camera.

As the size of your scene changes, so does the size 
of the box, which changes the box’s center point. 
As a result, the center of rotation for the camera 
also changes as you change the size of your scene. 
In fact, in this mode the camera’s center of rotation 
is constantly updated, so that it always remains in 
the center of the scene.

Center to Selection Mode

In this mode the camera also orbits around the 
scene. The center of the orbit, in this mode, is a 
selected object. As the object moves, so does the 

camera’s center of rotation. This mode is the best 
way of making sure that specific objects always 
remain in view.

Tripod Mode 

In this mode the center of rotation is fixed at the 
center of the camera, so it actually pivots in place. 
As the name suggests, the camera acts as though 
it’s on a tripod. It can rotate around, or tilt up and 
down, but it always remains in place.

Use the Tripod mode in conjunction with the Eye 
Level Camera command to get a sense of height. 
Refer to “Camera Axes Control Options” on page294 
for more on this command. 

Free Camera Mode

In this mode the camera is completely 
unconstrained. Its center of rotation can exist 
anywhere, from its center to a point somewhere in 
the scene. Since the placement of the camera’s 
center of rotation is not limited, this mode can 
simulate any of the other modes. For example, if 
you place the camera’s origin point in its center, it 
acts as though it’s on atripod. 

In Free mode the camera can move to any point and can rotate 
around its center or any other point in the scene.

Refer to “Manually Positioning the Camera” on 
page297 for more on positioning the camera’s ori-
gin point.
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To choose a camera mode:
1 Double-click either the Trackball or one of the 

Camera controls. The Camera & 2D Projection 
dialog appears.

2 Make sure the General tab is visible.

3 Click one of the mode buttons at the top of 
the dialog.

You can also switch between modes by clicking the 
triangle icon next to the Trackball and choosing a 
mode from the menu.

Using the Trackball
The Trackball lets you rotate the camera around its 
origin point. The position of the origin depends on 
the Camera mode you select. Refer to “Camera 
Modes” on page291 for more on these modes.

The Trackball doesn’t rotate the scene, it only 
changes the camera’s location (Offset) and 
orientation (Rotation) relative to your scene.

To move the camera using the Camera 
Trackball:

• Drag the mouse over the Camera Trackball 
control. The view of your scene moves in the 
direction youdrag.

Using the Camera Axes Controls
Camera Axes controls let you move the view of your 
scene along specific axes. When you’re using these 
controls, the view does not tilt or rotate from its 
original position. It only moves up, down, back or 
forward.

The Camera Axes controls affect your camera’s 
location (Offset) only, not its orientation (Rotation).

Camera Axes controls are not available if you are in 
any Orthogonal View. When unavailable, these con-
trols turn dark grey. If you are in an Orthogonal 
View, you must use the Zoom and Pan tools for navi-

gation. Refer to “Orthogonality and Views ” on 
page21 for more on these views.

There are three Camera Axes controls available:

X-Y Camera Control

The X-Y Camera control provides control for 
horizontal and vertical motion. The sphere at the 
center of the camera control lets you move the 
camera along both the X and Y axes. The arrows let 
you constrain movement either horizontally or 
vertically. 

X-Z Camera Control

The X-Z Camera control provides control for 
horizontal and depth motion. The sphere at the 
center of the camera control lets you move the 
camera in both the X and Z axes. 

Y-Z Camera Control

The Y-Z Camera control provides control for 
vertical and depth motion. The sphere at the center 
of the camera control lets you move the camera in 
both the Y and Z axis. 

Use these controls to move the camera along the Y axis.
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Use these controls to move the camera along the X axis

Use these controls to move the camera along the Z axis.

To move the camera along two axes at once:
• Drag the sphere at the center of one of the 

Camera controls. The cursor becomes a four-
way arrow.

The motion of your mouse determines the 
direction of the camera movement:

X-Y Camera control:  moving up, down, left 
and to the right, moves the camera up, down, 
left and right.

X-Z Camera control: moving up, down, left 
and right moves the camera backward, 
forward, left, and right.

Y-Z Camera control: moving up, down, left 
and right, moves the camera up, down, 
forward, and backward.

To move the camera along a single axis:
• Drag along the tip of an arrow. 

When you move the cursor over an arrow 
point, it changes to a letter to identify the axis 
of constraint.

Camera Axes Control Options

The Camera Axes controls have options that let you 
move the camera to create specific views.

To choose a Camera Axes control option:
• Click the triangle icon next to the Camera Axes 

controls and choose an option from the menu:

Center Scene rotates the camera so that all 
items in your scene are centered in the 
Working window. This option affects only the 
camera’s rotation, not its offset. If you can’t 
see all the objects in your scene after using this 
option, try pulling your camera back a bit with 
one of the Z controls.

Center Selection rotates your camera so that 
any selected object or objects will be centered 
in your view. This option does not reposition 
the object itself, only the camera’s rotation 
relative to the selected object.

Eye Level Camera repositions the camera to 
just above ground level. Use this command 
(especially in conjunction with the Trackball’s 
Tripod mode) to create the feeling of large, 
looming mountains or other objects. This is 
also effective in concert with the Field of View 
control.

Choose Camera to Director or Director to 
Camera to select either the Director or Camera 
View.

Edit Current Camera brings up a dialog that 
allows you to enter current camera 
information. Refer to “Positioning the Camera 
Numerically” on page296 for more 
information.
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Banking Controls
The Banking control sphere tilts your Camera 
(actually rotating the camera on the Z axis), 
creating the effect of a tilted horizon. This control 
is great for creating tilted airplane cockpit views. 
Banking simulates a Roll action.

This scene was created by banking the camera.

To bank the camera: 
• Drag the Banking control, which is located to 

the top left of the Camera Trackball. Drag 
right to bank to the right and left to bank to 
the left.

Press Option/Alt-click in this control to reset to 
normal. The normal (default) setting is zero.

Field of View
The Field of View control sphere acts like a zoom 
lens control. The higher the setting, the wider the 
field of view for your lens.

Because you are admitting more information into 
your lens, it will create the illusion that objects are 
receding from view, or getting smaller. That is not 
the case. Since you’re admitting more information, 
existing objects necessarily occupy a smaller 
percentage of space within your field of view.

This scene was created by increasing the camera’s field of view.

If you drag the Camera Z control to bring your 
“receding” objects back up to a larger area in your 
view, perspective distortion effects appear. This is 
particularly effective for creating broad, swooping 
cloud scenes.

When you view the camera in Director’s View or 
one of the orthogonal views, you’ll be able to see 
the camera’s Field of View displayed as a 3D 
pyramid that extends from the camera wireframe. 

The large triangle that extends from the camera’s wireframe 
represents its field of view. As the field of view changes, so does 
the shape of the triangle.

To display the camera’s field of view:
1 Switch to Director’s View or an orthogonal 

view so you can see the camera’s wireframe.

2 Select the camera in the Working window.
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3 Click the A icon that appears next to the 
camera object. The Camera & 2D Projection 
dialog appears. 

4 Enable the Show FOV option.

To increase/decrease the camera’s field of 
view: 
• Drag the Field of View control. Drag right to 

increase the field of view and left to decrease 
it.

Option/Alt-click on this control to reset to 
normal. The normal, or default, setting is 60°.

Positioning the Camera Numerically
The most precise way of positioning the view of 
your scene is by using the Camera & 2D Projection 
dialog. This dialog lets you enter values to set the 
camera position, the position of the camera’s origin 
point, rotation, and field of view. The dialog can be 
used to adjust either the Camera View or the 
Director’s View. 

When you display the dialog, you can see the 
numerical position of the camera and the position 
of its origin point. You can also see the active 
Camera Mode.

The Camera & 2D Projection dialog lets you view and set the 
attributes of the current camera.

There are different options available in the dialog 
depending on whether you’re in Camera View or 
Director’s View. When you’re in Camera View, the 
only Camera Mode available is Free Camera. As 
well, the Origin fields are only available if you’re 
using Free Mode.

Since the camera is an object, there are several 
more controls available when you’re in Camera 
View. These controls let you set linking and 
animation options. Refer to “Camera Modes” on 
page291 for more.

To position the camera’s origin point 
numerically:
1 Double-click either the Trackball or one of the 

Camera controls. The Camera & 2D Projection 
dialog appears.

2 With the Camera View active, make sure the 
General tab is visible.

3 Click the Free Mode button.

4 Enter values in the Origin X, Y, and Z fields.

To set the position of the camera numerically:
1 Double-click either the Trackball or one of the 

Camera controls. The Camera & 2D Projection 
dialog appears.

2 With the Camera View active, make sure the 
General tab is visible.

3 Enter values in the Position X, Y, and Z fields.

You can enter negative values here. 
Technically, since the Bryce environment is 
infinite, the range is infinite as well, but higher 
values can create unpredictable results. The 
default values are 102.40, 30.72, and 102.40, 
respectively.

To rotate the camera numerically:
1 Double-click either the Trackball or one of the 

Camera controls. The Camera & 2D Projection 
dialog appears.
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2 With the Camera View active, make sure the 
General tab is visible.

3 Enter values in the Rotate X, Y and Z fields. 
Values are expressed in degrees. 

X, Y, and Z rotations are also known as Yaw, 
Pitch and Roll. The Z rotation, or Rollfield, 
displays the current value for the Banking 
control.

You can enter negative values in these fields. The 
effective range is +/- 999. Default values are 0, 135, 
and 0°, respectively.

To set the Field of View numerically:

1 Double-click either the Trackball or one of the 
Camera controls. The Camera & 2D Projection 
dialog appears.

2 With the Camera View active, make sure the 
General tab is visible.

3 Enter a value in the Field of View field (FOV).

The value in this field, expressed in degrees, 
describes current settings for the Field of View 
control. The effective range is 1 to 180°, and 
the default value is 60°.

Manually Positioning the Camera
You can manually position the camera by adjusting 
the position of the camera wireframe in the 
Working window. The camera wireframe is visible 
only when you’re in Director’s View or one of the 
orthogonal views.

In the Director’s View, or an orthogonal view, you 
will see a blue Camera wireframe, which represents 
the location of your Camera. You can then drag the 
Camera wireframe to change the Camera position. 
The Nano-Preview updates to reflect your changes. 

The camera indicator appears only in the orthogonal views and 
the Director’s View. Drag the indicator to adjust the camera’s 
position. 

Camera Origin Point

In its default state, the Camera’s origin point is not 
visible and is located at its center. 

When the Camera’s origin point is visible, it 
appears as a green dot in the center of the camera’s 
wireframe. 

The green dot in the center of the camera wireframe represents 
its origin point.

You can simulate any of the camera modes by 
dragging the camera’s origin point to different 
locations in the scene:
• If you position the origin point in the center of 

the scene, the camera acts as though it’s in 
Trackball mode. When you rotate the camera, 
it moves around the origin point. 

• If you position the origin point over an object 
in the scene, it acts as though it’s in Center to 
Selection mode. When you rotate the camera 
object, it will pivot around the object under 
the origin point.

Origin Point
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• If you leave the origin point positioned at the 
center of the camera object, it acts as though 
it’s in Tripod mode. 

Once you offset the origin point, all the camera’s 
movements will be altered. If you, then, switch to 
Camera View, the camera may not move as 
expected.

To position the camera manually:
1 Switch to Director’s View or an orthogonal 

view.

2 Drag the camera wireframe to a location in the 
scene.

or 

• Click the camera wireframe and use the tools 
in the Edit palette to move, or rotate it.

To display the camera’s origin point:
1 Switch to one of the orthogonal views or 

Director’s View.

2 Click the camera wireframe.

3 Click the A icon that appears next to the 
camera’s wireframe. The Camera & 2D 
Projection dialog appears.

4 Click the General tab and enable the Show 
Origin Handle option.

To position the camera’s origin point 
manually:

1 In the Camera & 2D Projection dialog, display 
the camera’s origin point. 

2 Drag the green point to a location in the 
scene. 

Hold down Shift and click the origin point to reset it 
to the center of the camera object.

Aiming the Camera
The only problem with positioning the Camera 
using the Orthogonal or Director’s View is that the 
view from the Camera remains fixed as you adjust 

its location, so you may inadvertently lose the 
objects you were looking at when the position of 
the Camera changes. 

For example, at the beginning of this animation the Camera is 
pointing at the object in the center of the scene. The view from 
the Camera shows all the main objects in the scene.

When you move the Camera, it’s still pointing in the same 
direction but from its new position, only one of the objects in the 
scene is visible.

To solve this problem, Bryce lets you adjust the aim 
of the camera as you adjust its position. 
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When you look at the Camera as an object, you’ll 
see that there is a control handle extending from 
the front of the object. This handle represents the 
Camera’s current aim. By dragging this handle to a 
point in your scene, you can change the Camera’s 
aim.

The handle that extends from the front of the Camera lets you 
aim the camera.

When you change the aim of the Camera, it rotates 
to face the new target, but remains in the same 
position. 

To change the Camera’s aim in an orthogonal 
view:
1 In the Working window, click the triangle icon 

next to the View Control and choose top, left, 
right, bottom, front or back from the menu.

2 Drag the end of the control handle to the 
point in you scene where you want the camera 
to aim. 

As you drag, the end of the handle changes to 
a red dot so you can see the aiming point 
better.

As you drag the end of the camera’s control handle, it changes 
to a dot. The dot represents the point where the camera will 
aim. 

Saving Camera Positions
You can save your favorite camera positions using 
the Memory dots. The dots let you store up to 
seven different views of your scene.

Memory dots let you save views of your scene for later use.

The uppermost dot, slightly separated from the 
rest, is a quick way to return to the default Bryce 
camera position. There is no way to clear this dot. 
It will always contain the default Camera settings.

Dot settings are saved with your scene file, so if you 
open a previously saved scene, your dot settings 
from the previous session remain in place.

When you click on a full dot to activate it, the saved 
position becomes the current Camera View. When 
you no longer need a saved camera position, you 
can delete it by clearing the dot it is saved to. 

To save a camera position to a memory dot:
• Click an empty dot. Empty dots appear gray. 

Full dots appear blue.

To return to the default camera position: 
• Click the top memory dot.

The view returns to the default, regardless of 
how many changes you’ve made.

To switch between saved positions:

• Click a full (blue) dot.

Active dots appear blue with a white dot in the 
middle.

To clear a full dot:
• Option/Alt-click a full dot. The dot turns gray.

Default position

Saved positions
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Rendering

Rendering is the process of capturing a view of 
your 3D scene and displaying it as a 2D image. 
Once you’ve rendered the image, it can be used in 
other image editing or page-layout applications.

Rendering in Bryce uses multiple passes to 
generate the final rendered image. On the first 
pass, the image is rendered in large pixel blocks, 
and then, in successive passes is refined to 
produce finer detail. The final pass of the 
rendering is an anti-aliasing pass. 

Using this method you can see how the final 
image will look. Things like colors and light/object 
placement are very easy to see even during the 
first pass or two.
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Bryce renders images using multiple passes. On the first pass 
object placement and color are easily visible...

...on successive passes, the image becomes more refined.

Rendering an image requires a great deal of 
computation. Scenes with multiple terrains (at 
512x512 each or more) can generate hundreds of 
thousands of height points. This can yield millions 
of polygons to hit with rays. Animations with many 
frames can require even more computation to 
render. The more complex the scene or animation, 
the more computational power is required for 
rendering, and the longer rendering can take.

Raytracing
Bryce renders images using a technique known as 
Raytracing. In the case of a photograph, any given 
pixel’s color is the result of light coming from a 
scene, through a lens, and onto the film. Raytracing 
does the inverse. Virtual rays of light are shot from 

the virtual “film” through a mathematical “camera” 
and out into a 3D scene. As they pass through the 
scene, these rays collide with objects. The object 
they collide with is assigned a color. For example, if 
it hits a gray object, then that gray color ends up on 
that portion of the “film” or your final image.

Raytracing becomes much more complex when the 
beam strikes an object that has reflective, 
transparent, refractive, or other complex optical 
properties. These properties can cause the ray to be 
traced further into your scene, where it could end 
up bouncing from mirrors, dissipating through fog, 
or bending through a chunk of dense glass. 
Eventually, a final color is determined for each 
pixel. 

This technique can involve staggering amounts of 
computation which might make it impractical or 
impossible to use, but Bryce contains raytracing 
algorithms optimized for the task of creating 
natural and supernatural landscapes of all kinds.

Rendering a Scene
Once you’ve selected the rendering options you 
want to use and chosen a rendering mode, you’re 
ready to start rendering. You render your entire 
image using the Render controls or use the Plop 
Render controls to render areas of your image.

Using the Render controls
The Render controls let you start and resume a 
rendering of your image. There are controls for 
enabling two types of fast renders.
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Use the Render controls to control the rendering of your scene.

To start a rendering of the entire scene:
1 Click the Render All button.

If you have already rendered any portion of 
your scene, it is cleared before the rendering 
begins. 

You can interrupt any rendering by clicking 
the mouse. 

To resume a rendering:
• Click the Resume Render control or press 

Command/Ctrl+R.

To clear a selection and start a rendering:

• Click the Clear and Render control or press 
Command/Ctrl+Option/Alt+R.

This control clears the contents of any 
marqueed region, and starts a render of the 
selected region. Refer to Plop-Render Mode 
below for more on rendering regions. 

Plop-Render Mode
If you’ve begun rendering your image, you can use 
the Plop-Render controls to render specific areas of 
your image. You can use this mode to quickly see 
the results of repositioning and transformation 
operations.

Use Plop-Render mode to render specific areas of your image.

Plop-Render mode is enabled by default, but can be 
turned off using the Display palette.

To enable/disable Plop-Render mode:
• Click the Plop-Render On/Off toggle in the 

Display palette. 

When the small rectangle inside the icon 
(which represents an active Plop-Renderer) is 
red, Plop-Render mode is on. When it is white, 
the mode is off.

To render an area of your scene:
1 Make sure Plop-Render mode is enabled.

2 Begin rendering your scene by clicking the 
Render All button in the Render controls. 

3 Pause rendering by clicking the Render All 
button again.

4 Drag a marquee around an area of your image.

The selection is outlined in a thin white line 
and is separated from the rest of the image by 
a drop shadow. A series of buttons appear 
beside the marqueed selection.

5 Click the top button that appears beside the 
selection.

You can interrupt the rendering by clicking the 
mouse.

Render All

Fast Preview Mode Resume Render

Textures On/Off Clear and Render
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To resume a render:
• Click the second button that appears beside 

the selection.

To scale the selected area to fill the working 
window:
1 Make sure Plop-Render mode is enabled.

2 Begin rendering your scene by clicking the 
Render All button in the render controls. 

3 Pause rendering by clicking the Render All 
button again.

4 Drag a marquee around an area of your image.

The selection is outlined in a thin white line 
and is separated from the rest of the image by 
a drop shadow.

5 Click the triangle icon beside the Render 
controls and choose Zoom to Selection from 
the menu.

The command centers the selected portion of 
your wireframe scene and scales it up to fit 
your window. This is a pan and zoom 
operation, and therefore does not affect your 
camera position. 

Spray Rendering
You can also paint an area of your scene to render 
it. Use spray rendering to preview a specific area of 
your scene. If you render the entire scene after 
doing a spray render of a specific section, that area 
will not be re-rendered.

• Spray rendering controls include five circular 
and five square spray nozzles. While in spray 
rendering mode, use the 1 through 5 keys to 
select the circular spray sizes, and the 6 
through 0 keys to select the square nozzles.

The Spray Rendering tool.

To render using Spray Rendering:
1 Click the Spray Rendering tool on the 

Advanced Display palette. 

2 Use the tool to paint over the area of your 
scene that you want to render. 

3 Adjust the brush size to more easily paint a 
larger or smaller area.

You can also render a portion of your wireframe or 
rendered image to quickly see any modifications 
made to your scene. You can render from 
Wireframe mode or from Render mode. Spray 
rendering from Wireframe mode is a preview 
render that is lost when you press the Escape key.

Spray rendering from Render mode is a true render 
and can be continued by using Resume Render.

To render from Wireframe mode:
1 Click the Spray Rendering tool on the 

Advanced Display palette.

2 Use the tool to paint over the area of your 
scene that you want to render. 

3 Press the Spray Rendering tool again or press 
the Escape key to dismiss this render and 
return to Wireframe mode. This doesn’t 
affecting any previous render.

To render from Render mode:
1 Press the Escape key to switch from Wireframe 

to Render mode.

2 Click the Spray Rendering tool on the 
Advanced Display palette.

3 Use the tool to paint over the area of your 
scene that you want to render. 

4 Click the Spray Rendering tool to put the tool 
away and remain in render mode. Press Escape 
again to return to Wireframe mode yet not 
lose your paint rendered area.

5 If you Resume Render your scene, Bryce 
continues to render the un-rendered portions 
of your scene.
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Setting Up a Render
Bryce offers a number of options and controls that 
let you control rendering. 

As you work on a scene, you can use settings that 
produce fast renders. When you’re ready to 
produce your final image, you can choose settings 
that produce the highest quality image.

Setting Quality Mode Options
These options let you control the quality of the 
rendered image by setting the level of anti-aliasing. 

Anti-aliasing removes the jaggies on the edges of 
objects within the image. In Bryce, anti-aliasing is 
performed using a super-sampling method. This 
means that for every pixel that’s raytraced, more 
than one ray is used to determine the pixel’s color. 
The increase in rays increases the quality of the 
raytraced object.

Anti-aliasing can greatly improve the quality of your 
image, but it is time-consuming. It can also 
eliminate some desired roughness from high-
frequency textures. anti-aliasing is performed on 
the last pass of the rendering process.

An image rendered without anti-aliasing...

...and the same image rendered using anti-aliasing.

There are four quality modes available in Bryce: 
Default, Regular, Super, and Premium.

To set the quality mode:
• Click the triangle icon beside the Render 

controls, point to Quality, and choose a 
quality mode from the menu

or

Click the triangle icon beside the Render 
controls and click Edit Rendering. Click one of 
the quality modes at the top-left corner of the 
dialog.

Default (No anti-aliasing)

In this mode there is no anti-aliasing performed on 
the image.

Regular (Normal anti-aliasing)

In this mode, after the image is rendered, Bryce 
scans the entire bitmap to determine which areas 
require anti-aliasing. Only the areas of high 
concentration are antialiased. 

Super (Fine Art anti-aliasing)

In this mode, you can control the number of rays 
Bryce uses to trace every pixel in the image. Higher 
values produce a higher quality image, but can slow 
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down the entire rendering process. You should 
probably only use this mode to render showcase 
type artwork—not normal working images.

To set the number of rays per pixel 
numerically:
1 Click the triangle icon beside the Render 

controls and click Edit Rendering. 

2 Click the Super quality mode. With the Super 
quality mode selected, the Rays per pixel 
option becomes available. 

3 Click the triangle beside Rays per pixel and 
choose a value from 1 to 256.

Premium (Effect anti-aliasing)

In this mode, you can use a variety of premium 
effects, such as Soft Shadows, Blurry Reflections, 
Blurry Transmissions, True Ambience, and Depth of 
Field. 

Premium effects include: 

• Soft Shadows — Softens the edges of the 
shadows.

• Blurry Reflections — Blurs reflections.

• Blurry Transmissions — Blurs the transmission 
of light, for example, when light passes 
through frosted glass.

• True Ambience — Computes the ambient light 
for a surface using the color and intensity of 
nearby surfaces, resulting in color blending 
from one surface to another. 

• Depth of Field — Lets you focus the camera on 
a particular object, blurring those closer and 
further away from the camera’s focal point. 
You can control the Lens Radius and Focal 
Length numerically, or you can have Bryce 
calculate these values based on a selected 
object.

To turn on premium effects:
1 Click the triangle beside the Render controls.

2 Point to Quality and select the Premium 
quality mode.

3 Click the triangle icon beside the Render 
controls.

4 Point to Quality and select a premium effect.

To turn on premium effects and set effect 
options using the Render Options dialog:
1 Click the triangle beside the Render controls 

and click Edit Rendering.

2 Select the Super quality mode.

3 Select a premium effect.

For the Depth of Field effect, type a value in 
the Lens Radius and Focal Length fields or click 
Set To Current Selection to set the values 
based on the currently selected object.

Document Size and Render Resolution
The menu commands at the end of the Render 
Options menu are quick ways to resize your 
document. Values shown are expressed in pixels, 
and are for customizing the size and aspect of your 
document and the resulting render.

The render resolution options control the 
resolution of your final image. These options do 
not affect the resolution of your working 
document; they affect only the final rendered 
image.

To choose a document size:

• Click the triangle icon beside the Render 
controls and choose a document size from the 
bottom of the menu. 

To choose a render resolution:
• Double-click the Render All control, or choose 

File menu> Document Setup. Click one of the 
render resolutions at the bottom of the dialog. 
The selected resolution appears highlighted. 
Click the OK icon.
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Setting Optimization Options
Bryce 5 includes several new optimization options. 
These options change the mathematical algorithm 
used by Bryce to raytrace your image depending on 
the contents of your scene. There are two types of 
optimization, BSP and Grid, and each has three 
levels of optimization to choose from, Minimal, 
Normal, and Aggressive.

Bryce maintains an internal grid that is comprised 
of 3D cube increments, 2048 x 2048 x 2048 Bryce 
units in size. The grid gives you a common 
reference for all positioning operations within a 
scene. The grid is also used by Bryce when 
rendering. 

Bryce performs a multitude of mathematical 
calculations to raytrace a scene. These 
mathematical calculations use the grid to 
determine the position of objects in relation to 
each other. When you create a scene, depending on 
how objects are distributed in the scene, you may 
want to specify a different mathematical algorithm 
to increase the efficiency of the rendering 
operation. 

Bryce uses two different mathematical algorithms 
for rendering: 
• For Clustered Scenes (BSP) — the BSP 

algorithm is most efficient when rendering 
scenes that include clustered or overlapping 
objects.

• For Uniform Scenes (Grid) — The Grid 
algorithm is most efficient when rendering 
scenes that contain non-overlapping objects 
evenly spaced within the Bryce grid.

Levels of Optimization

There are three levels of optimization to choose 
from for each of the above optimization types:

• Minimal — This mode is best used for very 
simple scenes with less than five objects. In 
this mode, Bryce predetermines the areas 
where your objects reside and shoots rays only 
through that area. 

• Normal — This is the best mode for most 
scenes. In this mode, Bryce determines where 
your objects reside and then examines the 
concentration of objects within the larger 
area. This eliminates the computation of 
unnecessary rays.

• Aggressive — This is a more extreme version 
of Minimal mode. It is best used for complex 
scenes with localized concentrations of 
objects. If you have imported DXF objects in 
your scene, this mode will speed up rendering 
considerably.

To set optimization options:
• Click the triangle icon next to the Render 

controls, point to Optimization, and choose an 
optimization type and level

or

Click the triangle icon next to the Render 
controls, click Edit Rendering, and choose an 
optimization type and level from the Render 
Options dialog.

Setting Post-Processing Options
Bryce includes two post-processing options to 
compensate for the differences between viewing 
images on a computer display and on paper.
• 48 Bit Dithering — helps you work around the 

limitations of computer displays. It is a 
process that allows you to avoid color bands 
by smoothing. Evening skies or moon rings are 
good candidates for this option.

• Gamma Correction — allows Bryce to 
compensate for some of the shortcomings of 
computer displays. Your images will be 
brighter and contain colors that are more true 
to nature.

To set post-processing options:
1 Click the triangle icon next to the Render 

controls and click the desired post-processing 
options
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or

Click the triangle icon next to the Render 
controls, click Edit Rendering, and click the 
desired post-processing options from the 
Render Options dialog.

Render Reporting
This option, when selected, produces a summary 
report when your image is finished rendering. 

The report tells you how long the render took, 
including the anti-aliasing pass. It also provides 
statistics on how many rays were shot to create the 
image and breakdowns for the different types of 
rays, including a per-pixel breakdown. 

To produce a render report:

• Click the triangle icon next to the Render 
controls and choose Render Reporting from 
the menu.

or

Click File menu>Document Setup and choose 
Render Reporting from the menu.

Projection & Masking
Bryce offers several rendering modes that can be 
used to create different effects. For example, the 
Mask Render mode lets you produce an image that 
can be used as an alpha channel in other graphics 
applications.

To choose a projection type and mask mode:

• Click the triangle icon next to the Render 
controls and choose a projection type and 
mask mode from the menu

or

Click the triangle icon next to the Render 
controls, click Edit Rendering, and choose a 
projection type and mask mode from the 
Render Options dialog.

Projection Types

There are two projection types available in Bryce:
• Perspective Projection — renders a fully 

raytraced color image, based on your current 
camera’s position and view.

• 360° Panorama Projection — produces an 
image that looks as if your camera has a 360° 
lens. The left and right edges of the resulting 
image join seamlessly.

360° Panorama Projection is intended for use with 
the Bryce 360° scrolling screensaver, or 
QuickTime™ VR technology. Refer to “QuickTime 
VR” on page361 for a description of Apple 
QuickTime VR.

An example of an image rendered using 360° Panorama 
projection.

Rendered 360° images will have little resemblance to 
the wireframe working window behind it; this makes 
flipping back and forth between wireframe and bit-
map modes during composition fairly difficult. For 
this reason, we recommend working in standard Per-
spective Render mode as you compose your image.

For a good 360° panoramic image, you need a 
natural distribution of objects on all sides of the 
camera. 

To prepare a 360° panoramic render:

1 While in Perspective Render mode, switch to 
the Top view using the View controls and 
position objects around the camera. 

2 Display the Document Setup dialog using File 
menu> Document Setup, and either select the 
Panorama preset aspect ratio, or type in the 
dimensions that you want. 
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3 Do a quick test render in Perspective Render 
mode to check composition.

The horizon should be level at the vertical 
midpoint of your window. If it is not, double-
click the Trackball, enter “0” in the Rotate X 
field and exit the dialog.

4 Adjust your camera position and Y/Z rotation.

5 Switch to 360° Panorama render mode and 
render your image. 

Mask Modes

There are three different kinds of Mask Render 
modes for rendering available in Bryce, Object 
Mask, Distance Mask, and Altitude Mask.

Object Mask
In Object Mask mode, Bryce renders any selected 
objects as antialiased white shapes against a black 
background. You can use the resulting image as a 
mask or alpha channel in other 2D image editing 
programs.

An example of an image rendered as a mask using Object Mask 
mode.

Distance Mask
This mode results in a grayscale image, with 
objects represented in shades of gray based upon 
their distance from the camera. Nearby objects are 
black, distant objects are white, and objects in-
between are progressive shades of gray.

An example of an image rendered using Distance Mask mode.

You can use the Distance Mask image to produce depth-of-field 
effects using a 2D graphics application.

This mode can be used to create several distance 
effects. Refer to “Adding Depth” on page366 for 
more on using Distance Mask images.
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Altitude Mask
This mode results in a grayscale image, with 
objects represented in shades of gray based upon 
their height.

You can use Altitude Mask images in the same way 
you can use Distance Mask images to create special 
effects in other applications.

An example of an image rendered using Altitude Mask mode.

Setting Optics Options
Bryce includes a number of optics options that can 
help increase the realism of a rendered scene.  The 
optics options include:

• Reflections — Lets you choose whether to 
render reflections in a scene. 

• Transmissions — Lets you choose whether to 
render light transmissions in a scene. For 
transparent objects with a light source behind 
them, you must render transmissions for light 
to shine through the objects.

• Refractions — Lets you choose whether to 
render light refractions in a scene. When light 
is bent by an object such as a prism or a glass 
of water, you can see distorted views of the 
environment behind or to the side of the 
object due to the refraction of light. For Bryce 
to render these refractions, you must enable 
this option.

• Shadows — Lets you choose whether to 
render shadows in a scene.

• Maximum Ray Depth — Lets you control the 
depth of rays during rendering. For example, if 
you place a series of transparent objects one in 
front of the other, the Maximum Ray Depth 
setting determines how many of these objects 
the light will pass through.

• Total Internal Reflection (TIR) — Lets you 
control the amount of TIR in a scene. When 
you have reflective objects such as prisms or 
mirrors in a scene, you can encounter 
situations where light rays bounce back and 
forth an infinite number of times within the 
object or between two objects. By limiting the 
TIR depth, you can produce realistic scenes 
that include a certain amount of TIR. This lets 
you avoid creating an infinite number of 
internal reflections, thus speeding up the 
rendering time.

To enable Optics options:
1 Click the triangle icon next to the Render 

controls and click Edit Rendering.

2 Click an optics option to enable or disable it. 
When a checkmark appears beside the option, 
the option is enabled. When there is no 
checkmark, the option is off.

3 Type a value in the Maximum Ray Depth field.

4 If you have enabled the Total Internal 
Reflection (TIR) option, type a value in the 
Maximum TIR Depth field.

Preview Render Modes
Preview Render modes are accessed using the 
Render controls or the Render Options dialog, and 
provide lower quality renders that you can use to 
preview your image. 

Fast Preview

When this mode is enabled, the renderer ignores 
areas of low frequency and only raytraces areas of 
high frequency. This results in accelerated renders 
that are great for previewing during a session. 
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However, it also results in some patchiness in 
certain mid-frequency areas, so it should not be 
used for final output.

To enable Fast Preview mode:
1 Click the Fast Preview button in the Render 

controls. When the button turns blue, the 
mode is enabled. When the button is silver, 
the mode is off.

or

Click the triangle beside the Render controls, 
click Edit Rendering. Select the Preview Render 
option to enable Fast Preview mode, and select 
the Full Render option to disable it.

Textures On/Off

When this mode is enabled, all textural parameters 
are disabled. This mode performs the following 
procedures to speed up a render: 

• Objects with properties like transparency, 
reflection, and bumpy textures are rendered in 
flat opaque shades.

• Fog, Haze and Clouds are disabled.
• Any item with a procedural texture is rendered 

with a color drawn from the ambient color 
channel in the Materials Composer.

• Any item with a simple color texture is 
rendered in that color. 

The Textures On/Off mode is available in any mode. 

To enable Textures On/Off mode:

1 Click the Textures On/Off button in the Render 
controls. When the button turns blue, the 
mode is enabled. When the button is silver, 
the mode is off.

or

2 Click the triangle beside the Render Controls, 
click Edit Rendering, and click Render With 
Textures. When a checkmark appears beside 
the option, the mode is enabled. When there 
is no checkmark, the mode is off.

Rendering Animations
Rendering an animation is a lot like rendering a still 
image. Each frame in the animation is processed 
exactly like a still image. You can use the same 
rendering options you use to render still images.

In addition to the standard still image rendering 
options, there are several options you can set for 
movie files: you can choose a file type, a 
compression option, and a range of frames to 
render. You set movie rendering options using the 
Render Animation dialog.

The Render Animation dialog
The Render Animation dialog contains all the 
options you’ll need to render your scene as a 
movie. In this dialog, you select the range to 
render, the file format for the resulting animation, 
the quality of the animation, the filename and 
location for the animation, and the network 
rendering options. 

Range to Render

When you render an animation, you can render the 
entire animation, a specific range of frames, or only 
the frames within the Working Area of your 
animation’s timeline. Refer to “Setting Up the 
Working Area” on page325 for more on the 
Working Area.

Output Module

The Output Module section of the Render 
Animation dialog lets you choose a format and level 
of compression for the animation.

• On the Macintosh, you can render a scene as a 
QuickTime (MOV) file, or as sequenced frame 
files. 

• On the PC you can render your scene as a 
MOV, AVI file, or as sequenced frame files.
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The Edit button lets you access all the available 
compressors. The items listed in the Video 
Compression dialog depend on the compressors 
you have on your system. Refer to the 
documentation that came with the compressor or 
your system software for instructions on using a 
specific compressor.

File Location

The File Location area of the Render Animation 
dialog lets you specify a destination and a filename 
for the animation.

Render on Network

The Render on Network option lets you render your 
animation on multiple computers connected by a 
TCP/IP network. Refer to “Network Rendering” 
below for more on rendering over a network.

To start the rendering of an animation:

1 Choose File>Render Animation. 

or

Press Alt+Shift+R. The Render Animation 
dialog appears.

2 Choose a Range to Render option or specify a 
start and end frame number for the range.

3 Click the triangle beside Output Module and 
choose a file format for the animation.

4 Click Edit and choose the compression options 
for the animation.

5 In the File Location area, click Set and enter a 
destination and name for the animation.

6 If you want to perform a network render, 
enable the Render on Network option and 
click Configure to set up the network render. 
Refer to “Network Rendering” below for more 
on setting up a network render.

7 Click the OK icon. Bryce starts rendering each 
frame in the animation.

Network Rendering
Rendering complex scenes and animations requires 
a significant amount of computational power. 
Using only one computer, a complex scene or 
animation can take many hours to render. You can 
take a number of steps to decrease the time 
required to render such a scene, such as reducing 
the complexity of the scene, reducing the quality of 
the render, or upgrading the computing power of 
the computer.

The new Network Rendering feature in Bryce 5 lets 
you spread a rendering job over multiple 
computers. This lets you reduce the amount of time 
required to render a complex scene without 
sacrificing the complexity of the scene or the 
quality of the final rendered image or animation.

This is accomplished by breaking a scene into 
smaller sections and sending each section to a 
separate computer to be rendered simultaneously. 
The more computers you have working on 
rendering a particular scene, the less time it takes 
to render the scene.

How network rendering works
To use network rendering, you need two or more 
computers connected by a TCP/IP network. One of 
the machines acts as a server that controls the 
other machines, sending them sections to be 
rendered and reassembling all of the rendered 
sections into the final image or animation. The 
other machines act as client machines, receiving 
and rendering their sections of the image, and then 
sending the rendered section back to the server.

When you render an animation over a network, by 
default, Bryce sends each frame of the animation to 
the client computers.

When you render a single frame over a network 
with the Tile Optimization option turned on, Bryce 
divides the frame into tiles and sends the tiles to 
the client computers.
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The Tile Optimization option divides a frame into tiles, sending 
each tile to a client computer for faster rendering of the frame.

The server is the only computer that needs to have 
Bryce installed; the other computers can have 
either a licensed copy of Bryce installed, or you can 
install Bryce Lightning, an application included 
with Bryce that is specifically designed for network 
rendering. 

To start a network rendering session, you will need 
to know the IP addresses of each of the client 
machines you want to use. When you launch Bryce 
Lightning, it will display that information for you.

The next step is to open a scene on the server and 
select the network rendering option. You will then 
need to configure the server by giving it the IP 
addresses of the client computers you will be using 
for rendering the scene.

Prepapring for network rendering

To install Bryce® Lightning on a Windows 
client:

1 Insert the Bryce CD-ROM into the CD-ROM 
drive on the client computer. 

2 Click Start on the Windows taskbar, and click 
Run. Type X:\Bryce Lightning\setup where X is 
the letter that corresponds to the CD-ROM 
drive.

3 Follow the instructions on your screen.

To install Bryce Lightning on a Macintosh 
client:
1 Insert the Bryce CD-ROM into the CD-ROM 

drive on the client computer.

2 Navigate to the Bryce Lightning folder on the 
CD-ROM.

3 Double-click the Bryce Lightning installer to 
start the installation.

4 Follow the instructions on your screen.

To uninstall Bryce Lightning:
1 Drag the Bryce Lightning folder to the Trash/

Recycle Bin.

To determine the IP address of a client 
computer using Bryce Lightning:

• Launch Bryce Lightning on the client 
computer. 

Bryce Lightning displays a dialog listing the IP 
address of the client computer it is running on.

To configure the server computer for network 
rendering:
1 Launch Bryce Lightning on the client 

computers you plan on using for the network 
render.

2 Launch Bryce on the server computer.

3 Open the scene you want to render.

4 Click File>Render Animation.

5 Click Render on Network.

6 Click Configure.

The Network Render Settings dialog opens. 
You can use the Network Render Settings 
dialog to add and remove computers from the 

Server

Client

ClientClient

Client
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list of available clients, assign a name to the 
rendering job, and choose settings.

7 In the Render Job field, type a name for the 
rendering job.

8 In the Client IP Address field, type the IP 
address of a client computer and click Add.

Newly added client computers in the Client 
List are selected by default (they will have a 
checkmark beside them). You can click beside 
individual client computers in the Client List to 
select or deselect them for network rendering, 
or click the Select All button to select or 
deselect all the client computers in the Client 
List at once.

9 Choose the desired options:

• Save Client List — lets you save the Client 
List so that the next time you use network 
rendering to render a scene, the client 
computers will already be entered in the 
Client List.

• Use Host to Render — lets you use the 
server computer as well as the client 
computers to render the job.

• Tile Optimization — tells Bryce to 
optimize how sections of the scene are 
sent to the client computers. 

By default, Bryce divides the scene by 
frames and sends each client computer 
one frame at a time for rendering. While 
this works well for large animations, a 
single-frame scene is sent to a single 
machine for rendering, even if there are 
many computers in the Client List. With 
Tile Optimization turned on, Bryce breaks 
each frame of an animation or single-frame 
scene into multiple tiles and sends these 
tiles to the client computers for rendering,  
improving the efficiency of the network 
render. 

To remove clients from the Client List:
1 In the Network Render Settings dialog, select 

the client to be removed from the Client List.

2 Click Disconnect.

To start the network render:
1 Click the OK icon in the Network Render 

Settings dialog to return to the Render 
Animation dialog.

2 Click the OK icon in the Render Animation 
dialog. The network rendering job will start.

Monitoring network rendering
The Network Render Manager lets you monitor the 
progress of the network render. You can also 
monitor the status of individual client computers; 
pause rendering on a client computer; cancel 
rendering on a client computer; and add or remove 
client computers from the list of available clients. 
You will not see the scene being rendered on the 
server. However, you can go to the client 
computers and see the section that client is 
rendering.

The Network Render Manager displays a list of all 
network rendering jobs in progress, the state of 
each job, and its percentage complete. You can use 
the Network Render Manager to change the 
settings of a network rendering job.

To monitor a render using the Network 
Render Manager:
1 Click File>Network Render Manager.

From the Network Render Manager, you can 
monitor the progress of your network 
rendering jobs, view the status of the client 
computers working on a job, and pause or 
cancel a job.

To pause a network rendering job: 

1 Click File>Network Render Manager.

2 Select the job to be paused.
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3 Click Pause.

To resume a network rendering job:
1 Click File>Network Render Manager.

2 Select the paused job.

3 Click Run.

To cancel a network rendering job: 
1 Click File>Network Render Manager.

2 Select the job to be cancelled.

3 Click Cancel .

To view the status of the client computers 
working on a job:
1 Click File>Network Render Manager.

2 Select the network rendering job.

3 Click Settings. This brings you to the Network 
Render Settings dialog. Bryce will 
automatically verify the current status of client 
computers in the Client List, except for those 
clients you have manually disconnected.

You can click the Update button to have Bryce 
verify the current status of the client 
computers in the Client List that are listed as 
unverified, unreachable, or disabled.

The Status column in the Client List displays 
colored icons next to each client computer. 
Each color represents a different status:

• Green=Ready
The client computer at that IP address is 
running Bryce Lightning and is available to 
receive a rendering job from the server.

• Orange=Working
The client computer at that IP address is 
running Bryce Lightning and is processing 
a rendering job. 

• Red with horizontal bar=Locked
The client computer at that IP address is 
connected to another server, or an error 
has occurred on the client computer.

• Red with lightning bolt=Unreachable
The client computer at that IP address is 
unreachable or is not running Bryce 
Lightning, the IP address is invalid, or the 
client computer does not have enough 
memory to render the job.

• Black with question mark=Unverified
The Network Render Manager did not 
attempt to determine the status of the 
client computer at this IP address. This 
icon will only appear when you first add a 
client to the Client List.

• Grey=Disabled
The client computer at that IP address has 
been disconnected by the user and will not 
be used for the rendering job.

Batch Rendering
Batch Rendering lets you render a number of files 
at the same time. This way, instead of rendering 
each scene as you create it, you can set up a 
number of scenes, save them and then render them 
all at once at a convenient time.

To perform a batch render:
1 Save a number of scenes to a folder.

2 Drag all the files to the Bryce application.

Bryce opens each file, renders it, saves it, and 
then opens and renders the next file. You can 
render any number of files this way.

Fast Render Strategies
There are several techniques you can use to speed 
up the rendering process. These techniques are 
most useful when rendering animations, where you 
may have a large number of images to render.
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You can greatly increase the speed of a render just 
by using the Preview Render modes. Below is a 
table showing the percentage of time it takes to a 
render a scene, containing complex materials and 
lights, using normal and preview modes.

Patch Rendering
Using the Plop-Render mode, you can do a patch 
render of image. Patch rendering involves the 
rendering of background and flat elements using 
normal rendering and then using the Plop-Render 
controls to render areas that contain more complex 
elements.

There are two things you should remember when 
using patch rendering:

• Make sure you use the Clear and Render 
button when you make changes to a partially 
rendered image. If you stop a rendering, make 
changes and then click Resume Render, you’ll 
end up with noise instead of an image. 

• If you change elements that don’t affect a large 
area of your scene, you don’t have to render 
the entire scene again. For example, if you 
render a scene with a floating sphere and then 
delete the sphere, you don’t need to re-render 
the scene, only the area where the sphere was. 

To patch render your image:

1 Start a render as normal. 

2 Let the rendering proceed for two or three 
passes and then click the mouse.

3 Switch to Bitmap display mode.

4 Drag a marquee around key portions of your 
scene and then render those areas using the 
Plop-Render controls. 

You can also speed up rendering using these 
techniques:
• Limit the number of lights.

• Keep background objects simple.
• Limit the number of volume materials you 

apply.

• Limit the number of transparent and reflective 
objects.

• Limit the number of frames per second to 15 
for QuickTime movies. 

• Divide animations into smaller files and 
eliminate objects that won’t be seen in the 
rendered frames.

• Turn off anti-aliasing when previewing 
animations.

Working with Rendered 
Images
Once your scene is rendered, it becomes a 2D 
image that you can save in various formats and edit 
in 2D image applications. 

In Bryce, the 2D image is used as the Bitmap display 
mode. You can use the bitmap as a guide for 
moving objects, or as a preview of your final image.

Scaling Your Image
The Pan and Zoom tools work independently in 
wireframe display mode and in bitmap display 
mode. So if you use the Zoom tool to scale your 
wireframe scene, your rendered image remains 
unchanged. 

Render Option % of standard time

Normal Render 100%

Fast Render 41.7%

Textures Off 35.4%

Fast Render w/
Textures Off

8.3%

Fast, Textures Off, 
anti-aliasing Off

2.1%
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You can use the same tools and commands to zoom 
closer or further from your rendered image, 
independent of the scale of your wireframe scene. 
If you zoom in sufficiently, you can use the Pan tool 
to pan through the enlarged image.

Refer to “Panning” on page23 and “Zooming In and 
Out” on page22 for more on the Pan and Zoom 
tools.





15 
Animating

Animation is the process of adding a fourth 
dimension to your scene—time. To create an 
animation, you arrange a scene then record your 
movements or transformations of objects over 
time. Bryce creates a motion path from your 
recorded movements and then generates an 
animation. 

You can animate almost anything in your scene:

• the motion of objects and the camera

• object size and shape
• object materials

• terrain objects

• sky properties
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The Animation Process
Animation is a cooperative process between you 
and Bryce. You arrange objects and choose scene 
settings, and then make adjustments to the objects 
and scene over time. Bryce fills in the gaps between 
adjustments. When you play the animation, the 
illusion of motion is created.

The steps to creating an animation are as follows:

• Create objects using the Create tools.
• Build a scene by arranging and transforming 

objects, lights, and thecamera.

• Adjust the position, orientation, or scale of 
objects. Each time you make an adjustment, 
you create a key event which indicates a point 
where an object property was changed.

• Adjust the shape or placement of the motion 
path.

• Adjust the speed at which the object moves 
along the motion path using the Advanced 
Motion Lab.

• Render the animation as a movie file. You can 
render the animation as a QuickTime/AVI 
movie file or as a set of frames.

Time-Based Animation
In Bryce, key events are tied to real-world time 
increments (minutes and seconds) rather than 
individual animation frames. This means that you 
can create key events at specific points in time 
without worrying about the number of frames in 
your final animation.

Bryce automatically creates all the frames necessary 
to move from one key event to another. If you 
change the frame rate, Bryce adjusts the number of 
the frames between key events to match the new 
frame rate. 

For example, let’s say your frame rate is set to 15 
fps (frames per second) and then you set up two 
key events, one at 1 second and the other at 2 

seconds. Bryce automatically fills in the 15 frames 
necessary to move from the key event at 1 second 
to the key event at 2 seconds. If you change the 
frame rate to 30 fps, Bryce will add another 15 
frames between the two key events to match the 
new framerate.

Animation and Motion Paths
As you change the position, of an object, Bryce 
creates a motion path which shows you the path 
the object will take as it moves from one key event 
to another. 

An object’s motion path shows you the trajectory of the object 
as it moves from one key event to another.

 You can edit an object’s motion path to adjust its 
trajectory throughout the course of the animation. 

Refer to “Editing Motion Paths” on page331 for 
more on motion paths.

Animatable Properties
Each characteristic of an object or effect that can be 
animated is called a property. Most objects have 
many animatable properties. Properties like 
position, size and orientation are common to all 
objects. Other properties are specific to certain 
types of objects.

Lights have special properties like brightness, 
falloff and gels.

Skies have their own set of properties that control 
everything from cloud coverage to the time of day.
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The properties of individual objects can change 
depending on the material you apply. The color, 
texture, and density of an object can also be 
animated.

Some properties can be animated directly in a 
specific editor. Object material properties can be 
animated from within the Materials Lab and terrain 
geometries can be edited from within the Terrain 
Editor.

Properties in the Sequencer

Every time you change an object’s property, it 
appears as a key event in the animation’s 
Sequencer. In the Sequencer, each property of an 
object can be viewed on a separate timeline. You 
can expand an object’s listing to see all the 
transformations or changes that have been applied 
to its properties. If you have not performed any 
transformations on the object, it cannot be 
expanded.

Refer to “Editing Property Timelines in the 
Sequencer” on page335  for a complete discussion of 
the Sequencer.

To expand a listing in the Sequencer:
1 Make sure the Advanced Motion Lab is visible. 

If it’s not, choose Objects menu> Advanced 
Motion Lab.

2 Click the object’s listing.

Creating Animations
The Animation controls are the tools you’ll use 
most often when creating animations. The palette 
provides tools for most of the basic animation 
functions:

• viewing the timeline
• moving the current time

• setting the length of the animation

• specifying the Working Area
• previewing the animation

• recording key events

• adding/deleting key frames

The Animation controls appear at the bottom of 
the Working window as well as in the Terrain 
Editor and the MaterialsLab.

The Animation controls are made up of three areas:

The Timeline, located at the top of the palette, 
displays a visual representation of the time in your 
animation. The indicator on the timeline (called the 
Current Time Indicator ) represents the current time.

The Animation Preview Controls, located below the 
Timeline, let you preview your animation in the 
Working window.

The Key Frame Controls, located at the right edge 
of the palette, let you add and delete key frames.

To display the Animation controls in the 
Working window:
• By default the Animation controls are located 

at the bottom of the Working window. If the 
Selection palette appears at the bottom of the 
window, click the Time/Selection Palette 
toggle in the bottom-right corner of the Bryce 
window (or press S). 

Use the Time/Selection Palette toggle to switch between the 
Animation controls and the Selection palette.

The button switches between the Selection 
palette and the Animation controls.

Setting Up an Animation
Before you start setting up key frames or adjusting 
the timeline, you should set up some general 
parameters for your animation. 

The Animation Setup dialog lets you set up the 
duration, the frame rate and whether you want to 
display animation time as SMPTE (i.e.; 
hours:minutes:seconds:frames) or frame numbers.
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The Animation Setup dialog can used to set the duration of your 
animation or to move to a specific point in the timeline.

To set the duration of your animation 
numerically:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. The 
Animation Setup dialog appears.

2 Click the Scale button. This switches the 
Duration fields to set the duration of your 
animation. 

3 In the Duration fields, enter the total length of 
your animation in hours, minutes, seconds and 
frames.

When you enter a duration, Bryce 
automatically calculates the number of frames 
in the animation, based on the current frame 
rate. The number of frames is displayed in the 
Frame#field.

Setting the Frame Rate

The Frame rate for your animation can have a large 
impact on the final quality of your rendered movie. 
A low frame rate, is faster to render but may 
produce motion which is more jumpy, while a 
higher frame rate produces much smoother 
motion.

Bryce displays frames as frames per second (fps). 15 
fps is usually good enough for motions displayed 
on a computer. 30 fps is standard for broadcast-
quality video.

To set the frame rate for your animation:
1 Choose File menu> Animation Setup or 

double-click the Current Time Indicator. The 
Animation Setup dialog appears.

2 Enter a frame rate in the FPS field.

Animation Tools
Bryce 3D’s animation tools are designed to help 
you animate the properties of your scene. 

Animation Controls
The animation controls let you record an animation 
and preview it in the Working window. You can 
also use the controls to change the current time or 
move to different points in time.

Use the animation controls to record and preview your 
animation.

The Timeline appears in four places in Bryce: the 
Working window, the Terrain Editor, the Sky Lab, 
and the Materials Lab.

All four timelines represent the same time. The 
only difference is that when you’re in an editor, you 
can only add frames for properties associated with 
the editor. For example, in the Terrain Editor you 
can only add key frames associated with terrain 
properties. 

When you preview a timeline in the Working 
window, you’ll be able to see all the changes in 
your scene, including any changes you may have 
made in other editors or in the Advanced Motion 
Lab.

Timeline

Time Dots Key frame 
controls

Animation Preview 
controls
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The Timeline

The Timeline is a graphical representation of time. 
The darker gray area within the Timeline 
represents the current length of your animation.
 

The Timeline indicates the length of your animation and the 
current time.

The blue colored section of the timeline represents 
the length of the Working Area. The Working Area 
can be used as a visual guide to help you isolate 
portions of your timeline. When you render the 
animation you can choose to render the entire 
timeline or just the Working Area. When you use 
the animation preview controls, only the Working 
Area is previewed. Refer to “Setting Up the 
Working Area” on page325 for more on the 
Working Area.

The Current Time indicator lets you move to 
different points in time. This is the main tool you’ll 
use to create animations. Every time you want to 
add a key event, you move the Current Time 
indicator to a different point on the timeline.

Working with Time 
The light gray area in the Timeline is called the 
Available Time Area and it represents all time. This 
area is unlimited; you can scroll the time area 
infinitely. 

The white tick marks within the Timeline are visual 
cues that let you know when the time area is 
moving. If you move the Current Time Indicator off 
the screen, you’ll see these white ticks move along 
the time area. 

To scroll the time area:

• Drag the Current Time Indicator off the screen 
to the right.

You’ll see the white tick marks move along the 
time area to the left.

Setting the Animation Range in the Timeline

The dark gray within the light gray area of the 
Timeline represents the total length of your 
animation. This area is usually hidden by the 
Working Area, so you may need to shorten the 
Working Area to adjust the Animation Range.

This area is automatically generated as you set up 
key events. The time of the final key event 
automatically creates the limit of the animation 
range. However, you can manually extend or 
shorten the area to set the range of your animation. 

You cannot shorten the Animation Range below the 
last frame in the scene since you can’t have frames 
outside the animation range.

To manually set the Animation Range:
• In the timeline, drag the handle that appears 

at the end of the Animation range to the point 
where you want the animation to end.

The handle may be obscured by the Current 
Time Indicator, so you might have to move the 
indicator to a different position.

Setting the Current Time for an Animation

The large green handle in the Timeline is called the 
Current Time Indicator (commonly called a 
scrubber). It sets the current time of the animation. 

The Current Time Indicator is the most important 
tool of the Animation controls. When you’re 
creating key events, the Current Time Indicator 
controls when the key event occurs in the 
animation. 

Refer to “Recording Key Events” on page326 for 
complete instruction on creating key events.

Timeline

Working Area Current Time Indicator
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As you move the Current Time Indicator the Text 
Display Area shows you the current time. If you’re 
using SMPTE time, the current time is displayed as:

The Frame # changes as you change the frame rate 
for the animation. For example, at 15 fps Bryce will 
insert 15 frames within each second.

If you’re using Frame number, the number of the 
current frame is displayed.

You can also move to a specific point in time using 
the Animation Setup dialog. In this dialog, you can 
move to either a specific time or frame.

To move to a specific frame manually:
• Drag the Current Time Indicator along the 

Timeline. 

As you drag, watch the Text Display Area. 
You’ll notice that the final number cycles 
through each frame in the second of animation 
time. So at 15 fps the final number will cycle 
through frame 0-14 between seconds. 

Release the mouse button when the Frame # 
reaches the desired frame.

The Current Time Indicator also controls which 
portion of your animation is being displayed in the 
Working window. 

When the indicator is at the beginning of the 
animation, you’re seeing the first frame of the 
animation in the Working window. When you move 
the indicator, the Working window displays a 
different portion of the animation. So, when you 
move the indicator to the center of your animation 
range, you’re seeing what the animation looks like 
at the middle of the movie. 

To move the current time manually:
• Drag the Current Time Indicator along the 

Timeline. Release the mouse button when the 
Text Display Area shows the desired time. 

To move the current time numerically:

1 Choose File menu> Animation Setup. The 
Animation Setup dialog appears.

2 In the Current fields, enter the hour, minutes, 
seconds and frame you want to move to.

The Frame # field displays the number of the 
frame located at the specified time.

Time Dots

The Time Dots let you save positions on the 
timeline. You can use the dots to quickly jump 
between areas of the timeline you’re working on.

Use the Time dots to quickly move between saved positions 
along the timeline.

To save the position of the Current Time 
Indicator:
1 Move the Current Time Indicator to the 

position you want to save.

2 Click on an empty Time Dot at the bottom of 
the Animation controls.

A dot is empty when it appears white.

To move the Current Time Indicator to a saved 
position:

• Click the Time Dot for the position you want 
to use.

To delete a saved position:
• Option/Alt+click on a full Time Dot.

A full dot appears blue.

Hours Minutes Seconds Frame #
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Setting Up the Working Area

The blue portion of the Timeline represents the 
Working Area. This area highlights the portion of 
the timeline you’re currently working on.

Use the Working Area to isolate the portion of the timeline 
you’re currently working on.

When you’re previewing your animation, only the 
portion of the timeline within the Working Area is 
previewed. 

The Working Area is most useful when you’re 
working on a long animations as it saves on 
preview time, or when you’re refining a specific 
portion of your animation. 

When you’re rendering the animation, you can 
choose to render the entire animation, or just the 
Working Area portion. 

You can also use the Working Area to render out 
sections of the timeline while you’re setting up the 
animation, and then render the entire Animation 
Range when you’re creating the final animation.

To set the range of the Working Area 
manually:
• Drag either end of the existing Working Area. 

Release the mouse button when the Working 
Area is the desired length.

The Working Area cannot be extended past the end 
of the Animation Range.

To set the range of the Working Area 
numerically:

1 Choose File menu> Animation Setup or 
double-click the Current Time Indicator. The 
Animation Setup dialog appears.

2 Click the triangle icon at the top-left of the 
dialog and choose Working Range Low from 
the menu.

3 Enter the starting time for the Working Range. 

4 Click the triangle icon again and choose 
Working Range High. 

5 Enter the ending time for the Working Range. 

Setting Timeline Scale

The scale indicator at the right edge of the timeline 
let you adjust the scale the timeline.

If you have a very long timeline, you can use this 
control to scale it down so you can see the whole 
timeline at once. If you have a very short timeline, 
you can use the control to scale it up so it extends 
across the length of the palette.

Use the scale indicator to scale the timeline.

To set the scale of the timeline:
• Drag the scale indicator. 

Drag right to increase the scale and left to 
decrease it.

The scale of the timeline does not affect its length, 
only how it’s displayed in the Animation controls.

Scaling Animation Duration

You can adjust the length of your animation, by 
scaling its duration to fit within a certain amount of 
time. For example, you created an animation that’s 
five seconds long, but only want it to take up three 
seconds, you can scale the entire animation to last 
only three seconds. 

When you scale the animation, all the events in the 
animation are compressed or stretched to fit within 
the desired amount of time. If you increase the 
scale, the events are stretched out, so they take 
longer to complete. If you decrease the scale, the 
events are compressed so the action speeds up.

To set the scale of the entire animation 
manually:
• Hold down Option/Alt and drag the animation 

range handle. Release the mouse button when 
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the duration of the animation is the desired 
length. 

Option/Alt-drag the animation range handle to scale the 
animation down or up.

To scale the animation numerically:
1 Choose File menu> Animation Setup or 

double-click the Current Time Indicator. The 
Animation Setup dialog appears.

2 Click the Scale Animation button.

3 Enter the desired animation duration in the 
Duration fields. 

Recording Key Events
You can record key events by enabling Auto-Record 
mode. The Timeline options menu, located at the 
right edge of the controls, lets you enable or 
disable Bryce’s automatic animation system.

When you enable Auto-Record mode, every object 
transformation or change of property you perform 
is recorded as a key event. 

A key event can store any change in size, position, 
orientation, material property, sky property, light 
property or geometry.

However, a key event can only store one change per 
property at a specific point in time for each object 
in the scene. This means that at a single point in 
time, you can only have one change in position, 
size, material, or geometry per object recorded as a 
key event. 

If you keep changing the same properties at the 
same point in time, the new changes replace 
existing changes. Only the last change you perform 
is recorded as the key event. 

To record more than one change in the same 
object’s property you have to move to a different 
point in time. Then each change can be recorded as 
a separate key event and applied to the animation.

If you move an object up and down at the same point in time, 
only the last transformation is recorded as the key event.

...but if you move the object up at one point in time and then 
move the object down at a different point in time, both 
transformations are recorded.

When Auto-Record mode is disabled, the animation 
system is off. This means that your changes are not 
recorded as key events, and changes in the 
Timeline do not effect your view in the Working 
window. 

You can continue changing object and scene 
properties, but they won’t be recorded as key 
events. If you want to record a setting or 
transformation you’ll have to manually add a key 
frame using the Add Frame button. Refer to 
“Adding and Deleting Key Frames” on page328 for 
more on adding frames.

To enable or disable Auto-Record mode:

• Click the triangle icon to the right of the 
controls and choose Auto-Key. The animation 
system is on when the option has a checkmark 
next to it. 

Choose Auto-Key again to turn off the 
animation system.
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Animation Preview Controls

The Animation Preview controls let you move 
between the key frames in your animation.

Use the Animation Preview Controls to move between key 
frames in your animation and start the movie preview.

The outermost buttons move to the beginning and 
the end of the animation. The inner buttons move 
to the next and previous key frames, and start or 
stop the preview.

Previewing Animations
You can preview your animations using either the 
mini-preview in the nano-preview or by using the 
Animation Preview controls. Both of these methods 
allow you to see either a rendered preview or a 
storyboard. 

Using the Movie Preview Window 

Using the movie preview window, you can see a 
rendered version of your animation quickly.

To preview your animation:

1 Create an animation.

2 Click the Preview Animation button.

Using the Storyboard Preview

Using the storyboard preview feature, you can 
review or navigate your animation, frame-by-frame.

To view your storyboard:

1 Create an animation.

2 Click and hold down on the Preview Animation 
button.

3 Select Storyboard.

4 Click on the Preview Animation button.

All of the frames appear in a grid pattern as they 
are rendered. When the rendering is finished, the 
movie plays in the nano-preview.

To stop the movie preview:

• You can stop the preview at any time by 
clicking the mouse. 

To exit movie preview mode:

• To exit movie preview mode completely, press 
the Esc key or redraw/render your scene.

Additional Features of the Storyboard

If you pause in the storyboard portion of the 
animation preview, you can perform various 
manipulations on your animation. You can:
• Click on a frame to select it.

• Set the current time to that frame. 

• Drag the scrubber and move forward or 
backwards through the animation.

• Double-click the corresponding storyboard 
image to render any of the frames.

As you perform these manipulations, the animation 
updates in real-time in the movie preview window.

Using the Animation Controls

When you play an animation, all the frames in the 
animation within the Working Area are displayed. 
The preview is shown in Wireframe display mode.

Preview Animation

Previous Key Frame

Play

To End

To Start
Stop

Next Key Frame
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Setting Previewing Options

There are three options you can use to alter the 
preview of your animation. You can preview the 
animation only once. You can play the animation 
continuously, or you cycle forward through the 
animation, and then back.

To set a preview option:

1 Choose File menu> Animation Setup. The 
Animation Setup dialog appears.

2 Enable a Play option:

• Once plays the animation only once.

• Repeat plays the animation continuously.

• Pendulum plays the animation forwards 
then backwards, then forwards, 
continuously.

Key Frame Controls

The Key Frame controls let you add and delete key 
frames in your animation. 

Use the Key Frame controls to add and delete key frames from 
the timeline.

The Key frame indicator is only active when the 
current time is at a key frame.

Adding and Deleting Key Frames

Usually you use the Auto-Record mode to add key 
frames to your animation, but there are some cases 
when you would need to force the system to create 
a key frame. For instance, if you accidentally make 
a number of changes while Auto-Record mode is 
disabled, you’ll have to create a key frame to store 
your changes, or they’ll be discarded when you 
move to a different point in time.

Adding Key Frames

The Add key frame (plus) button lets you add a key 
frame. When you are in Camera View, with nothing 
selected, Add key frame automatically key frames 
the camera. In Director’s view, it does not. It also 
keys the sky.

In Auto-Key mode, Bryce automatically adds key 
frames for you, but when you disable the mode, 
you’ll have to use Add Key frame to add key frames 
at points in the timeline.

If you have an object selected, Bryce only records 
the changes in property for the selected object. If 
you have nothing selected, Bryce only records the 
changes in the sky (i.e. changes you make in the Sky 
& Fog palette).

Plays the animation. Click during 
play to pause the animation.

Stops the animation.

Moves to the beginning of the 
Recorded Area.

Moves to the end of the Recorded 
Area.

Moves one key frame forward in the 
animation.

+Shift moves one frame forward.

Moves one key frame backward in 
the animation.

+Shift moves one frame back.

Starts a quick animation preview.

Key frame indicator

Add key frame Delete key frame
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You can also modify the add key frame operation so 
that, for a selected object, only a specific property 
is recorded as a key event. 

To add a key frame:
1 Move the Current Time Indicator to the point 

where you want to add a key frame

or 

If you need to force Bryce to overwrite an 
existing key frame, leave the Current Time 
Indicator where itis.

2 Click the Add Key Frame button.

Any changes you made at this point are 
recorded in the key frame.

To add a frame for a certain property:
1 Select an object. 

2 Hold down the mouse button over the Add Key 
frame button and choose an object property 
from the menu that appears.

To add a key frame for sky properties:
• Make sure there is nothing selected, and click 

the Add Key frame button.

or 

• Hold down the mouse button over the Add Key 
frame button and choose Sky from the menu.

Deleting Key Frames

The Delete Key frame button deletes the current 
key frame event or a specific type of key event. In 
the Working window, deleting a key event deletes 
all the frames at the current time. In the editors the 
Delete Key frame button only deletes key events for 
the properties associated with the editor.

As with adding frames, Bryce deletes frames 
differently based on your current selection. 

If you have an object selected, Bryce only deletes 
the changes in property for the selected object. If 
you have nothing selected, Bryce deletes the 
changes recorded for your scene’s sky.

You can modify the Delete Key Frame button’s 
function so that only a certain type of object 
property is deleted.

Adding or deleting frames will effect the shape of an 
object’s motion path.

To delete a key frame:

1 Use the Animation Preview controls to move 
through the key frames until you find the 
frame you want to delete.

2 Click the Delete Key Frame button.

All the properties recorded at that point in 
time are deleted.

To delete a frame for a specific object 
property:

1 Select an object. 

2 Hold down the mouse button over the Delete 
Key Frame button and choose the object 
property from the menu that appears.

Adding and Deleting Frames in the Editors

When you add a frame in the editors, only the 
properties associated with the editor are recorded 
as a key frame. 

When you delete a frame in the editors only the 
properties associated with the editor are deleted. 
For example, it you delete a frame that contains 
position, material and scale data in the Materials 
Lab, only the material data is removed from the key 
frame.
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Animation Options

The triangle icon to the right of the animation 
controls displays the Auto-Key Framing option 
menu. This menu lets you turn the animation 
system on or off. 

When the animation system is enabled, every 
change you make to the scene is recorded as a key 
event. Changes can include things like moving an 
object, changing a material, or changing the shape 
of a terrain.

When the animation system is disabled, your 
changes are not recorded. To record a key event 
you have to use the Add Key Frame button. The 
animation system is enabled by default.

This menu also contains the following:
• Ticker Marks lets you select from frame or 

time options. 

• Play mode lets you choose Once, Repeat, or 
Pendulum.

• Time display is either SMPTE or Frame.

Motion Paths
A motion path is a visual representation of an 
object’s trajectory as it moves through time. 

An object’s motion path is automatically generated 
as you create key events. Each new key event adds a 
new point to the path. 

The shape of the curve is determined by the 
interpolation performed by Bryce. In most cases 
Bryce tries to create smooth motion so the path is 
drawn as a curve.

An object’s motion path is automatically generated as you 
create key events. As you move the object at a specific point in 
time, the motion path line extends out from the object’s 
wireframe.

As you add key events, the curve is adjusted to 
include the new motion. 

As you add more key events to your animation, the path changes 
shape to include the new motion. Bryce always keeps the motion 
smooth, so each new point is added as a curve.

Motion paths exist in 3D space so they can be 
viewed from any angle. If you move the camera, 
you can see how the object moves along the X, Y 
and Z axes. 
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If you move the camera to different views, you’ll be able to see 
the object’s trajectory along all three axes.

The default state of the motion path can be difficult 
to see in a complex scene. You can give your 
motion path some extra depth by displaying it as a 
ribbon. 

The ribbon lets you see the motion path as a flat track running 
through the scene.

By default, the motion path for an object only 
appears when the object is selected. Otherwise the 
path is invisible. As well, it does not render in the 
final animation.

You can change the display mode of the motion path 
in the Animation tab of the Object Attributes dialog.

To show the motion path as a ribbon:
1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

3 Click the Animation tab.

4 Enable the Show as Ribbon option and click 
the OK icon.

To display the path only when the object is 
selected:
1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

3 Click the Animation tab.

4 Enable the Show Only when Selected option 
and click the OK icon.

To display the path at all times:
1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

3 Click the Animation tab.

4 Enable the Show Always option and click the 
OK icon.

Editing Motion Paths
Changing the shape of the motion path changes the 
trajectory of the object. The path acts like a Bezier 
curve. You can change its shape by dragging its 
control points. 

You don’t have to be in Auto-Record mode to edit 
the path. The changes you make to the path’s shape 
are applied directly to the path in real time.
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Changing the shape of a path does not affect when 
key events occur. A key event that occurs at 
00:00:01.00 will still occur at the same time 
regardless of where it is.

The events on the path above occur at 00:00:00.01, 
00:00:01.00 and 00:00:02.00. When you change the shape of 
the path, the direction in which the object travels changes, but 
all the events still occur at the same time they did in the original 
path.

Since Bryce treats the motion path as a Bezier 
curve, you can edit it just as you would any curve in 
any 2D illustration application. You can also display 
the curves tangents which indicate the angle of the 
curve. 

When you display a path’s tangents you can see the angles of its 
curve points.

Motion Path Modifiers
There are a number of modifiers you can apply to 
the path change the way motion occurs along the 
path. 

Normally an object moves from the first key event 
on the path to the last over the course of the 
animation. If you want the object to move 
backwards along the path, or repeat its action, you 
would have to reposition the object and set up new 
key events. The modifiers let you create these types 
of effects automatically. 

For example, if you wanted to animate the motion 
of a grandfather clock pendulum, you have to set 
up the forward motion, and then the backward 
motion. 

However, using the Pendulum modifier you just 
have to set up the forward motion path since the 
modifier changes the object’s behavior so that it 
moves forward then back along the same path 
during the course of the animation. All you have to 
do to see the new motion is extend the duration of 
the animation. 

The motion of  the bird’s wings was created using the Pendulum 
modifier.

 There are four modifiers available:

• Make One Shot restores the motion of the 
path to its original configuration, meaning the 
action along the path only occurs once. 

• Make Repeat creates a loop in the action. The 
motion on the path repeats continuously.

• Make Pendulum creates a repeating cycle in 
the action along a path. The object will move 
forward on the path, then back and then 
forward continuously.
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• Make Circular closes the path to create a 
circular path. The object will move along the 
path and when it reaches the end, it’ll swing 
around to the front of the path and start all 
over.

To apply a modifier to a motion path:

1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

3 Click the Animation tab.

4 Enable a modifier.

5 Extend the duration of the animation so you 
can see the change in motion.

Moving the Path
You can also move the path, by dragging it to a new 
location. When you drag the path, all the events on 
the path shift position. Changes in motion path 
position are not recorded as key events. 

When you drag the motion path, you’re not changing its shape, 
you’re adjusting the position of all the events on the path, so 
this animated ball occurs at a higher altitude.

 To move a motion path:
• Click on a section of the path that does not 

contain any control points and drag it to new 
location.

You have to click on a part of the path without 
control points, otherwise you’ll change its 
shape.

Aligning Objects to the Path
Normally, the orientation of an object remains 
fixed relative to world space as it moves from point 
to point. Using the aligning option, you can have 
the object’s orientation remain parallel to the path 
so that it reorients itself as moves from point 
topoint

You can use this option to create more realistic 
motion for objects that have a distinct front and 
back.

The motion of this airplane looks rather unrealistic since its 
rising and falling without tilting.

If you align the airplane to its path, the airplane’s nose tilts 
down as it moves down and up as it moves up.

There are two align options available:

• Do Not Align disables aligning. The shape of 
the curve has no effect on the object’s 
orientation.

• Align adjusts the object so that its orientation 
matches the shape of the path.

To align an object to a motion path:
1 Select the object.

2 Click the A icon that appears next to its 
bounding box. The Object Attributes dialog 
appears.

3 Click the Animation tab.
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4 Enable an alignment option and click the OK 
icon.

Advanced Motion Lab Button

The Advanced Motion Lab button opens the 
Advanced Motion Lab.

Use the Advanced Motion Lab button to enter the Advanced 
Motion Lab.

The Advanced Motion Lab
The Advanced Motion Lab contains tools that let 
you control the detailed properties of your 
animation.

You can use the lab to:

• view the hierarchical structure of your scene

• rearrange the sequence of key events for 
individual object properties

• remap the time it takes to move from one key 
event to another

• preview your animation

The Advanced Motion Lab lets you control the speed of objects 
along a motion path and the placement of key frames on the 
timeline.

The Advanced Motion Lab is divided into four 
areas:
• The Hierarchy List area, located in the bottom-

left corner of the window.

• The Sequencer area, in the bottom-center of 
the window. 

• The Time Mapping Curve Editor, located at the 
top-left of the window.

• The Preview Area, located at the top right of 
the window.

Hierarchy List Area

The Hierarchy List Area displays the scene’s 
hierarchical structure, including links, and groups. 
You can view all the hierarchies expanded or just 
the parent objects in the scene. You can also 
expand an object’s listing to show all of its 
properties. 

The Hierarchy List area is used to control the 
display of both the object hierarchies and object 
property timelines. If you want to view only your 
scene’s object hierarchies you’ll have to hide all the 
properties for all objects. You can hide each object 
individually or select from the menu to the right of 
the Preview Area to display or not display the 
hierarchy.

Refer to “Object Hierarchies ” on page221 for more 
on object hierarchies.

To hide an object’s property timelines:
• To hide an individual object’s property 

timelines, click the name of the object whose 
properties you want to hide.

• To hide all the property timelines in the 
Hierarchy List area, either hold down Option/
Alt while you click, 

or

select Collapse All Timelines from the menu to 
the right of the Preview Area. 

SequencerHierarchy List Area

Preview AreaTime Mapping Curve Editor
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When all the object timelines are hidden, the only 
thing displayed in the Hierarchy Area is the 
hierarchical structure of your scene.

The Hierarchy List can be viewed in two ways: 
collapsed or expanded. You can use the arrow icons 
to expand or collapse the Hierarchy. When the 
Hierarchy List is collapsed you can only see the 
Parent objects in the object hierarchies.

When it’s expanded, you can see all child objects in 
the hierarchy.

The indents indicate Parent-child links or groups. 
The parent is aligned to the left, and its children 
are indented from there.

To display or hide the hierarchical 
relationship:

• To display the hierarchical relationship in the 
Hierarchy List area, select Display Hierarchy 
from the menu to the right of the Preview 
Area.

• To hide the hierarchical relationship in the 
Hierarchy List area, deselect Display Hierarchy 
from the menu to the right of the Preview Area

To expand/ collapse the Hierarchy List:

• To expand or collapse individual items in the 
Hierarchy List, click the Arrow icon beside an 
object’s listing. 

• To expand the entire hierarchy, hold down 
Option/Alt and click an arrow, or select Expand 
All Hierarchies from the menu to the right of 
the Preview Area.

• To collapse all hierarchies, select Collapse All 
Hierarchies from the menu to the right of the 
Preview Area.

A right facing arrow indicates a collapsed hierarchy, 
and a down-facing arrow indicates an expanded 
listing.

The Sequencer

The Sequencer lets you see the key frames recorded 
for each property within an object. Each property 
has its own timeline track. Key frames are displayed 
as white marks on the timeline. The current time is 
indicated by the Current Time bar.

The Sequencer lets you see where in time a change 
in an object’s property occurred and edit the 
position of that event. Different types of objects 
have different properties. 

A scene contains more than just objects. You can 
expand the Hierarchy List to also display the 
properties for your scene’s sky and the camera.

The display buttons along the left side of the 
hierarchy area let you hide or display an object in 
the animation preview. This can help you isolate 
objects in a complex scene.

Use the display buttons to hide or show objects in the animation 
preview.

Editing Property Timelines in the Sequencer

Each object in the Hierarchy List has a number of 
timelines associated with it. When you display an 
object’s properties you can see the timelines 
associated with each object.

To display an object’s property timelines:

• To display an individual object’s property 
timelines, click the name of the object whose 
properties you want to display.

• To display all the property timelines in the 
Hierarchy List area, either hold down Option/
Alt while you click, or select Expand All 
Timelines from the menu to the right of the 
Preview Area. 

These timelines represent the various animatable 
properties for an object type. Different types of 
objects have different animatable properties. 
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For example, this is the listing for a sphere object. When the 
object ‘s property timelines are displayed, you can see the key 
events recorded for each property.

The white tick on a property timeline indicates that 
a key event has been recorded for the property. 

The ruler at the top of the Sequencer lets you see 
the exact point in time when the key event was 
recorded. 

You can tell exactly when an event was recorded by lining the 
key event marker up with the ruler at the top of the Sequencer 
area.

In this example, a position key event was recorded at time 
00:00:01.25 (or 1 second and 25 frames)

By moving these key events you can control 
precisely when events occur.

This sequence represents an animation where a ball moves up 
and down four times, rotates as it makes its third jump and 
shrinks when its done bouncing.

If you move the position key events closer together the bounces 
occur faster, but the timeline remains the same.

If you move the fourth position key event in front of the third 
event, you’re changing the shape of the motion path, because 
the ball bounces up before it bounces down. 

Object 
Name

Animatable 
properties

Recorded Key Event

Time Ruler
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Position is not the only key event you can arrange. Here both the 
rotation and scale key events have been repositioned. Now, the 
ball grows larger as it bounces and it rotates only at the end of 
the animation.

It’s a good idea to activate the continuous preview 
while editing the timeline, so you can quickly see the 
effects of your changes. Refer to “Previewing Anima-
tions” on page327 for more on previewing.

The amount of time available in the Sequencer area 
is not limited by the current Animation Range. If 
you position a key event past the current limit of 
your animation, the Animation Range is 
automatically extended.

To move a key event on a timeline:
1 Expand the listing you want to edit.

2 Click the white tick mark on the listing’s 
timeline.

3 Drag the key event to a new position.

To move a group of key events:

1 Drag a marquee around all the key events you 
want to select or hold down Shift and click 
each of the key events you want to move.

You can select key events on different 
timelines.

2 Drag one of the selected key events. All the 
other selected key events movealso.

To delete a key event from a timeline:
1 Select the key event, or group of events you 

want to delete.

2 Press Backspace (on some Macintosh 
keyboards, the backspace key may be labelled 
“Delete”). The key event is removed from the 
timeline.

To copy a key event on a timeline:
Hold down Command/Ctrl and drag a key event. 
The original remains in place, but the copy moves 
as you drag.

Time Mapping Curve Editor

The Time Mapping Curve editor lets you control the 
length of time between key events. Each property 
listing in the Hierarchy List has its own time 
mapping curve. 

The curve acts like a time filter which remaps the 
time in your animation. Depending on the shape of 
the curve, the events in your animation may take 
longer to complete, or may occur very rapidly.

A time mapping curve can speed up events while 
slowing down others. You can even reverse the 
action in your animation. Refer to “Time Mapping 
Curves” on page340 for more on working with 
Time Mapping Curves.

The Time Mapping Curve editor lets you remap the time in your 
animation.
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Preview Area

The Preview Area in the Advanced Motion Lab 
contains tools that let you preview your animation.

The Animation Preview area lets you see any changes you make 
to the timing and velocity of objects.

The Preview Area has three parts:
• The Animation Preview area displays a 

wireframe preview of your scene. Any changes 
you make in the Time Mapping Curve editor or 
the Sequencer are updated to this area.

• The Preview VCR controls let you play the 
animation like a movie. You can stop, play, 
move forward one key frame, or back one. The 
far right button renders the scene.

• The Preview Display Controls let you zoom in/
out of the preview, switch between Camera 
View and Director View, pan the preview and 
reset the preview.

Once you start the animation, it will run 
continuously until you press the Stop button. 
Running the preview also moves the Current Time 
Bar in the Sequencer area and the cross-hairs in the 
Time Mapping editor. As well, the counter at the 
bottom of the Time Mapping editor displays the 
current time of the animation as it plays.

To preview an animation:
• Click the Play button in the Preview Area 

controls. 

The animation starts running. It will continue 
playing until you press the Stop button.

Click the Stop button to stop the preview.

The controls along the left side of the Preview Area 
control several options for your animation preview.

To switch between Camera View and 
Director’s View in the preview:
• Click the Swap Views button next to the 

Preview Area.

When you first open the Advanced Motion Lab, 
the Preview Area displays the current camera 
view. 

In Director’s View you’ll be able to see the 
camera in the scene.

Preview Controls

Animation Preview

Preview VCR Controls
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When you switch to Director’s View in the Preview Area you can 
see the camera in the scene.

• Click the button again to switch back to 
Camera View.

Changing views in the Preview Area doesn’t affect 
the view in the Working window.

To render your preview:
• To render your preview, click the last VCR 

button under the Preview Area in the 
Advanced Motion Lab.   

To change the view in the Preview Area:
• To orbit around your scene, drag the preview 

in the direction you want to move the view of 
your scene.

To zoom in and out of the preview:
• Click the + button next to the Preview Area. 

The view of the scene enlarges.

To reset the view in the preview area:
• Click the Reset button next to the Preview 

Area.

The view returns to the view displayed when 
you first entered the Advanced Motion Lab.

To pan the Preview Area:

• Drag the cursor over the Pan button next to 
the Preview Area.

Hiding and Displaying Objects

The Hierarchy List area displays all the objects in 
your scene. The icons on the left side of the listing 
indicates whether or not the object is displayed in 
the preview area. 

The eye icon indicates whether or not an object is hidden.

When you hide an object it does not appear in the 
Preview Area at the top of the Advanced Motion 
Lab. This setting has no effect outside the lab. 
Objects that are hidden in the lab will be visible in 
the Working window and will still render normally.

You can use this feature to isolate objects that 
you’re editing in the Sequencer or Time Mapping 
areas.

To hide/display an object:

• Click the Eye icon to hide the object.

Click the icon again to display the object.

Director’s View

Camera View

Hidden Object

Visible Object
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Saving Preview Positions

The Memory dots next to the Preview Area let you 
save specific camera positions in the preview for 
later use.

The Memory Dots on the right side of the Preview Area let you 
save positions in the Hierarchy area and the animation preview.

To save a position:
1 Play the animation and then stop it at the 

point you want to save.

or

Move the Current Time bar in the Hierarchy 
area to the position you want to save.

2 Click on an empty Memory dot on the right 
side of the Preview Area.

A dot is empty when it appears gray.

To move to saved position:
• Click on a full Memory dot. A dot is full when 

it appears purple.

To delete a saved position:
• Option/Alt+click on a full Memorydot.

Using Presets
Above the Time Mapping Curve Editor are eight 
time mapping curve presets. 

You can create a preset of the current curve then 
apply it to a different attribute of the same object 
or to another object. 

To add, apply, or remove a preset:
• To add a preset, click in one of the blank 

squares. 

• To apply a preset, click in the square that 
displays the present you want to apply. 

• To remove a preset, press Option/Alt and click 
on the square that displays the preset you 
want to delete. 

When all the preset slots are filled, a new one is 
automatically generated when you click on the 
right arrow. 

• To scroll to the newest preset or to the next 
preset in line, click on the end of the preset 
container. 

Animation Features
Bryce has several special features that let you add 
extra effects to your animations:

• Time Mapping Curves

• Animating Transformations
• Animating Materials

• Animating Terrains

• Animating Skies

Time Mapping Curves
Time Mapping Curves are graphical representations 
of the time mapping filter. The filter remaps the 
time in your animation, so that the events that 
occur at specific times in your animation occur 
differently in actual time. 

By adjusting the shape of the curve, you can control 
how fast events occur. When you create a sharp 
jump in the curve, you speed up the events in your 
animation. When you flatten the curve, you slow 
down key events.

Each property of your scene can have a different 
curve, so you can have key events occurring at 
different speeds. Refer to “Time Mapping Curve 
Editor” on page337 for more on Time Mapping 
Curves.
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The curve acts like a filter. Time from the actual 
animation is remapped according to the shape of 
the curve to produce the final time. Depending on 
the shape of the curve, events can occur faster, or 
slower.

Time Mapping curves can only remap the time avail-
able in the animation. You cannot add more time, or 
reduce the amount of time in an animation. 

Editing Time Mapping Curves

The horizontal axis in the editor displays all the 
time in the animation. The vertical axis displays the 
time map for the properties’ timeline. The key 
events recorded for an object property are 
displayed as horizontal dotted lines. The curve in 
the middle represents the time mapping filter. The 
point where the curve intersects a key event line 
tells you exactly when an event occurs.

At point A in this timeline, an event that occurred at 2 seconds 
in the original animation, will occur at 3 seconds after it’s 
passed through the filter.

The default time mapping curve for any property is 
a diagonal line. In this curve, time is not being 
remapped since events occur at the same time 
along both the horizontal and vertical axes.

At point A in the default timeline, an event that occurred at 2 
seconds in original animation, also occurs at 2 seconds in the 
time map.

When you change the shape of the default curve, 
you’re remapping time. 

For example, if you make the curve convex, events 
occur later in the animation, but they’re closer 
together which means the action at that point in 
your animation will speed up.

In this example you can see that at point A an event that 
occurred at 1.5 seconds now occurs at 3.1 seconds. At point B 
an event that occurred at 2.5 seconds now occurs at 3.9 
seconds.

Although both events now occur later, there’s much less time 
between them, so the action in your animation occurs later but 
the changes at that point are faster.

A concave curve would create the same type of effect, except 
that the events occur earlier. Here, event A and B occur much 

A

Animation Time

Time Map

A

A

B

A

B
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earlier, within the first second, and the amount of time between 
them is much less.

Different curve shapes represent different time 
mapping effects. A flat curve means that no motion 
is occurring since all the events on the curve are 
happening at exactly the same point in time. 

This curve indicates that a pause occurs during the course of the 
animation.

 A steep jump in the curve indicates a sharp 
increase in speed, as many events occur in a very 
short time.

This curve indicates a sharp increase in speed.

An oscillation in the curve, indicates that events 
repeat, since they intersect the curve more than 
once.

In this curve event A occurs once at 1.5 seconds and again at 3.5 
seconds.

You can combine any variation of curve slopes to 
create different velocity effects. 

While you’re editing a Time Mapping curve, you 
may want to continuously run the animation 
preview. As the preview runs, the cross-hairs in the 
Time Mapping editor move from the beginning of 
the animation to the end. This way you can quickly 
see the effects of your edits. Refer to “Previewing 
Animations” on page327 for more on continuous 
preview.

The counter at the bottom of the editor shows you 
the current time of the animation. As the animation 
runs, the counter updates to continuously show the 
current time. 

You can also move the current time by dragging the 
Current Time bar in the Hierarchy area.

To edit a Time Mapping curve:

1 Display the Advanced Motion Lab.

2 Click the name of the object whose properties 
you want to remap

3 Click the name of the property you want to 
remap.

4 In the Time Mapping Editor, click a point on 
the curve and drag it to a new location. 

• If you move over an existing point the 
cursor changes to cross-hairs. 

• If there is no point on the curve, the cursor 
turns into a pen.

A A
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5 Continue dragging points until you achieve the 
desired shape.

To zoom into an area of the Time Mapping 
curve:

1 Move the cursor over the curve in the Time 
Mapping Editor. 

2 Click and drag over an area of the curve. When 
you release the mouse, the area is enlarged.

To zoom out of an area in the Time Mapping 
curve:
• Hold down the Shift key and click inside the 

Time Mapping Editor.

To pan the Time Mapping curve:
• To pan, press the Spacebar and drag the curve 

in the editing window.

To reset the view in the Curve Editor, press 
Command/Ctrl + Shift + Click.

Animating Transformations
When you’re in Auto-Key mode, every 
transformation you apply to an object is recorded 
as a key frame. 

In the Hierarchy area you can see where the key 
frames for these transformations appear in the 
timeline. By moving these key frames you can 
control the order in which transformations are 
applied. For example, you can take an object that 
grows larger and then moves left, and turn it into 
an object that moves left and then grows. Several 
animation techniques, like squash and stretch, can 
be simulated using transformations. 

Refer to “Animating Transformations” on page343 
for more on animating transformations.

Animating Materials
The Materials Lab has its own set of animation 
tools that let you animate material properties. You 
can animate almost any property or texture. 

When you’re animating between textures, Bryce 
interpolates between patterns and colors over 
time. You can have a rocky terrain turn into a 
desert during the course of your animation.

Refer to “Animating Materials” on page350 for 
more on animating materials.

Animating Terrains
The Terrain Editor has a set of animation tools that 
let you animate a terrain over time. You can 
animate the shape of the terrain, or the filtering 
effects like Erosion or Mounds. 

Using these tools, you can create a terrain that 
changes shape as time passes.

Refer to “Animating Terrains” on page357 for more 
on animating terrains.

Animating Skies 
The Sky & Fog palette and the Environmental 
Attributes dialog have a number of controls that let 
you set the properties of your environment. By 
changing these properties over the course of an 
animation, you can animate your environment. For 
examples, you can make clouds move, or gradually 
change the time of day.

Refer to “Animating Skies” on page354  for more on 
animating skies.

Animating Techniques
Bryce has several features you can use to add 
realism to your animations. The techniques covered 
in this chapter can be used together to help you 
develop more exciting, natural and dynamic 
animations. 

In this section, you’ll learn how to animate objects 
using the Tracking feature. You’ll also learn how to 
animate several different properties of your scene 
like material channel properties, which can 



Animating344

dramatically alter the look of your objects, and 
terrain object properties, which can alter the layout 
of your landscape.

Tracking Objects
Tracking lets you connect an object to another, 
called the target, so that the object remains pointed 
at the target throughout the animation.

As the target moves, the original object pivots 
around its origin so that it remains pointed at the 
target. Normally, the original object does not 
change position, only orientation. However, if you 
offset the object’s origin point, it might change 
location as it rotates around the offsetpoint.

When an object tracks a target object, it remains pointed at the 
target object no matter where it moves in the scene.

You can use tracking to quickly set up the 
animation of a number of objects at once. When an 
object is tracking another, you only have to set up 
the motion path of the target object. The motion of 
the objects tracking the target are automatically 
created.

The original object pivots around its origin point so that it’s 
always facing the target object. 
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For example, in this scene the motion of all the lights is created 
when you move the target object.

You can use this feature to ensure that a light or 
the camera remains pointed at an object during the 
entire course of the animation. You can also use it 
to create motions like a radar dish following a 
satellite or a sunflower following the sun.

A parent object cannot track its child object. 

To set up object tracking interactively:
1 Select the object you want to remain 

stationary (that is, the one that tracks the 
target object).

2 Move the cursor over the target icon that 
appears next to the object’s bounding box.

3 Drag the Target line from the icon to the 
target object. The target object turns blue.

As you drag the Tracking icon from the tracking object to the 
target, a tracking line appears.

To set up object tracking using the Object 
Attributes dialog:
1 Select the object you want to remain 

stationary.

2 Click the A icon that appears next to the 
object’s bounding box. The Object Attributes 
dialog appears.

3 Click the Linking tab.

4 Click the Target Object Name menu and 
choose the name of the target object.
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Animating the Camera
When you animate the camera, you’re changing the 
view of your scene over the course of the 
animation. Since you’re in 3D space you can move 
the camera to any position in the scene. You can 
have your camera circle around the scene, zoom 
into it or even fly under it.

There are two ways of animating the camera in 
Bryce: using the Camera Position controls, or by 
moving the camera as an object.

The easiest way of animating the camera is to use 
the Trackball, (or other Camera Position controls) 
in Camera View while Auto-Key mode is enabled. 
Any changes you make to the position of the 
camera are automatically recorded as part of a key 
event. When you play the animation, your camera 
changes are added to all the other changes in scene 
properties to create the action in your animation.

While working in Camera View may be the easiest 
way of animating the camera, it’s not the most 
precise. Because of the view’s first person 
perspective, it can be hard to see the exact path of 
the camera as it moves. This can make creating a 
precise motion difficult. 

However, if you switch views, to an orthogonal 
view or the Director’s View, you’ll be able to see the 
camera as an object in the scene. Then you can 
select the camera and set up key events for its 
position, just as you would for any other object. 
Also, you can display the camera’s motion path so 
you can make precise adjustments to its 
movements.

After you’re done setting up the key events for the 
camera, you can see the changes in the Sequencer 
in the Advanced Motion Lab. There you can 
rearrange the order of events or change how long it 
takes to move between camera positions. Refer to 
“Object Hierarchies” on page221 for more on 
working in the Hierarchy, or “Time Mapping 
Curves” on page340 for more on remapping time.

Camera Motion and Skies
The motion of sky elements can affect how fast the 
action in your animation appears. For example, in 
time-elapsed movies, the clouds and sun fly by 
quickly as the objects stay in the same position. 
You could inadvertently create this type of action in 
your scene if you move only the camera in the 
scene without considering the static nature of the 
sky elements. Since the clouds stay in exactly the 
same position as you move the camera, they’ll 
appear to be moving much faster than the objects 
in the scene. 

To avoid this problem, Bryce lets you link the 
clouds to the camera. This way, whenever the 
camera moves, the cloud positions also move, so 
they look like they’re staying in the same position.

Although you can also link the sun to the camera, 
it’s not a very good idea to link the two during an 
animation since any change in the camera position 
will change the time of day.

To link clouds to the camera:
1 Display the Sky&Fog palette.

2 Click the triangle icon in the bottom right 
corner of the palette and choose Sky Lab from 
the menu. The Sky Lab dialog appears.

3 Click the Cloud Cover tab.

4 Click the Link Clouds to View button at the 
bottom of the palette.

5 Click the OK icon to exit the palette.

Using the Orthogonal Views
In Camera View you can’t see the physical position 
of the camera in the scene since you’re looking 
through it, but using one of the Orthogonal views 
(Top, Bottom, Left, Right, Front and Back) you’ll be 
able to see the camera as an object.
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In this example, the scene is displayed in Top view. Here you can 
see the exact position of the camera in the scene.

In these views you can animate the camera by 
changing its position at different points in time. 
When you run the animation, Bryce fills in the gaps 
between positions to create smooth camera 
motion.

To animate the camera in an orthogonal view:
1 In the Working window, click the triangle icon 

next to the View Control and choose an 
orthogonal view from the menu: Top, Left, 
Right, Bottom, Front or Back.

2 Move the Current Time Indicator in the 
Timeline to the point where you want to start 
changing the Camera View.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Drag the Camera wireframe in the Working 
window to a new position.

5 If you want to see the results of your changes, 
choose Camera View from the View Control 
menu and click the Play button in the 
Animation controls.

Using Director’s View
Director’s View is similar to Camera View, except 
that in this view, you can see the camera as an 
object in the scene and the movements of the 
Director’s camera are not recorded as key events.

In Director’s View you see the camera as an object in the 
Working window. You can change this view using any of the 
Camera Position controls in the Control Palette.

In Director’s View, you can move the view of the 
scene using the Trackball or the Camera Position 
tools. The view of the scene changes in the 
Working window, but no new key events are 
created. 

You can also preview the animation while in 
Director’s View. In the Working window you can 
see all the objects moving along their motion 
paths—including the camera.

To animate the camera using Director’s View:
1 In the Working window, click the triangle icon 

next to the View Control and choose Director’s 
View from the menu.

2 Move the Current Time Indicator in the 
Timeline to the point where you want to start 
changing the position of the camera.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Drag the Camera wireframe in the Working 
window to a new position.

5 If you want to see the results of your changes, 
click the Play button in the Animation 
controls.

Displaying the Camera’s Trajectory
If you’re setting up a precise path for the camera, 
you may want to display its motion path. Just like 
with other motion paths, you adjust the trajectory 
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of the camera by adjusting the shape of the path. 
Refer to “Editing Motion Paths” on page331 for 
more on working with motion paths.

When you display the camera’s trajectory, you can see the exact 
path it will take during the course of the animation.

To display the camera’s trajectory:

1 In the Working window, click the triangle icon 
next to the View Control and choose: Top, 
Left, Right, Bottom, Front or Back from 
themenu.

2 Select the Camera in the Working window.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

4 Click the Animation tab.

5 Click the Show Trajectory option and click the 
OK icon.

Linking and Tracking with the Camera
Since Bryce lets you treat the camera as an object, 
you can also link the camera to an object, or you 
can have it track an object. 

When you link the camera to an object, the view of 
the scene changes as the position of the parent 
object changes.

If you link the camera to an airplane, the view of the scene will 
follow the airplane’s trajectory as it moves long its motion path.

When the camera is linked to an object, both its 
aim and position change as the object changes.

When you set the camera to track an object, the 
camera remains pointed at the target object no 
matter where the object moves in the scene. This 
means the Trackball is disabled because the 
orientation of the camera is controlled by the 
position of the target object. Also, you can’t change 
the aim of the camera because it always aims at the 
target object. 

However, you can position the camera using the 
Camera controls as these controls change the 
position of the camera not its orientation.

If you have the camera track an airplane, the view of the scene 
will follow the airplane’s trajectory.
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Linking the camera can cause unpredictable move-
ments when you’re in Camera View. If you change 
the position of the target object, the view of the 
scene will also shift.

To link the camera to an object using the 
Camera & 2D Projection dialog:
1 Switch to an orthogonal view or Director’s 

View.

2 Select the camera.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

4 Click the Linking tab.

5 Click the Object Parent Name menu and 
choose the name of the object you want to use 
as the parent object.

6 Click the OK icon to link the two objects.

You can also access the Camera & 2D Projection dia-
log by double-clicking the Trackball, or by clicking 
the triangle icon beside the Camera controls and 
choosing Edit Current Camera from the drop down 
menu. Only the Camera & 2D Projection tab will be 
available when you access the dialog using one of 
these methods.

To link the camera to an object interactively:
1 Switch to an orthogonal view or Director’s 

View.

2 Select the Camera.

3 Move the cursor over the Link icon that 
appears next to the camera’s bounding box.

4 Drag the linking handle from the icon to the 
object you want to use as the parent object.

To force the camera to track an object using 
the Camera & 2D Projection dialog:
1 Switch to an orthogonal view or Director’s 

View.

2 Select the camera.

3 Click the A icon that appears next to the 
camera’s bounding box. The Camera & 2D 
Projection dialog appears.

4 Click the Linking tab.

5 Click the Track Object Name menu and choose 
the name of the target object.

6 Click the OK icon.

To force the camera to track an object 
interactively:
1 Switch to an orthogonal view or Director’s 

View.

2 Select the Camera.

3 Move the cursor over the Tracking icon that 
appears next to the camera’s bounding box.

4 Drag the tracking handle from the icon to the 
object you want to use as the target object.

Creating Camera Orbits
The camera’s origin point controls its center of 
rotation. When the origin point is at the camera’s 
center, it rotates around in place. When the origin 
is positioned somewhere in the scene, it will orbit 
around the origin point. During an animation, the 
view of your scene will orbit around a specific point 
in the scene.

In this example, the camera’s origin point was positioned in the 
center of the scene. During the course of the animation, the 
camera appears to orbit around the entire scene.



Animating350

To create a camera orbit:
1 Switch to Director’s View or one of the 

orthogonal views.

2 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

3 Click the Camera wireframe in the Working 
window.

4 Click the A icon that appears next to the 
camera wireframe. The Camera & 2D 
Projection dialog appears.

5 Click the General tab.

6 Click the Show Origin Handle button and click 
the OK icon.

7 Drag the origin handle to a position in the 
scene.

8 Rotate the object using the Rotation tool in 
the Edit palette or the Trackball.

Animating Materials
The action in your scene can include much more 
that just motion. Many subtle or dramatic effects 
can be created by changing the properties of an 
object’s surface over the course of the animation. 

This section assumes that you’re familiar with the 
concepts and procedures involved in creating mate-
rial and textures. Refer to “Building Materials ” on 
page162 for more on creating materials and “Creat-
ing and Editing Textures” on page169 for more on 
editing textures.

By animating an object’s texture you can create 
subtle effects like changing the color of an object 
to simulate things like a tomato ripening. You can 
also create more dramatic effects like changing all 
the properties of a material at once. Using this 
technique you can change an object from marble to 
metal, or glass to wood.

In this animation, the illusion of a banana ripening was created 
by changing the color and texture of a material over time.

In Bryce, animating materials is a rather straight-
forward process. Using the animation tools in the 
Materials Lab you set the properties of a material at 
different points along the Timeline. When you run 
the animation, Bryce interpolates between the 
properties to create a transition from one material 
to the other.

You can animate any property of a material:
• Colors

• Channel values

• Texture component usage (that is, switching 
between components A, B, C and D)

• Texture properties

• Volume Material properties

Take care when you’re choosing which properties to 
animate. Some properties, like transparency, and 
volumetric effects can greatly increase the rendering 
time of your animation.
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Material animations are created using the 
Animation controls at the bottom of the Materials 
Lab. 

The Animation controls at the bottom of the Materials Lab let 
you move along the Timeline and preview your animation.

These controls let you move along your animation’s 
timeline. This timeline is the same as the one at the 
bottom of the Working window. It contains all the 
same key events as the Working window timeline. 
The Animation controls in the Materials Lab can 
perform all the same features as the Animation 
controls in the Working window.

Animating Material Channel Values
By animating the channels in a material you can 
alter the properties of a material without changing 
its basic function. Using this technique, a rock 
material would still look like a rock, but change 
color, or glass would still look like glass except 
become shinier. 

In this example, the effect of a cat’s eyes growing brighter as the 
sunlight fades, was created by animating the Ambience channel 
value.

This is the simplest way of animating a material 
and it requires the least amount of processing time. 

To animate a material’s channel values:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Move the Current Time Indicator to the point 
where you want to start changing the material.

5 Change the values of the material channels 
using the Value controls.

or 

Change the color used for a channel by using 
the color picker.

6 Move the Current Time Indicator to a different 
point on the Timeline.

Timeline

Scrubber

Preview Controls Key Frame 
Controls
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The current time appears in the counter next 
to the preview controls.

7 Change the channel values again.

8 Continue moving the Current Time Indicator 
and changing channel values until you achieve 
the effect you want.

9 Click the OK icon to exit the Materials Lab.

Animating Texture Components
Animating a texture component is an effective way 
of creating motion within a material. When you 
change the orientation, position or scale within a 
texture component, the texture elements, (like 
dots, checks or patterns) will appear to move.

You can use this technique to create realistic wave 
motion in a water texture. If you change the 
position of the texture pattern at different points in 
the Timeline, the waves will appear to move over 
the surface of the object.

This tide effect was created by changing the makeup of the 
water texture in the material applied to the water slab.

If you wish to avoid unexpected texture movement 
during a texture animation, use Object Space 
mapping mode for the texture. This way the texture 
moves as the object moves. However, you can 
create some very interesting effects using World 
Space.

You can also animate a texture component by 
altering the makeup of the texture using the Deep 
Texture Editor. Using the editor you can change the 
make-up of any or all of the four texture 
components in a material. 

To animate a material’s texture components:

1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Move the Current Time Indicator to the point 
where you want to start changing the material.

5 Click the button in the upper left corner of the 
texture component window. The Edit Texture 
palette appears.

6 Adjust the position, orientation or scale of the 
texture and click the OK icon to exit the 
controls.

7 Click the pink button in the upper-left corner 
of the texture component window. The Deep 
Texture Editor appears.

8 Adjust the values of the texture’s components 
and click the OK icon to close the editor.

9 Move the Current Time Indicator to a different 
point on the Timeline.

The current time appears in the counter next 
to the preview controls.

10 Change the texture properties again.

11 Continue moving the Current Time Indicator 
and changing texture properties until you 
achieve the effect you want.
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12 Click the OK icon to exit the Materials Lab.

Animating Between Materials
Animating channel values or texture components is 
a good way of creating subtle effects in a material, 
but to create more dramatic action, you’ll need to 
animate between two completely different 
materials.

This is how you create a transition from rock to 
glass, or wood to metal.

The transition between rock and glass in these temple columns 
was created using two completely different materials.

Animating between materials is exactly like 
creating two different materials for the same 
object. As long as the Auto-Key mode is enabled, all 

your settings are recorded as key events, so you can 
set up a material at one point in time and then 
move to a different point on the Timeline and 
create a completely different material. 

There are two quick ways of creating different 
materials:
• By switching the Texture Component used to 

set a material channel, you can completely 
change the color, pattern, or bumpiness of a 
texture.

• Using the Preset Materials Library, you can 
quickly apply a different material to the 
object.

To animate between materials:
1 Select an object.

2 Click the M icon that appears next to the 
object’s bounding box. The Materials Lab 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Move the Current Time Indicator to the point 
where you want to start changing the material.

5 Set up a material by setting channel values and 
texture components.

6 Move the Current Time Indicator to a different 
point on the Timeline.

The current time appears in the counter next 
to the preview controls.

7 Set up a different material by choosing 
different components or applying a preset.

8 Click the OK icon to exit the Materials Lab.
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Previewing Material Animations
Any change you make to a material’s properties are 
displayed in the Material Preview area. When you 
play a material animation, the same preview area 
shows you the transition of the material from one 
key event to the other.

This is not the most effective way to see a material 
animation.The best way of seeing a material transformation is 
by rendering the scene.

To preview a material animation:

• Click the Play button in the Animation controls 
at the bottom of the Materials Lab.

Click the Stop button to stop the preview.

Animating Skies
All the properties of a Bryce sky can be animated. 
This means that any attribute you can set in the Sky 
& Fog palette or the Sky Lab dialog can be 
animated using the Animation controls on the 
Timeline. 

This section assumes that you’re familiar with the 
concepts and procedures involved in creating skies. 
Refer to “Creating Skies ” on page241 for more on 
creating skies.

By changing the attributes in the Sky & Fog palette 
at different points in the timeline, you can animate 
everything from the position of the sun to the color 
of the clouds. 

For example, you can simulate changes in the time of day by 
changing the position of the sun over time.

There are several techniques you can use to add 
motion to your skies. You can animate all or some 
of the properties of your sky. You can activate and 
deactivate sky effects at different points in the 
animation. You can also animate the position of the 
sun or moon. 
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Sky animations are created using the Animation 
tools in the Working window and the Sky Lab 
dialog.

Animating Sky & Fog settings
Animating Sky & Fog settings changes the 
properties of a sky over time. For example a scene 
can become cloudier, or darker during an 
animation. The intensity of the change depends on 
how many properties you adjust and the amount of 
each adjustment.

In this example, the animation of approaching storm clouds was 
created by changing the Cloud Frequency and Amplitude value 
and the Cloud Color at different points in the Timeline.

Most Sky & Fog properties can be changed using 
the thumbnail controls. Other settings are available 
in the Sky Lab dialog. 

You won’t be able to see the effects of a sky 
animation until you render the entire animation.

To animate Sky & Fog settings:
1 Click the triangle icon in the Animation 

controls and make sure Auto-Key is enabled. 

2 Move the Current Time Indicator to the point 
in the Timeline where you want the sky to 
change.

3 Adjust the sky’s properties using the Sky & Fog 
palette controls.

4 Move the Current Time Indicator to a different 
point on the Timeline. 

5 Change the properties of the sky again.

6 Continue moving the Current Time Indicator 
and changing the sky’s properties until you 
achieve the desired effect.

Animating Clouds
You can create the effect of wind in your 
environment by setting up cloud motion 
parameters. Based on your settings, Bryce 
automatically moves the clouds in your 
environment to create motion.

Cloud motion parameters are set in the Sky Lab 
dialog.

The Cloud Direction control lets you set the direction for cloud 
motion, while the other controls set the speed and distortion of 
the clouds. 

To animate clouds:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

2 In Sky & Fog palette, click the Sky Lab button. 
The Sky Lab dialog appears.

3 Click the Cloud Cover tab.

Cloud Direction 
controls

Speed control

Turbulence control
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4 Move the direction indicator in the Cloud 
Motion controls to set a direction for the 
clouds as they move in the animation.

5 Adjust the speed control to set how fast the 
clouds move. You can also enter a speed value.

6 Adjust the Turbulence control to set how 
much the clouds will distort as they move. You 
can also enter a turbulence value.

Animating Environmental Effects
Many environmental effects like rainbows and fog 
are not permanent features of a sky. They appear 
for a brief time and then fade way. You can 
simulate this action by changing the properties of 
the environmental effects at different points along 
the Timeline. 

Environmental effects controls are located on the 
Atmosphere tab of the Sky Lab dialog. You can also 
animate the various settings for an effect. For 
example, the radius of moon rings can increase or 
decrease during the course of your animation.

To animate environmental effects:

1 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

2 Move the Current Time Indicator to the point 
in the Timeline where you want the sky to 
change.

3 Display the Sky Lab dialog: Atmosphere tab 
and change the properties of an effect.

4 Move the Current Time Indicator to a different 
point on the Timeline. 

5 Change the properties of the effect again.

6 Continue moving the Current Time Indicator 
and changing the effect’s properties until you 
have the desired effect.

Animating Sun or Moon Position
One of the most spectacular effects you can create 
using the scene’s sky is elapsed time. In the great 
outdoors we perceive time in relation to the 
position of the sun and the brightness of the sky. 
By changing the position of the sun or moon you 
can simulate time passing in terms of days or 
months.

In this example, the passage of time is simulated by the change 
in the sun’s position.

Since all the elements in the sky are linked, the 
other properties of the sky like Ambient Light 
change as the position of the sun changes, adding 
to the realism of the effect.

For the moon, you can also change its phases, so 
you simulate the passage of an entire month just by 
adjusting the moon attributes.
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To animate Sun or Moon position:
1 Click the triangle icon in the Animation 

controls and make sure Auto-Key is enabled. 

2 Move the Current Time Indicator to the point 
in the Timeline where you want the sky to 
change.

3 Adjust the position of the sun or moon using 
the Sun Position control in the Sky & Fog 
palette.

4 Move the Current Time Indicator to a different 
point on the timeline. 

5 Change the position of the sun or moon again.

6 Continue moving the Current Time Indicator 
and changing the sun or moon position until 
you achieve the desired effect.

Animating Terrains
Terrain objects are animated by changing their 
properties in the Terrain Editor. 

This section assumes that you’re familiar with the 
concepts and procedures involved in creating ter-
rains. Refer to “Elevation Tools” on page99 for more 
on creating and editing terrains.

By changing the shape of your landscape at 
different point on the Timeline you can simulate 
geological events like earthquakes or erosion.
 

The appearance of cracks in the earth during an earthquake, 
can be created by animating the geometry of the terrain.

There are several techniques you can use to control 
how the shape of your terrain changes. You can use 
the grayscale paintbrush to totally change the 
geometry of the terrain by adding new peaks and 
valley, or you can use the Filtering tools to add 
small changes in elevation to the terrain.

Terrain animations are created using the Animation 
controls that appear at the bottom of the Terrain 
Editor.

The Animation controls at the bottom of the Terrain Editor let 
you move along the Timeline and preview your animation.

Timeline

Scrubber

Preview Controls Key Frame Con-
trols
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The Timeline in the Terrain Editor is the same as 
the one in the Working window. All the key events 
recorded for object transformations and material 
changes are displayed in the Timeline. The 
Animation controls in the Terrain Editor can 
perform all the same functions as the those in the 
Working window. Refer to “Creating Animations” 
on page321 for more on using the animation 
controls.

Animating Terrain Geometry
There are two ways of changing the geometry of a 
terrain object: by painting directly on the 2D 
Preview or by applying an elevation effect. When 
you paint on the canvas you create large changes in 
the terrain like the creation of new mountains or 
valleys.

The violent motion of great rock columns shooting up from the 
ground was created by painting a new peak onto an existing 
terrain at different points along the timeline.

The appearance of foot prints in the sand was created by 
painting dark footprint shapes in the 2D Preview at different 
points in the Timeline.

When you apply an effect you create smaller more 
subtle changes like a mountain eroding over time.

The rolling motion in this terrain was created by applying the 
erode effect at one point in the Timeline and then undoing it in 
another.
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You can also use this technique to record how a 
terrain object was formed. By adjusting the Current 
Time as you add elements to the terrain, you’ll have 
a complete record of all your steps.

To animate terrain geometry:
1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain object’s bounding box. The Terrain 
Editor appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Move the Current Time Indicator to the point 
in the Timeline where you want the terrain to 
change.

5 Paint new areas in the terrain using the 
Grayscale paintbrush.

or 

Apply one of the effects in the Elevation tab.

6 Move the Current Time Indicator to a different 
point on the Timeline. 

7 Change the shape of the terrain again using an 
effect or the paintbrush.

8 Continue moving the Current Time Indicator 
and changing the terrain’s shape until you 
achieve the desired effect.

9 Click the OK icon to exit the editor.

Animating Terrain Filtering
By animating the shape of a terrain object’s 
filtering graph you can create some very specific 
geometry effects. 

For example, you can make specific areas of your 
terrain sink to simulate the damage caused by an 
earthquake. To create this effect you would darken 
only areas you want to sink in the Filtering graph. 
Likewise, you create the effect of ridges forming by 
lightening specific areas of the graph. 

The gradual appearance of stairs in this terrain was created by 
adjusting the filtering graph at different points in the timeline.

You can also use the Filtering graph to gradually 
raise or lower the entire terrain over the course of 
your animation.

To animate terrain filtering:
1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain’s bounding box. The Terrain Editor 
appears.

3 Click the Filtering tab.

4 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

5 Move the Current Time Indicator to the point 
in the timeline where you want the terrain to 
change.

6 Adjust the shape of the Filtering graph.

7 Move the Current Time Indicator to a different 
point on the timeline. 

8 Change the shape of the graph again.
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9 Continue moving the Current Time Indicator 
and changing the terrain’s graph until you 
have the desired effect.

10 Click the OK icon to exit the editor.

Animating Terrain Clipping
The setting of the Terrain Clipping bracket can also 
be animated. As areas of the terrain are clipped, 
they’re removed from the terrain object in the 
scene. Your terrain will look like it’s breaking up, or 
like portions it are falling into the sea.

The gradual destruction of this island was created by changing 
the length of the clipping bracket at different points in the 
Timeline.

To animate terrain clipping:

1 Click a terrain object. 

2 Click the E icon that appears next to the 
terrain’s bounding box. The Terrain Editor 
appears.

3 Click the triangle icon in the Animation 
controls and make sure Auto-Key is enabled. 

4 Move the Current Time Indicator to the point 
in the Timeline where you want the terrain to 
change.

5 Adjust the width of the clipping bracket.

6 Move the Current Time Indicator to a different 
point on the timeline. 

7 Change the width of the bracket again.

8 Continue moving the Current Time Indicator 
and changing the width of the bracket until 
you achieve the desired effect.

9 Click the OK icon to exit the editor.

Previewing Terrain Animations
Any change you make to a terrain’s properties 
appear in the 3D Terrain Preview. When you play a 
terrain animation, the same preview area shows 
you the transition of the terrain from one key event 
to the other.

The 3D Terrain Preview displays the preview of your terrain 
animation.

To preview a material animation:
• Click the Play button in the Animation controls 

at the bottom of the Terrain Editor.

Click the Stop button to stop the preview.
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QuickTime VR
QuickTime VR allows you to take a 360° panoramic 
image, and make it into a VR Movie; this unique 
movie will display a 2D panoramic representation 
of your 3D world, and allow point and click 
navigation through the world. You can look up, 
down and around your rendered scene as though 
you were a camera on a tripod.

Further, QuickTime VR lets you create “Nodes,” or 
hotspots in the movie where you can click and go 
to another linked movie. This means you can look 
around a landscape, and seeing an interesting rock 
formation in the distance, click on it to view the 
entire landscape from that new vantage point.

These nodes can also contain “Object Movies;” 
another specialized technology from Apple that 
allows you to click and drag to, in effect, “pick up” 
any object in the VR movie and examine it from all 
sides, as if you literally picked it up and turned it 
around and around in your hands.

Creating QuickTime VR 
Panoramas
The process of creating a panorama involves 
completing a few easy steps.

To create QuickTime VR panoramas:
1 Choose Default in the Document Setup dialog. 

2 Click on the uppermost Views Memory Dot in 
the control palette, to make sure your camera 
is level.

3 Set up your scene.

The important thing to remember is that for a 
successful 360° scene, you need interesting 
objects all around your camera. The best way 
to work on this is to go to the Top View, and 
position objects all the way around the 
camera. 

4 Keep the Nano-Preview in Camera View mode 
to check your view while you are working in 
Top View. 

5 Drag the tip of the camera around in the 
Working window to check the view of your 
scene from all directions.

6 Once you have a good distribution of objects 
in a visually interesting scene, switch back to 
Camera View and do a quick test render.

7 After the render, make any required position 
changes.

8 Choose File> Document Setup and select 
QTVR Panorama. 

This aspect ratio is optimized for use with 
Apple's Make QTVR Panorama tool, though 
many aspects will work. 

The preferred aspect is 13:4. Width must be 
divisible by 96, and height must be divisible by 
4. The QTVR Panorama option ensures that 
your image meets these criteria.

9 Click the triangle icon next to the Render 
controls and choose Select 360° Panorama 
from the menu.

10 Click the Render button to do a quick test 
render. 

The panoramic render mode necessarily 
introduces some distortion into your image, 
and this may change the way you want your 
objects to appear. 

11 Make any position changes you like.

When you do a panoramic render, your wireframe 
scene will bear little resemblance to the rendered 
scene. This is why you should work on your scene in 
standard Default mode, and switch to Panoramic 
rendering after everything is set up.

12 Choose File menu >Render To Disk. The 
Render to Disk dialog appears.

13 Leave the default settings. 
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The Output Size in Pixels was set by the QTVR 
Panorama option in the Document Setup 
dialog. 

The Print Resolution defaults to 72dpi, which 
is the only acceptable setting for the screen-
resolution VR movies; and the Output Size in 
Inches is extra information. You can, however, 
use these features to your benefit if you need 
to print out a 2D version of your VR scene.

14 Click the OK icon.

15 In the Save dialog, choose QuickTime VR, then 
click the Save button.

16 Specify the location and file name for your 
rendered QuickTime VR panorama.

To export a QuickTime VR Panorama:
1 Follow the steps above through step 11.

2 Click the Render button if you made any 
changes after your test render.

3 When the rendering is done, choose File 
menu > Export Image  and choose 
QuickTime VR from the list. 

4 Specify a location for the saved panorama, 
then click Save.

Further VR Exploration
This is a quick way to get started with simple, 
single-node QTVR movie-making. To create movies 
with other embedded nodes, or to get deeper into 
the world of QuickTime VR, contact Apple 
Computer.
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Using Bryce with 
Other 
Applications

This chapter describes how Bryce works with 
other applications, the file formats that Bryce 
supports for both import and export, how to use 
Bryce to create Web-based content, and how you 
can communicate with other Bryce users on the 
Web. 

The effects you add to a rendered image are 
considered post production. Post production 
includes things like compositing, filtering, and 
retouching the image in an image-editing 
application. Post-production can also include 
exporting to other applications. These aspects of 
post production are also covered in this chapter.

When you’re working with animations, post 
production can include all of the still image 
operations, or it can include more advanced 
editing, like combining clips and adding sound 
effects.
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Working with Other 
Applications
Bryce lets you import images and objects from 
other applications. You can also export images and 
objects created in Bryce.

Importing 2D Images
Choose File menu > Open Image  and select from 
one of the following image types:

• Windows Bitmap (.bmp)

• Enhanced Metafile (.emf)

• CompuServe® GIF (.gif)

• JPEG (.jpg)

• Photoshop® (.psd)
• Targa (.tga)

• TIFF (.tif)

• PICT (Mac only)

Exporting 2D Images
You can export images to the file formats listed 
below:
• Windows Bitmap (.bmp)

• JPEG (.jpg)

• Photoshop (.psd)
• PICT (Mac only)

• TIFF (.tif)

Use one of the following commands to export files. 
If you need to conserve memory or plan to create a 
panorama movie, you must use the Render to Disk 
option.

• Choose File menu>Save Image As, then 
select a file type from the list. Not all file types 
are supported.

• Choose File menu>Export Image, then 
select a file type from the list. Bryce uses plug-

in filters for both the Export Image and Render 
to Disk options.

• Choose File menu > Render to Disk . This is 
the best choice if you have created a very large 
image, because it lets you set the DPI and 
saves memory.

Export Image and Render to Disk allow you to 
export to the following additional formats:

• HTML (.htm)

• QuickTime VR (.mov)

To learn more about QTVR, see “QuickTime VR 
Panorama Movies” on page369.

Importing and Exporting 3D Objects
Bryce can import objects saved to the following file 
formats. 

• TrueSpace™ (.cob) Versions up to 4.0 are 
supported. Material properties are supported.

• VideoScape (.vsa) All versions are fully 
supported. 

• VRML1 (.wrl) Imports all properties relevant to 
Bryce, including camera, light, and surface and 
material textures. 

• LightWave™ (.lwo or .lws) Both objects and 
scenes are supported. The camera, lights, and 
all objects (with material information) are 
imported. Versions 6 and up are not 
supported.

• Heightfield (.hf) Used to import descriptions of 
heightfields (terrains).

• USGS DEM (.dem) All forms of DEM files are 
supported.

• USGS SDTS (.ddf) This format is the new USGS 
format which will replace DEM files. 

• Portable Greyscale Map (.pgm) Used to import 
descriptions of heightfields (terrains).

• 3d Studio® Objects (.3ds)

• 3DMF (.3mf)

• AutoCad® (.dfx)
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• Direct 3D (.x) 

• Wavefront (.obj) 
• WCS Elev (.elev)

• WorldToolKit® (.nff) 

Bryce can export your final rendered object to most 
of the file formats listed above. You can also export 
a rendered object to the following file formats: 

• Ray Dream Studio (.rds)

• RayShade (.hf)
• Infini-D 4.0 (.id4)

When you export a file, you save information, such 
as vertices, smoothed normals, UVs (texture 
coordinates), and texture maps. 

Some file formats have limitations. For example, 
DXF doesn’t support smooth normals or UVs. If the 
file format doesn’t support texture embedding, 
each texture map is written as a separate image at 
the same location specified for the mesh file. The 
names of the images will start with the name you 
specified for the mesh file and include the name of 
the material. If UV information can’t be written, 
two texture maps are exported: one for the top 
part, and one for the bottom.

When you export to a 2D format such as DEM or 
PGM, all the possible texture maps are generated.

To import an object:
1 Choose File menu>Import Object.

2 Choose the drive and folder where the file is 
stored.

3 Double-click the filename.

To export an object:

1 Select the object you want to export.

2 Choose File menu>Export Object. 

3 Choose the drive and folder where you want to 
save the file.

4 Choose a file format.

5 Type a filename.

Post Production
Bryce is a 3D application that creates landscapes, it 
is not an image-editing program. As such, you 
won’t find the image-enhancing capabilities of an 
image editor. For post production operations you’ll 
need to use applications like Corel ® Painter™, 
Corel PHOTO-PAINT® or Photoshop. You can use 
these applications to adjust colors, contrast or 
brightness. You can even paint in elements that 
were not in the original scene.

Rendered images can be saved to formats 
compatible with almost any image-editing 
application.

Compositing
Compositing is the process of pasting one image 
into another. For example, if you create a farm 
scene in Bryce and then create a mask for that 
scene, you could paste it into a scanned image of a 
tornado. With a little creativity you can make the 
farm appear as though it were about to be 
destroyed by the storm.

The shape of the foreground image is taken from a 
black-and-white image that contains the shape of 
your scene. This image is called a mask. You can 
generate a mask in Bryce by using the Mask Render 
mode.

Using compositing, you can take the scene you created in 
Bryce ...
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...render it as a mask, using Mask Render mode...

...and then use the image as a selection mask in a 2D image-
editor. Once selected, you can place your Bryce scene into a 2D 
image.

To render a scene as a mask:
1 Click the triangle next to the Render controls 

and choose Object Mask from the menu.

2 Choose File menu>Export and choose either 
BMP or PICT.

Using Corel® Painter™

The following compositing procedure uses Corel 
Painter as a post production application. The steps 
for Adobe Photoshop would be almost the same.

To composite using Corel Painter:

1 Render the scene normally using Perspective 
Render mode.

2 Save the image in a convenient location.

3 Select the objects you want masked.

4 Render the scene again, this time using Object 
Mask mode.

5 Save the mask image to the same location.

6 Open the Perspective Render image in Painter. 

7 Choose Select menu>Load Selection.

8 In the dialog, select the Object Render image. 
Click OK.

Painter selects the objects in your scene.

9 Choose Edit menu>Copy.

10 Open the background image (the image you 
want to paste your Bryce scene into).

11 Choose Edit menu>Paste.

The selection is pasted into the image as a 
floater.

12 Position the floater where you wantit.

Refer to the documentation that came with your 
image-editing application for more information on 
working with masks.

Adding Depth
Distance Mask Render mode produces an image 
that can be used as a distance mask in most image-
editing applications. The Distance Render image 
contains grayscale representations of all the images 
in your scene. Objects closer to the camera appear 
black, while those furthest away appear white. The 
objects in between are various shades of gray 
depending on their distance from the camera. 

This grayscale information can be used to create 
photographic depth of field effects. For example, if 
you take an image that has a lighthouse in the 
foreground and a fishing village in the background 
and render it using Distance Mask Render mode, 
you can take the image into Photoshop and create 
an image where the lighthouse is in sharp focus 
while the village is blurred.
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You can add depth to your scene...

...by rendering it as a distance mask, using Distance Mask 
Render mode...

...and using an image-editing application to place the distance 
mask into the original image’s alpha channel. Once the Distance 
Render is in the alpha channel, you can apply filters to create 
photographic depth of field.

To render a scene as a distance mask:
1 Click the triangle next to the Render controls 

and choose Distance Mask from the menu.

2 Choose File menu>Export and choose PICT.

3 Choose the drive and folder where you want to 
save the file.

Using Photoshop

The following procedure uses Photoshop as a post 
production application. The steps for Corel Painter 
would be almost the same.

To create depth of field using Photoshop:
1 Render the scene normally using Perspective 

Render mode.

2 Save the image in a convenient location.

3 Render the scene again, this time using 
Distance Mask Render mode.

4 Save the mask image to the same location.

5 Open the Perspective Render and the Distance 
Render images in Photoshop.

6 Place the Distance Render image into the 
alpha channel of the Perspective image.

7 Load the alpha channel as a selection.

8 Apply Gaussian Blur.

Objects close to you will appear sharp while 
objects farther away will become progressively 
more out of focus.

• You can also invert the selection and apply 
Motion Blur to the image. In this case, objects 
in the foreground would be motion blurred, 
and the background would be sharp, as if you 
took a picture from a moving car.

• You could determine very specifically which 
objects in your scene are in focus and which 
are not. Select the Distance Rendered alpha 
channel and remap the gray values in the 
Curves dialog in Photoshop. Remap black 
input to lighter output, and the gray value of 
the desired focal object to black. 



Using Bryce with Other Applications368

You can change the focus of images by remapping the gray 
values in the alpha channel of your image.

Printing Images
You can print rendered images directly from Bryce. 
If you need color separations, use an image-editing 
or pre-press application.

To print an image:

1 Choose File menu> Print, or press Command/
Ctrl+P. The Print dialog appears.

2 Choose the options you want to use.

Using Bryce on the Web
If your computer is connected to the Internet, you 
can access the Internet while using Bryce5. You can 
communicate with other Bryce users, visit the Corel 
site, or view the latest technical support 
information.

Accessing the Web
Bryce now has a Links menu that will launch your 
default browser. You can update this list of links to 
add your own links and delete any default links you 
may not need.

In addition, you can export 2-D files to the Web 
using the Export Image or Render to Disk options 
on the File menu. You can export animations 
through the Render Animation feature.

To select a Web link: 
1 Go to the Links Menu. 

2 Click a Web link. 

Bryce communicates with your browser to 
access the desired link.

Modifying a Web Links Menu 

You can modify your Web links menu using a text 
editor. It is a simple file that contains one line per 
link. Each line contains the name of the link, 
surrounded by quotes, a separating comma, and 
the URL in quotes.

To add or delete Web links:

1 Locate the Bryce 5 Links file in your Bryce 
folder.

2 Open the file in a text editor, such as 
WordPad, Notepad, or SimpleText.

Note that each line of the file contains the 
name of the link, in quotes, followed by the 
URL, also in quotes. 

3 Delete the entire line for any links you want to 
remove from your list. 

4 Enter the name of any new link, a comma, and 
any amount of space, followed by the URL of 
the new link in quotes. 

5 If you want to add a dividing line to your 
menu, place an underline in quotes in both the 
link label and URL. 

6 Save the file. 

Your menu should now reflect your new links.
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Create HTML Images 
Use Bryce to get your images on the Web! Bryce 
will export an HTML page with your rendered 
image, along with any hotspot links associated with 
the objects in your scene.

With the HTML dialog, you can set your Web page 
title, the server directory for the page (either your 
local hard disk or the Web host), the name of the 
JPEG file for the image, your e-mail address, and the 
Background URL. 

Also, in the dialog are two sliders—one for the 
level of JPEG compression, and the other for how 
precise you wish the hotspot polygons to be. Bryce 
will then generate the HTML page and the JPEG 
image file for you, ready to be brought straight 
onto the Web.

To create an HTML page:

1 Select the objects that will become hotspot 
links.

2 Click the A icon to display the Object 
Attributes dialog. 

3 Click the Linking Tab, and enter an URL in the 
Web Link box.

4 Select File menu>Render To Disk.

5 Select HTML files (.htm) as the type of file to 
export/render to disk and name the file.

6 Fill in the settings in the HTML Export dialog.

Your image is exported in JPEG format.

QuickTime Movies 
Bryce creates pre-flattened QuickTime movies that 
are ready to go wherever you wish to take them, be 
it the Internet or your friend's computer. 

To create a QuickTime movie:
1 Create an animation in Bryce.

2 Select File menu>Render Animation.

3 Click the triangle icon beside Output module, 
and select QuickTime Movie.

4 Click Edit, and adjust the details of the 
animation.

5 Click Set, and choose the drive and folder 
where you want to save the file.

6 Type a filename.

QuickTime VR Panorama Movies
Bryce can now generate QuickTime VR Panorama 
Movies directly. Panorama movies are movies in 
which you can interactively shift your viewing 
angle. 

You can generate a QTVR movie from Export Image 
or Render To Disk. When you use Render To Disk, 
you can optionally select 90 degree 
counterclockwise rotation for QTVR, to save 
memory.

For information about generating QTVR movies, 
refer to “QuickTime VR” on page361. 
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Glossary

2D projection Your 3D scene must be 
interpreted as a 2D projection; that’s how it is 
translated to your 2D screen! Pretend your 3D 
scene is a drawing on a (2D) piece of paper, which 
is in front of your camera lens; you have control 
over the right/left up/down position of the paper 
(Pan controls), and over the scale of the drawing 
(Zoom/Scale tools). 2D Projection values are an 
important factor in defining a View for your scene.

3D transformation This is a term that refers to 
any operation relating to the size, rotation, and 
position of any object. There are in fact other 
types of 3D transformations that are possible in 
3D space, such as deformations, sweeps, and 
lathing; but Bryce is not a modeler, and supports 
only the basic three: size, rotation, and position.

3DMF 3D MetaFile format from Apple for 
exchanging 3D geometry between applications.

absolute coordinates Values which express an 
absolute location, rotation, or size, whether they 
are location coordinates, degrees of rotation, or 
units of measure.

additive mode A color blending algorithm which 
adds the brightness value of colors from one item 
to the brightness values of another.
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algorithm A finite step-by-step problem-solving 
procedure.

aliasing A visual artifact caused by low resolution 
sampling that can cause hard edges or areas of high 
frequency in an image to look jagged (often 
referred to as “jaggies”). See “antialiasing.” 

alpha channel A separate grayscale channel 
accompanying any PICT/BMP file that can 
determine which areas of the PICT/BMP will be 
visible in the final image and which will not. 
Typically, white areas in the alpha channel describe 
the areas in the corresponding image that will be 
visible, while black areas in the alpha channel 
describe the areas in the corresponding image that 
will not be visible. Also referred to as a mask. In the 
absence of an alpha channel, Bryce can use the 
luminance values of any 2D PICT or 3D solid texture 
as alpha information.

altitude A measurement of height. In Bryce, many 
textures will change their behavior based on 
altitude. 

ambient Light that has no point of origin or 
specific direction, and is presumed to strike every 
point on every object with equal intensity. Since it 
is not affected by other environmental light, it 
tends to affect objects in shadow, and can make 
objects visible even with no specific light source.

amplitude In Bryce, this refers to the intensity of 
the cloud definition. Increasing the amplitude will 
make cloud contours harder, while decreasing it 
will result in softer-edged, more diffuse cloud 
formations.

antialiasing The process of eliminating aliasing 
by higher resolution sampling, so that hard but 
jagged edges appear smooth and clean. 

aspect ratio The relationship between the width 
and height of your document, expressed in pixels 
as a width to height ratio.

auto-update A feature in the Sky & Fog palette 
and Nano-preview which will automatically update 
your changes into your rendered scene or Nano-
preview, respectively.

banking Camera rotation around its Z axis; kind 
of a left/right tilt. Also known as roll, it creates the 
illusion that your horizon is tilted.

batch rendering A process that will allow you to 
automate the rendering of multiple scenes. Just 
drag and drop a group of scene files on the Bryce 
application icon, and Bryce will do the rest.

bitmap Literally, a “map of bits.” Your screen is 
comprised of pixels, and each one of those pixels 
expresses a level of color, whether it is one bit 
(black and white) or 24-bit (millions of colors). Your 
image, when rendered, can be thought of as a pixel-
by-pixel map of color, hence the term “Bitmap”.

boolean rendering A rendering process wherein 
either the space taken up by “negative” objects is 
subtracted from “positive” objects, yielding an 
object with portions removed; or two or more 
objects are combined to form a composite object 
combining the mass and dimensions of all 
contributing objects.

boolean A fancy word that is used to describe a 
system where there are two possible states: On/Off, 
Yes/No, 0/1, True/False, and so on. With respect to 
Bryce rendering, a Boolean attribute such as 
Negative or Intersect will determine whether a 
particular part of a group of objects will be 
Rendered/Not Rendered.

Bryce units of measure An arbitrary system of 
measurement for 3D objects in Bryce 3D. Most 
Bryce objects when they are created are a default 
size of 2048x2048x2048 Bryce units.
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bump mapping A process that interprets changes 
in an object’s surface luminance or color values 
and, without actually affecting the object’s 
geometry, expresses them as perturbations on the 
object’s surface.

camera space A method for representing objects 
in 3D space. It uses a set of Cartesian coordinates 
which are relative to your camera.

camera A metaphorical “tool” for viewing areas in 
a scene. The metaphor refers to the conical 
projection of the scene onto a 2 dimensional plane 
along a specific direction.

center scaling The ability to perform resizing or 
rotating operations on an object based on the 
object’s center, rather than an alternate point, such 
as its base.

CMYK color A well known subtractive color 
standard widely used in the print industry. CMY 
color models blend Cyan, Magenta, and Yellow to 
approximate colors for print; almost always used 
with a fourth ink, black (K), to compensate for ink 
impurities.

conversion The process of changing an object of 
one type into an object of another type. Use the 
little arrow in the Edit palette...

deformation A special form of 3D transformation 
which will deform an object’s geometry, creating 
bulges, twists, bends, and more. Bryce 3D does not 
support this kind of transformation; but you can 
certainly import deformed objects from other 
modeling applications via the Import DXF and 
3DMF feature in Bryce.

depth cueing The effect we use to create the 
appearance that wireframes far away are dimmer 
than wireframes closer to the camera. This effect is 
adjustable.

derivative objects Most primitives available in the 
Create palette also have a few derivative objects as 
well. For instance, the Sphere is accompanied by an 
Ellipsoid and a Squashed Sphere; both are 
considered to be Spheres by Bryce, but they have 
had some post-processing applied to change their 
sizes. 

diffuse Light that is evenly reflected from an 
object’s surface, visible regardless of the angle from 
which it is viewed. Diffuse is associated with matte 
objects.

document resolution The actual size of your 
working document area, expressed in pixels. When 
your Render Resolution is set to 1:1, the Render 
resolution is the same.

DXF Originally developed for use with AutoCad®, 
this is the most common 3D file exchange format.

edit Any action performed on an object after its 
initial creation. Includes moving, resizing, rotating, 
copying, assigning textures, pasting, and more.

family A kind of logical association, assigning a 
Family attribute to a set of objects allows you to 
select and display sets of objects based on an 
assignable wireframe color and associated family 
name. This way, objects which share some 
characteristic such as distance, structure, material, 
or other, can be easily seen, selected, soloed, and 
so on.

field of view Field of View values describe the 
range, from 1 to 180°, which your camera is 
allowed to take in.

frequency A measurement of the number of times 
certain textural characteristics repeat themselves 
within a fixed area.

gel A texture or picture which is applied to a light 
and treated as a transparency or slide, enabling the 
light to project colors, textures, or images onto 
objects in your scene.
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gradient A smooth progression of two or more 
colors.

gradient lights A light object that colors surfaces 
differently depending on the distance of the surface 
from the light object.

grayscale-to-height mapping A process that 
interprets a grayscale range from black to white 
and expresses that range as height, from low to 
high.

group Grouping, a kind of spatial association, 
allows a set of objects to be treated as one. To 
achieve Boolean rendering effects, objects must be 
grouped.

HLS color An alternative color model: Hue, 
Lightness, and Saturation.

HSV color An alternative color model: Hue, 
Saturation, and Value.

illumination In Bryce 3D, any property or 
characteristic related to how an object responds to 
light. This includes Ambient, Color, Diffuse, 
Reflectivity, Refraction, Specular, and Transmitivity.

image resolution Since Bryce renders bitmaps at 
72dpi, the only image resolution you need to 
determine is the height to width ratio of your 
image.

infinite plane A two dimensional surface that 
extends infinitely along the X and Z axes. Bryce 
3D’s Ground, Cloud, and Water Planes are all 
infinite planes, though they exhibit different 
textural properties and are placed in the scene at 
different altitudes.

landing Dropping an object straight down onto 
the object directly beneath it. Usually used to 
“land” an object on the ground.

link to view A Bryce feature which locks the sun’s 
position to the camera position. This way you can 
use the sun control to set your sun position, and 
you will not lose that position if you move the 
camera.

location An object’s position in 3D space. 
Synonymous with position and offset.

mapping The process of interpreting data input 
of one kind and expressing it as another. See Bump 
Mapping, Grayscale-To-Height Mapping, Pict 
Mapping, and Texture Mapping.

marquee selection Marquee is a noun which 
refers to a tool, in many applications, which will 
create a selection area; it can also be used to refer 
to the selection itself. Bryce has no marquee tool 
per se, but you can click and drag in the wireframe 
window to marquee a selection (here the term is 
used as a verb), and you can click and drag in the 
rendered image to marquee a selection for discrete 
rendering.

material In Bryce 3D, the sum of up to four 
textural elements, either 3D procedural or 2D 
picture-based, used to drive various effect channels, 
plus post processing, used as a surface property for 
Bryce objects.

materials channel The rows in the Materials Grid, 
grouped as Light, Effect, and Color; can be driven 
independently or by Texture Components.

materials grid The gameboard-like area in the 
Materials Lab where Texture Components drive 
parameters in the various Channels in the Grid to 
make a Material.

matrix The term is used only in the Bryce Edit 
menu, for the Copy/Paste Matrix commands. When 
you use these commands, you are copying and 
pasting an object’s position, rotation, and size; you 
are not copying size, rotation, or position alone, 
but the matrix of all coordinates, hence the name.
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memory dots This feature, available in the 
Control palette for use with Views, and in the Sky & 
Fog palette, allows you to simply click on a Memory 
Dot to save the state of the parameters to which it 
pertains.

mesh Sometimes known as polyhedron. Used in 
reference to imported geometry as well as Bryce’s 
internally created Stone objects. Similar to 
Polygon, but polygonal faces have been diagonally 
split, or triangulated. 

metaballs Spheres that blend into each other 
based on proximity. The closer two Metaballs are 
to each other, the more their shape merges 
together. Metaballs can be used to create fluid 
shapes that are otherwise time-consuming or even 
impossible to create using primitives and Boolean 
operations.

nano-editor The Nano Editor is a small version of 
your wireframe window, which you can use to edit 
your scene quickly.

nano-preview A small preview of an object or 
scene. The Nano-preview window is at the top of 
the Control Palette.

network rendering  A special rendering mode 
that sends sections of a render to multiple 
computers. This reduces the amount of time 
required to render a complex scene without 
sacrificing the complexity of the scene or the 
quality of the final rendered image or animation.

network render server  A computer connected to 
a TCP/IP network that controls the other machines 
on the network, sending them sections to be 
rendered and reassembling all of the rendered 
sections into the final image or animation.

network render client  A computer connected to 
a TCP/IP network that receives and renders sections 
of an image, and then sends the rendered sections 
back to the network render server.

object space A method for representing objects 
in 3D space. It uses a set of Cartesian coordinates 
which are relative to a given object.

object type Though Bryce creates and imports 
many kinds of objects, for the purpose of selections 
and conversions it must sort these objects into 
types. These types can be clearly seen in the 
Conversion option and in the Edit palette. Cubes 
and their derivatives are all of the Cube type; Cloud, 
Water, and Ground planes are all of the Infinite 
Plane type; Pict objects and 2D Faces are all of the 
2D Face type; all imported objects are of the mesh 
type.

offset An object’s position in 3D space. 
Synonymous with position and location.

opacity The degree to which light cannot pass 
through an object. In Bryce, the term primarily 
refers to the opaque portions of alpha-channels.

orientation An object’s orientation in 3D space, 
expressed in degrees; synonymous with rotation.

orthogonal A special projection of your scene 
which has no perspective distortion. Kind of a 
perspective-free drafting board view, used for 
precise alignments. All Views with the exception of 
the Camera View are Orthogonal. The term can be 
used interchangably with the term orthographic.

output resolution Available in the Export Render 
dialog, you can set the print resolution of the 
resulting rendered image expressed in dots per 
inch. 

parallel light A light which cast rays that are 
perfectly parallel to one another.

patch rendering A technique you can use in Bryce 
3D: select a specific area, or patch, of your image 
for further rendering. Useful to examine areas for 
detail before doing a final render, or for re-
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rendering specific areas after making a change, 
thereby avoiding having to re-render your entire 
image.

pict mapping A process that interprets a 2-
dimensional Pict and expresses it as the surface of a 
3-dimensional object, according to a specified 
algorithm.

pitch Camera rotation around its X axis; kind of a 
tilt forward or back.

plop-render Just a cute name for our way of 
representing a marqueed selection of your 
rendered image. Selections appear to “plop” 
forward, with attendant drop shadows and 
rendering controls. This feature can be enabled, 
disabled, or hidden, as you wish.

polygon All 3D objects in Bryce 3D are built from 
multiple-sided (in Bryce, we use 4 sides) geometric 
surfaces, and are therefore inherently polygonal in 
nature.

primary rays The quantity of virtual rays of light 
that are initially "shot" into the Bryce scene. 

primitive A basic geometric form, such as a cube 
or sphere, used as a basis for constructing 
compound 3D objects such as buildings, rocket 
ships, or snowmen.

primitives Like primary colors, Primitives are the 
primary objects in Bryce. Spheres, cubes, cylinders, 
pyramids, cones, disks, squares, and toruses are all 
primitives. 

procedural objects Procedural objects are object 
that require special constructions or “procedures” 
to create them. Procedures can include operations 
such as preassignment of materials, randomization 
of internal parameters or assignment of light 
properties. For example, terrains.

radial light A light which casts rays equally in all 
directions.

ray hits The total number of times all rays strike 
objects in your scene. Note: The total of Ray Hits 
and Misses is not equal to the total of Primary and 
Shadow rays because secondary rays are not 
quantified in the Render Report.

ray misses. The total number of rays that are fired, 
but strike no objects in your scene. Note: The total 
of Ray Hits and Misses is not equal to the total of 
Primary and Shadow rays because secondary rays 
are not quantified in the Render Report.

raytracing An image synthesis technique by 
which a virtual beam of light is projected from a 
virtual camera into a 3D scene in order to evaluate 
shading and visibility. The virtual beam may be 
absorbed, reflected, or otherwise affected to some 
degree by every object it strikes. For instance, if it 
hits your sky, then a blue sky color ends up on that 
portion of your virtual “film”, your image. In this 
way, a final color is determined for each pixel in 
your image.

reflectivity The degree to which an object 
bounces light back from its surfaces.

refraction As a light wave passes from air through 
another medium such as water or thick glass, it 
seems to bend or turn to a certain degree. This 
phenomenon is known as refraction, and the 
degree to which light bends or turns in these 
situations is controlled by the Refraction channel in 
the Materials Lab.

relative coordinates Values which express 
location, orientation, or size relative to the current 
location, orientation or size. 

render The complex process of building a 2-
dimensional bitmapped image from all the 
information contained in your 3-dimensional 
wireframe scene.
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render resolution The size of your rendered 
image, expressed in pixels, or as a multiple of your 
Document Resolution. The implication here is that 
your rendered image can be larger or smaller than 
your Document Resolution.

replicate While Duplicate will create a copy of 
your selected object, Replicate will create a copy of 
the object and the last 3D transformations applied. 
If you create an object, move it up a bit and rotate 
it a bit, selecting Replicate will create a copy, move 
it and rotate it for you; Multi-replicate will do the 
same with multiple copies in one step. 

roll Camera rotation around its Z axis; kind of a 
left/right tilt. Also known as banking, it creates the 
illusion that your horizon is tilted.

rotation An object’s rotation in 3D space, 
expressed in degrees; synonymous with 
orientation.

scale Values that express the space an object 
occupies; synonymous with Size, though Size 
implies an absolute space.

scene a) The complete content of your Bryce 
world; b) The two-dimensional screen projection of 
your 3D scene; c) The file that Bryce saves, 
containing all information regarding your 
landscape.

secondary rays When a primary virtual light ray 
strikes an object, if that object is reflective or 
transparent, another secondary ray is fired from 
that location (either bounced, if reflective, or bent, 
if transparent/refracted) to continue through the 
scene. This process is repeated up to six times, to 
find a home for the ray, and therefore a final color 
for a pixel in your scene. Secondary rays are not 
quantified in the Render Report.

shadow rays Once a primary or secondary virtual 
light ray has found a final resting place, it must 
determine whether or not to create a shadow 
behind the object. To do so, another ray is fired 
from that location, and this is a shadow ray.

size Values that express the space an object 
occupies; synonymous with Scale, though Scale 
implies a relative size.

sky dome A secondary environmental ambient 
light, used to create a color cast in a scene where 
there is little visible global light.

smoothing Imported objects consist of 
polyhedral faces, which, when rendered, appear 
quite chunky. This is not, in most cases, desirable. 
Use the smoothing command to eliminate this 
chunkiness. You can set a threshold angle for 
smoothing as well. 

snap to A special form of 3D Transformation 
changes the selected object’s position based on the 
Snap To. command you select. These commands 
are located in the Edit palette, in the Alignment 
Options menu. 

solid texture A three-dimensional mathematical 
description of an object’s textural characteristics. 
Often referred to as procedural texture.

specular The “highlight” of any object with a 
shiny surface; light that reflects non-uniformly in 
specific directions depending on the surface 
roughness. “Specular highlight” refers to the point 
where specular reflection is most pronounced.

spotlight A light which casts rays in a cone 
shaped spread; often used top create the classic 
“Hollywood spotlight” effect.

square spotlight Similar to the SpotLight, but 
casts rays in a pyramid-shaped spread; think of it as 
a slide projector.
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symmetrical lattice A procedural Bryce Terrain 
object which has another Terrain mirrored at the 
base.

terrain An object used in Bryce as the basis for 
mountains, islands, plateaus, and other landscape 
objects.

Terrain Canvas The area in the Terrain Editor 
onto which you paint and apply effects. Terrain 
data can be rendered at many levels of detail, from 
16x16 to 1024x1024. This resolution does not refer 
to the wireframe that is used to represent the 
terrain, but instead to the grayscale data used to 
determine the internal level of detail used to 
generate the terrain. Terrains with lower 
resolutions will appear chunky, and will render very 
quickly; use these for terrains that are far in the 
background or where detail is not so important. 
Terrains with higher resolutions will show 
increasing levels of detail, and will take much 
longer to render; use these for foreground terrains, 
or in other cases where detail is important.

terrain resolution Terrain geometry can be 
rendered at several levels of detail. At very low 
settings, you may see geometric “facets” in your 
terrains, even with “smooth surfaces” selected. In 
this case, increase your terrain resolution. Low 
resolution rendering is often best for items in the 
far background, where detail is not so important.

texture component a part of an object’s material. 
Texture Components, which can either be a 2D 
Picture or 3D Texture.

texture mapping A process of applying detail to a 
surface without actually affecting the object’s 
geometry. Values from the texture can determine 
or affect any surface characteristic, including color, 
reflectivity, transparency, or bumpiness.

torus A Bryce primitive that looks like a donut.

transparency The measure of an object’s ability 
to transmit light through its surfaces. Also referred 
to as transmitivity.

triangulation The process of splitting up 
geometric faces into triangles for greater flexibility.

unity The state a Bryce object is in when it is first 
created, or just after the Unity button has been 
pressed; positioned within a “cube” of fixed size in 
an invisible 3D grid, with no rotation applied.

view The sum of camera position in 3D space, 
plus 2D Projection pan and scale values.

wireframe A mesh representation of a 3D object.

wireframe resolution Your onscreen wireframe 
objects can be displayed at various levels of detail; 
this display resolution can be set discreetly for 
static, selected, and moving wireframes. This 
resolution has no relevance to document, render, 
or output resolution.

world space A method for representing objects in 
3D space. It uses a fixed, or absolute, set of 
arbitrarily determined Cartesian coordinates.

yaw Camera rotation around its Y axis; kind of 
turning to look right or left.
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ambient color 136
diffuse color 134
specular color 137
transparent color 140
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Color Perspective 252
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animating 352
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creating 65
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Control palette
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Controls
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definition coordinates 205
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Create light tools  277
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Create Path command 89
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documents 18
HTML pages 369
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metaballs 81
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spotlights 277
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Cubes
creating 65
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adding 254
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creating 65

D
Dampen

terrain effect 103
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Day/Night toggle 261
Deep texture editor 196

blend modes 192
building textures 197
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component previews 198
drag and drop 198
randomizing components 199
using 197

Definition coordinates 205
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defined 373
Delete Key button 329
Deleting

objects from a selection 66
pictures 87
Preset objects 76
preset skies 270

DEM 364
Depth

adding 366
Depth Cue 27

defined 373
icon 28

Depth of field 306
Derivative primitives 65

defined 373
Deselect All command 66
DFF file format 364
Dialogs, displaying 12
Diffuse color 134
Diffusion 133

defined 373
Director’s view 288

animating 347
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banking 295
field of view 295
overview 290
positioning numerically 296
swapping with camera view 290

Disabling
sun 263

Discs
creating 65

Display
changing 22

Display Mode tool 26
Display modes

bitmap 26
Flat Shaded Preview 27
setting 26
switching 26
wireframe 26
wireframe/bitmap 26

Displaying
dialogs 12
interface information 10
object statistics 10
objects as boxes 23
objects as wireframes 23
palettes 12, 29
pictures 85
rendered image information 10
scenes 19
Selection palette 66
show as box 234
submenus 12
VCR Controls 67

Distance render 366
Do not align option 237
Document resolutions

defined 373
Documents

aspect ratio 18
creating 18
preset resolutions 18
resolution 18

DXF file format
defined 373

DXF objects
smoothing 238

E
Edge softness 143
Edit Attributes command 74, 230
Edit button 239
Edit Gradient Dialog 281
Edit palette 11
Editing

attributes 74
cloud textures 254
imported meshes 238
materials 13
stones 238
terrains 12
toruses 237
trees 119
visible light material 284

Editing objects 229
animation attributes 236
attributes 230
boolean attributes 233
converting 239
display attributes 234
icon 233
linking attributes 236
names 233
restoring 230
torus attributes 237
tracking attributes 236
transformations 235

Editor
terrain 93

Effects
applying locally 106
elevation tools 99
eroding 97
image filtering 102
removing locally 106

Elevation
basic tools 100
image filtering effects 102
painting 106
tools 99
using tools 99

EMF file format 364
Enhanced Metafile file format 364

Environmental attributes
Sky Lab 243

Environmental effects 266
animating 356
rainbows 267
stars 268
sun/moon illusion 267
sun/moon rings 266

Environments
adding clouds 253
effects 266
rainbows 267
Sky Lab 243
stars 268
sun 260
sun/moon illusions 267
sun/moon rings 266

Equalize
terrain effect 103

Erasing
Marker Pen lines 24

Eroding
locally 107
terrains 97

Exiting dialog boxes 32
Expanding

object hierarchies 223
Exporting

images 364
mesh objects 239
Preset objects 76
sky presets 271
terrains 115

exporting 239
Eye Level Camera 294

F
Faces

creating 65
Falloff 280
Families 226

defined 373
icon 231
tool 67

Fast preview 310
Fast render strategies 315
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patch rendering 316
Field of View 295

defined 373
Files

closing 25
opening 18
saving 25

Filtering 186
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altitude minus slope—Xb + a 
(altitude-slope)  189
altitude—X(a* altitude + b) 190
applying changes to preview 
110
blending with canvas 110
choosing filter 187
clip aX + b 189
editing filter 187
gaussian—(a(X + b)) 189
how it works 107
none 188
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+ b) 191
quantize 188
saw wave 188
sine wave—sin (aX) + b 188
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smooth clip 191
snow puddles 191
tab 109
terrains 107
xpower—(X PWR a) + b 189

Filtering Graph
altering 109
softening 110
terrains 109

Filtering tab 109
graph 109
presets 110

Fixed cloud plane 259
Flat Shaded Preview display 27
Flipping objects 210
Fly-around view 23
Fly-around view icon 23
Fog

adding 248

attributes 248
color 249
height 249
linking to sun 250
localized 250
setting amount 249

Fog color
blending 249

Fractal
terrain effect 99

Free Mode 292
Frequency

clouds 257
defined 373

Front view 21
Full Scene mode 20
Fuzzy Factor 143

G
Gaussian Edges

terrain effect 101
Gels 83, 284

defined 373
using texture 285

General tab 68
Geometric paths

converting to 89
linking options 225
linking to objects 89

Geometry
animating 358

Geometry effects
blob maker 104
bubble ridges 106
cross ridges 105
cross rodges 2 105
raise edges 105
relief noise 104
subplateaus 105

GIF file format 364
Global texture changes 194

colors 195
filtering 196
noise 195
phase 195
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Gradient
defined 374

Gradient lights 280
creating 280
defined 374
editing 281
offset 281
range 281
transparency 282

Gradients
for terrains 113

Graph
filtering 109

Gray levels
darkening 107
lightening 107
painting 106

Grayscale
switching to color 114
to-height mapping,defined 374

Grid 216
units 216

Ground plane tool 77
Ground planes 77
Grouping objects 221 , 225

defined 374
families 226
icon 232
ungroup icon 232

Groups
selecting objects 66

H
Handles 69
Haze

adding 248
attributes 251
color 251
intensity 251
linking to Sun 252

Haze color
blending 252

Height Noise
terrain effect 102

Heightfield file format 364
HF file format 364
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Hidden objects 234
selecting 66

Hiding
interface 29
palettes 29

Hierarchies  221
collapsing 223
expanding 223
families 226
grouping 225
linking 223
structure 221
viewing 222

Hierarchy List 334
HLS color

defined 374
Horizon

sun/moon illusion 267
HSV color

defined 374
HTML file format 364 , 369
HTML images

creating 369

I
Icons

editing objects 233
families 231
grouping 232
landing objects 233
material 232
object attributes 230
tracking 231
ungroup 232

ID4 file format 365
Illumination

defined 374
Image filtering effects 102

dampen 103
equalize 103
mosiac 103
mounds 103
posterize 103
sawtooth 104
spikes 102
subcontours 104

Image resolution
defined 374

Images
compositing 365
exporting 364
importing 364
printing 368
rendered information 10
working with rendered 316

Imported objects
smoothing 238

Importing
images 364
objects 89, 364
Preset objects 76
sky presets 271

Infini-D 4.0 file format 365
Infinite planes 77

defined 374
Infinite slabs 79
Information

adding to pictures 86
interface 10
objects 10
rendered images 10

Installing 3
Macintosh 4
uninstalling for Macintosh  4
uninstalling for Windows 3
Windows 3

Intensity
light 279
setting haze  251
shadows 247

Interactive
repositioning 215
resizing 211
rotation 213

Interface
Bryce 32
hiding 29
information 10

Intersecting
objects 74

Intersection
boolean 73, 234

Invert button 88
Inverting

Alpha channel 88
alpha channel 83
terrains 97

J
JPEG file format 364
JPG file format 364

K
Keyframes

controls 328

L
Labs

Advanced Motion Lab 13
Materials Lab 13

Landing objects 218
defined 374
icon 233

Landscapes 91
creating 92
filtering 107

Lattices
wireframe mode 71

Launch state 25
Left view 21
Library

adding pictures to 85
Light Editor

Picture Library and 85
Lighting 278
Lighting Lab 278
Lights

adjusting color 279
adjusting edges 279
adjusting intensity 279
creating 275
deleting settings 285
falloff 280
gels 284
gradient 280
linking 285
overview 274
parallel lights 277
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preview options 278
radial  276
round parallel 276
saving settings 285
setting up 275
shadow ambience 279
shadow softness 279
spotlight 276
square spotlights 277
tracking 285
viewing 274
visible 275, 282
volumetric world 270

LightWave file format 364
Lines

erasing 24
Link icon 89, 231
Linking

camera 348
geometeric paths 225
objects to paths 89
propagate 225
to view,defined 374

Linking objects 221 , 223
editing attributes 236
lights 285
options 225

Linking tab 68
Links menu 368

modifying 368
Lists, pictures 88
Load button 82
Loading

pictures 112
pictures into library 85

Localized fog 250
Location

defined 374
Locked 234

object 234
Locked button 234
Logical groups 226
LWO or LWS file formats 364

M
Make circular option 237

Make one shot option 237
Make pendulum option 237
Make repeat option 237
Manually Positioning the Camera 
297
Mapping

defined 374
Mapping color

to terrain canvas 113
Marker Pen tool 24

erasing lines 24
Masks 84
Materials 127

alpha channels 133
animating 343 , 350
animating between  353
channels,defined 374
components 132, 144
defined 374
editor 13
grid, defined 374
icon 232
pictures as 83
structure 128
surface material channels 128, 
133
surface shading modes 156
volume 13
volume material channels 130, 
142
volume shading modes 157

Materials Lab
displaying 232
overview 13
Picture Library and 85

Matrices
defined 374

Maximize
windows 26

Maximum
paintbrush behavior 107

Memory dots
camera positions 299
defined 375

Menu bar 12
Merge command 19

Merging
scenes 19

Mesh
exporting 239

Meshes
smoothing 238

Metaballs 81
defined 375

Metallicity 138, 142
setting using a texture 138

Minimum
paintbrush behavior 107

Modes
bitmap 26
camera 291
center to selection 292
display 26
Flat Shaded Preview mode 27
free 292
preview render 310
switching 27
trackball 291
tripod 292
wireframe 26
wireframe/bitmap 26

Modifier keys 6
Moon

animating 356
brightness/sharpness 265
phases 265
positioning 264
rings 266
size 267
working with 263

Mosaic
terrain effect 103

Motion paths
align options 237
converting to geometric path 
89
display options 236
editing attributes 237
geometry options 237

Mounds
terrain effect 103

MOV files 311, 364



Bryce5 ix

Moving
palettes 12

N
Naming

objects 69, 233
Nano-edit mode 208
Nano-editor

defined 375
Nano-Preview 9, 71

Full Scene mode 20
Sky Only mode 20
using 23
Wireframe Only mode 20

Nano-preview
Auto Update mode 20
defined 375

Negative boolean 74, 234
Network render client

defined 375
Network render server

defined 375
Network rendering 312

Bryce Lightning, installing 313
Bryce Lightning, uninstalling 
313
cancelling 315
configuring the server 313
defined 375
how it works 312
IP address 313
monitoring 314
options 314
pausing 314
resuming 315

Neutral
boolean 72, 233

New command 18
Noise

auto-phased 182
difference 182
dsisplaced max 183
irregular 181
maximum 181
maximum 90 182
minimum 182

minimum 90 182
modes 181
more irregular 181
mulitfractal 181
multiply 182
octaves 180
standard 181
with rotation 182

Nudging 216
Numerical

alignment 220
panning 23
positioning camera 296
repositioning 215
resizing 211
rotation 213
zooming 22

O
Object attributes

camera 289
dialog 230
editing 230
icons 230

Object Attributes dialog 68, 345
Object hierarchies 201, 221

expanding/collapsing 223
families 226
grouping 225
linking 223
viewing 222

Object space 202
coordinates 205
defined 375

Objects
adding preset objects 75
adding to a selection 66
aligning 216
alpha channels 82
arranging 33
as boxes  23
as wireframes 23
attributes 230
changing display 22
converting 239
deleting Preset objects 76

deselecting 66
editing 229
hiding 234
hierarchies 221
importing 89, 364
intersecting 74
linking 223
linking to paths 89
locking 234
materials 127
mesh 239
metaballs 81
names 233
naming 69
negative 74
origin points 207
placement 25, 65
positioning 214
preview 70
preview modes 70
randomizing 220
resizing 208
restoring 230
rotating 212
selecting

by family 67
by type 66
hidden 66

shadows 70
statistics 10
stones 80
subtracting 74
tracking 344
transforming 206
types,defined 375
VCR controls and 67
wireframe attributes 27

Offset 375
OK and Cancel 32
OK icon 32
Opacity

defined 375
Open command 18
Open List button 88
OpenGL accelerator card 71
Opening
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files 18
Pictures Lists 88

Operations, Boolean 73
Optics channels 130

reflection 141
refraction 141
transparency 139

Orbits
creating 349

Orientation
defined 375
tracking option 236

Origin points 207
camera 297
setting camera point 296
showing 234

Orthogonal
defined 375
projection 22

Orthogonal Views 288, 290
overview 21
using in animations 346

Output
alpha 173
bump 173
color 172
resolution,defined 375
types 172

Outputs
textures 172

Overview
Bryce 17

P
Paintbrush

applying locally 106
behaviors 106
modifying behavior 107
painting 106
removing locally 106

Painting
a render area 304
elevations 106
erosions 107

Palettes
Advanced Display palette 11

Create palette 10
displaying 12, 29
Edit palette 11
hiding 29
moving 12
resetting 29
Selection palette 11, 66
Sky & Fog palette 11
sky and fog 242
tools 10

Panning 23
numerically 23

Panoramas
creating 361

Paper
backgrounds 28

Parallel light
defined 375

Parallel lights 277
Partial render 304
Pasting

Alpha channel information 87
pictures 86
RGB information 87

Patch rendering 316
defined 375

Paths
converting 89
linking to objects 89

PGM file format 364
Phase 183

creating 184
dimensions 184
frequency 185
noise modes  186
noise octaves 186
noise orientation 186
noise type 185

Phases
moon 265

Photoshop file format 364
Pict file format 364

saving 25
Pict mapping

defined 376
Pict Object tool 82

Pict objects
alpha channels 82
creating 81

Picture
terrain effect 100

Picture Library 84
accessing 85
adding pictures 86
displaying pictures 85

Picture Lists 88
opening 88
saving 88

Pictures
adding to Library 85
adding to Picture Library 86
as gels 83
as material 83
as terrains 111
blending 112
copying 86, 112
deleting 87
dialog 82
displaying 85
lists 88
loading 112
pasting 86
previewing 85
terrain editor tab 111
thumbnails 85
working with 83

Pitch
defined 376

Placement
objects 25, 65

Planes
ground 77, 78
infinite slabs 79
water 77

Plop-render
defined 376

Plop-Render mode 303
enabling/disabling 303

Polygons
defined 376

Polyhedrons
defined 375
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Polymesh objects
selecting 67

Portable Greyscale Map file for-
mat 364
Positioning

animating 356
camera 9, 32
lights 285
moon 264
objects 214
sun 260
the camera, numerically 296
the view of your scene 291

Positive boolean 234
Post production 363

compositing 365
Posterize

terrain effect 103
Preferences

Working window 26
Preferences command 25
Preset Materials Library

overview 15
Preset Object Library 75
Preset objects

adding 75
deleting 76
exporting 76
importing 76
using 75

Preset Objects Library
overview 15

Preset Skies Library
overview 15

Presets
adding skies 270
deleting skies 270
exporting skies 271
importing skies 271
resolution 18
skies 270
terrain filtering 110

Preview
applying fitlering changes 110
Nano-Preview 9

Preview controls

animation 327
Preview modes

Bounding Box 70
Rendered Preview 71
Shaded Preview 71

Preview render modes 310
fast preview 310
spray rendering 304
textures on/off 311

Previewing
Advanced Motion Lab 338
from different angles 20
lights

Render Against Neutral 279
Render In Scene 279

material animations 354
modes 70
objects 70
pictures 85
Sky Lab changes 243
terrain animations 360
texture components 198
thumbnails 85

Primitives 64
creating 65
defined 376
derivative 65

Printing
images 368

Procedural objects 64
defined 376

Propagate
linking option 236
options 225

PSD file format 364
Pyramids

creating 65

Q
QTVR Panorama Movies

file format 364
Quality/Speed 144
Quick render 304
QuickTime VR 361

creating movies 369
creating panoramas 361

in Bryce 3D 361
Quit command 25

R
Radial light 276

creating 277
defined 376

Rainbows 267
animating 356

Raise Edges
terrain effect 105

Raise/Lower
terrain effect 100

Randomize tool 207 , 220
Randomizing

objects 220
skies 245
texture components 199
using randomize tool 220

RayDream Studio file format 365
Raytracing 302

defined 376
rendering 302

RDS file format 365
Redo command 24
Reflection 141

setting using a texture 142
Refraction 141

defined 376
Relative coordinates 206

defined 376
Relief Noise

terrain effect 104
Render button 22, 26
Render Controls 10, 302
Render Movie dialog 311
Render quality mode

default 305
premium 306
regular 305
super 305

Render reporting 308
Render resolution 18, 306

defined 377
Render to Disk 364
Render With Neutral Sky option 
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75
Rendered Preview preview mode 
71
Rendering 301 , 302

batch 315
controls 10, 302
defined 376
fast rendering strategies 315
images 316
movies 311
network rendering 312
plop-render mode 303
post processing options 307
premium effects 306
projection types 308
quality mode options 305
raytracing 302
resuming 304
setting up 305
spray rendering 304

Rendering algorithms 307
Rendering optimization

aggressive 307
minimal  307
normal  307

Reposition tool 207, 214
Repositioning objects

interactively 215
nudging 216
numerically 215
using reposition tool 214

Reset Palettes command 29
Resetting

views 21
zoom values 23

Resize tool 207 , 208
Resizing objects 208

interactively 211
numerically 211
using resize tool  209
using the keyboard 212

Resolution
documents 18
preset value 18
render 18
rendering 306

setting 96
wireframes 28

Resolution tool 28
Restoring objects 230
Revert to Saved command 24
RGB images

creating 87
pasting 87
replacing information 86
viewing 85

Right view 21
Roll

defined 377
Rotate tool  207, 212
Rotating objects 212

interactively 213
numerically 213
using rotate tool 212

Rotation
defined 377

Round Edges
terrain effect 101

Round parallel light 276

S
Save As 364
Save As command 25
Save command 25
Save List button 88
Saving

files 25
light settings 285
Pictures Lists 88
preferences 25
terrains 115
textures 199

Saving camera positions 299
Sawtooth

terrain effect 104
Scale

defined 377
Scaling

rendered images 316
Scenes

creating 18
defined 377

displaying 19
merging 19
rendering 301, 302
viewing 21

Select All command 66, 67
Select by Type icons 66, 67
Select Color command 29
Selecting

background color 29
background texture 28
hidden objects 66
objects

by family 67
by type 66
VCR controls 67

Polymesh objects 67
within groups 66

Selection
adding objects to 66
deleting objects from 66

Selection palette 11, 66
displaying 66

Sequencer 335
Setting

display modes 26
display preferences 25
Working window preferences 
26

Setting Palette Options 244
Setting up

lights 275
rendering 305

Shaded Preview preview mode 71
Shadow 279
Shadows 70

control 246
setting intensity 247
skies 246

shadows
ambience 279
edges 279

Sharpening
terrain effect 100

Sharpness
moon 265

Show always option 236
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Show as box 234
Show as Box button 234
Show as ribbon option 237
Show handles 237
Show Object as Box command 23, 
71
Show Object as Lattice command 
23, 71
Show origin point 234
Show tangents option 237
Show trajectory option 236
Show when selected option 236
Size

defined 377
Skies

adding fog 248
adding haze 248
ambient color 248
and camera motion 346
animating 343, 354
animating clouds 355
clouds 253
environmental effects 266, 267, 
268
fog 248
haze 251
preset library 270, 271
randomizing 245
shadows 246
sky attributes 246
sky dome color 257
Sky Lab 243
sky modes 245
sun 260
sunrise 261
sunset 261

Sky and Fog palette 11, 242
ambient color 248
animating settings 355
attributes 246
cloud altitude 257
cloud coverage 256
control thumbnails 244
day/night toggle 261
fog 248
frequency and amplitude 257

haze 251
options 244
positioning sun 260
saving settings 244
shadows 246
sky dome color 257
sky modes 245
working with 244

Sky dome
color 257
defined 377

Sky Lab 243
atmosphere tab 267, 270
cloud tab 254
color perspective 252
sun/moon tab 260, 263

Sky modes 245
atmosphere off 246
darker sky 245
soft sky 245

Sky Only mode 20
Slope Noise

terrain effect 102
Smoothing

defined 377
imported objects 238
terrain effect 100

Snap To options 218
defined 377

Soft shadows 306
Soft sky 245
Softening

filtering graph 110
Solo Mode button 68
Source generators

fractal 99
picture 100

Specular
defined 377

Specular color 137
setting using texture 137

Specular Halo 137
setting using texture 138

Specularity 136
setting using texture 137

Speeding up textures 199

Spheres
creating 65

Spikes
terrain effect 102

Spotlight
defined 377

Spotlights 276
adjusting spread 279
creating 277

Spray Rendering 304
Square Edges

terrain effect 101
Square spotlights 277

creating 277
Star fields 268
Static resolution 28
Statistics

object 10
Stones

creating 80
editing 238

Stratus
adding 254
clouds 254

Subcontours
terrain effect 104

Submenus
displaying 12

Subplateaus
terrain effect 105

Subtracting
objects 74

Subtraction
boolean 73

Sun
animating position 356
color 263
disabling 263
horizon illusion 267
linking to camera 262
linking to fog 250
linking to haze 252
positioning 260
rings 266
working with 260

Sun/Moon size 267
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Sunrise 261
Sunset 261
Supported file formats

exporting 364
importing 364
objects 364

Surface material channels 128 , 
133

ambience 135
ambient color 136
bump height 138
color channels 129
diffuse color 134
diffusion 133
metallicity 138, 142
optics channels 130
reflection 141
refraction 141
specular color 137
specular halo 137
specularity 136
transparency 139
transparent color 140
value channels 130

Surface Visible Lights 282
Switching

between display modes 26
modes 27
views 20

Symmetrical Lattice
defined 378
tool 80

T
Targa file format 364
Technical suport

knowledge base 2
Technical support

AnswerPerfect 2
Classic Service 2
FAQs 2
fax on demand 2
mail, fax, email options 3
newsgroups 2
Premium Service 3
Priority Service 2

self-serve options 2
telephone options 2

Techniques
animating 343

Terrain canvas 94
defined 378

Terrain editor 93
3D preview 94
animation controls 96
clipping bracket 114
elevation tools 99
exporting 115
features 93
filtering tab 109
overview 12
paintbrush behaviors 106
paintbrush controls 95
pictures tab 111
terrain canvas 94
undoing opertations 97
zoom area 98

Terrains 91
adding color 113
animating 343 , 357
animating geometry 358
basic tools 100
clipping 114
creating 92
creating new 97
creating with pictures 111
defined 378
editing 12
editor 93
eroding 97
exporting 115
filtering 107
image filtering effects 102
inverting 97
previewing animations 360
resolution, defined 378
saving 115
speeding up 117

Test render 304
Text Display area 10
Texture blend modes 192

add 193

average 193
blend altitude 194
blend maximum 193
blend minimum 193
blend orientation 194
blend random 194
blend slope 194
blend v1 and v2 194
combine 193
difference 194
fast slope 194
maximum 193
minimum 193
multiply 193
parallel 192
procedural blend 194
subtract 193

Textures
background 28
blend modes 192
color blending modes 175
color component 174
combining components 192
component elements 174
component structure 171
component, defined 378
editing clouds 254
filtering 186
global changes 194
mapping, defined 378
output 172
output types 172
phase 183
saving 199
speeding up 199
structure 170

Textures On/Off 311
TGA file format 364
Thumbnails 85

sky controls 244
TIFF file format 364
Time Dots 324
Time Mapping Curve editor 337
Time/Selection palette toggle 11, 
66, 67, 234
Timeline 323
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Tools
Cloud plane tools 78
Display Mode tool 26
elevation 99
Families tool 67
Ground plane tool 77
Marker Pen tool 24
palettes 10
Pict Object tool 82
Resolution tool 28
Symmetrical Lattice tool 80
Water plane tool 78
Zoom In tool 22
Zoom Out tool 22
Zoom tool  22

Top view 21
Toruses

creating 65
defined 378
editing 237

Trackball
using 293

Trackball Mode 291
Tracking

camera 348
icon 232

Tracking objects 344, 345
editing attributes 236
icon 231
lights 285

Trajectory
camera 347

Transformation tools  206
align tool 207, 217
randomize tool 207 , 220
reposition tool 207 , 214
resize tool 207, 208
rotate tool 207, 212

Transforming objects 206
aligning 216
flipping 210
nano-edit mode 208
origin point 207
positioning 214
randomizing 220
resizing 208

rotating 212
tools 206

Transparency 139
defined 378
gradient lights 282
setting using texture 139

Transparent color 140
setting using texture 140

Tree Lab 120
Trees

branches 122
creating 79
editing 119
leaves 124
previewing 121
saving settings 124
trunks 122

Tripod Mode 292
True ambience 306
TrueSpace file format 364
Tutorial 31
Type

selecting by 66

U
Underground On/Off button 28
Undo

terrain editor 97
Undo command 24
Undoing operations 24
Union

boolean 73
Unity

defined 378
User guide

about 6
conventions 6

USGS DEM file format 364
USGS SDTS file format 364
Using

Bryce Interface 29
Nano-Preview 23
Preset objects 75

V
Value channels 130

ambience 135
bump height 138
diffusion 133
metallicity 138, 142
specularity 136

Values
animating 351

VCR Controls
displaying 67

VCR controls 11, 67
VideoScape file format 364
View Control 9
View control icon 23
View of scene

positioning 291, 293
View of you scene

setting up 288
View of your scene 274, 288

banking 295
camera view 288
director’s view 288
field of view 295
orthogonal views 288
rotating 293
setting up 288

Viewing
lights 274
object hierarchies 222
pictures 85
scenes 21

Views
camera view 20, 288, 289
defined 378
director’s view 288, 290
fly-around 23
from back 21
from bottom 21
from front 21
from left 21
from right 21
from top 21
icon 21, 23
Nano-Preview 9
orthogonal 21
orthogonal views 288
othogonal views 290
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panning 23
positioning 291
resetting 21
swapping 290
switching 20

Visible lights 275, 282
editing material 284
surface 282
volume 282

Volume channels 132
base density 143
edge softness 143
fuzzy factor 143
quality/speed 144
volume color 142

Volume Color 142
Volume material channels 130, 
142

base density 143
edge softness 143
fuzzy factor 143
quality/speed 144
volume channels 132
volume color 142

Volume materials 13
Volume Visible Lights 282
Volumetric world 270
VRML1 file format 364
VSA file format 364

W
Water plane tool 78
Water planes 77
Web Links menu 368

modifying 368
Web support 368
Windows

backgrounds 28
Bryce 8
maximizing 26
paper texture 28
setting up 25
Working window 8, 26

Wireframe mode
attributes 27

Wireframe Only mode

Nano-Preview and 20
Wireframe Shadows button 28
Wireframe/Bitmap display mode 
26
Wireframes

defined 378
depth cue 27
displaying 26
displaying objects as 23
motion resolution 28
preview 70
resolution 28
resolution, defined 378
selected resolution 28
shadows 28
static resolution 28
underground 28

Working window 8
setting up 26

World space 202
defined 378

WRL file format 364

X
X-Y Camera control  293
X-Z Camera control 293

Y
Yaw

defined 378
Y-Z Camera control 293

Z
Zoom area

moving 98
resizing 98
terrains 98
turning on 98

Zoom In tool  22
Zoom Out tool 22
Zoom tool 22
Zooming

in 22
numerically 22
out 22
resetting values 23


